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Введение

Итак, вы держите в руках книгу, посвященную использованию одного из наиболее
совершенных и популярных графических редакторов — Adobe Photoshop CS в циф-
ровой фотографии. Эта книга адресована в первую очередь тем, кто уже знаком
с цифровой фотографией и умеет пользоваться фотокамерой. Прочитав ее, вы на-
учитесь производить цветокоррекцию изображений, устранять различные недостат-
ки фотографии, готовить изображения к печати и выводить их на принтер. Также
вы узнаете, каким образом производится описание изображения в цифровом виде,
в каких форматах следует сохранять изображение в том или ином случае, как под-
готовить изображение к отправке по электронной почте и размещению в Интернете.

Хотя в этой книге очень часто встречаются термины «цифровая фотография»,
«цифровой фотоаппарат», «цифровая камера», практически все сказанное в ней
применимо и к обработке изображений, полученных «традиционными» метода-
ми. Вы узнаете, как получить изображение, используя сканер, а также позна-
комитесь с другими способами получения изображений, подходящих как для
обучения, так и для применения в профессиональных проектах.

Даже если вы не используете и не планируете использовать в своей работе или
даже во всей вашей жизни ни цифровой, ни пленочный фотоаппарат, эта книга
позволит вам познакомиться со многими методами обработки изображения при
помощи новейшей на момент выхода книги версии Adobe Photoshop.

Авторы надеются, что вы в любом случае найдете в этой книге что-нибудь инте-
ресное для себя. Также мы хотим поблагодарить всех, кто помогал нам в работе
над этой книгой, а также тех, чья работа осталась за кадром — менеджеров, ре-
дакторов, верстальщиков, корректоров, дизайнеров, печатников и многих других
людей, без труда и заботы которых эта книга не могла бы оказаться на вашей
книжной полке.

'

Успехов вам в освоении просторного поля деятельности — фотографии!

От издательства
Ваши замечания, предложения, вопросы отправляйте по адресу электронной
почты comp@piter.com (издательство «Питер», компьютерная редакция).

Мы будем рады узнать ваше мнение!

На веб-сайте издательства http://www.piter.com вы найдете подробную информа-
цию о наших книгах.



Глава 1

Возможности цифровой
фотографии
В последнее время все большее распространение получают компьютеры и циф-
ровые технологии. На компьютерах создаются макеты журналов и рекламные
модули, модели одежды, производятся расчеты. Эта книга тоже подготовлена
при помощи компьютеров и установленных на этих компьютерах программ. Од-
новременно расширяются компьютерные сети, наиболее известной из которых
является сеть Интернет.

Такое широкое распространение цифровых информационных технологий не мог-
ло не затронуть традиционные области деятельности человека, в том числе и фото-
графию. В этом разделе мы ознакомимся с возможностями, которые предостав-
ляет нам цифровая фотография.

Развитие цифровой фототехники непосредственно связано с развитием компь-
ютеров, и это же определяет ее основное преимущество — вы получаете изо-
бражение на экране монитора буквально через несколько секунд после съемки.
Разумеется, для этого необходимо подключить цифровую камеру к компьютеру
и скопировать изображения на жесткий диск. Кроме того, вы получаете копии
изображений в виде файлов, что позволяет с легкостью копировать их.

Файлы изображений могут легко копироваться, а применение графических ре-
дакторов, например Adobe Photoshop CS, позволяет использовать изображения
в ходе разработке дизайна веб-сайтов, полиграфической продукции и других
художественных объектов. Вы можете легко подготовить файл к отправке по
электронной почте или записать его на компакт-диск с качеством, пригодным
для полиграфической печати. Возможность редактирования изображения позво-
лит вам легко устранить некоторые недостатки изображений — изменить яркость
и соотношение цветов, добавить к изображению поясняющую надпись.

Так как в процессе съемки цифровым фотоаппаратом не участвует фотопленка,
вам не придется сдавать ее в проявку и печать и ждать результатов, которые дале-
ко не всегда оказываются удовлетворительными. Записанные на носитель инфор-
мации файлы гораздо более стойки к внешним воздействиям, чем рулон пленки
или слайды. Файлы изображений не боятся отпечатков пальцев и пыли. Вы може-
те использовать их с первоначальным качеством до тех пор, пока СУЩЕСТВУЕТ
хоть малейшая возможность считать данные с носителя информации.



Возможности цифровой фотографии 13

Цифровые носители информации, используемые при съемке, не боятся света, до-
статочно прочны, легки и компактны. Вы можете легко поместить в своем кармане
объем сменной памяти, достаточный для получения сотен и даже тысяч кадров.

Получив отснятые кадры, вы можете использовать их не только при выполнении
своих художественных проектов, но и как обычные фотографии. Можно легко
просмотреть их на экране компьютера, причем вам не придется прибегать к скани-
рованию пленки или отпечатков. Вы можете распечатать фотографии на домаш-
нем принтере, профессиональной цифровой печатной машине или отдать диск
(или другой носитель информации) с фотографиями в фотолабораторию и полу-
чить их в «традиционном» виде — на обычной фотобумаге.

Помимо удобства обращения с полученными в результате съемки изображения-
ми, важны особенности самой съемки цифровым фотоаппаратом. Большинство
из них оснащены дисплеем, который позволяет наблюдать изображение, попа-
дающее в поле кадра в процессе съемки, или просматривать уже снятые изобра-
жения. Также вы можете получить информацию о режиме съемки, выбранном
камерой, и, если камера предоставляет такую возможность, вмешаться в него,
установив настройки, соответствующие вашим замыслам. Система индикации
и звуковых сигналов делает процесс съемки удобным, а наличие большого цвет-
ного дисплея и возможности просмотра изображения до и после съемки делает
процесс съемки очень наглядным, что особенно полезно для начинающих фото-
графов. Возможность просмотра изображения позволяет сразу выяснить, насколь-
ко удачен тот или иной кадр, и при необходимости повторить съемку.

Так как цифровой камере не нужны кассеты с пленкой, она гораздо компакт-
нее пленочного фотоаппарата, что немаловажно для тех, кто ценит мобильность
и предпочитает брать с собой легкие и малогабаритные вещи. В сочетании с ма-
лыми размерами источников питания и сменных модулей (карт) памяти это де-
лает цифровые фотоаппараты очень удобными для любителей активного образа
жизни.

Ценным дополнением к цифровому фотоаппарату является поставляемое с ним
программное обеспечение и различное дополнительное оборудование, например,
фотовспышка или штатив. Программы, поставляемые вместе с камерой, позво-
лят вам быстро просмотреть фотографии, подготовить их к печати, отправить по
электронной почте или разместить на домашней веб-странице. Для выполнения
этих действий вам не понадобится специальная подготовка — программное обес-
печение цифровых фотокамер, как правило, рассчитано на начинающих фотолю-
бителей, не успевших пока еще освоить все премудрости работы с фотоаппара-
том и компьютером.

В дополнительные возможности фотокамеры может входить печать фотографий
на принтере без участия компьютера или просмотр отснятых кадров на экране
телевизора.

Все эти преимущества и возможности делают цифровую фотографию очень
привлекательной для многих пользователей. Профессионалы, постоянно ис-
пользующие фотографии в работе, оценят скорость получения материала, ко-
торый полностью готов к дальнейшей обработке или использованию в проекте.
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Любители, занимающиеся фотографией для собственного удовольствия или для
развлечения, проведут много приятных минут, делая снимки и рассматривая по-
лученные изображения прямо на месте.

Однако, наряду с широким набором положительных качеств цифровая фотогра-
фия имеет ряд недостатков, также обусловленных ее основой — цифровыми тех-
нологиями. '

Прежде всего, стоит отметить низкое качество изображений, получаемых мно-
гими, особенно простыми и дешевыми, Моделями камер. Малый размер (в пик-
селах) кадра не позволяет полноценно использовать изображение для печати
фотографий большого размера. Камера с чувствительной матрицей, состоящей
из 2 мегапикселов (приблизительно 2 000 000 пикселов, кадр размером пример-
но 1200 х 800 пикселов), позволит вам печатать фотографии размером 10 х 15, в то
время как кадр, снятый самой простой пленочной «мыльницей», может быть уве-
личен до размера настенного плаката. На качество изображений значительно
влияют искажения, вносимые алгоритмами сжатия изображений, используемы-
ми для более эффективного использования объема памяти. Профессиональные
или полупрофессиональные камеры, в конструкции и программном обеспечении
которых принимаются специальные меры для существенного улучшения качест-
ва изображения, имеют достаточно высокую стоимость.

Для съемки цифровым фотоаппаратом требуется более тщательно выбирать
условия съемки. Далеко не все аппараты хорошо работают в условиях низкой
освещенности или съемки быстро перемещающихся объектов, например, вечера
при свечах или спортивных соревнований. Это накладывает определенные огра-
ничения на их использование.

Хотя цифровые носители информации предоставляют вам информацию в исход-
ном виде до тех пор, пока сам носитель пригоден к использованию, сами носите-
ли часто оказываются достаточно нежными и чувствительными. Поэтому вы
должны особенно тщательно заботиться о сохранности компакт-дисков и других
устройств хранения информации. Возможно, стоит хранить две копии вашего
фотоархива, тем более что для этого потребуется не так много места, как для
дублирования нескольких тысяч обычных фотографий или негативов.

Цифровые фотокамеры не используют фотопленку, но гораздо сильнее зависят
от источников питания — расход энергии на работу механизмов камеры и дис-
плея очень высок. Поэтому, планируя длительную поездку или напряженную
фотосессию, позаботьтесь о запасных батареях или источнике питания для заряд-
ки аккумуляторов.

Еще одним недостатком или неудобством использования цифровой фотографии
является высокая стоимость печати фотографий на обычной или фотобумаге.
Стоимость расходных материалов для домашнего фотопринтера, позволяющего
получать отпечатки, близкие по виду и качеству к обычным фотографиям, весьма
высока. Фотолаборатории, принимающие заказы на печать фотографий с циф-
ровых носителей, все чаще встречаются в крупных городах, но они еще не так по-
пулярны, как обычные лаборатории. Стоимость печати одного отпечатка в цифро-
вой лаборатории может в два раза превышать стоимость печати обычного снимка,
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хотя в этой области стоит ожидать снижения цен, — для печати часто использует-
ся одно и то же оборудование, так что все зависит от объема спроса на цифровые
фотоуслуги.

Из всего, что мы сказали выше, можно сделать следующий вывод — цифровая
фотография предоставляет отличные возможности для наглядного освоения
и обучения процессу съемки. Однако вам придется освоить методы работы с ка-
мерой, совершенно не свойственные традиционной фотографии, а также научить-
ся учитывать качество изображения и цель, для которой делается снимок, — это
позволит вам правильно настроить камеру для съемки.

Если вы используете фотоаппарат для съемки друзей, прогулок, вечеринок, вам
подойдет любительская цифровая камера, работающая в автоматическом режи-
ме или допускающая некоторое вмешательство в процесс настройки. Размер
матрицы (число пикселов) в этом случае практически не имеет значения, если
вы планируете печатать обычные фотографии размером 1 0 x 1 5 или просматри-
вать фотографии на экране компьютера.

Для тех, кто планирует использовать фотографии в разработке художественных
проектов или для высококачественной печати фотографий большого размера,
предпочтительнее использовать профессиональные или полупрофессиональные
цифровые камеры, имеющие качественные матрицы и позволяющие получать
изображения большого размера. Также очень полезной будет возможность вруч-
ную задавать параметры съемки и получаемого изображения.

Итак, мы кратко рассмотрели основные преимущества и недостатки цифровой
фотографии. Эта книга посвящена в первую очередь обработке полученных фото-
графий, а не процессу съемки. Поэтому за подробными сведениями и рекоменда-
циями по выбору аппаратуры и собственно фотографии обратитесь к специали-
зированной литературе, в том числе выпускаемой Издательским домом «Питер».

ПРИМЕЧАНИЕ
Например, вы можете обратиться к книге Стивена Гринберга «Самоучитель: Цифровая фо-
тография», 3-е издание, «Питер», 2004.



Глава 2

Способы получения изображений
Прежде чем начать работу над фотографией, вам необходимо получить исход-
ный материал — изображение в цифровом виде. Существует множество спосо-
бов получения таких изображений. В этой главе мы рассмотрим наиболее рас-
пространенные и доступные из них.

Получение изображения с цифровой
фотокамеры
Проще всего получить оцифрованную фотографию с цифровой фотокамеры (или
видеокамеры, поддерживающей режим цифровой фотосъемки). Для хранения
данных в этих устройствах используются, как правило, сменные карты памя-
ти. Они могут обрабатываться как непосредственно камерой, так и различными
устройствами, подключаемыми к компьютеру и предназначенными для считыва-
ния информации с карт памяти. Устройства для чтения карт памяти обычно
встраиваются в карманные компьютеры (их иногда называют «наладонника-
ми», «палмами» от названия наиболее известной компании-производителя этих
устройств) или КПК — карманный персональный компьютер). Также устройствами
для работы с картами памяти оснащаются некоторые модели ноутбуков. В зави-
симости от функциональности (и цены) компьютера он может работать с карта-
ми одного или нескольких типов. Специальные устройства, встраиваемые или
подключаемые к настольным компьютерам, также работают с одним, двумя,
пятью или даже шестью типами памяти.

В настоящее время наиболее распространены такие типы памяти, как Secure Digital
(SD), Multimedia Memory Card (MMC) (разработчик — компания Panasonic),
Compact Flash (выпускаются двух форматов — Typel и Type 2), Memory Stick
(основной поставщик — компания Sony), Smartmedia (в настоящее время использу-
ется в устаревших моделях камер), XD (применяются в основном в камерах Olimp-
us и Fuji), IBM Microdrive (по сути, является миниатюрным жестким диском).

Сменные карты памяти позволяют наращивать объем доступной памяти за счет
использования карт большей емкости, менять карты по мере заполнения, пере-
носить информацию между различными устройствами (например, между каме-
рой и компьютером). При поставке компания-производитель обычно комплекту-
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ет цифровую камеру картой памяти небольшого объема (обычно 16 или 32 Мб),
но так как этого объема достаточно для записи лишь 8-30 кадров (в зависимости
от конкретной модели камеры и ее настроек), рекомендуется сразу же приобре-
сти карту большего объема.

В некоторых случаях для хранения отснятых изображений служит встроенная
в камеру несъемная память. Она также является многократно перезаписываемой,
но ее объем является фиксированным (некоторые камеры имеют встроенную па-
мять и разъемы для установки сменных карт). Обычно такой способ хранения
данных применяется в недорогих моделях начального уровня.

Еще один, гораздо более экзотический вид хранения информации в цифровой
камере, — сменные диски. Эта технология задействована, например, в камерах
серии Sony Mavica. Раньше использовались гибкие диски, теперь — оптические
записываемые (CD-R) или перезаписываемые (CD-RW), а иногда и DVD.

ПРИМЕЧАНИЕ —
Карты памяти представляют собой миниатюрные микросхемы многократно перезаписы-
ваемой энергонезависимой памяти (так называемой Flash-памяти). Для удобства хранения
и подключения к устройству чтения и записи (цифровой камере, портативному компьютеру,
считывателю карт) они заключаются в пластиковые корпуса, снабженные контактами,
миниатюрными переключателями, запрещающими изменение записанной информации (ана-
лог защиты от стирания гибкого диска) и другими дополнительными средствами. Конкрет-
ные возможности и характеристики карты зависят от ее типа.

Если ваша камера использует для хранения информации компакт-диски —
никаких проблем с передачей информации в компьютер не возникнет. Просто
вставьте его в устройство для считывания компакт-дисков. Камера записы-
вает изображения в виде файлов формата TIFF или JPEG (некоторые камеры
работают с другими форматами, например RAW). Скопируйте эти файлы на
ваш компьютер и работайте с ними, как обычно.

Для извлечения отснятых кадров из камеры со сменными картами памяти или
встроенной памятью вам потребуется подключить к компьютеру саму камеру.
Впрочем, сменные карты памяти можно прочитать при помощи отдельного или
встроенного в компьютер устройства, предназначенного для этой цели.

Соединение камеры с компьютером осуществляется при помощи специального
кабеля (современные камеры обычно используют интерфейс USB). В некоторых
моделях предусмотрена базовая станция, в которую устанавливается камера. Ба-
зовая станция подсоединяется к компьютеру и источнику питания для зарядки
аккумуляторов.

В ранних моделях камер для передачи данных применялись специальные про-
граммы, подобные программам управления сканерами. Сейчас камеры, как пра-
вило, используют интерфейс, позволяющий операционной системе распознавать
камеру как дополнительный съемный диск и работать с ним так же, как с жест-
ким диском, — открывать, копировать и удалять файлы. Аналогичным образом
реализуется работа с картами памяти, помещенными в устройство для доступа
к ним. Если в инструкции к вашей камере указан иной порядок действий —
придерживайтесь его.
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ПРИМЕЧАНИЕ -
Для реализации автоматического распознавания типа устройства и организации доступа
к нему необходим драйвер порта USB. Он входит в состав операционных систем Windows Me,
2000 и ХР. Для операционной системы 98 потребуется установить этот драйвер, который
обычно входит в комплект поставляемого с камерой программного обеспечения.

Взаимодействие камер и компьютеров в режиме, подобном работе со сканером, использует-
ся и сейчас в профессиональных и полупрофессиональных камерах. В этом режиме вы мо-
жете загружать фотографии непосредственно в графический редактор, например в Adobe
Photoshop.

После подключения камеры к компьютеру (порядок выполнения этой операции
описывается в прилагаемой к камере инструкции), она становится доступной
как дополнительный диск. Используйте любую программу для работы с фай-
лами (например, FAR, Total Commander или Проводник Windows) для копи-
рования файлов на жесткий диск вашего компьютера. Вы можете открыть файл
непосредственно с карты памяти или из памяти цифровой камеры, но обмен
данными с картой или памятью камеры идет медленнее, чем передача данных
с жесткого диска, кроме того, при работе с камерой расходуется энергия ее акку-
муляторов (если вы не применяете дополнительный блок питания или базовую
станцию).

СОВЕТ
Некоторые камеры позволяют получить доступ к хранящимся в их памяти файлам при помо-
щи системной папки Панель управления > Сканеры и камеры. Устройства появляются в спи-
ске, находящемся в этой папке, только после их подключения к компьютеру.

ВНИМАНИЕ
Независимо от того, используется для работы с камерой или картой памяти специальная
программа или программа для работы с файлами, не отключайте камеру от компьютера,
не выключайте ее питание и не вынимайте карту памяти из камеры или считывающего
устройства до завершения передачи данных. В противном случае могут быть потеряны
данные, передававшиеся в момент отключения, или повреждены камера или карта памяти.
О выполнении операций с картой памяти обычно сигнализирует специальный индикатор,
размещенный на камере или устройстве для чтения карт памяти.

Обычно цифровые камеры дают создаваемым на картах памяти файлам имена,
состоящие из некоторого набора символов (например, названия семейства ка-
мер) и порядкового номера. Например, DSC_0001.JPG. Некоторые камеры нумеру-
ют файлы в пределах одной карты памяти. После замены карты нумерация начи-
нается заново. Другие камеры могут использовать сплошную нумерацию. Она
может быть начата заново только в случае ручного сброса настроек или установ-
ки их в начальное состояние, например, после длительного отсутствия в отсеке
питания заряженных аккумуляторов.

Нумерация помогает различать файлы между собой, однако для большей на-
глядности и удобства стоит дать им более информативные имена. Особенно по-
лезно давать осмысленные имена файлам, которые вы отобрали для дальнейшей
цифровой обработки.
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СОВЕТ
Если вы печатаете фотографии, полученные с цифровой камеры, установите в програм-
ме, из которой производится печать, режим вывода вместе с изображением имени фай-
ла. Это позволит в дальнейшем легко определить, в каком файле находится искомое
изображение.

Для удобства поиска можно давать файлам имена, содержащие обозначение (например, по-
рядковый номер в архиве) компакт-диска или другого носителя информации, на котором эти
файлы находятся.

Удобно создать для снимков, относящихся к одной теме (встрече Нового года,
поездке в соседний город или далекую страну и т. д.), отдельные папки. При
записи на компакт-диск задайте в программе записи информативную метку
диска, позволяющую даже без изучения обложки и содержимого диска опреде-
лить, что на нем находится. Да и несколько минут, потраченных на составление
аннотации и запись ее на обложке диска (или печать на принтере и помещение
листа под крышкой футляра диска), могут сэкономить вам впоследствии много
времени и сил.

•

Получение изображения со сканера
Для получения изображений в электронном виде может с успехом использовать-
ся сканер. Этим способом вы можете перевести в электронный вид свою коллек-
цию «традиционных» бумажных фотографий или получить новые изображения,
например, из книг или журналов.

Если в вашем распоряжении имеется сканер для фотопленки или слайд-сканер,
вы можете получать изображения, минуя процесс фотопечати. В сочетании с вы-
сокими характеристиками современных пленочных и слайд-сканеров это позво-
ляет получить изображения значительно лучшего качества, чем при сканирова-
нии фотографий любительским сканером. Для сканирования пленок и слайдов
могут использоваться некоторые настольные сканеры в сочетании со специаль-
ными адаптерами.

Отсканированные изображения при грамотном выполнении всех действий не
только не уступают, но и превосходят по качеству изображения, полученные
цифровой камерой.

Работа со сканером осуществляется в большинстве случаев под управлением
специальной программы-драйвера. Она автоматически вызывается из приложения,
обратившегося к сканеру, например из Adobe Photoshop. Процесс сканирования
управляется из программы-драйвера при помощи ее интерфейса, а полученное
изображение передается в приложение, обратившееся к программе управления
сканированием. Процесс получения изображения со сканера в Adobe Photoshop
будет рассматривается ниже, в отдельном разделе.

Для получения наилучших результатов при сканировании изображений необхо-
димо грамотно выбрать оборудование (сканер) и оригинал. Для большинства
пользователей подойдет простой сканер, обеспечивающий оптическое разрешение
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при сканировании в районе 300 dpi. Получаемые при помощи таких сканеров
изображения вполне подходят для размещения на домашней страничке в Интер-
нете, печати на домашнем принтере или же пересылки друзьям по электронной
почте. Большинство домашних сканеров способны обеспечить большее разреше-
ние (а значит, и лучшее качество изображения), но процесс сканирования при
этом может занять неоправданно много времени.

Также следует учитывать, что чем большая разрешающая способность запроше-
на от сканера, тем больше будет объем полученного файла. Даже при относи-
тельно небольших разрешениях, например 100 dpi (изображения такого качест-
ва подходят разве что для пересылки по электронной почте и просмотра на
экране компьютера), объем несжатого изображения, полученного при скани-
ровании фотографии размеромiO x 15 см, превысит 500 Кбайт. Для размещения
в Интернете или отправки по электронной почте такие файлы лучше сохранять
в форматах, допускающих сжатие изображений. К сожалению, в большинстве
случаев сжатие изображения приводит к ухудшению его качества.

Для цифровой обработки или для последующего вывода изображений на качест-
венную печать (профессиональный или полупрофессиональный фотопринтер
или цифровую печатающую машину) желательно получить изображение как
можно более высокого качества и большого размера (в данном случае эти поня-
тия являются практически синонимами). Имея цифровое изображение большого
размера (содержащее много информации), вы и ваше программное обеспечение
будете обладать большим «простора» для работы. Большой объем информации
позволит сформировать качественное изображение при выводе на печать.

В большинстве случаев изображения, отсканированные с разрешением 600 или
800 dpi, позволяют подготовить качественные материалы для обработки и после-
дующего вывода на печать при разрешении печати 300 dpi (этого вполне доста-
точно для основных целей).

ПРИМЕЧАНИЕ :

Оптическим или аппаратным разрешением часто называют разрешающую способность ска-
нера, обеспечиваемую его чувствительным элементом. Эта характеристика в основном оп-
ределяет объем собираемой информации об изображении. Многие программы позволяют
при сканировании использовать значения разрешающей способности, превышающие оп-
тическое разрешение. Следует знать, что изображение при этом сканируется при разре-
шающей способности, определяемой аппаратными возможностями сканера, а затем искус-
ственно увеличивается программными методами, что не только не улучшает, но даже может
ухудшить качество изображения.

Качество сканера определяется множеством параметров. Поэтому если вы не уверены в сво-
их знаниях, при выборе сканера проконсультируйтесь с более опытными пользователями
и персоналом магазина.

Отсканировав изображение, сохраните его на жестком диске. Имейте в виду, что
изображения могут иметь большой объем. Для их хранения может потребовать-
ся много места на диске. Файлы стоит поместить в папку, отведенную для свя-
занных с вашим проектом или определенной темой кадров. Для удобства вы мо-
жете указать в названии файла размер изображения и разрешение, при котором
производилось сканирование.
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Если вы уже владеете соответствующими методами и приемами, перед тем как
закрыть файл, проведите начальную цветокоррекцию. Скорее всего, потребуется
произвести коррекцию уровней черного и белого. Возможно, потребуется кор-
рекция оттенков, но может быть, вы сочтете, что оттенки изображения соответ-
ствуют действительности или вашим ожиданиям и целям, что не менее важно.
Коррекцию яркости и оттенков можно отложить и выполнить в процессе работы
над изображением.

Если упомянутые выше термины, например «уровни черного и белого», понятны
вам не больше чем китайская грамота, вам следует ознакомиться с главой этой
книги, посвященной коррекции изображений.

ВНИМАНИЕ
Для получения наилучших результатов используйте для печати фотографий, подлежащих
сканированию, глянцевую фотобумагу. Если требуется действительно высокое качество, за-
кажите отпечатки максимального формата, подходящего для вашего сканера.

Сканирование полиграфических материалов может потребовать дополнительных мер для
устранения муара, возникающего при сканировании полиграфического растра (точек крас-
ки, образующих изображение). Об этих мерах подробно рассказано в разделе, посвященном
взаимодействию Adobe Photoshop со сканерами.

Коллекции изображений
Профессиональные фотографы часто издают свои произведения в виде сборников
и каталогов, из которых вы можете заказать ту или иную фотографию. В таких
каталогах, как правило, содержатся фотографии высокого качества, пригодные
практически для всех видов графических работ. Если вы планируете разработку
профессиональных рекламных материалов или веб-сайта, вам стоит обратить
внимание на этот источник изображений.

Каталоги фотографий (их часто называют фотобанками) доступны в виде веб-
сайтов, компакт-дисков с коллекциями изображений, бумажных каталогов. Фо-
тографии в каталогах чаще всего разбиваются по тематике. Это могут быть как
постановочные фотографии, так и фотографии, снятые в реальных условиях.

По такому каталогу вы можете заказать файл требуемого разрешения (размера
изображения), который будет доставлен вам через Интернет или на компакт-дис-
ке по обычной почте. В некоторых случаях вы можете заказать копию негатива
или отпечаток требуемого размера.

Следует отметить, что большинство фотобанков работают на коммерческой ос-
нове. Вам придется заплатить либо за доставку файла, либо за покупку компакт-
диска. Кроме того, некоторые фотографы требуют отчислений за тираж продук-
ции, изготовленной с использованием их произведений. Плата может быть высо-
кой, поэтому к услугам фотобанков прибегают в основном рекламные агентства
и профессиональные дизайнеры, для которых изготовление рекламных модулей,
обложек журналов, оформление публикаций, верстка и подготовка материалов
к печати являются источником дохода. На рис. 2.1 показана страница одного из
фотобанков, размещенных в Интернете.
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Рис. 2.1. Вы можете найти высококачественные фотографии
в фотобанках, размещенных в Интернете

Некоторые из размещенных в Интернете фотобанков являются бесплатными.
Вы можете пользоваться их архивами свободно или с незначительными ограни-
чениями. Например, вам могут разрешить выбрать фотографии для личных це-
лях бесплатно, но потребовать плату за право применения изображений в ком-
мерческой продукции.

Некоторые фотографы размещают на своих сайтах собственные коллекции изо-
бражений, доступные для просмотра и иногда — для использования. Если автор
разрешает использовать фотографии при подготовке каких-либо изображений
или документов, на сайте могут быть доступны высококачественные версии изо-
бражений, пригодные не только для Интернета, но и для полиграфии.

ПРИМЕЧАНИЕ
При полиграфической печати используется более высокое разрешение, чем при просмотре
изображений на экране. Экран монитора позволяет отображать изображения с разрешени-
ем 72 или 96 dpi, в то время как при цветной печати в основном используется разрешение
300 dpi. Такая разница в разрешающей способности печатающих машин и мониторов приво-
дит к тому, что изображение, имеющее достаточно большой размер и высокое качество при
просмотре на экране монитора, после печати может оказаться маленьким или приобрести
совершенно непрезентабельный вид (изображение становится нечетким, на нем проявля-
ются отдельные пикселы).
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Если вы решили выбрать в качестве источника изображений фотобанк, разме-
щенный в Интернете, каталог или коллекцию изображений на компакт-диске,
вам не потребуется заниматься сканированием. Просто перепишите изображе-
ния с полученного компакт диска, электронного письма или указанного вам ка-
талога на сервере в нужную папку на жестком диске вашего компьютера.

В этой главе вы изучили наиболее удобные и распространенные методы получе-
ния цифровых фотоизображений, пригодных для создания ваших собственных
произведений. В следующем разделе вы ознакомитесь с форматами файлов, слу-
жащих для хранения исходных фотографий, промежуточных результатов рабо-
ты и для сохранения конечных результатов вашего труда.



Глава 3

Форматы файлов изображений
Во время работы с изображениями в цифровом виде вам придется иметь дело с
различными типами файлов. Цифровые камеры сохраняют изображения в раз-
личных форматах. Чаще всего это формат JPEG или TIFF. После копирования
файлов на жесткий диск вашего компьютера вы можете сохранять файлы в дру-
гих форматах, выбирая тот или иной формат в зависимости от стоящих перед
вами целей.

Различные форматы предоставляют вам различные возможности — вы можете
сохранить файл со всеми дополнительными элементами, использованными во
время редактирования, можете применить сжатие изображения для удобства
размещения его в Интернете или отправки по электронной почте, можете сохра-
нять файлы в различных цветовых моделях, оптимизируя файл для вывода на
экран или на печать.

Таким образом, на различных этапах работы вам предстоит работать с файлами
различных форматов. Необходимо научиться правильно выбирать формат фай-
ла и использовать его возможности.

Формат JPEG
Работая с цифровыми камерами, вы, как правило, можете выбрать формат, в ко-
тором будут сохраняться снимки. Эту возможность предоставляют большинство
современных камер.

Объем карт памяти ограничен, а их стоимость, особенно для карт большого объ-
ема, довольно высока. Поэтому пользователи заинтересованы в сохранении как
можно большего числа фотографий при минимизации объема файлов. Можно
сохранять изображения меньшего размера, но это не всегда приемлемо, по-
скольку уменьшается качество изображений при печати (при неизменном раз-
мере и разрешении отпечатка). Для того чтобы сохранить размер изображения
и при этом уменьшить размер файла, используют формат, позволяющий сжимать
информацию.

Наиболее распространенным в настоящее время форматом, предназначенным для
хранения полноцветных фотоизображений с применением сжатия данных, явля-
ется формат JPEG. Первые работы над его созданием были начаты в 1982 году,
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когда в рамках Международной организации по стандартизации (International
Standardization Organization — ISO) была создана Группа экспертов по машинной
обработке изображений (Photographic Experts Group — PEG). Эта организация
занималась вопросами передачи видеоданных, изображений и текста по каналам
цифровой связи. Целью исследований была разработка международных стандар-
тов в области передачи данных этих типов в компьютерных сетях. В 1986 году
Международный консультационный комитет по телеграфии и телефонии (Con-
sultative Committee for International Telephone and Telegraphy — CCITT) начал
разработки, направленные на создание алгоритмов передачи факсимильной ин-
формации (цветных и монохромных изображений). Алгоритмы, созданные спе-
циалистами этих организаций, оказались похожими, и в 1987 году они объеди-
нили свои усилия по разработке единого стандарта сжатия изображений.

Результатом этого сотрудничества стал формат JPEG Qoint Photography Experts
Group), позволяющий реализовать сжатие полноцветных или монохромных изо-
бражений до размеров, удобных для передачи по каналам связи. В отличие от
формата GIF JPEG позволяет хранить изображения, содержащие до 16 миллио-
нов оттенков.

Так как фотографии и видеоизображения часто содержат протяженные области
с плавными переходами цвета (градиентами), для их сжатия не подходят алго-
ритм LZW или подобные ему. Они не позволяют значительно снизить размер
файла. Для качественной компрессии понадобились новые алгоритмы, основан-
ные на других принципах.

В основе JPEG лежит так называемое сжатие с потерями. Это значит, что сжатие
изображения происходит за счет выбрасывания мелких, незначительных дета-
лей. Во многих случаях эти детали столь малы и незаметны, что человек не в со-
стоянии заметить разницу между сжатым изображением и оригиналом. Однако
разница в размерах соответствующих файлов может быть значительной.

Основы алгоритма JPEG — преобразование информации о цвете, хранимой
отдельно для всех цветовых составляющих, одного пиксела в область частот с по-
следующей фильтрацией. Проще говоря, для хранения данных о цвете использу-
ются не цветовые составляющие каждого пиксела, а сведения о том, как изменя-
ется вклад той или иной составляющей в результирующий цвет. Такие методы
обработки основываются на принципах частотного анализа, широко применяе-
мого в радиоэлектронике. В данном случае изменение яркости или цветовых
составляющих от пиксела к пикселу описывается в виде набора колебаний (по
аналогии с радиоэлектроникой эти колебания можно назвать составляющими
сигналами) различной частоты и амплитуды. Такую операцию также называют
определением спектра сигнала.

ПРИМЕЧАНИЕ
Преобразование сигналов в набор частотных составляющих осуществляется при помощи
так называемого прямого преобразования Фурье. Обратное преобразование Фурье позволя-
ет синтезировать сигнал по его спектру.
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Простейший случай такого преобразования изображен на рис. 3.1. Жирной ли-
нией обозначено изменение значения одного из параметров пиксела (например,
яркости). Синусоида представляет собой первую гармонику (частотную состав-
ляющую) этого «сигнала» с частотой, равной частоте повторения «импульсов»
яркости. Вторая гармоника будет иметь частоту, в два раза превышающую часто-
ту первой, третья — в три раза и так далее. Каждая из таких частотных состав-
ляющих описывается частотой, амплитудой и начальной фазой.

Яркость
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Рис. 3.1. Выделение низкочастотной составляющей из зависимости
изменения яркости пикселов от координаты X

При использовании подобного частотного разложения теоретически можно вна-
чале выделить из сигнала бесконечное число составляющих (гармоник), а потом
просуммировать их и получить исходный сигнал. Однако реализовать это на
практике сложно. Дело в том, что работать с бесконечными рядами невозможно,
а обработка ряда с большим количеством элементов займет много машинных
ресурсов. Поэтому приходится обходиться некоторым числом составляющих,
зависящих от требуемой точности воспроизведения сигнала.

Ограничиться некоторым числом составляющих можно благодаря тому, что с ро-
стом частоты амплитуда гармоник значительно убывает. Если требования к точно-
сти невысоки, то часто можно рассмотреть только 5-10 самых низкочастотных
составляющих, остальными можно пренебречь. Разумеется, часть информации
при этом будет потеряна, но сигнал будет воспроизведен с приемлемой точностью.

Обратите внимание: уменьшая число рассматриваемых составляющих сигнала,
мы тем самым уменьшаем объем информации, описывающей этот сигнал, то есть
производим сжатие данных.

ПРИМЕЧАНИЕ
Даже если не отбрасывать составляющие сигнала, потери все равно возникнут. Дело в том,
что компьютер производит все операции с определенной точностью. Из-за округления
изображение исказится даже при отсутствии сжатия.

В этом утверждении заложена сущность всех алгоритмов сжатия изображения с по-
терями. Частью информации можно пренебречь ради того, чтобы воспроизвести
изображение с приемлемой точностью и при этом достичь уменьшения объема
описывающих его данных. Конечно, при этом теряются некоторые детали изо-
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бражения, качество снижается, но, разумно выбирая алгоритм и степень сжатия,
можно добиться того, что файл с рисунком значительно уменьшится в объеме,
а сам рисунок останется пригодным к использованию.

Для лучшего понимания основ работы алгоритма JPEG следует рассмотреть осо-
бенности восприятия человеком окружающей его реальности. Человеческий
глаз более чувствителен к яркости, чем к цветовым составляющим изображения.
Если вы переведете картинку в монохромный режим (яркий пример — черно-
белый телевизор), то изображенные предметы останутся узнаваемыми, — вы
сможете сказать, что изображено, и даже определить некоторые свойства объекта,
например материал, из которого он состоит. Изображение, содержащее цвета, но
лишенное яркостной составляющей, практически невозможно распознать. Вы
можете легко убедиться в этом при помощи Photoshop. Просто закрасьте ка-
кой-либо рисунок любым цветом (но не черным и не белым) при помощи инст-
румента Paintbrush (Кисть) в режиме Luminosity (Яркость). При этом все пикселы
приобретут яркость цвета кисти.

Итак, у нас в руках два основных принципа сжатия изображений при записи в фор-
мате JPEG. С одной стороны, разложив некоторый сигнал (в данном случае —
это информация об изображении) на частотные составляющие и отбросив самые
незначительные из них, мы можем достичь сжатия данных. С другой стороны,
человеческий глаз устроен так, что он воспринимает в первую очередь яркость
изображения и уже потом — его цветовые характеристики. Это предоставляет
два способа уменьшения объема файла изображения, которые и используются
в алгоритме JPEG:

• объем хранимых и передаваемых данных может быть уменьшен путем разло-
жения информации о цвете на частотные составляющие с последующим от-
брасыванием самых незначительных из них — «лишних».

• так как глаз человека более чувствителен к яркости изображения (в данном
случае оно состоит из пикселов), чем к его цвету, следует стремиться передать
без искажений информацию о яркости пикселов, а информацией об их цвете
можно до определенной степени пренебречь.

Применение этих методов позволяет достичь высокой степени сжатия и значитель-
но уменьшить объем файлов, содержащих изображение. Грамотное использова-
ние алгоритма позволяет получить настолько высокое качество воспроизведения
картинки, что различить сжатое изображение и оригинал практически невозможно.

При сохранении изображения в формате JPEG над ним производятся следую-
щие операции.

1. Изображение преобразуется из исходной цветовой модели (например, RGB,
где каждая точка описывается тремя цветовыми составляющими) к модели,
содержащей яркостный компонент и два компонента, определяющих цвет
точки. Это необходимо для раздельной обработки яркостной и цветовой
составляющих изображения. Если изображение уже находится в подходящем
цветовом режиме, преобразования не требуется. В дальнейшем все компонен-
ты обрабатываются независимо друг от друга.



28 Глава 3. Форматы файлов изображений

2. Цветовые компоненты усредняются между соседними пикселами, что позво-
ляет уменьшить объем данных, необходимых для их передачи. Обычно усред-
нение производится так, что «поле» цветовых компонент уменьшается в два
раза по вертикали и по горизонтали. Например, для изображения 400 х 400 пик-
селов будут получены «поля» цветовых компонент размером 200 х 200. Воз-
можны и другие сочетания коэффициентов пропорциональности сторон, на-
пример 2 : 1, но они дают меньшую степень сжатия. Яркостный компонент на
этом этапе не изменяется. Благодаря этому яркость изображения подвергает-
ся меньшим искажениям.

3. Применение дискретного преобразования Фурье. Изображение (точнее, каж-
дая из его компонент) разбивается на блоки 8 x 8 пикселов, к которым приме-
няется дискретное преобразование Фурье. При этом информация о значении
того или иного компонента представляется в виде соответствующих колебаний.
По аналогии с радиотехническими сигналами можно выделить в преобразован-
ных компонентах некоторое среднее значение (некоторый аналог постоянного
тока), а также переменную составляющую (аналог переменного тока). Высо-
кочастотные (быстрые) изменения параметров ме'нее заметны, чем изменения
низкочастотные (плавные). Поэтому верхние частоты могут быть отброшены.

4. Квантование значений параметров. Для отбрасывания ненужных компонен-
тов значения, полученные в ходе преобразования Фурье, делятся на весовые
коэффициенты и округляются. Для каждой точки внутри блока преобразова-
ния (8x8 пикселов) используется свой коэффициент, который выбирается из
специальной таблицы. Для выбора яркости и цветовых составляющих сущест-
вуют и цветовых составляющих отдельные таблицы. Составлять такие табли-
цы достаточно сложно, поэтому большинство кодировщиков JPEG используют
стандартную таблицу ISO.

5. Именно на этом этапе производится регулировка качества изображения. Из-
меняя весовые коэффициенты, можно определить, какая часть информации
будет отброшена. При этом качество изображения и размер файла изменяют-
ся обратно пропорционально друг другу.

6. Сжатие полученных значений без потерь. Для устранения повторов в полу-
ченных значениях параметров изображения данные дополнительно сжима-
ются по методу Хаффмана. Этот метод основывается на замене всех кодов,
встречающихся в исходных данных, на новые, причем наиболее часто встре-
чающиеся комбинации получают самые короткие «обозначения». Этот метод
позволяет достичь высокой степени сжатия без потери информации.

Для раскодирования данных необходимо выполнить эти операции в обратном
порядке.

Данные разархивируются в соответствии с методом Хаффмана. В результате по-
лучаются отсчеты параметров изображения.

1. Из файла считывается таблица весовых коэффициентов. С ее помощью восста-
навливаются результаты преобразования Фурье, выполненного при сжатии.
В зависимости от степени сжатия, заданной кодировщиком, эти данные в той
или иной степени соответствуют исходным.
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2. Над отсчетами частотных составляющих производится обратное преобразова-
ние Фурье. Это позволяет восстановить значения компонентов изображения.

3. Полученные значения цветовых компонентов «распределяются» между сосед-
ними пикселами. Это необходимо из-за того, что при сжатии «поле» цветовых
компонентов было уменьшено. Значение яркости сразу готово для последу-
ющей обработки.

4. Для удобства вывода на экран или выполнения обработки изображение пре-
образуется в одну из цветовых моделей (к примеру, в RGB для вывода на эк-
ран или в CMYK для печати).

Рассмотрев принцип работы алгоритма JPEG, мы можем подробнее остановить-
ся на сферах его применения.

Основная проблема, ограничивающая применение этого формата, — уменьшение
качества изображения при увеличении степени сжатия. Причем для каждого изо-
бражения приемлемая степень сжатия будет разной. Определить ее проще всего
подбором. Посмотрим, как сказывается сжатие на качестве изображения. Для этого
сохраним фотографию в формате JPEG. На рис. 3.2, а приведено исходное изо-
бражение. На рис. 3.2, б, ей г изображена та же картинка после сжатия в различ-
ных режимах. Все изображения сохранялись при помощи Adobe Photoshop. Для
них приведено значение показателя качества, используемого в этой программе.

Рис. 3.2. Увеличенные фрагменты изображения после сохранения в формате JPEG с различными
значениями показателя качества: а — оригинал (формат TIFF без сжатия), б — показатель

качества 10, в — показатель качества 6, г — показатель качества 1
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Размеры файлов (см. рис. 3.2): а — 132 Кбайт, 6—28 Кбайт, в — 22 Кбайт, г —
19 Кбайт. Из рис. 3.2, г видно, что при степени сжатия, близкой к максимальной,
на изображении возникают шумы и искажения, в то время как при сжатии с мак-
симальным (или близким к максимальному) показателем качества (см. рис. 1.3, б)
изображение практически не отличается от оригинала

ПРИМЕЧАНИЕ
Искажения, вносимые в картинку кодировщиком JPEG, часто называют артефактами JPEG,

Результаты этого небольшого эксперимента позволяют сделать вывод о том, что
формат JPEG хорошо подходит для хранения фотографий и других изображе-
ний, содержащих много различных оттенков с плавными переходами между
ними. А вот изображения, содержащие четкие линии (например, чертежи), в нем
сохранять не следует — линии могут смазаться (см. рис. 3.2, в). Также не следует
сохранять в этом формате изображения, содержащие большие однотонные плос-
кости — на них может возникнуть шум.

Тестирование также показало, что при помощи JPEG можно достичь значитель-
ной степени сжатия. Например, для изображения, показанного на рис. 3.2, г, она
составила 6,9. Однако качество изображения при таких режимах сохранения мо-
жет стать неприемлемым. Разумно выбирая режим, можно добиться высокого
качества изображения и при этом значительно уменьшить размер файлов на дис-
ке или в памяти камеры. Так, для фото, представленного на рис. 3.2, б, степень
сжатия равна 4,71, а качество вполне подходит для оформления веб-страниц,
цифровой фотопечати и даже для некоторых видов полиграфических работ. Для
изображения, показанного на рис. 3.2, в, степень сжатия еще больше, но качество
еще вполне приемлемо для многих целей, включая печать в любительской фото-
лаборатории.

Итак, мы рассмотрели принципы работы и основные свойства алгоритма JPEG.
Но это только основной (базовый) вариант стандарта. У этого формата есть не-
сколько дополнений, каждое из которых позволяет существенно расширить его
возможности.

ПРИМЕЧАНИЕ
В англоязычной литературе базовый вариант JPEG часто называется «baseline» (базовый)
или «standard» (стандартный). Некоторые производители могут не поддерживать расшире-
ния формата.

Среди таких расширений можно назвать прогрессивное построение изображе-
ний, разбиение изображений на зоны с разными показателями качества, сохране-
ние нескольких рисунков с разной разрешающей способностью в одном файле
и т. д. Для веб-дизайна наиболее полезным является прогрессивное построение
изображений. При использовании этой функции файл сохраняется за несколько
проходов. После загрузки на компьютер пользователя данных об одном прохо-
де изображение сразу выводится на экран, но с низким качеством. По мере загруз-
ки оставшихся данных качество изображения повышается.
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У файлов, сохраненных с применением прогрессивного построения изображений,
есть еще одно достоинство — они обычно имеют несколько меньший размер, чем
файлы, сохраненные в стандартном формате.

Кроме собственно изображения в файлах формата JPEG могут сохраняться и не-
которые дополнительные элементы, например направляющие линии, используе-
мые при редактировании изображений. Цифровые камеры записывают в созда-
ваемые файлы информацию об условиях съемки (чувствительность, выдержка,
диафрагма, фокусное расстояние, параметры вспышки и т. д.). Конкретный
набор параметров и степень детализации данных зависят от модели камеры.
Некоторые программы (например, Adobe Photoshop или программы просмотра
файлов, поставляемые вместе с камерой) могут считывать эти данные и отобра-
жать их в удобном для восприятия человеком виде. Windows XP также позволяет
считывать эти данные. Для их просмотра вызовите пункт Свойства из контекст-
ного меню файла в окне Проводника Windows или другой подобной программы,
перейдите на закладку Сводка и щелкните на кнопке Дополнительно.

ПРИМЕЧАНИЕ
Данные о параметрах съемки, сохраняемые в файле цифровой камерой, часто обозначаются
аббревиатурой EXIF.

Формат PSD
Так как графический пакет Adobe PhotoShop является одним из наиболее рас-
пространенных средств обработки изображений и подготовки веб-графики, его
внутренний графический формат (PSD) также получил широкое распростра-
нение.

ПРИМЕЧАНИЕ
Данный формат наиболее широко применяется для хранения промежуточных результатов
работы над оформлением сайта или другим проектом. Для хранения исходных изображений
обычно используются другие форматы.

Формат PSD развивается одновременно с программой Photoshop, что необходи-
мо для хранения элементов, которые вводятся в новых версиях программы. При
этом сохраняется полная обратная совместимость форматов. То есть файл,
сохраненный, например, в Photoshop 5.0, можно открыть в Photoshop CS без по-
тери элементов изображения и качества. Следует учитывать, что обратная со-
вместимость форматов не поддерживается. Это значит, что некоторые элементы
файла не смогут быть прочитанными в более ранних версиях программы.

ПРИМЕЧАНИЕ
Основа использующегося в настоящее время формата PSD была введена в Photoshop 3.0.
Именно в этой версии были введены слои, позволяющие более гибко работать с изображе-
ниями и хранить его элементы отдельно друг от друга. В предыдущих версиях формата PSD
слои отсутствовали, поэтому они рассматриваются как самостоятельные форматы хранения
изображений.
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В настоящее время файл, сохраненный в формате PSD, может, содержать сле-
дующие элементы.

• Слои изображений. Для каждого слоя хранится отдельный канал прозрачно-
сти (альфа-канал), позволяющий отдельно задать прозрачность каждой точки
изображения. Прозрачность может изменяться от 0 до 100 % (256 градаций).
Один из слоев полностью непрозрачен и называется Фон (Background). Этот
слой формируется по умолчанию в любом создаваемом файле (за исключением
случая создания файла с прозрачным фоном). Для сохранения файлов в фор-
матах, не позволяющих сохранять слои, все существующие слои объединяют-
ся в фоновый слой. Слои могут быть сгруппированы или объединены в набор
(layer set), после чего многие операции (такие, как перемещение изображе-
ния) выполняются над всеми слоями группы или набора одновременно. Кро-
ме того, для слоя могут быть определены стили и эффекты, определяющие
вид изображения, но не изменяющие его (например, можно легко установить
тень, отбрасываемую слоем, не изменяя самого слоя).

ПРИМЕЧАНИЕ
В компьютерной графике данные о прозрачности изображения принято называть альфа-ка-
налом (alpha-channel). Прозрачность некоторого объекта может обозначаться в программах
как «альфа» («alpha»).

Дополнительные альфа-каналы. Вы можете определить и сохранить допол-
нительные альфа-каналы, не связанные с конкретными слоями. Эти каналы
могут использоваться для сохранения сложных масок (выделений фрагмен-
тов изображений).

Цветовые каналы. Изображение в формате PSD может храниться в различ-
ных цветовых моделях (RGB, Lab, CMYK, Grayscale и т. д.). Для моделей,
предусматривающих наличие нескольких цветовых каналов, эти каналы сохра-
няются отдельно (например, для изображения в модели Lab отдельно сохра-
няются каналы L, а и Ь). Это позволяет конвертировать изображения из одной
модели в другую после загрузки из файла. Кроме того, каналы могут быть выде-
лены в отдельные файлы, что используется, к примеру, при подготовке изобра-
жения к печати. Кроме основных каналов цветовой модели могут сохранять-
ся каналы дополнительных цветов (spot channels), хранящие информацию
о дополнительных красителях, применяемых при печати изображения.

Цветовые профили (профили ICC). Цветовые профили позволяют скорректи-
ровать изображение таким образом, что его цвета отображаются на выводящем
устройстве (мониторе или принтере) без искажений. Внедренные в PSD-файл
цветовые профили позволяют с легкостью переносить эти файлы с одного
компьютера на другой без искажения оттенков. Благодаря использованию си-
стемы цветокоррекции программа Photoshop удобна для дизайнеров, работаю-
щих в полиграфии. Для веб-дизайна это не столь актуально, так как конечные
файлы изображений не могут сохранять цветовые профили. Возможность
применения внедренных цветовых профилей появилась в Photoshop 5.O.
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• Векторные объекты. В предыдущих версиях Photoshop можно было внедрять
в файлы растрового изображения векторные объекты. Это позволяло строить
сложные кривые и сохранять выделения с возможностью последующего ре-
дактирования. В версии Photoshop 6.0 возможности применения векторной
графики были существенно расширены. Появились автофигуры, при помощи
которых можно легко строить такие фигуры, как прямоугольники, эллипсы,
линии и многогранники.

• Направляющие. Направляющие линии позволяют легко выравнивать объек-
ты, расположенные на разных слоях, точно выделять прямоугольные области
изображения, проводить прямые линии. Эта возможность была впервые реа-
лизована в Photoshop 4.O.

• Текстовые слои. Для удобства работы с текстом в Photoshop 5.0 были введе-
ны текстовые слои. Такие слои сохраняют текст не только в растровой форме
(обычная графика), но и в виде собственно текста, что позволяет изменять
текст и параметры его отображения. Программы, используемые для про-
смотра файлов (например, ACDSee), отображают такие слои в виде пикселов,
a Photoshop позволяет получить доступ к таким атрибутам, как гарнитура
шрифта, его размер, начертание, расстояние между символами (кернинг) и дру-
гим. Следует заметить, что в Photoshop 6.0 были введены новые правила
форматирования текста. В связи с этим предыдущие версии этой программы
могут отображать и редактировать текст, сохраненный в шестой версии толь-
ко в виде растровой графики.

• Миниатюры (thumbnail). Этот элемент представляет собой уменьшенную
копию изображения, хранимого в файле. Многие программы считывают это
изображение и отображают до открытия основного содержимого. По этим ри-
сункам можно быстро выбрать нужный файл, особенно если его имя не связа-
но с содержимым.

Кроме перечисленных выше элементов файл в формате PSD может содержать
текстовые и звуковые комментарии, а также некоторые другие блоки.

Для уменьшения объема, занимаемого PSD-файлом на диске, в этом формате ис-
пользуется алгоритм сжатия RLE (Run-Length Encoding — кодирование серий).
Этот алгоритм обеспечивает сравнительно невысокую степень сжатия, но позво-
ляет повысить скорость обработки данных, кроме того, сжатие производится без
потерь информации. PSD-файлы занимают меньше места на диске, чем, скажем
несжатые файлы в формате TIFF. Файлы PSD можно дополнительно сжать при
помощи программы-архиватора. Это позволяет уменьшить объем файла еще
приблизительно в два раза (в зависимости от содержимого).

ПРИМЕЧАНИЕ
Алгоритм сжатия данных RLE предусматривает замену последовательностей одинаковых
символов на два символа — кодируемый символ и число его повторений. Разумеется, наи-
больший эффект от применения этого алгоритма достигается на файлах, содержащих много
одинаковых символов, следующих друг за другом. Применительно к графике это изображе-
ния, содержащие большие области, равномерно залитые одним цветом. Подобные алгорит-
мы кодирования обычно используются в устройствах передачи данных (например, в портах
ввода/вывода), поддерживающих аппаратное сжатие данных.

2 Зак. 805
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СОВЕТ
Работая с исходными изображениями (фотографиями, заготовками), стремитесь получать
оригиналы большего размера, чем это нужно. Например, если вам необходимо получить
изображение размером 100 х 100 пикселов и обработать его, возьмите исходное изображение
размером 1000 х 1000. Обработав изображение, придайте ему нужные размеры. Разумеется,
такое соотношение размеров не является правилом, все зависит от конкретной ситуации.
Поступать подобным образом следует потому, что при обработке растровых изображений
программа сталкивается с конечной единицей измерения — пикселом. Нельзя получить эле-
мент изображения меньший, чем один пиксел. Графический редактор, обрабатывая изобра-
жение большего размера, получит большую «свободу действий» и сможет выполнить обра-
ботку более качественно. Если речь идет об исходных изображениях в формате JPEG, можно
рекомендовать использовать тот же подход. В самом деле, если изображение несколько
размыто при сжатии, но имеет размер, больший, чем нужно, уменьшение изображения
может поправить ситуацию.

Формат TIFF
Формат TIFF (Tagged Image File Format — формат файлов изображений, снаб-
женных тегами) является одним из наиболее широко распространенных форма-
тов, используемых при подготовке графики. Этот формат является фактически
стандартом для подготовки изображений в полиграфии. Файлы этого формата
обычно имеют расширение .tif или .tiff.

TIFF является одним из наиболее сложных по своей внутренней структуре фор-
матов. Файлы TIFF начинаются с заголовка файла изображения (IFH — Image
File Header) длиной 8 байт. Заголовок файла содержит блок, называемый ката-
логом файла изображения (IFD — Image File Directory). Этот блок позволяет
графическим программам определить внутреннюю структуру файла.

ПРИМЕЧАНИЕ
Файл формата TIFF обычно начинается с символов «II*». Это можно использовать для про-
стого определения формата файла, имеющего нестандартное расширение.

При помощи IFD из файла можно выделить теги — блоки данных, содержащие
информацию о размерах изображения, его цветовой модели, размере палитры
(числе используемых цветов), сжатии данных и т. д. Само изображение также
содержится в отдельном теге. Всего определено насколько десятков таких блоков.
Так как весь TIFF-файл состоит из тегов, этот формат легко поддается модерни-
зации и расширению. В самом деле, для введения дополнительных возможно-
стей достаточно определить новый тег. Однако в этом кроется источник возмож-
ных ошибок — если программа не сможет определить значение тега, введенного
кем-либо из производителей аналогичного программного обеспечения, файл мо-
жет быть открыт неправильно или вовсе не сможет быть прочитан.

В файле формата TIFF изображение может храниться в цветовых моделях CMYK,
RGB, Lab, в режиме индексированных цветов, а также в виде оттенков серого
(grayscale). Это позволяет применять данный формат для хранения самых разных
изображений, используемых как для подготовки веб-графики, так и в полиграфии.
Подробнее о цветовых моделях будет рассказано немного позже. Кроме цветовой
модели сохраняется и разрешение, с которым следует выводить изображение на
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печать. Задав высокое разрешение, можно получить качественные распечатки,
если, конечно, принтер поддерживает печать с заданными параметрами.

Максимальное число бит, которыми описывается один пиксел изображения в фор-
мате TIFF, составляет 24. Это позволяет закодировать до 16 777 216 цветов.

ПРИМЕЧАНИЕ
В веб-дизайне чаще всего используется «родная» для компьютерных мониторов модель RGB
или режим индексированных цветов (до 256 произвольных цветов или стандартная палит-
ра). Разрешение, задаваемое в файле, чаще всего составляет 72 dpi.

СОВЕТ
Создавая изображение для сайта, не имеет смысла требовать для него большого разре-
шения при печати. Большинство мониторов способно отображать графику с разрешени-
ем 72 или 96 dpi.

Кроме изображения, в TIFF-файле могут сохраняться каналы прозрачности
(альфа-каналы), позволяющие сохранять прозрачные области изображения или
выделения объектов между сеансами работы. Если вы работаете в Photoshop,
можно сохранить в формате TIFF файл, содержащий слои, но другие программы
смогут прочитать такой файл только как единое изображение. Для указания на
необходимость сохранения слоев установите флажок Layers (Слои) в окне выбора
имени сохраняемого файла.

ПРИМЕЧАНИЕ
Adobe Photoshop может сохранять в формате TIFF дополнительные элементы изображения,
например направляющие линии.

Еще одна особенность формата TIFF — возможность сохранения нескольких
изображений, имеющих собственные наборы атрибутов и свойств (тегов) в од-
ном файле. Это делает TIFF похожим на формат GIF, однако в нем отсутствует
возможность создания анимированных изображений.

Важное свойство формата TIFF — использование сжатия данных. Такое сжатие
не является обязательным и может быть включено или выключено пользова-
телем. В большинстве случаев применяется алгоритм сжатия LZW (метод
Лемпела-Зива-Уолша, сжатие без потерь информации), но может применяться
и сжатие с потерями (например, алгоритм JPEG). Сжатие данных позволяет
существенно снизить размер файла. Это особенно заметно в случае изображе-
ний, содержащих большие однотонные пространства, например, в отсканирован-
ных текстах и схемах.

Однако сжатие данных можно применять далеко не всегда. Дело в том, что алго-
ритм LZW защищен патентом, и фирмы-разработчики вынуждены оплачивать
его использование в своих программах. Поэтому не все программы могут сохра-
нять файлы со сжатием и правильно читать их. Если вы отправляете кому-либо
файлы в формате TIFF, лучше воспользуйтесь какой-либо программой-архива-
тором (например, WinRAR или WinZip). Это уменьшит вероятность того, что
получатель не сможет открыть ваши файлы.



36 Глава 3. Форматы файлов изображений

TIFF Options
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Рис. 3.3. Окно сохранения TIFF-файла в Adobe Photoshop. Можно задать порядок байт
(для IBM PC или для Macintosh), а также задействовать сжатие изображения

В зоне Compression (Сжатие) можно выбрать один из четырех доступных алгорит-
мов. Для алгоритма JPEG можно также указать качество изображения. Устано-
вив флажок Save Transparency (Сохранить прозрачность), вы укажете программе
на необходимость сохранения прозрачных областей изображения. В противном
случае они будут залиты белым цветом.

Если изображение содержит слои, после задания описанных выше параметров на
экран будет выведено предупреждение о том, что сохранение изображения с учетом
слоев увеличит размер файла. Если вы не хотите, чтобы это предупреждение вы-
водилось снова, установите флажок Don't show again (Больше не выводить).

ВНИМАНИЕ
Файлы в формате TIFF, сжатые при помощи алгоритмов JPEG и ZIP, не могут быть прочита-
ны большинством старых программ. Если вы не уверены в том, что получатель ваших фай-
лов сможет с ними работать, избегайте использования этих методов.

Формат TIFF широко распространен не только на платформе IBM PC, но и на
Apple Macintosh (собственно, Macintosh — «родина» TIFF). Многие графические ре-
дакторы (разумеется, и Adobe Photoshop) поддерживают сохранение и чтение фай-
лов в режимах IBM PC и Apple. Эти режимы различаются порядком записи файлов.

ПРИМЕЧАНИЕ
Процессоры, на основе которых строятся компьютеры Apple, читают байты двухбайтных
чисел слева направо (вначале старший байт, а потом — младший). Процессоры Intel (и дру-
гие совместимые с ними) записывают и читают первым младший байт, а потом — старший.
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То, что TIFF «прижился» и на IBM PC, и на Apple, позволяет применять его для
передачи изображений с одной аппаратной платформы на другую без потери их
свойств, атрибутов и, разумеется, содержания. Также этот формат можно исполь-
зовать для передачи данных между различными приложениями, «не понимаю-
щими» форматы друг друга, но «знающими» TIFF. При такой передаче будут со-
хранены многие атрибуты изображения, теряющиеся, например, при передаче
данных через буфер обмена Windows.

Для сохранения цветов изображения при передаче с одного компьютера на другой
(из-за различий в составе аппаратного обеспечения и его настроек цвета могут
отображаться иначе) в состав файла может быть включен цветовой профиль ICC.

СОВЕТ
Если вы сохранили файл в формате TIFF в одной программе и не можете открыть его в другой,
возможно, причина в несовместимости наборов тегов, используемых в этих приложениях. При
отсутствии другого пути обмена данными попробуйте открыть такой файл в другой программе
(например, в программе просмотра ACDSee) и сохранить его в TIFF или в другом формате.

Некоторые цифровые камеры могут сохранять файлы в формате TIFF. Этот
формат служит для получения качественных изображений, не содержащих сле-
дов сжатия алгоритмом JPEG. Такие изображения занимают гораздо больше
места, чем изображения, сохраненные в сжатом формате, поэтому применять
TIFF в цифровой камере следует только в двух случаях — если вы точно знаете,
что использование сжатого формата не позволит вам получить изображение же-
лаемого качества, или же у вас под ругой находится компьютер или достаточное
количество запасных карт памяти.

В заключение отметим, что формат TIFF может применяться для сохранения про-
межуточных результатов работы, не требующих внедрения специфической ин-
формации (векторных объектов, направляющих линий, слоев и других объектов).
Распространенность этого формата позволяет легко переносить изображения ме-
жду программами и аппаратными платформами. Использование цветокоррек-
ции (профилей ICC) дает возможность сохранить цвета без изменения (насколь-
ко это возможно) при просмотре на разных мониторах и при выводе на печать.

Формат BMP
Формат BMP также может применяться для хранения данных без потери каче-
ства. Это собственный формат Windows, используется для целей системы. На-
пример, именно в этом формате изображения включаются в состав исполняемых
файлов приложений и выводятся на экран. По сути дела, любое приложение, ис-
пользующее графический интерфейс Windows, содержит средства для открытия,
редактирования и сохранения BMP-файлов.

В формате BMP можно сохранять изображения с глубиной цвета (числом бит,
описывающих один пиксел изображения) 1, 4, 8 и 24 бита, что соответствует
максимальному числу используемых цветов 2, 16, 256 и 16 777 216 соответ-
ственно. Файл может содержать палитру, определяющую цвета, отличные от
принятых в системе.
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В отличие от таких форматов, как TIFF или PSD, в формате BMP не предусмат-
ривается использование системы цветокоррекции. Это значит, что вы не сможете
гарантировать, что получатель вашего файла увидит цвета изображения такими,
какими вы их определили (предположим, у вашего коллеги монитор настроен на
меньшую или большую, чем у вас, яркость).

ПРИМЕЧАНИЕ
Для того чтобы учесть яркость и другие настройки монитора в системе цветокоррекции, вам
понадобится откалибровать монитор и программу коррекции цветов (в Adobe Photoshop для
этого служит программа Adobe Gamma, которая автоматически загружается при старте си-
стемы). Процедура коррекции может быть выполнена при первом запуске Adobe Photoshop
или путем вызова утилиты настройки из Панели управления (Control panel > Adobe Gamma
(Панель управления > Adobe Gamma)).

Изображение в формате BMP можно сжать при помощи алгоритма RLE (такие
файлы обычно имеют расширение .Не вместо .bmp). Однако файлы с таким сжати-
ем распознаются и обрабатываются далеко не всеми графическими программами.

Adobe Photoshop позволяет включить сжатие только для файлов, сохраняемых
с глубиной цвета 4 или 8 бит (16 или 256 цветов). На рис. 3.4 показано окно со-
хранения BMP-файла, выводимое на экран после выбора его имени. Для вклю-
чения сжатия установите флажок Compress (RLE) (Сжатие (RLE)).

Л OoS/2

.024 bit

Ш зг bit'.

ПрНр row order Advanced Modes

Рис. 3.4. Окно сохранения файла в формате BMP

1
Если вы работаете с изображением в режиме RGB, BMP-файл может иметь глуби-
ну цвета 16, 24 или 32 бита. Режимы градаций серого и индексированных цветов
позволят вам сохранять файлы с глубиной цвета 4 и 8 бит, а также использовать
сжатие изображения. Черно-белые изображения (режим bitmap) сохраняются
в формате BMP с глубиной цвета 1 бит. Сжатие для таких файлов не произво-
дится. В окне выбора режима сохранения файла в формате BMP (рис. 3.4) имеет-
ся кнопка Advanced Modes (Расширенные режимы). Щелкнув на ней, вы можете
выбрать режим сохранения с учетом специальных параметров.
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Итак, формат BMP сохраняет изображения с достаточным качеством и глуби-
. ной цвета, но не позволяет использовать цветокоррекцию, хранить слои и другие
элементы изображений. Поэтому он применяется редко, в основном как конеч-
ный формат при подготовке графики для Windows.

Формат TGA
После появления видеоадаптеров, поддерживающих режимы с числом цветов
более 256, производители программного обеспечения получили возможность
создавать приложения, работающие с большим числом цветов. Для сохране-
ния многоцветных изображений понадобился новый формат. Первый такой
формат был разработан компанией Truevision для применения с видеоадаптера-
ми Truevision.

Формат Truevision Targa (TGA) подразумевает хранение для каждого из пик-
селов трех цветовых компонентов: красного, зеленого и синего. Изображение
может храниться в нескольких режимах: 24 бита на пиксел (три канала по 8 бит),
32 бита на канал (три канала по 8 бит и альфа-канал — 8 бит), режим градаций
серого, а также режим индексированных цветов (без альфа-канала).

Кроме изображения в файле формата TGA может сохраняться ряд дополнитель-
ных сведений:

• уменьшенная копия изображения;

• дата и время создания файла;

• имя автора;

• авторские комментарии;

• время редактирования;

• коэффициент пропорциональности сторон изображения (полезен при работе
в различных режимах монитора).

В структуре формата предусмотрена возможность простого расширения и введе-
ния новых блоков данных.

Изначально этот формат разрабатывался в расчете на применение в игровых
программах и программах обработки изображений, что проявляется в опти-
мизации скорости обработки и небольшом объеме памяти, требующемся для
открытия файла.

В настоящее время формат TGA используется в компьютерных играх и програм-
мах обработки видеоданных. Часто видеофильмы, полученные, например, с пла-
ты видеозахвата, сохраняются на жестком диске в виде последовательности кад-
ров, представленных в формате BMP или TGA. Программы видеомонтажа или
специальные утилиты «склеивают» эти файлы в файл видеоданных (например,
в формате AVI). Вы можете использовать этот формат для сохранения изобра-
жений, предназначенных для последующего включения в видеофильмы. Разуме-
ется, для этого вам потребуется какая-либо программа видеомонтажа.
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Формат RAW
Данный формат несколько отличается от форматов, рассмотренных нами ра-
нее — он предназначен для хранения полной информации об изображении, по-
лученном цифровой камерой. В файл этого формата записывается информация,
полученная чувствительной матрицей камеры, без каких-либо изменений. Кроме
того, в файл вносятся данные об изменениях, внесенных в изображение при
коррекции, с учетом баланса белого цвета, насыщенности, яркости, контраста,
экспозиции и других параметров. Эти параметры позволяют фотографу самостоя-
тельно изменить вид изображения еще до начала изменения средствами графи-
ческого редактора.

ПРИМЕЧАНИЕ
Формат RAW используется в основном в цифровых фотокамерах, производимых компанией
Canon, хотя и другие производители, например Sony, вводят его использование в своих
цифровых камерах.

Такой подход к коррекции изображения позволяет избежать потерь деталей, не-
избежных при коррекции обычных изображений, сохраненных, например, в фай-
лах JPEG или TIFF.

В формате RAW не применяется сжатие с потерями, сохраняемое в них изобра-
жение может быть воспроизведено без каких-либо .искажений. При этом они за-
нимают значительно меньше места, чем изображения того/же размера, сохранен-
ные в формате TIFF.

Как правило, формат RAW поддерживается программным обеспечением, постав-
ляемым вместе с камерой. Стандартные средства импорта изображений (напри-
мер, встроенные в операционную систему) могут не распознавать файлы форма-
та RAW и не позволять загружать их на компьютер. В этом случае обратитесь
к камере как к сменному диску и скопируйте файлы вручную. Файлы, сохранен-
ные в формате RAW, как правило, имеют расширение .crw.

ПРИМЕЧАНИЕ —
Некоторые камеры при подключении к компьютеру распознаются как дополнительный
сменный диск, с которым вы можете работать как с гибким диском или Flash-накопителем.
В некоторых случаях это единственный способ «общения» с камерой при помощи компью-
тера. Если камера не распознается как сменный диск, вы, скорее всего, сможете получить
к ней доступ при помощи системной папки Панель управления * Сканеры и камеры. Подклю-
чите камеру к компьютеру, зайдите в эту папку и дважды щелкните на соответствующем
значке (эта возможность имеется не во всех версиях Windows). Также можно использовать
программное обеспечение, поставляемое в комплекте с цифровой фотокамерой.

Adobe Photoshop может открывать файлы формата RAW самостоятельно, без
внешних программ, хотя для некоторых версий вам потребуется загрузить с сайта
компании (www.adobe.com) специальный дополнительный модуль и установить
его. Модули открытия файлов RAW обновляются по мере выпуска новых моделей
камер разных производителей. При открытии файла RAW в Adobe Photoshop CS
на экран выводится окно, показанное на рис. 3.5.
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Рис. 3.5. Окно открытия файла в формате RAW

В центральной части окна отображается изображение, хранящееся в файле. В ниж-
ней части окна находятся списки и поля для выбора цветового профиля (Space
(Цветовое пространство)), глубины цвета (Depth (Глубина цвета)), размера изо-
бражения (Size (Размер)) и разрешающей способности (Resolution (Разрешение)).
В правой части окна вы найдете гистограмму, отображающую распределение
яркости пикселов изображения (разными цветами выводится информация для
красного, зеленого и синего каналов), а также несколько закладок с органами
управления коррекцией изображения. Переключатель, находящийся над ги-
стограммой, позволяет переключить органы коррекции изображения в простой
(Basic) или расширенный (Advanced) режим.

ПРИМЕЧАНИЕ
В заголовке окна выводится информация об основных параметрах съемки — эквивалентной
чувствительности (ISO), выдержке, диафрагме и фокусном расстоянии объектива.

При открытии файла для него устанавливаются значения корректирующих пара-
метров, заданные камерой при записи файла. Установив, если это необходимо, но-
вые значения параметров, щелкните на кнопке ОК для открытия файла в Adobe
Photoshop и перехода к его редактированию. Для отказа от открытия файла
щелкните на кнопке Cancel (Отмена). При нажатой клавише Alt кнопка Cancel (От-
мена) заменяется кнопкой Reset (Восстановить), позволяющей вернуть изобра-
жение и его параметры в состояние, соответствующее моменту открытия файла.
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Кнопка ОК меняется на кнопку Update (Обновить). При щелчке на этой кнопке
файл не будет открыт, но внесенные в его параметры изменения будут сохранены.

При открытии RAW-файла к изображению применяются установленные каме-
рой или вами параметры. При его повторном открытии окно изменения парамет-
ров (см. рис. 3.5) выведено не будет. Вы можете редактировать изображение в
обычном режиме, но даже сразу после открытия вам будет предложено сохра-
нить изображение не в формате RAW, а в формате TIFF или каком-либо из фор-
матов, поддерживающих внесенные вами изменения (например, при сохранении
изображения со слоями по умолчанию предлагается формат PSD).

Adobe Photoshop CS позволяет сохранять изображения в формате RAW, но он
отличается от форматов, используемых в фотокамерах. Кроме того, он не полно-
стью сохраняет информацию об изображении, а это значит, что при повторном
открытии часть данных может быть потеряна.

Итак, мы узнали, что формат RAW, применяемый в некоторых цифровых каме-
рах для сохранения изображения без потери качества, является достойной аль-
тернативой формату TIFF, также используемому для этих целей. Он позволяет
сохранить полную информацию об изображении и корректировать такие парамет-
ры, как баланс белого, цветовой баланс, яркость, экспозиция и так далее. Однако
следует учитывать, что данный формат является не самым распространенным,
для его преобразования в другие форматы вам могут понадобиться поставляемая
вместе с камерой программа или дополнительный модуль для графического ре-
дактора. Использовать встроенную в Adobe Photoshop CS возможность сохране-
ния файлов в формате RAW не стоит, с точки зрения совместимости и удобства
гораздо лучше задействовать формат PSD, TIFF или JPEG.

В этой главе вы ознакомились с основными типами файлов, которые могут
встретиться и пригодиться вам при работе с фотографиями. Вы будете постоянно
сталкиваться с необходимостью сохранять, переносить или копировать файлы,
поэтому вам необходимо знать, в каких файлах может находиться изображение
и какой формат следует использовать в том или ином случае.
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Что вам понадобится для работы
с цифровыми фотографиями
В этой главе мы поговорим о том, какое оборудование вам понадобится для
получения, обработки, хранения и вывода на печать или передачи через Интер-
нет цифровых фотографий. Разумеется, для работы в любой сфере, будь то
цифровая фотография, обычная традиционная фотография или, скажем, строи-
тельство дома, требуется не только горячее желание заниматься любимым делом,
талант, а также соответствующие навыки. Без всего вышеперечисленного брать-
ся за дело, наверное, и не стоит, но для успешного завершения начатого потребу-
ется соответствующее оборудование.

В данном случае мы поговорим об оборудовании и программах, необходимых
для работы с цифровыми фотографиями на достаточно высоком уровне и для
обработки, хранения, печати и распространения изображений.

По официальной информации компании Adobe, для нормальной работы про-
граммного пакета Adobe Photoshop CS и Adobe ImageReady CS требуется сле-
дующая конфигурация компьютера:

•

• процессор класса Pentium III или Pentium IV;

• операционная система Windows XP или Windows 2000 с установленным па-
кетом обновлений 3;

• 192 или 256 (рекомендуется) Мбайт оперативной памяти;

• 280 Мбайт свободного места на жестком диске;

• цветной монитор и видеоадаптер, поддерживающий режимы не хуже чем
16 бит на пиксел и разрешение 1024 х 768 пикселов или выше;

• устройство для чтения компакт-дисков;

• подключение к Интернету для активации программы.

Компьютер
Для цифровой обработки изображений, прежде всего, требуется компьютер.
Существует несколько основных разновидностей компьютерных «платформ» —
наборов стандартов, позволяющих создавать совместимые между собой системы.
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Самыми распространенными среди домашних компьютеров являются платфор-
мы IBM PC и Apple Macintosh. В России наиболее распространены компьютеры
типа IBM PC (IBM PC-совместимые компьютеры). В большинстве случаев на
них используется операционная система Windows, точнее, одна из ее разновид-
ностей. В некоторых случаях на один компьютер устанавливается несколько
операционных систем, но этот случай мы здесь рассматривать не будем.

Эта книга посвящена обработке цифровых изображений на компьютере типа
IBM PC, работающем под управлением операционной системы Windows.

Процессор
Обработка изображений — процесс, требующий больших затрат вычислительных
ресурсов компьютера. Относительно простые операции, такие как масштабиро-
вание изображения, поворот, рисование при помощи «кистей», выполняются
достаточно быстро на большинстве компьютеров. Операции, связанные с приме-
нением к изображению сложных фильтров и эффектов (при этом часто задейст-
вуются сложные математические алгоритмы), занимают гораздо больше времени.
Для того чтобы сделать время ожидания применения очередного фильтра если
не незаметным, то хотя бы приемлемым, необходим компьютер с достаточно
мощным процессором. В настоящее время для комфортной обработки люби-
тельских изображений можно рекомендовать процессор с тактовой частотой не
менее 2 ГГц. Для профессиональной обработки изображений, предназначенных,
например, для широкоформатной печати с высоким разрешением, этого может
оказаться маловато.

В действительности вы сможете нормально работать и на менее скоростном
процессоре, но в настоящее время они уже практически не выпускаются и не
устанавливаются в новые компьютеры. Если компьютер у вас уже есть и он
оснащен процессором класса Pentium III, Pentium IV, К7 Duron или Athlon, вы
можете с успехом его использовать.

Жесткий диск
Файлы изображений, особенно фотографий, снятых или отсканированных с высо-
ким разрешением, а также файлы проектов, подготовленных к высококачествен-
ной печати, могут занимать большой объем на диске. Еще больший объем может
потребоваться для хранения архива работ и коллекций изображений («клип-ар-
та»), хотя для их хранения надежнее и удобнее использовать компакт-диски.
Кроме того, достаточно большой объем требуется для установки и работы опера-
ционной системы и требующегося вам программного обеспечения (графические
и текстовые редакторы, программы для записи компакт-дисков и так далее). Ис-
ходя из всего вышеперечисленного, можно рекомендовать установить жесткий
диск объемом не менее 40 Гбайт, из которых около 8 Гбайт отвести под отдель-
ный логический диск (обычно это диск С:) под операционную систему и про-
граммное обеспечение. Если на системном диске не хранить рабочих и архивных
файлов, сбои операционной системы и программ можно легко устранить фор-
матированием диска и переустановкой системы и программного обеспечения.
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Для повышения быстродействия можно установить на компьютер два отдельных
жестких (физических) диска, один из которых использовать для нужд операци-
онной системы и программ, а другой отвести для временных файлов Adobe
Photoshop и рабочих файлов.

Для установки Adobe Photoshop CS может потребоваться до 280 Мбайт свобод-
ного места на жестком диске.

Оперативная память
Для обработки больших объемов данных, относящихся к изображениям, по-
требуется также и большой объем оперативной памяти. Adobe Photoshop no
умолчанию задействует 50 % оперативной памяти для своих целей (вы можете
вручную изменить этот объем). Кроме того, значительный объем оперативной
памяти может быть задействован операционной системой или другими приложе-
ниями. При нехватке оперативной памяти задействуется виртуальная память —
специальный файл на жестком диске, но работа с данными при этом существен-
но замедляется.

Для нормальной работы современных операционных систем и простого набора
программ требуется не менее 128 Мбайт оперативной памяти. Обработка фото-
графий и других относительно небольших изображений будет полностью ком-
фортной при наличии не менее 256 Мбайт, а для профессиональной обработки
изображений, особенно при работе с файлами, предназначенными для высо-
кокачественной печати, или трехмерной графикой, следует установить не менее
512 Мбайт оперативной памяти.

Видеоадаптер
Для обработки фотографий и других двумерных («плоских») изображений не
требуется использование SD-ускорителей. Они полезны в основном при за-
пуске компьютерных игр или программ, использующих или обрабатывающих
SD-графику (например, 3D Studio MAX). Однако видеокарты часто снабжаются
специальными ускорителями для двумерной графики, которые увеличивают
скорость перерисовки изображения, например, при перемещении окна или про-
крутке изображения в окне документа. Значительный объем видеопамяти при
обработке двумерной графики также не требуется.

Если вы планируете заниматься исключительно обработкой двумерной гра-
фики и работой в офисных приложениях, при выборе видеокарты вам следует
в первую очередь обратить внимание на качество воспроизведения цветов (цве-
топередачу). Если же вы не ограничиваете круг возможных задач этими на-
правлениями, вам потребуется SD-ускоритель, которым в настоящее время ос-
нащаются практически все видеоадаптеры. Проконсультируйтесь с персоналом
компьютерного магазина. Если продавцы обладают достаточной квалификацией,
они подскажут вам, какая модель удовлетворит ваши потребности при мини-
мальных затратах.
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Монитор
Наравне с процессором и видеоадаптером монитор является одним из основных
компонентов графической станции (компьютера, предназначенного для обработ-
ки изображений).

От качества цветопередачи монитора зависит адекватность восприятия вами
полученного со сканера или цифровой камеры изображения. Становящиеся в на-
стоящее время все более популярными жидкокристаллические мониторы, к со-
жалению, в большинстве случае заметно искажают оттенки, что делает их не-
пригодными для профессиональной работы без специальной калибровки. Из-за
особенностей мониторов даже калибровка не всегда может исправить искажения
цвета. Поэтому для профессиональной работы можно рекомендовать традици-
онный электронно-лучевой монитор, желательно с плоским экраном, — это умень-
шит вносимые монитором искажения и поможет избавиться от бликов, напри-
мер, от окна или ламп освещения.

Чем больший размер имеет экран монитора, тем больше информации может
быть на нем представлено без чрезмерного уменьшения размера пикселов. В на-
стоящее время оптимальными по соотношению цена/комфорт являются мони-
торы размером (с диагональю экрана), равным 17". Также можно приобрести
монитор с диагональю экрана 19". Мониторы большего размера пока еще дороги,
к тому же они занимают много места.

Также следует обратить внимание на такие характеристики монитора, как макси-
мальное разрешение (размер отображаемого изображения в пикселах) и частота
обновления экрана. Чем выше разрешение, тем больше информации вы сможете
наблюдать одновременно. Большая частота обновления экрана снизит утомляе-
мость и повысит комфортность работы. Для жидкокристаллических мониторов
этот параметр может не указываться, так как изображение на них обновляется
только тогда, когда в него вносятся некоторые изменения. Зато для них следует
обратить внимание на такой параметр, как время отклика, — он определяет время
реакции монитора на поступление сигнала об изменении изображения. Ранние
модели имели настолько большое время реакции на управляющие сигналы, что
играть в динамичные игры или смотреть фильмы на них было практически не-
возможно. Чем меньше время отклика — тем лучше.

Дополнительные устройства хранения
информации
Основным устройством хранения информации в современном компьютере явля-
ется жесткий магнитный диск (винчестер). Однако кроме него используются
дополнительные устройства, задача которых — обеспечить перенос информации
с одного компьютера на другой или архивное хранение данных.

Для переноса информации и хранения архивных копий программ, изображений
и других файлов в настоящее время применяются компакт-диски и устрой-
ства для их чтения. Кроме того, широко используются устройства для записи/
стирания/перезаписи записываемых (CD-R) и многократно перезаписываемых
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(CD-RW) компакт-дисков. Большинство программ распространяются на компакт-
дисках, поэтому хотя бы простое читающее устройство для компакт-дисков про-
сто необходимо.

Устройство для записи/стирания и перезаписи компакт-дисков значительно уп-
ростит процесс создания архива ваших исходных изображений и готовых работ.

В настоящее время на смену компакт-дискам постепенно приходит формат DVD.
Диски DVD имеют тот же размер, но их емкость превосходит емкость обычных
компакт-дисков более чем в четыре раза, поэтому через некоторое время окажет-
ся оправданным приобретение записывающего устройства для работы с DVD-
дисками. В настоящее время они доступны на рынке, но достаточно дороги, так
же как и записываемые и перезаписываемые диски стандарта DVD.

Широко использовавшиеся еще пару лет назад дисководы в настоящее время ус-
танавливаются в компьютеры скорее по привычке, однако стоит иметь диско-
вод 3,5" хотя бы для того, чтобы в случае необходимости воспользоваться аварий-
ным загрузочным диском (они все еще удобнее распространенных загрузочных
компакт-дисков).

Для переноса информации с одного компьютера на другой вместо дискет все шире
используются перезаписываемые компакт-диски или переносные модули памя-
ти — Flash-drive. Эти модули выпускаются в виде микросхем памяти и вспомога-
тельных схем, заключенных в компактный корпус, легко помещающийся в кар-
ман. Для соединения устройства с компьютером используется интерфейс USB.

При подключении такого устройства к компьютеру он автоматически распозна-
ется операционной системой как дополнительный диск, с которым возможно
выполнение любых операций с файлами.

ПРИМЕЧАНИЕ -
В операционной системе Windows 98 потребуется дополнительно установить драйвер
порта USB, который обычно поставляется вместе с модулем памяти на компакт-диске.

Выпускаются переносные модули Flash-памяти объемом от 16 Мбайт до 1 Гбайт.
Встречаются устройства и большей емкости.

Если вы работаете с цифровой камерой, полезным может оказаться дополнитель-
ное устройство для считывания данных с карт памяти. Это может быть отдель-
ный блок, соединяемый с компьютером при помощи интерфейса, или устройство,
устанавливаемое внутрь системного блока, иногда прямо на заводе-изготовителе
или же при сборке компьютера. Подобное устройство можно установить на компь-
ютер самостоятельно.

Устройства ввода
Под устройствами ввода обычно понимают такие устройства, как мышь и кла-
виатура. Выбрать клавиатуру достаточно просто — главное, чтобы вам было
удобно на ней работать. Мышь лучше выбрать «оптическую» — использующую
для определения направления и скорости перемещения оптический датчик.
Такие мыши надежнее, чем механические, практически не требуют очистки (разве
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что от забившихся на линзу датчика шерстинок любимого кота), обеспечивают
больший комфорт при работе и лучшую управляемость, что особенно важно при
работе в графическом редакторе. Кроме того, они работают практически на лю-
бой поверхности.

По мере вашего профессионального роста вы, возможно, захотите расширить
свои возможности. Тогда вам следует обратить внимание на графические план-
шеты (дигитайзеры). Они позволяют вводить информацию непосредственно,
указывая нужную точку при помощи пера или специального курсора (устройст-
во для точного указания координат, применяется в основном при вводе в компь-
ютер чертежей и другой подобной информации). При помощи планшета можно
рисовать на экране компьютера практически так же, как на бумаге. Так как при
этом вы держите в курах не мышь, а перо, практически не отличающееся по виду
от карандаша или авторучки, движения получаются естественными. Специаль-
ные программы (например, Corel Painter) позволяют не только полностью ис-
пользовать возможности такого ввода информации, но и имитировать в процессе
рисования некоторые живописные техники, например карандаш, акварель или
масляную живопись.

Устройства ввода изображений
Устройство ввода — основной компонент, относящийся непосредственно к обра-
ботке изображений. От качества используемого вами сканера или цифровой ка-
меры зависит результат всей работы. Незначительные отклонения яркости или
оттенков, присущие практически всем устройствам, легко устраняются при помо-
щи Adobe Photoshop или другого графического редактора, но если изображение
изначально серьезно испорчено, добиться хороших результатов будет сложно
или практически невозможно.

Выбирая сканер или цифровую камеру, прежде всего определитесь, для каких
целей вы будете использовать полученные изображения. Для сканирования текста,
съемки простых портретов и вечеринок для последующего размещения на домаш-
ней страничке в Интернете, простой печати фотоснимков формата 10x15 вполне
хватит сканера, обладающего оптической (аппаратной) разрешающей способно-
стью 300 dpi или цифровой камеры со светочувствительной матрицей, состоя-
щей из 2 млн пикселов (около 2 мегапикселов).

Для подготовки профессиональных иллюстраций или качественной выездной или
студийной съемки желательно иметь цифровую камеру с матрицей 5 мегапиксе-
лов и больше. Качественный профессиональный сканер имеет оптическое разре-
шение не менее 800 dpi (использование больших разрешений при сканировании
в большинстве случаев неоправданно из-за чрезмерных затрат времени и слишком
явно проявляющихся дефектов оригинала, например шерохватости бумаги).

При выборе цифровой камеры необходимо хотя бы примерно определить характер
основных сюжетов для съемки. В зависимости от этого следует обратить внимание
на камеры, оснащенные короткофокусным объективом с широким углом зрения
(для съемки в помещениях, простой любительской съемки), или камеры с боль-
шим оптическим увеличением (для съемки удаленных объектов, архитектурной
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съемки, съемки в путешествиях). Следует помнить, что при увеличении более
чем в 4-5 раз качественная съемка без штатива практически невозможна. Если вы
планируете снимать разнообразные сюжеты в профессиональных целях, вам мо-
жет подойти камера со сменными объективами. Это дает большую гибкость в ра-
боте, но стоимость такой камеры может быть очень высокой. Если вы планируе-
те много снимать на улице, в путешествиях, на мероприятиях, полезной может
оказаться функция стабилизации изображения, помогающая снимать при больших
увеличениях, при тряске или при плохой освещенности. Эта функция встреча-
ется в некоторых камерах, но их сложно отнести к начальной (и дешевой) кате-
гории, скорее они относятся к «продвинутым» любительским или полупрофес-
сиональным камерам.

В некоторой степени о качестве цифровой камеры, выпущенной той или иной
фирмой, можно судить по тому, выпускает ли фирма традиционные пленочные
фотоаппараты. Оптические системы, используемые в пленочных и цифровых ка-
мерах, очень схожи, и качество аппарата во многом зависит от опыта, наработан-
ного компанией-изготовителем.

Выбирая сканер, обратите внимание также на интерфейс связи с компьютером.
От его быстродействия зависят скорость получения изображений и ваш комфорт
во время работы.

В большинстве современных сканеров применяется интерфейс стандарта USB,
который позволяет передавать данные с достаточной для нормальной работы
скоростью. Контроллер USB устанавливается практически на все современные
материнские платы. Дополнительных затрат и усилий для подключения такого
сканера к компьютеру не потребуется. Некоторые профессиональные модели
оснащаются более скоростными и удобными в использовании интерфейсами
FireWire или SCSI. Так как контроллеры (устройства для управления работой
устройств) этих интерфейсов, как правило, поставляются в виде отдельных плат,
устанавливаемых в разъемы расширения материнской платы, вам придется при-
обрести такую плату, чтобы подключить приобретенный сканер.

Устройства вывода изображений
Кроме экрана монитора для вывода изображений используются различные печа-
тающие устройства, позволяющие получить «твердую» копию материала.

В настоящее время на рынке представлено множество моделей принтеров, боль-
шинство из которых в той или иной степени предназначены для печати фотогра-
фий. Для домашнего применения больше всего подходят струйные принтеры.
Они, как правило, имеют не очень высокую стоимость, обеспечивают хорошее
или высокое качество печати, приемлемую скорость и невысокую стоимость экс-
плуатации. Традиционно лидерами в области фотопечати являются принтеры
фирмы Epson, в то время как для печати текста и простой графики лучше выбрать
принтеры Hewlett Packard. Промежуточное положение между этими двумя кате-
гориями занимают принтеры компании Canon.

Некоторые принтеры позволяют печатать не только на бумаге, но и на других ма-
териалах, например на специально подготовленной ткани или компакт-дисках
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(для этого служат специальные компакт-диски, имеющие обратную сторону,
пригодную для печати, обычно они имеют обозначение Printable — пригодный
для печати).

Если главным фактором для вас являются скорость или объем печати, стоит
приобрести лазерный принтер или цифровую печатную машину. Эти устройства
дороги и занимают немало места, но при этом обеспечивают скорость печати до
нескольких десятков страниц в минуту и качество, сравнимое с качеством поли-
графической печати.

Возможно, вы планируете печать чертежей, плакатов, фотографий большого
формата. В этом случае вам потребуется широкоформатный принтер или плоттер
(традиционное название устройства для широкоформатной печати, хотя совре-
менные плоттеры по технологиям изготовления и печати практически не отлича-
ются от струйных принтеров). В зависимости от модели они позволяют печатать
на листах формата A3, А2, А1 или АО. Встречаются и более «широкие» принтеры,
но они служат для таких специфических целей, как печать пленок, вывешивае-
мых на рекламных щитах.

Стоимость широкоформатных принтеров, как правило, очень Высока, что делает
их покупку оправданной только при постоянной загрузке. В противном случае
выгоднее обратиться в один из многочисленных печатно-копировальных центров.
В зависимости от ваших задач, необходимого размера и качества распечатанного
изображения и ценовой политики центра стоимость может составлять от несколь-
ких десятков до нескольких сотен рублей за один лист.

Для печати фотографий небольшими тиражами хорошо подходят так называемые
термосублимационные принтеры. В них краситель переходит на бумагу под дей-
ствием нагрева специальным нагревательным элементом. При этом на изображе-
нии практически отсутствуют точки, характерные для струйной печати. Полу-
ченные таким образом отпечатки практически неотличимы по внешнему виду от
традиционных фотографий. Недостатками таких принтеров является высокая
цена самих принтеров и расходных материалов, а также низкая скорость печати.

Говоря об устройствах печати, следует упомянуть и об используемой бумаге.
Струйные и обычные лазерные принтеры, как правило, довольно «привередливы»
к расходным материалам. Слишком тонкая бумага плохо удерживается подаю-
щими валиками, а слишком толстая плохо сгибается, может застрять и повре-
дить валики или печатающую головку. Однако принтеры, ориентированные на
фотографическую печать, как правило, способны работать с более плотной бума-
гой. Такие отпечатки меньше намокают и коробятся под действием чернил во
время печати, более удобны для рассматривания и лучше выглядят в альбомах.

Подходящую для вашего принтера толщину бумаги (обычно указывается не
толщина бумаги, а ее плотность, эти величины прямо пропорциональны) вы
можете выяснить в инструкции по эксплуатации, в компьютерном магазине
или у представителя компании-производителя. Обычная офисная бумага имеет
плотность 80 г/м2. Для печати фотографий хорошо подходит бумага с плотно-
стью 120-180 г/м2, для печати открыток — 200-280 г/м2.
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Отдельной категорией принтеров являются устройства для вывода изображений
на фоточувствительные материалы — фотопленку и фотобумагу. Некоторые из
них используются для подготовки материалов к офсетной печати. Специальные
принтеры служат для вывода изображения на обыкновенную фотопленку. После
проявки такую пленку можно применить для печати в любой фотолаборатории.
В цифровых фотолабораториях установлены фотопечатающие машины, выводя-
щие изображение на фотобумагу. При печати с пленки она вначале сканируется
встроенным в машину сканером, при печати цифровых данных изображение
считывается из готовых файлов.

Кроме непосредственно печати машины могут содержать встроенные средства
цветокоррекции и простой обработки (например, поворота и масштабирования)
изображений. Некоторые из них оснащены встроенными устройствами чтения
информации с компакт-дисков и других носителей, что позволяет самостоятель-
но получать изображения. Также возможно подключение такой машины к ком-
пьютеру или компьютерной сети для обмена данными. Машина может не только
получать информацию для вывода, но и использоваться в качестве скоростного
(к сожалению, не всегда качественного) сканера для фотопленок.

Появление подобной техники в лабораториях и копировальных центрах позво-
ляет художникам, дизайнерам и обычным любителям фотографии и рисования
не только создавать свои произведения, но и переводить их в ощутимую, «реаль-
ную» форму, существующую не только на экране монитора.

Системы связи
Если вы хотите, чтобы ваш компьютер мог общаться с внешним миром не только
посредством компакт-дисков, гибких дисков или иных носителей информации,
вам понадобится установить устройство связи. Вам может понадобиться сетевая
карта для связи с расположенными рядом компьютерами, устройство Bluetooth
или инфракрасный порт для связи с мобильными устройствами, модем для свя-
зи с другими компьютерами и выхода в Интернет через телефонную сеть.

Программное обеспечение
Для работы на компьютере необходимо программное обеспечение, способное
управлять его работой. Производитель записывает в постоянную память компь-
ютера, размещаемую на материнской плате, набор базовых служебных программ
(BIOS — Basic Input/Output System — Базовая система ввода/вывода). Эти про-
граммы позволяют провести самотестирование компьютера, загрузку операцион-
ной системы и работу с некоторым набором стандартных устройств (видеокарта,
память, дисковод, жесткий диск, клавиатура, иногда устройство для чтения ком-
пакт-дисков, а также некоторые другие устройства).

Все то, что вы можете сделать при помощи своего компьютера (играть в игры,
рисовать, смотреть кино, набирать текст, производить математические расчеты),
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осуществляется под управлением операционной системы, обеспечивающей взаи-
модействие различных устройств компьютера и специализированных приложе-
ний, выполняющих те или иные задачи.

Данная книга посвящена применению новой версии одного из наиболее извест-
ных и популярных графических редакторов — Adobe PKotoshop CS 8.0. В после-
дующих главах вы найдете множество полезных советов, инструкций и просто
интересных замечаний, касающихся обработки цифровых фотографий и других
изображений с помощью этой программы.

Однако для того чтобы вы смогли в полной мере насладиться предоставляемыми
Adobe Photoshop (да и любой другой программой) возможностями, необходимо
подготовить среду для использования этого приложения.

Прежде всего, вам потребуется операционная система версии Windows XP или
Windows 2000 (для этой операционной системы необходим пакет обновлений
(service pack) 3). Установив операционную систему, вы сможете установить Adobe
Photoshop CS. Кроме того, вы автоматически получите в свое распоряжение
браузер (программу, позволяющую просматривать веб-страницы, а также осно-
ванную на веб-технологиях справочную систему Adobe Photoshop). Операцион-
ная система также предоставляет драйверы (служебные программы, отвечающие
за взаимодействие программ с каким-либо устройством) для большинства стан-
дартных и просто распространенных устройств.

Если для работы вам не требуются какие-либо дополнительные устройства (на-
пример, графический планшет или сканер), перед началом работы следует уста-
новить соответствующие драйверы. Следуйте инструкциям по установке и на-
стройке оборудования и прилагаемого к нему программного обеспечения.

Кроме драйверов, обеспечивающих работу подключенных к компьютеру уст-
ройств, и самой программы Adobe Photoshop вам могут пригодиться следующие
программы.

• Архиваторы — программы сжатия данных, используемые для уменьшения
размера файлов. Архивирование (сжатие) данных особенно полезно при от-
правке файлов по электронной почте или размещении больших файлов на
сайтах в Интернете. Наиболее распространенные в настоящее время про-
граммы архивации (а значит, и форматы архивов): WinZIP (архивы типа ZIP)
и WinRAR (архивы типа RAR). Программа для доступа к архивам формата
ZIP и сжатия данных в этом формате встроена в операционную систему Win-
dows ХР, а также в некоторые из более ранних версий (в системе Windows
эти архивы называются Сжатая папка или ZIP-папка).

ВНИМАНИЕ
Отправляя архив по электронной почте или записывая его для кого-то на компакт-диск или
Flash-модуль, уточните, имеется ли у получателя программа, способная открыть этот архив
и извлечь из него данные.

Файловые менеджеры — программы для работы с файлами (FAR, Windows
Commander или Total Commander). Эти программы позволяют выполнять
такие операции, как копирование, перемещение, переименование и удаление
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файлов. Также они позволяют быстро вызывать программы просмотра и ре-
дактирования файлов. В программы для работы с файлами часто встраивают-
ся модули для работы с архивами данных (программы-архиваторы) и прото-
колом FTP (File Transfer Protocol — Протокол передачи файлов — служит
для загрузки файлов на веб-сайты или передачи файлов с использованием
специальных файловых серверов в Интернете).

• Программы для записи компакт-дисков — для записи программ и данных на
компакт-диски необходима программа, управляющая этим процессом. Со-
ответствующее программное обеспечение часто поставляется вместе с устрой-
ствами для записи компакт-дисков. Вы также можете использовать програм-
му записи, входящую в состав Windows XP или любую другую аналогичную
программу. Необходимо убедиться, что она совместима с вашим устройством
для записи компакт-дисков.

• Почтовые программы — программы для работы с электронной почтой. Если
вы предполагаете использовать электронную почту, кроме модема или иного
устройства для подключения к Интернету и канала связи вам потребуется про-
грамма, предназначенная для отправки, приема и хранения электронных писем.
Почтовая программа Outlook Express поставляется вместе с браузером Internet
Explorer и входит в комплект поставки операционных систем семейства Win-
dows. Вы можете установить и использовать другую почтовую программу.

• Браузер — программа для просмотра веб-страниц — необходима для работы
в Интернете. В состав операционной системы Windows входит браузер Micro-
soft Internet Explorer.

• Антивирусные программы — если вы активно работаете в Интернете или
пользуетесь электронной почтой, вам понадобится программа для защиты от
компьютерных вирусов, желательно постоянно находящаяся в памяти компь-
ютера и отслеживающая выполняемые с жестким диском операции. Вы можете
приобрести хорошо зарекомендовавшие себя программы, такие как Dr. Web,
AVP, Panda, или какую либо другую аналогичную программу.

В этой главе мы познакомились с требованиями, предъявляемыми Adobe Photo-
shop CS к компьютеру и операционной системе. Также мы кратко рассмотрели
основные компоненты аппаратного обеспечения и программы, которые понадо-
бятся вам при работе с цифровыми фотографиями и другими видами компью-
терной графики.



Глава 5

Adobe Photoshop — работа
с файлами изображений
После установки Adobe Photoshop можно приступать к работе над изображени-
ем. Можно создать новое изображение или начать обработку фотографий, полу-
ченных со сканера или цифровой камеры. Но, прежде всего, следует открыть или
создать файл, в котором вы будете работать. По окончании работы необходимо
сохранить результаты труда. Этот раздел посвящен работе с файлами в Adobe
Photoshop CS — открытию файлов, созданию новых изображений, импорту дан-
ных из других файлов, а также сохранению результатов работы.

Открытие файлов
Открыть файл в Adobe Photoshop можно несколькими способами. Самый из-
вестный по аналогии с другими программами способ: использовать команду
меню File > Open (Файл > Открыть). Также можно использовать комбинацию
клавиш Ctrl+О. При вызове этой команды на экран выводится окно открытия фай-
лов. Оно основано на стандартных элементах операционной системы, поэтому
его элементы имеют названия на языке, принятом в системе (рис. 5.1).

В этом окне можно выбрать файл, который будет открыт. В верхней части окна
находится раскрывающий список Папка. Выберите из него папку, содержащую
нужные вам файлы. Справа от списка расположены стандартные кнопки управ-
ления обзором файлов в Windows.

В центральной части окна находится список файлов, находящихся в выбранной
папке. Отображаются файлы, которые можно открыть в Adobe Photoshop. Имя
выбранного файла из списка отображается в поле Имя файла, расположенном под
списком файлов. Это поле также является раскрывающимся списком, из которо-
го можно выбрать файлы, с которыми вы работали раньше.

Слева от списка файлов находятся несколько кнопок, позволяющих быстро пе-
рейти к обзору одной из системных папок Windows.

Под полем ввода Имя файла есть список Тип файлов, который позволяет выбрать
формат файлов, которые будут отображаться в списке выбора файлов. По умолча-
нию в этом списке выбрано значение All Formats (Все форматы), которое соответ-
ствует отображению в списке файлов всех форматов, поддерживаемых Photoshop.
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Рис. 5.1. Окно открытия файлов Adobe Photoshop
/

После выбора файла в нижней части списка будут отображены его размер (File
Size) и миниатюрная копия изображения. Эти копии создаются и встраиваются
в файлы при сохранении многими графическими редакторами, в том числе и Adobe
Photoshop. Миниатюры (thumbnail) позволяют быстро вывести на экран копию
изображения, не считывая из файла все изображение. Однако они увеличивают
размер файла, поэтому при сохранении файлов, например, для использования
в Интернете, сохранение копий изображений лучше отключить. Это можно сде-
лать, сохраняя изображение в специальном режиме подготовки к размещению
в Интернете.

Выбрав файл, щелкните на кнопке Открыть для того, чтобы открыть его в Adobe
Photoshop. Если вы не хотите открывать .файл, щелкните на кнопке Отмена.

Можно выбрать и открыть сразу несколько файлов. Выберите файл, после этого
выберите другой, удерживая нажатой клавишу Shift. При этом выбранными
окажутся все файлы, лежащие между файлами, указанными вами. Удерживая
клавишу Ctrl и щелкая по именам файлов, можно добавлять их к выделенным по
одному.
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Выбрать несколько файлов можно и при помощи мыши. Для этого «начертите»
рамку, охватывающую несколько имен файлов (рис. 5.2). Они будут выделены
автоматически, а их имена будут помещены в поле ввода имен файлов. Можно
также ввести несколько имен файлов вручную, заключив их имена в кавычки.

Недавние
документы

Рабочий стол

V Мои документы!;

Мой
компьютер

Имя Файла:

Сетевое [ !ип Файлов:

:. ..;:::::
yjew2.a" 'View3.ti(" 'View4 lit"'

,
IA| Formats

T 'V

File Size:

Рис. 5.2. Выделение нескольких файлов при помощи мыши

Если файл, который содержит ваши данные, имеет расширение, не соответ-
ствующее его формату, программа не сможет автоматически распознать его тип
и не позволит открыть файл. Для того чтобы открыть его, используйте команду
File > Open As... (Файл > Открыть как...) или комбинацию клавиш Ctrl+Alt+0. Вы-
брав файл в окне (рис. 5.3), выберите его формат из списка Open As (Открыть как)
и щелкните на кнопке Open (Открыть).

Если вы недавно работали с файлом, можно быстро открыть его снова, выбрав
его имя из списка, находящегося в подменю File > Open Recent (Файл > Недавно
открытые документы). \
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Рис. 5.3. Окно открытия файлов с ручным указанием формата

Еще один способ быстро выбрать нужный файл — встроенный в Adobe Photo-
shop блок просмотра файлов и данных о них. Для его вызова используйте команду
File > Browse... (Файл > Просмотр...) или комбинацию клавиш Ctrl+Shift+0. При
вызове этой команды на экран выводится окно просмотра списка файлов, нахо-
дящихся в папках на дисках вашего компьютера, и информация о них (рис. 5.4).

В этом окне можно просмотреть список файлов, расположенных в папках на
дисках вашего компьютера. Выбрав файл из списка, можно просмотреть умень-
шенную копию содержащегося в нем изображения (уменьшенные копии изобра-
жений также выводятся в списке файлов, если вы не отключите данный режим).
Также при выборе файла выводятся данные, записанные в него при сохранении
создавшей его программой. Например, цифровые камеры сохраняют в файле
информацию о времени и параметрах съемки.

СОВЕТ
Можно открыть файл, «перетащив» его мышью из окна Проводника Windows или другой
программы для работы с файлами в окно Adobe Photoshop.

Команда File > Revert (Файл > Вернуть) или клавиша F12 позволят вам вернуть
файл в состояние, соответствующее последнему выполненному сохранению. Эта
команда выполняется как большинство других команд обработки изображения.
Она, как и команда Save (Сохранить), доступна, только если в изображение были
внесены изменения с момента сохранения.
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Рис. 5.4. Окно просмотра файлов

Создание нового документа
Хотя вам часто будет требоваться открыть какой-либо файл для его обработки или
получения фрагментов изображений, необходимых для работы над другим доку-
ментом, нередко возникает необходимость создать новый документ (изображение).

Для создания нового изображения (называть его файлом до сохранения на же-
стком диске несколько некорректно) используйте команду File > New... (Файл >
Создать...) или комбинацию клавиш Ctrl+N. При вызове этой команды на экран
выводится окно, показанное на рис. 5.5.

В этом окне находится ряд полей и списков, при помощи которых можно задать
параметры нового изображения.

Name (Имя файла) — в этом поле можно ввести имя файла, точнее, название до-
кумента. При первом вызове команды сохранения файла (см. ниже) название до-
кумента будет предложено вам в качестве имени файла. По умолчанию докумен-
там присваиваются названия вида Unititled-1 (Без имени-1).
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Рис. 5.5. Окно создания нового документа

Preset (Предустановки) — из данного списка можно выбрать сохраненный ра-
нее вами или имеющийся в программе по умолчанию набор установок для
создания нового документа. В такой набор входят все параметры документа,
включая размер и разрешающую способность изображения, цветовой режим,
цвет фона, цветовой профиль и соотношение сторон пикселов.

Выбрав режим Default Photoshop Size (Принято в Photoshop по умолчанию),
можно создать документ со стандартными настройками, принятыми в Adobe
Photoshop. Документы такого типа создаются и в предыдущих версиях этого
графического редактора. Режим Clipboard (Буфер обмена) автоматически вклю-
чается при наличии в буфере обмена Windows информации, пригодной для
помещения в документ Adobe Photoshop. Это может быть изображение, текст,
векторный объект. В этом режиме параметры документа выставляются таким
образом, чтобы наиболее точно соответствовать имеющимся в буфере обмена
данным. Режим Custom (Настройки пользователя) установлен в том случае,
если вы создали документ с параметрами, отличными от стандартных зна-
чений, предлагаемых программой. Adobe Photoshop запоминает параметры
последнего созданного документа. Остальные предустановленные настройки
созданий документа позволяют быстро создавать изображения, имеющие раз-
мер, разрешение и другие параметры, соответствующие, например, телевизи-
онному изображению стандарта PAL, формату А4 или A3, размерам экрана
при разрешении, например, 1024 х 768 и т. д.

СОВЕТ
Для того чтобы создать документ на основе фрагмента изображения, достаточно скопи-
ровать фрагмент в буфер обмена, вызвать команду создания нового документа в Adobe
Photoshop, нажать клавишу Enter (подтвердить создание документа, не меняя его пара-
метров) и вставить изображение в документ, который будет иметь точно соответствующий
этому изображению размер.

В конец списка предустановленных значений добавляются имена нескольких файлов, ко-
торые были созданы последними. Можно быстро создать документ такого же размера, как
и содержащиеся в этих файлах изображения.
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• Width (Ширина) и Height (Высота) — основные характеристики документа,
определяющие размер изображения, Если вас не устраивают значения, предло-
женные Photoshop, введите нужные данные. Из списков, расположенных ря-
дом с полями ввода, можно выбрать названия единиц измерения, в которых
задаются размеры.

Изображение в любом случае состоит из пикселов, однако их число зависит
не только от размеров изображения, но и от его разрешающей способности.
Чтобы задать точное число пикселов (это удобно, если вы готовите изобра-
жения к использованию в Интернете или какой-либо программе), установите
в качестве единиц измерения пикселы. Выбрав другие единицы измерения,
вы сможете задать размер в них, а число пикселов будет рассчитано програм-
мой исходя из заданных размеров и разрешающей способности.

• Resolution (Разрешение) — величина, определяющая, сколько точек изображе-
ния (пикселов) будет размещено на отрезке длины при выводе изображения
на печать. Разрешение задается числом пикселов на дюйм (pixels/inch, dpi)
или числом пикселов на сантиметр (pixels/cm). Выбрать единицы измерения
можно при помощи списка, расположенного рядом с полем ввода разрешения.

При выводе изображений на экран монитора учитывается каждый пиксел, а раз-
решение монитора неизменно, поэтому заданная разрешающая способность
значения не имеет. При выводе на печатающее устройство разрешающая спо-
собность, как правило, может изменяться. Поэтому, задавая разрешение файла,
можно управлять размером изображения на печати, не меняя числа пикселов,
а значит, и качества изображения. Кроме того, при печати с более высоким
разрешением каждая точка изображения образуется из большего числа пик-
селов, что повышает качество отпечатанного изображения. Печать с низким
разрешением, наоборот, может ухудшить качество полученных распечаток.

• Color Mode (Цветовой режим) — из этого списка можно выбрать цветовой ре-
жим создаваемого документа. Описанию цветовых режимов посвящен от-
дельный раздел этой книги. Для подготовки изображений к выводу на экран
(например, для публикации в Интернете) лучше всего подходит режим RGB.
Кроме того, именно на него рассчитано большинство дополнительных мо-

• дулей и фильтров для Adobe Photoshop. Режим CMYK используется при
подготовке изображений к печати. Остальные цветовые режимы служат для
различных специальных целей (например, иллюстрации для этой книги сохра-
няются в режиме Grayscale (Оттенки серого)).

Рядом со списком выбора цветового режима находится еще один список, из
которого можно выбрать число бит, которые будут использоваться для описания
каждого из цветовых каналов для каждого пиксела. В зависимости от выбран-
ного цветового режима доступные разрядности изображения могут изменять-
ся. По умолчанию задана разрядность 8 бит/канал. Разрядность 16 бит/канал
может использоваться при сканировании изображений сканерами, имеющими
широкий динамический диапазон, или при подготовке к выводу на высокока-
чественные печатающие устройства. Однако монитор компьютера не способен
отображать все оттенки, описываемые в этом режиме, поэтому вам придется
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полагаться на цифровую информацию, выводимую программой на панелях
инструментов и в окнах команд.

• Background Contents (Цвет фона) — в этом списке можно выбрать цвет фона,
который будет установлен для нового документа. Доступны следующие вари-
анты — White (Белый), Black (Черный) и Transparent (Прозрачный).

Щелкнув на кнопке Advanced (Дополнительно), можно получить доступ к неко-
торым дополнительным настройкам (рис. 5.6).
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Рис. 5.6. Дополнительные настройки нового документа

Из списка Color Profile (Цветовой профиль ) можно выбрать модуль цветокор-
рекции, который будет использован в новом документе. Модули цветокоррек-
ции позволяют согласовывать цвета, выводимые различными устройствами,
и обеспечивают адекватное воспроизведение изображения, например, на эк-
ране монитора или при выводе на печать.

Выбрав режим Don't Color Manage this Document (He использовать цветовой
профиль), вы отключаете цветокоррекцию для текущего документа. Это по-
зволит несколько уменьшить размер сохраняемого файла, но может отрица-
тельно сказаться на качестве отображения на мониторе или вывода на печать
изображения при переносе файла на другой компьютер.

Из списка Pixel Aspect Ratio (Соотношение сторон пиксела) можно выбрать
соотношение между длиной и высотой элементов пикселов — базовых эле-
ментов изображения. По умолчанию задан режим Square ( Квадрат), соответ-
ствующий традиционным квадратным пикселам, образующим изображение
на мониторах компьютеров и печатающих устройствах. Другие соотношения
сторон пикселов используются при подготовке изображений для телевеща-
ния или кинопроката.
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Кнопки Save Preset... (Сохранить параметры...) и Delete Preset... (Удалить па-
раметры...) позволяют сохранять и удалять предустановленные наборы пара-
метров, которые вы затем сможете вызывать при создании новых документов.
При щелчке на кнопке Save Preset... (Сохранить параметры...) на экран выво-
дится окно, показанное на рис. 5.7. Можно ввести название набора параметров
и отметить флажками параметры, подлежащие сохранению. Для несохранен-
ных параметров при создании документа будут предложены последние ис-
пользованные значения этих параметров.

.

New Document Preset

•Ereset Name: : j 5383 px X 370 px

••••' Include In Saved Settings:

0 Resolution 0 Content
0№>de BErofile
0 Bit Depth -0 Pixel Aspect Ratio

V I l Values not included in the saved preset
4^/ will default to their tast used value.

Cancel

Рис. 5.7. Окно сохранения набора предустановленных параметров нового изображения

При щелчке на кнопке Delete Preset... (Удалить параметры...) вам будет предложе-
но удалить выбранный в данный момент из списка набор Preset (Предустановки)
параметров. Удалять наборы, включенные в программу по умолчанию, нельзя.

Под кнопками сохранения и удаления наборов параметров выводится приблизи-
тельный размер будущего документа после сохранения без сжатия и различных
дополнительных элементов, например слоев (см. рис. 5.5).

СОВЕТ
Как и в большинстве диалоговых окон Adobe Photoshop, при нажатии клавиши Alt кнопка
Cancel (Отмена) в окне создания нового документа меняется на кнопку Reset (Сброс), кото-
рая позволяет вернуть установленные в окне значения к состоянию, соответствующему вы-
зову окна на экран.

Сохранение документа
После того как, вы создали или открыли документ и закончили его обработку,
следует сохранить файл. Чаще всего для этого служит команда File > Save...
(Файл > Сохранить...). Также можно использовать комбинацию клавиш Ctrl+S.
Если файл до этого не был сохранен, на экране появится окно сохранения файла,
показанное на рис. 5.8.

Выберите диск и папку, в которой будет сохранен файл. Следует ввести в поле
File name (Имя файла) имя нового файла. Вы также можете выбрать один из
файлов, имена которых представлены в списке файлов. При этом его имя будет
автоматически введено в поле ввода имени нового файла. Можно отредактиро-
вать его и создать новый файл или же оставить неизменным и тем самым указать
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программе заменить существующий файл. В этом случае на экран предваритель-
но будет выведен запрос. Из списка Format (Формат) можно выбрать формат
файла. Отдельные элементы, например слои изображения, не могут быть сохра-
нены в файлах некоторых форматов. Поэтому в зависимости от состава докумен-
та и цветового режима изображения список может содержать не все доступные
Adobe Photoshop форматы файлов.

Рабочий стол

Мои документы ||

Сетевое ;' Format:

•Save Options

Save:

Cotor:,

............

TIFF (".TIF;".TIFF) .: Отмена

DAS а сете

0ICC Profile; SRGBIEC61966-2.1

E3 Use Lower Case Extension

Рис. 5.8. Окно сохранения файла

Под списком выбора формата находится набор флажков, устанавливая и снимая
которые можно управлять сохранением тех или иных элементов в файле. На-
пример, слои изображения (Layers) могут быть сохранены в файле формата
TIFF, но большинство других приложений «понять» такой файл не смогут. По-
этому сохранение слоев (если они содержатся в изображении) можно отключить
для обеспечения совместимости с другими программами. Это касается и других
элементов документа.
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СОВЕТ
При подготовке окончательной версии изображения можно выполнить объединение слоев,
а также удалить все1 ненужные теперь дополнительные элементы (направляющие, коммен-
тарии, векторные объекты).

Если вы не хотите сохранять текущий файл, а хотите сделать копию изображе-
ния, установите флажок As a Copy (Сохранить копию).

Снимите флажок ICC profile (Профиль ICC), если вы не хотите внедрять в файл
профиль цветокоррекции. Рядом с этим флажком отображается имя текущего
профиля, который будет сохранен в файле.

В окне настроек управления файлами (оно вызывается при помощи команды Edit >
Preferences > File Handling... (Правка > Настройки > Управление файлами...)) нахо-
дится список Image Previews (Уменьшенные копии изображений). Если из него
выбран режим Always Save (Всегда сохранять), флажок T h u m b n a i l (Предвари-
тельный просмотр), управляющий сохранением уменьшенных копий изображения
в файле, в окне сохранения файла будет установлен и недоступен для изменения.
Если вы выберете режим Never Save (Никогда не сохранять), этот флажок будет
снят и также недоступен для изменения. Если же выбран режим Ask When Saving
(Спрашивать при сохранении), вы сможете включить или отключить сохранение
уменьшенной копии изображения во время выбора его имени и формата файла.

СОВЕТ
Уменьшенная копия изображения, сохраненная в файле, может быть полезной при работе
с некоторыми графическими редакторами и программами для просмотра файлов. Копия
изображения ускоряет процесс предварительного отображения содержимого файлов в спис-
ках, если программа предоставляет эту возможность.

Так как копия изображения занимает определенный объем, при сохранении файлов для раз-
мещения в Интернете или для пересылки по электронной почте сохранение уменьшенных
копий изображений лучше отключить. Поскольку уменьшенная копия изображения имеет
стандартный размер и формат, она может существенно увеличить размер файла, содержа-
щего небольшое изображение.

Также в окне сохранения файла присутствует флажок Use Lower Case Extension
(Расширение в нижнем регистре). Если этот флажок установлен, расширение
файла будет записано строчными буквами, если флажок снят — прописными.
Регистр букв имени и расширения файла не имеет значения в операционной
системе Windows, однако может распознаваться и различаться в других систе-
мах, что проявляется, например, при размещении файлов на веб-страницах. Ука-
зание имени файла в неверном регистре может помешать браузеру найти файл.

Если вы вызовете команду File > Save... (Файл > Сохранить...) для файла, кото-
рый уже имеет имя и был сохранен на жестком или ином диске, доступном для
записи, файл будет сохранен без вывода на экран каких-либо окон и запросов.

Если вы хотите сохранить редактируемый файл под новым именем, воспользуй-
тесь командой File > Save As... (Файл > Сохранить как...). При этом на экран бу-
дет выведено окно, полностью аналогичное окну, показанному на рис. 5.8. Все
действия по сохранению файла в этом случае полностью аналогичны действиям,
описанным выше.
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При сохранении файлов для размещения в Интернете необходимо внимательно
отнестись к выбору формата файла и его параметров. Сохраняя файл, предназна-
ченный для размещения на веб-странице, следует как можно сильнее сжать его,
уменьшая размер файла (но не изображения), и при этом постараться сохранить
качество изображения максимально высоким. В большинстве случаев эти тре-
бования являются противоречивыми, поэтому вам придется искать разумный
компромисс.

Для сохранения файлов, подготавливаемых для размещения в Интернете, в Adobe
Photoshop предусмотрена специальная команда — File > Save for Web (Файл >
Сохранить для Web) и аналогичная ей по действию комбинация клавиш —
Ctrl+Alt+Shift+S.

При вызове этой команды на экран выводится окно, показанное на рис. 5.9.

Рис. 5.9. Окно сохранения файлов с оптимизацией для размещения в Интернете

В верхней части окна находятся несколько закладок, переключаясь между кото-
рыми можно просмотреть в центральной части окна оригинал (Original) изобра-
жения (изображение до сжатия), оптимизированное изображение (Optimized),
подлежащее сохранению, а также 2 (2-ир) или 4 (4-ир) образца изображения с раз-
ными настройками. Если выбран режим отображения нескольких образцов, можно
выбрать один из них щелчком мыши и работать с ним так же, как и со всем окном,
используя все доступные инструменты и настройки параметров. При сохранении

3 Зак. 805
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файла будут использованы параметры, указанные для выбранного в данный мо-
мент образца. В левой части окна находятся несколько инструментов, с которы-
ми можно работать в окне.

• Hand (Рука) — служит для прокрутки изображения в окне.

• Slice Select (Выделение фрагмента) — служит для выбора фрагмента изобра-
жения, ранее созданного при помощи инструмента Slice (Фрагмент). Для каж-
дого фрагмента можно задать индивидуальные параметры сохранения.

• Zoom (Увеличение) — служит для увеличения или уменьшения (при нажатой
клавише Alt) масштаба изображения в окне или выбранном образце.

• Eyedropper (Пипетка) — позволяет получать образцы цвета, например, для
объявления некоторых областей изображения прозрачными.

• Eyedropper Color (Цвет пипетки) — можно изменить цвет, отобранный пипет-
кой, вручную. Для этого дважды щелкните мышью на расположенном на па-
нели инструментов образце цвета.

• Toggle Slice Visibility (Переключатель отображения фрагментов) — кнопка,
щелкая на которой можно включать или выключать отображение границ
фрагментов, созданных при помощи инструмента Slice (Фрагмент).

В правой части окна находятся кнопки Save (Сохранить), Cancel (Отмена) и Done
(Завершить). Кнопка Done (Завершить) позволяет закрыть окно, запомнив уста-
новки сжатия для всего файла в целом или отдельных фрагментов изображения.
Если удерживать нажатой клавишу Alt, кнопка Cancel (Отмена) изменится на
кнопку Reset (Восстановить), позволяющую вернуть все настройки в состояние,
соответствующее моменту открытия окна. Кнопка Done (Завершить) при нажа-
тии на клавишу Alt сменяется клавишей Remember (Запомнить), позволяющей
запомнить настройки, выставленные в окне.

Также в правой части окна можно выбрать формат файла для всего изображения
или для выбранного фрагмента. Для сохранения фотографий лучше всего подхо-
дит формат JPEG. Основным параметром при сохранении файла в этом формате
является качество. Задать его можно при помощи поля и ползунка Quality (Каче-
ство). Чем выше качество изображения, тем больше размер файла.

СОВЕТ
Выбрать формат и предустановленные настройки сохранения можно при помощи списка
Preset (Предустановка).

ПРИМЕЧАНИЕ
В окне сохранения изображений для использования в Интернете качество изображения за-
дается в процентах, в то время как при сохранении изображения обычной командой Save
(Сохранить) качество изображения в формате JPEG определяется цифрами от 1 до 12.

Оба этих значения в конечном счете определяют объем информации об изображении,
«остающейся» после сохранения файла. Формат JPEG подразумевает сжатие за счет «от-
сеивания» части относительно ненужной информации. Разумеется, чем больше сведений
не будет отсеяно в процессе сжатия, тем более качественное изображение будет получено
в результате.
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ВНИМАНИЕ
Так как формат JPEG предусматривает сжатие с потерями, сохраненное в файле изображе-
ние всегда хуже оригинала. Поэтому не следует сохранять в этом формате промежуточные
результаты обработки изображения.

При выборе формата файла JPEG под списком форматов файлов появляется
еще один список, из которого можно выбрать предустановленные настройки ка-
чества.

• Low (Низкое качество) — показатель качества устанавливается равным 10 %.
Задавать такие низкие показатели качества целесообразно только для сохра-
нения версий изображения для предварительного просмотра. Возможно, вам
удастся использовать возникающие при сжатии искажения как художествен-
ный эффект,

• Medium (Среднее качество) — 30 %. Этот режим подходит для сохранения
изображений для предварительного просмотра или неответственных изобра-
жений для веб-страниц.

• High (Высокое качество) — 60 %. В этом режиме можно сохранять изображе-
ния, предназначенные для размещения на веб-страницах, отправки по элек-
тронной почте (если требования к качеству невысоки, выбирайте менее каче-
ственные, но более сжатые файлы, имеющие меньший объем).

• Very High (Очень высокое качество) — 80 %. Хорошо подходит для сохранения
качественных изображений при приемлемых объемах файлов.

• Maximum (Максимальное качество) — 100 %. Используйте этот режим для со-
хранения высококачественных изображений, например для архива или для
последующей обработки.

Прежде чем сохранить изображение в файл, следует просмотреть его (например,
на вкладке Optimized (Оптимизированное). Подбирая степень сжатия (качество
изображения) вручную, можно добиться максимального качества изображения,
минимизировав при этом объем файла.

Флажки Optimized (Оптимизированный) и Progressive (Прогрессивная развертка)
указывают на необходимость сохранять файл в модифицированных версиях фор-
мата JPEG, позволяющих уменьшить размер файла. Файлы с прогрессивной раз-
верткой, кроме того, отображаются в некоторых браузерах с постепенным улучше-
нием качества изображения по мере загрузки. Обычные JPEG-файлы загружаются
и отображаются построчно. Однако следует помнить, что некоторые программы
(сейчас их осталось не так много) могут не поддерживать эти расширения формата.

Параметр Blur (Размытие) позволяет задать размытие изображения для увеличе-
ния качества изображения.

Щелкнув на образце цвета Matting (Обработка краев) или используя список, рас-
положенный радом с ним, можно выбрать, каким цветом будут заполнены при
сохранении прозрачные области изображения (формат JPEG не поддерживает
сохранение информации о прозрачности).

После щелчка на кнопке Save (Сохранить) на экране появится окно сохранения
оптимизированных файлов, показанное на рис. 5.10.
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Рис. 5.10. Окно сохранения оптимизированных изображений

Выберите папку для сохранения файлов. Выберите из списка Тип файла тип со-
храняемых данных:

• HTML and Images (HTML и изображения) — для сохранения изображений
и HTML-кода, служащего для вывода на экран в окне браузера изображения
или его фрагментов и их компоновки в единое целое;

• Images Only (Только изображения) — в этом режиме будут сохранены только
изображения; если изображение состоит из нескольких фрагментов, для их
хранения создается папка, по умолчанию имеющая имя images; отдельные
фрагменты сохраняются в отдельные файлы, получающие имена, состоящие
из имени исходного документа и порядкового номера;

• HTML Only (Только HTML) — сохраняются только данные HTML, служащие
для вывода изображения в окно браузера; можно самостоятельно подставить
в него имена нужных файлов или получить нужные файлы из другого источ-
ника и дать им указанные в HTML-документе имена.

Из списка Settings (Настройки) можно выбрать набор настроек для сохранения
файлов. Пункт Other... (Другое...) позволит вам настроить режим сохранения са-
мостоятельно. Список Slices (Фрагменты) позволяет выбрать режим сохранения
фрагментов. Пункт All Slices (Все фрагменты) указывает на необходимость со-
хранить все фрагменты, даже созданные программой автоматически. При выборе
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пункта All User Slices (Все пользовательские фрагменты) будут сохранены только
фрагменты, созданные пользователем вручную, а пункт Selected Slices (Выбран-
ные фрагменты) позволит сохранить только фрагменты, выбранные в момент
щелчка на кнопке Save (Сохранить). Выбрать несколько фрагментов можно,
щелкая на них инструментом Slice Select (Выделение фрагмента), удерживая при
этом нажатой клавишу Shift.

Если для сохранения документа вы используете не команду Save for Web... (Со-
хранить для Web...), а команду Save (Сохранить) или Save As (Сохранить как),
после выбора формата файла и нажатия кнопки Save (Сохранить) на экране мо-
жет появиться окно с запросом дополнительных параметров, доступных для вы-
бранного вами формата.

Если вы сохраняете документ в формате PSD («родном» формате Adobe Photo-
shop), никаких дополнительных запросов не выводится. Рассмотрим настройку
сохранения файла в наиболее часто используемых при обработке фотографий
форматах — TIFF и JPEG. На рис. 5.11 показано окно установки параметров со-
хранения файла в формате TIFF.

TIFF Options

г- Image Compression ЕЖЗ

1 О Macintosh:

DSave Image Pyramid

©RLE (faster saves, bigger files)

OZIP (slower saves/smaller files)

5.11. Окно настройки параметров сохранения файла в формате TIFF

В группе Image Compression (Сжатие изображения) можно выбрать алгоритм, ко-
торый будет применен для сжатия данных изображения. Использование сжатия
позволяет значительно уменьшить объем файла (степень сжатия сильно зави-
сит от содержания изображения), однако далеко не все программы способны
адекватно воспринимать сжатые файлы формата TIFF, особенно при выборе
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относительно недавно добавленных алгоритмов ZIP и JPEG. По умолчанию вы-
брано значение None (Без сжатия). Рекомендуется оставить его неизменным.

Если вы все-таки решили использовать сжатие изображения, выберите необхо-
димый вам алгоритм. При выборе алгоритма JPEG вам станут доступны органы
управления качеством сжатого изображения.

СОВЕТ
Использовать сжатие внутри формата TIFF крайне не рекомендуется по соображениям со-
вместимости с другими программами. Это особенно актуально, если вы собираетесь пере-
дать файл другому человеку и не знаете, какой программой он намеревается воспользовать-
ся для открытия вашего файла.

Если вам необходимо уменьшить объем файла, например, для отправки по электронной поч-
те, используйте дополнительные программы-архиваторы (например, WinRAR или WinZIP).
Этот метод архивации распространен гораздо шире.

ПРИМЕЧАНИЕ
Сжатие с применением алгоритма JPEG внутри файлов формата TIFF практически бессмыс-
ленно — сохраненное изображение теряет качество (основное преимущество традиционного
формата TIFF — сохранение качества изображения неизменным). Кроме того, файлы стано-
вятся практически несовместимыми со многими графическими редакторами и программами
для просмотра изображений.

В группе Byte Order (Порядок байтов) выберите платформу, на которую ориенти-
рован файл, — IBM PC или Apple Macintosh (Mac). В компьютерах этих си-
стем (платформ) различается порядок записи байтов в числах, что может создать
некоторые проблемы при переносе файлов между компьютерами разных плат-
форм. Однако в большинстве случаев программы просмотра изображений и гра-
фические редакторы успешно распознают платформу, на которую ориентирован
файл, и программными методами приводят его в приемлемый для отображе-
ния вид.

Флажок Save Image Pyramid (Сохранить пирамиду изображений) позволяет сохра-
нить в одном файле несколько изображений с различным разрешением. На прак-
тике эта функций практически не используется.

Флажок Save Transparency (Сохранить прозрачность) позволит сохранить инфор-
мацию о прозрачных областях изображения. Формат TIFF поддерживает сохра-
нение каналов прозрачности (альфа-каналов) с числом градаций прозрачности,
равным 256. При отсутствии прозрачных областей этот флажок недоступен.

Если изображение содержит слои и вы не сняли флажок Layers (Слои) в окне
сохранения файла (см. рис. 5.8), вам станет доступна группа Layer Compression
(Сжатие слоев). В ней вы сможете выбрать алгоритм сжатия или отключить со-
хранение слоев (пункт Discard Layers and Save a Copy (Объединить слои, сохранить
как копию)).

ВНИМАНИЕ
Большинство программ не работают с файлами формата TIFF, содержащими слои изо-
бражения.
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ПРИМЕЧАНИЕ
Доступный вам для сжатия слоев формат RLE (Run-Length Encoding — Последовательное ко-
дирование) используется в файлах формата PSD для уменьшения их объема. Этот алгоритм
особенно эффективен при сохранении изображений, содержащих большие площади, зали-
тые одним цветом.

При сохранении файла в формате JPEG на экран будет выведено окно, показан-
ное на рис. 5.12.

JPEG options
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Рис. 5.12. Окно настройки параметров сохранения файлов в формате JPEG

В группе Image Options (Параметры изображения) задается главный параметр
изображения, сохраненного в формате JPEG, — его качество. В данном случае за-
дается собственно качество — чем больше значение, тем меньше данных «отбра-
сывается» при сжатии с потерями, тем лучше выглядит изображение, тем боль-
ше места на диске занимает файл.

ПРИМЕЧАНИЕ
В некоторых программах задается не качество изображения, а обратно пропорциональный
ему показатель — степень сжатия.

Ввести качество изображения можно при помощи поля ввода или расположен-
ного под ним ползунка. Также можно выбрать одно из предустановленных зна-
чений при помощи расположенного в этой же группе раскрывающегося списка.

СОВЕТ
Можно быстро увеличивать и уменьшать числовые значения, введенные в поля ввода, рас-
положенные в окнах Adobe Photoshop. Для этого установите курсор в поле и используйте
клавиши t и 4 для увеличения и уменьшения значения. Шаг изменения составляет 1, а при
нажатой клавише Shift — 10. Этот метод можно применять в большинстве диалоговых окон
Adobe Photoshop.
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В группе Format Options (Настройка формата) можно выбрать, какая из разновид-
ностей формата JPEG будет применена при сохранении файла. Версия Baseline
"Standard" (Базовая) является наиболее распространенной. При ее использова-
нии вы вряд ли столкнетесь с проблемами совместимости файлов и программ.
Версия Baseline Optimized (Базовая оптимизированная) отличается от базовой
тем, что позволяет дополнительно уменьшить размер файла для отдельных изо-
бражений. Некоторые программы (сейчас они встречаются редко) могут отка-
заться обрабатывать такие файлы. Версия Progressive (Прогрессивная развертка)
характерна тем, что при загрузке сохраненных с ее использованием файлов они
могут отображаться с постепенным увеличением качества, в зависимости от того,
какая часть информации уже получена. Это позволяет придать законченный вид
веб-страницам еще до их полной загрузки. Прогрессивная развертка может не
поддерживаться некоторыми программами, но это не помешает им показать изо-
бражение, хотя и без специальных эффектов.

Для версии Progressive (Прогрессивная развертка) можно выбрать число прохо-
дов записи информации об изображении — число «кадров» с разным качеством,
последовательно передаваемых в процессе загрузки.

Подбирая версию формата, ее параметры (для версии Progressive (Прогрессивная
развертка)) и степень сжатия, можно значительно уменьшить объем файла, со-
хранив качество на приемлемом уровне. В каждом отдельном случае эти пара-
метры лучше подбирать для конкретного изображения индивидуально. Внешний
вид сохраняемого изображения зависит от версии формата в гораздо меньшей
степени (или вообще не зависит), чем от заданного показателя качества.

В группе Size (Размер) отображается приблизительный размер файла после со-
хранения и примерная скорость загрузки ее с указанной скоростью. Скорость пе-
редачи данных для расчета времени загрузки можно указать при помощи распо-
ложенного рядом списка.

Для того чтобы в ходе подбора параметров сохранения оценить качество изобра-
жения, установите (или оставьте установленным) флажок Preview (Просмотр).
При этом все изменения будут отображаться в окне документа. Используя мышь
(будет автоматически включен инструмент Hand (Рука)), а также комбинации
клавиш Ctrl+«+» и Ctrl+«-» для увеличения и уменьшения масштаба, вы сможете
рассмотреть разные участки изображения, оценивая пригодность данного набора
параметров сохранения.

Импорт и экспорт изображений
Иногда изображения имеют формат, не поддерживаемый Adobe Photoshop на-
прямую, или же источником данных служит не файл, а какое-либо устройство,
например сканер. В этом случае вам стоит попробовать воспользоваться коман-
дами подменю File > Import (Файл > Импортировать). В нем содержатся команды
импорта изображений из файлов PDF, импорта комментариев (Annotations) из
других файлов формата PSD, импорта изображений с различных устройств, под-
ключенных к компьютеру и поддерживающих интерфейсы TWAIN или WIA.
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Импорт данных производится под управлением специально вызываемой для этой
цели программы или стандартного интерфейса Windows.

Команда File > Place (Файл > Поместить) позволяет поместить изображение, содер-
жащееся в некотором файле, в открытый в настоящий момент документ. Таким
образом можно поместить в файл изображение, содержащееся в векторном файле,
сохраненном, например, программой Adobe Illustrator. Поддерживаются такие
форматы, как AI, EPS, PDF и PDP.

Для экспорта векторных объектов из Adobe Photoshop в Adobe Illustrator исполь-
зуйте команду File > Export > Paths to Illustrator (Файл > Экспорт > Пути в Illustrator).

ПРИМЕЧАНИЕ
Программы Adobe Phtoshop и Adobe Illustrator могут обмениваться данными через буфер
обмена. Причем, копируя векторный объект из Illustrator в Photoshop, в момент вставки
изображения в документ вы сможете выбрать, будет изображение вставлено в виде векто-
ров или в виде растрового объекта.

В меню File > Export (Файл > Export) могут находиться и другие команды, на-
пример команда экспорта в формат Zoom View (формат, ориентированный на
просмотр изображений большого объема через Интернет по частям с целью со-
кращения времени загрузки и объема загружаемых данных).

В этом разделе мы рассмотрели различные способы открытия и сохранения фай-
лов в Adobe Photoshop. Мы познакомились с возможностями импорта данных из
файлов, не поддерживаемых Adobe Photoshop напрямую. Нам стало известно,
где расположены команды, используемые для получения изображений с различ-
ных устройств, подключенных к компьютеру. Также мы узнали, какие парамет-
ры можно задать во время сохранения файлов в наиболее распространенных при
обработке фотографий форматах — TIFF и JPEG.



Глава 6

Взаимодействие Adobe
Photoshop CS со сканерами
и цифровыми камерами
В главе 2, посвященной способам получения цифровых изображений, мы уже го-
ворили о сканировании и загрузке файлов с цифровой камеры. В данной главе
мы подробнее рассмотрим процесс выполнения этих действий.

Начнем с процесса загрузки файлов изображений с цифровой камеры. Как уже
неоднократно говорилось, существует несколько способов получения доступа
к изображениям, хранящимся в памяти цифровой камеры. Рассмотрим самые
распространенные из них:

• подключение камеры к компьютеру и работа с ней как со сменным диском;

• подключение камеры к компьютеру и работа с ней при помощи специальной
программы;

• подключение к компьютеру или считывание другим способом извлеченного
из камеры носителя информации.

Большинство современных цифровых фотокамер имеют разъемы и интерфейсы
для подключения к компьютеру. При этом пользователь может копировать на
компьютер хранящиеся в памяти камеры данные, мспользовать камеру в качест-
ве считывающего устройства для карт памяти, управлять работой камеры и даже
производить фотосъемку не прикасаясь к фотоаппарату. Конкретный набор функ-
ций зависит от модели камеры и доступного программного обеспечения.

Для подключения камеры к компьютеру необходим соединительный кабель и на-
личие на компьютере соответствующего интерфейса, поддерживаемого камерой.
Кабель, как правило, поставляется в комплекте с камерой.

В большинстве современных фотокамер для связи с персональным компьюте-
ром используется интерфейс USB. В устаревших моделях может встречаться по-
следовательный интерфейс (СОМ-порт, RS-232). Некоторые профессиональные
модели могут оснащаться интерфейсом FireWire.

Для работы с цифровой фотокамерой вам потребуется установить на компьюте-
ре программное обеспечение — драйвер интерфейса и камеры, а также програм-
му, обеспечивающую доступ к хранящимся в памяти камеры файлам. Роль такой
программы в большинстве случаев с успехом выполняет обычный Проводник
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Windows или другая программа для работы с файлами. Драйверы необходимы
для обеспечения корректного взаимодействия операционной системы с вновь
подключаемым оборудованием — цифровой фотокамерой. Для установки про-
граммного обеспечения следуйте инструкции, прилагаемой к вашей камере.

ВНИМАНИЕ —
Для корректной работы с интерфейсом USB кроме наличия этого интерфейса в составе ком-
пьютера потребуется операционная система, способная обеспечить работу с ним. Из семей-
ства систем Windows это системы Windows 98, Windows 98 SE, Windows ME, Windows NT 4.0,
Windows 2000 и Windows XP. Для операционных систем Windows ME, Windows 2000 и Win-
dows XP устанавливать драйвер порта USB не потребуется, кроме того, драйвер для вашей
камеры обычно входит в стандартный комплект поставки системы.

Подключите камеру к компьютеру, следуя инструкции. После этого вы сможете
получить доступ к файлам, хранящимся в ее памяти. Если карта поддерживает
работу в качестве сменного диска, воспользуйтесь Проводником Windows или
другой программой для работы с файлами. Просто скопируйте файлы в нужную
папку на жестком диске. Многие камеры позволяют удалить файлы с карты памя-
ти, для того чтобы освободить место для новых снимков. Удалить файлы можно
также с любого другого диска вашего компьютера.

В последних версиях Windows имеется системная папка Сканеры и камеры, раз-
мещающаяся на Панели управления. В этой папке вы найдете все подключённые
к компьютеру и распознанные Windows сканеры и цифровые фотоаппараты.
Найдя значок нужной камеры, используйте его для открытия содержимого па-
мяти камеры в новом (или том же, в зависимости от настроек системы) окне.
После этого можно работать с файлами так же, как и с файлами, хранящимися
на вашем компьютере.

ПРИМЕЧАНИЕ
Процедура работы с цифровой фотокамерой зависит от конкретной модели. В любом случае
перед началом работы изучите инструкцию.

ВНИМАНИЕ
Независимо от способа подключения камеры к компьютеру не выключайте камеру, не отклю-
чайте ее от компьютера и не меняйте режим ее работы (если иное не оговорено в инструкции)
при активном индикаторе обмена данными с компьютером или другим устройством. В против-
ном случае могут оказаться поврежденными передаваемые данные или даже карта памяти.

СОВЕТ
Удалить файлы с карты памяти можно, используя функции самой камеры, не прибегая к по-
мощи компьютера.

Adobe Photoshop CS может открывать файлы, в том числе файлы специфическо-
го для цифровых камер формата RAW, скопированные с цифровой фотокамеры
на жесткий диск компьютера. Кроме того, если ваша камера поддерживает рабо-
ту с интерфейсом WIA или TWAIN, с ней можно работать непосредственно из
Adobe Photoshop. При этом Photoshop вызывает поставляемую вместе с камерой
программу управления, дает возможность работать с этой программой, после
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чего открывает полученные файлы. Собственно файлы на жестком диске могут
при этом и не создаваться — изображения будут храниться в оперативной памя-
ти компьютера, пока вы сами не укажете сохранить их на жестком диске.

ПРИМЕЧАНИЕ
В версиях Windows, предшествующих Windows XP, для доступа к сканерам и цифровым ка-
мерам использовался интерфейс TWAIN. Этот интерфейс, так же как и интерфейс WIA, яв-
ляется программным — никаких дополнительных устройств, разъемов и кабелей вам не по-
надобится.

Для доступа к цифровой фотокамере посредством интерфейса WIA воспользуй-
тесь командой File > Import > WIA Support (Файл > Импорт > Устройство WIA). Если
устройство (сканер или фотокамера) подключено к компьютеру и готово к рабо-
те, на экране появится окно запроса, показанное на рис. 6.1. Если устройство не
подключено или не готово к работе (например, выключено питание), на экране
появится сообщение об ошибке.

WIA Support

This Wizard assists you with acquiring images from WIA
compatible cameras and scanners. : '.

C;i00cumanli and Sellings...у DocumentsVly Pictures!
Browse..

0Open Acquired Irnage(s) in Photoshop '•]':'•

13Create Unique Subfolder Using Today's Date

[ Cancel

Рис. 6.1. Окно начала загрузки изображений с цифровой камеры

В группе Destination Folder (Папка для копирования файлов) отображается путь
и название папки, в которую будут помещены извлеченные из камеры изображения.
Щелкните на кнопке Browse (Обзор) и укажите другую папку, если это необходимо.

Флажок Open Acquired Image(s) In Photoshop (Открыть полученное изображе-
ние^) в Photoshop) указывает программе не только загрузить указанные вами
изображения, но и открыть их в Adobe Photoshop CS для редактирования. Фла-
жок Create Unique Subfolder Using Today's Date (Создать уникальный подкаталог,
используя сегодняшнюю дату) позволяет не только поместить файлы изображе-
ний в указанную папку, но и создать для них новый подкаталог с именем, указы-
вающим на дату копирования файлов.

Щелкните на кнопке Start (Начать) для начала процесса копирования изображений.
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ВНИМАНИЕ
Процесс взаимодействия с камерой или сканером может зависеть от конкретной модели и ус-
тановленного программного обеспечения. Приводимый здесь пример загрузки изображений
с цифровой камеры может не соответствовать тому, что вы увидите на своем компьютере.

Если доступно несколько совместимых с интерфейсом WIA устройств, вы смо-
жете выбрать то, с которым собираетесь работать в данный момент. Это окно по-
казано на рис. 6.2.

-f': Выбор устройства

Какое укрЩШШ

Canon
PowerS hot G5

^̂ ^̂ ^̂ ^̂ ^̂ ^̂ S| . : ." .

.::1:|;0.пмй

..

Рис. 6.2. Окно выбора устройства, которое будет служить источником изображений

Выберите устройство, которое вы намереваетесь использовать, и щелкните на
кнопке ОК.

ПРИМЕЧАНИЕ
Окно выбора устройства (рис. 6.2) выводит операционная система, поэтому его язык может
отличаться от языка, используемого в Adobe Photoshop. Дальнейшие действия выполняются
в окне программы, поставляемой совместно с цифровой фотокамерой, их вид и доступные
функции зависят от фирмы-изготовителя, модели камеры и версии программного обеспечения.

На рис. 6.3 показано окно программы, используемой для загрузки изображений
с цифровой фотокамеры Canon Power/shot G5.

В центральной части окна расположен список файлов с уменьшенными копиями
изображений. При помощи находящихся над этим списком кнопок можно вы-
брать режим отображения списка или удалить выбранные файлы. В нижней ча-
сти окна вы видите кнопку Получить снимки, позволяющую загрузить изображе-
ния с фотокамеры.

ПРИМЕЧАНИЕ
Рассматриваемая здесь фотокамера имеет возможность дистанционного управления съем-
кой. Для того чтобы сделать снимок, достаточно щелкнуть на кнопке Снять в окне получения
изображений.
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Ш Получи гь снимки с Салоп PowecShot С5

Выберите один или несколько снимков и нажмите кнопка "Получить снимки". Для
копирования нескольких снимков удерживайте нажатой клавишу Shift или Control

!

Также можно; v . .

Присмотреть сведения о снимке
\?|'Побить снимки j ( .Отмена };:..

Рис. 6.3. Окно копирования фотоснимков с фотокамеры производства компании Canon

Как было сказано выше, еще одним способом получения цифровых изображений
является сканирование. Сканеры позволяют перевести в электронный вид изо-
бражение, уже зафиксированное на бумаге. Удобнее всего сканировать плоские
предметы — фотографии, книги, открытки. В некоторых случаях можно полу-
чить с помощью сканера изображение небольших предметов, однако для этих
целей гораздо лучше подходит цифровая фотокамера.

ВНИМАНИЕ
Перед началом сканирования убедитесь, что сканер подключен к компьютеру и включен
в сеть. Если вы ранее не использовали сканер, проверьте, установлены ли драйверы и необ-
ходимое программное обеспечение.

СОВЕТ

Цифровая камера может служить для пересъемки документов. При соответствующей подго-
товке процесс пересъемки, например, части книги, занимает гораздо меньше времени, чем
сканирование. Полученные в результате изображения могут вполне подойти как иллюстра-
ции или материал для распознавания текста. Разумеется, для обеспечения высокого качест-
ва следует обеспечить достаточную освещенность объекта съемки и использовать штатив.

Чтобы начать получение изображения со сканера в среде Adobe Photoshop, вы-
полните команду File > Import (Файл > Импорт) и выберите из списка название
сканера. После выполнения этой команды откроется диалоговое окно работы
с вашим сканером.

Работа со сканером производится под управлением специальной программы
управления, поставляемой совместно со сканером. Adobe Photoshop вызывает эту
программу для установки параметров и сканирования. Отсканированное изобра-
жение загружается в Adobe Photoshop и становится доступным для редактирова-
ния после выхода из программы управления сканером.
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ПРИМЕЧАНИЕ
До выхода из программы сканирования вы не сможете использовать другие функции Adobe
Photoshop.

В качестве примера окна программы управления сканером на рис. 6.4 представ-

лено диалоговое окно работы со сканером Epson Perfection 3200 PHOTO.

ШЙ?Ш !̂̂ Ш;Й

В

:•.'.: :; Й?грйник документа: : ; :: j Планшет для документов

(документ

Цветной 24-бига

'̂ •:; (Наилучшее

1300

j Размер назначения: '• 1111: ̂ Оригинальный

270.2.||мм'

В ил : '.

•8 k Сброс

>)Средний

Направляющие: в : Основной

; Сзравка:

Рис. 6.4. Окно сканирования изображений сканера Epson Perfection 3200 PHOTO
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В зависимости от функциональных возможностей сканера диалоговое окно ра-
боты с ним имеет различные группы настроек. В общем случае для большинства
моделей настроить можно следующие параметры: тип и размер изображения,
желаемое разрешение, яркость и контрастность изображения.

Под типом изображения обычно подразумеваются цвет и его глубина. Цветное
изображение может иметь глубину 24 или 48 бит, изображение в оттенках серо-
го — 8 или 16 бит.

ВНИМАНИЕ
Не все графические редакторы имеют достаточно возможностей для обработки 48-битовых
цветных изображений. В Adobe Photoshop CS можно использовать для более точной переда-
чи цвета режим 16 бит/канал (см. главу 11).

Важно также задать правильное разрешение для сканирования. Цветные фото-
графии имеет смысл сканировать с разрешением 200-300 dpi, если их предпола-
гается в дальнейшем распечатывать, или 72 dpi для просмотра на экране монито-
ра. Для последующей обработки имеет смысл получить изображение как можно
большего качества, поэтому используйте высокое разрешение (300-600 dpi).
Лучшие результаты можно получить, сканируя отпечатки большого формата.

ВНИМАНИЕ
При сканировании матовых фотографий на полученном изображении, скорее всего, возник-
нет «шум» или зернистость — проявления неровной поверхности отпечатка. Поэтому для
сканирования лучше подходят глянцевые фотографии. Учтите это, заказывая отпечатки
в фотолаборатории.

Текст для последующего распознавания в соответствующих программах достаточ-
но сканировать с разрешением 100-150 dpi, однако при разрешении 300-600 dpi
качество и точность работы программы распознавания значительно повышаются.

Будьте осторожны при сканировании с газет, журналов и буклетов — специфика
офсетной печати приводит к появлению на сканированных цифровых изображе-
ниях помех в виде так называемого муара. Некоторые сканеры позволяют уда-
лить муар на стадии сканирования, а также провести цветовую коррекцию изо-
бражения и повысить его резкость.

ПРИМЕЧАНИЕ
Муаром называются помехи в виде темных и светлых областей или пятен. При сканировании
муар проявляется на изображении из-за взаимодействия сканера и его программного обес-
печения с периодически повторяющимся рисунком полиграфического растра. Муар обычно
возникает при сканировании газет, журналов или иной типографской продукции.

Еще одна возможная причина возникновения муара — недостаточное разрешение экрана
при отображении изображений, содержащих периодически повторяющиеся фрагменты.
Устранить такой муар можно, увеличив масштаб просмотра изображения.

СОВЕТ
Муаровые рисунки способны испортить отсканированное изображение, но сами по себе они
часто оказываются достаточно красивыми, вы можете использовать их в своих работах.
Существуют специальные программы и модули для Adobe Photoshop, генерирующие муа-
ровые узоры.
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Для сканера Epson Perfection 3200 PHOTO муар на стадии сканирования удаля-
ется с помощью группы элементов Фильтр Удаление растра. Из раскрывающегося
меню можно выбрать тип сканируемого изображения: обычный, газета, журнал
или высококачественная печать. Для некоторых сканеров команда удаления
муара может называться Descreen (Удаление растра).

Рис. 6.5. Слева — изображение с растром, справа — изображение, отсканированное
с применением фильтра Удаление растра (сканер Epson Perfection 3200 PHOTO)

При отсутствии в программе управления сканером функции удаления растра
или в том случае, когда в вашем распоряжении оказывается уже отсканирован-
ное изображение, вы можете попытаться избавиться от муара, используя фильт-
ры группы Blur (Размытие).

В этой главе мы познакомились с методами получения изображений со сканеров
и цифровых камер. С их помощью можно загружать изображения, вызвав про-
грамму загрузки изображений прямо из Adobe Photoshop CS.



Глава 7 •

Использование инструментов
редактирования изображений
После того как вы загрузили изображение с цифровой камеры, отсканировали
любимую фотографию или просто открыли в Adobe Photoshop фото, загруженное
с веб-сайта, можно начать создавать из него собственное произведение искусст-
ва. Но сначала следует ознакомиться с инструментами, при помощи которых вы
будете воплощать свои мечты и фантазии. Эта глава посвящена инструментам,
при помощи которых редактируются изображения в Adobe Photoshop CS.

Панель инструментов Adobe Photoshop предоставит доступ ко всем основным
средствам редактирования изображений. Разумеется, многие действия выпол-
няются при помощи команд меню, но если вы хотите просто выделить участок
изображения для выборочного применения фильтра или команды, придется
воспользоваться одним или несколькими инструментами. Панель инструментов
показана на рис. 7.1.

Первая группа инструментов, наверное, самая популярная — инструменты выделе-
ния фрагментов изображения. Они служат для копирования части изображения
между документами или программами, кадрирования, ограничения действия
других инструментов или команд некоторой областью изображения. Примене-
нию инструментов этой группы и другим способам выделения фрагментов изо-
бражений посвящена глава 12 — «Выделение фрагментов изображения».

Вторая группа кнопок главной панели инструментов позволяет задействовать
инструменты, непосредственно изменяющие изображение, — рисующие инстру-
менты. В этой главе мы рассмотрим в основном их.

СОВЕТ
Можно временно скрыть панели инструментов с экрана, чтобы освободить дополнительное
место для просмотра изображения. Для этого используйте клавишу Tab. Повторное нажатие
этой клавиши вернет панели на свои места.

При выборе любого из инструментов на панели свойств инструмента (по умол-
чанию она расположена вдоль верхнего края окна программы, рис. 7.2) отобра-
зятся применимые к нему настройки, которые можно изменить по своему усмот-
рению. Рассмотрим настройки инструментов и особенности их использования.
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Вызов информации о программе

Инструменты выделения

Инструменты редактирования
изображения (рисующие
инструменты)

Инструменты работы с текстом
и векторными объектами

Вспомогательные инструменты

Индикаторы (образцы) цветов
переднего и заднего плана

] Переключатель режима «быстрой маски»

1 Переключатель вида окна программы

1 Переход в программу Adobe ImageReady

Рис. 7.1. Основная панель инструментов Adobe Photoshop

« р« ШШ „.

Рис. 7.2. Панель свойств инструментов Adobe Photoshop (применительно к инструменту Marquee)

Инструмент Brush
Инструмент Brush (Кисть) — один из основных инструментов Adobe Photo- f~jp

shop. С его помощью выполняются самые разнообразные действия — обыч- »•*

ное рисование, изменение оттенка изображения, нанесение штрихов, имитирующих

работу аэрографа или сухой волосяной кисти, и даже выделение фрагментов

изображения (в так называемом режиме «быстрой маски»).

Выбрав этот инструмент, проведите им по изображению, удерживая нажатой ле-

вую кнопку мыши. «Кисть» оставит свой след на изображении. Для рисования

используется цвет переднего плана — его отображает верхний квадрат-индика-

тор цвета (рис. 7.1).

ПРИМЕЧАНИЕ
Изменить цвет можно при помощи панели инструментов Color (Цвет) и инструмента Eyedropper
(Пипетка). Наибольшие возможности предоставляет окно выбора цвета, открываемое при
двойном щелчке на индикаторе (образце) цвета. Щелчок на верхнем образце позволяет
выбрать цвет переднего плана (цвет кисти), щелчок на нижнем образце — цвет фона.
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На рис. 7.3 показано несколько штрихов, оставленных инструментом при разных
настройках. О самих настройках этого инструмента мы расскажем позже.

Рис. 7.3. Штрихи, оставленные инструментом Brush при использовании различных настроек

Для настроек инструмента служит панель его свойств. Для инструмента Brush
(Кисть) она принимает вид, показанный на рис. 7.4.

Рис. 7.4. Панель свойств инструмента при использовании инструмента Brush

Первая слева кнопка этой панели (с изображением кисти) позволяет вы- г^ц
брать один из предустановленных наборов настроек этого инструмента или
создать собственный набор (Preset) на основе свойств инструмента, установлен-
ных и используемых в данный момент.

Следующая кнопка (Brush (Кисть)) позволяет выбрать форму и размер кисти,
которой вы будете рисовать. При щелчке на этой кнопке на экран выводится до-
полнительное окно (рис. 7.5), в котором можно выбрать нужную форму кисти,
задать ее размер и некоторые другие параметры.

Выберите форму кисти, пролистывая список. Ползунок Master Diameter (Главный
диаметр) позволяет задать размер кисти (ширину штриха).

Для некоторых форм кистей доступны дополнительные параметры. Например,
ползунок Hardness (Жесткость) определяет плотность краев штриха. При уста-
новке этого параметра на 100 % края штриха сглаживаются ровно настолько, на-
сколько это необходимо для получения ровной линии, без заметных «зазубрин» —
излишне контрастных пикселов, расположенных по краям следа от кисти. При
уменьшении плотности штрих становится более размытым, что полезно, напри-
мер, при создании плавных цветовых переходов.
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Рис. 7.5. Окно выбора формы кисти

Небольшая кнопка со стрелкой, расположенная в верхнем левом углу окна выбора
кисти, позволяет вызвать меню управления наборами предустановленных парамет-
ров кистей. Команда New Brush Preset (Заготовка новой кисти) позволит создать
на основе установленных в данный момент параметров новую предустановлен-
ную кисть, которую затем можно будет быстро выбрать из списка. Команды Load
Brushes (Загрузить кисти) и Save Brushes (Сохранить кисти) позволяют сохранять
наборы кистей на жестком диске и загружать их в список предустановленных на-
строек. Команда Reset Brushes (Восстановить кисти) восстанавливает исходное хщ<
состояние списка кистей, заданное при установке программы. Под кнопкой
вызова меню расположена еще одна кнопка, щелчок на которой аналогичен
вызову команды New Brush Preset (Новая кисть) из меню этого окна.

Далее на панели свойств инструментов расположен раскрывающийся список Mode
(Режим). Из него можно выбрать режим (способ) наложения штриха, оставляе-
мого кистью, на изображение, которое уже находится на текущем слое. Подроб-
нее о режимах наложения штрихов рассказывается в конце этой главы. Работе со
слоями посвящена глава 10 этой книги — «Слои изображения и их использование».
Пока лишь отметим, что действие режима наложения штриха кисти проявляется
только при рисовании поверх уже существующего изображения. При рисовании
на пустом прозрачном слое режим наложения кисти не влияет на результат.

Еще одним важным параметром кисти является прозрачность оставляемого ею
штриха. Она задается при помощи поля ввода и ползунка (появляется на экране
при щелчке на расположенной рядом с полем стрелке) Opacity (Непрозрачность).

Плотность штриха задается в процентах: — 100 % — штрих максимальной плот-
ности, 0 % — полностью прозрачный штрих.

СОВЕТ
Можно задать прозрачность кисти при помощи клавиатуры. Для этого, выбрав данный инст-
румент, нажмите клавишу от 1 до 0 — этим вы установите прозрачность в десятках процен-
тов (от 10 до 100 %). Быстрое нажатие двух клавиш подряд позволит ввести двузначное
число, например 68 %.
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В правой части панели расположены поле ввода с ползунком Flow (Поток) и кноп-
ка, служащая для включения режима аэрографа. В этом режиме густота «крас-
ки» будет постепенно увеличиваться при повторном мазке по одной точке изо-
бражения кисти без отпускания левой кнопки мыши. В обычном режиме краска
наносится только в момент помещения мыши в указанную точку при нажатой
левой кнопке мыши. Параметр Flow (Поток) устанавливает количество краски,
наносимой при одном проходе кисти по одной точке.

Для большинства рисующих инструментов можно аналогичным образом задать
форму кисти и прозрачность (плотность) штриха.

СОВЕТ
Работая с инструментом Brush (Кисть), а также с другими инструментами, можно использо-
вать клавиши Ctrl, Shift и Alt, предоставляющие доступ к некоторым дополнительным функ-
циям и значительно ускоряющие работу. Подробнее назначение этих и некоторых других
клавиш описано в конце этой главы.

Инструмент Pencil
Если указать курсором мыши на кнопку инструмента Brush (Кисть) и некоторое
время удерживать левую кнопку мыши нажатой, кнопка развернется в неболь-
шую панель, на которой можно выбрать один из двух инструментов — Brush
(Кисть) и Pencil (Карандаш). Кнопка выбранного инструмента будет помещена
на панель инструментов.

ПРИМЕЧАНИЕ
Подобным образом можно выбирать многие инструменты. На то, что кнопка панели скрыва-
ет за собой несколько инструментов, указывает небольшая стрелка в нижнем правом углу
кнопки.

Инструмент Pencil (Карандаш) во многом схож с инструментом Brush (Кисть).
Основное отличие «карандаша» от «кисти» состоит в том, что к штрихам
карандаша не применяется сглаживание — штрихи получаются четкими. На
рис. 7.6 приведены увеличенные фрагменты линий, нарисованных инструмента-
ми Pencil (Карандаш) и Brush (Кисть).

Рис. 7.6. Фрагменты линий, нарисованных инструментами Penal (слева) и Brush (справа)
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Четкость линий, оставляемых инструментом Pencil (Карандаш), делает его удоб-
ным для построения схем, разметки изображений и макетов будущих печатных
работ или веб-страниц. Еще одно применение этого инструмента — закрашива-
ние выделенных областей. Инструмент Brush (Кисть) из-за сглаживания краев
штриха может дать неравномерную окраску.

Параметры инструментов Pencil (Карандаш) и Brush (Кисть) схожи, но в отличие
от обычной кисти карандаш не может работать в режиме аэрографа. Вместо это-
го можно включить режим Auto Erase (Стирать), установив соответствующий
флажок. В этом режиме карандаш будет рисовать цветом переднего плана, если
цвет в начальной точке штриха не совпадает с этим цветом. Если же вы начи-
наете рисовать в точке, имеющей цвет переднего плана, для рисования будет
использован цвет фона.

Инструмент Erase
Инструмент Erase (Ластик) широко используется для удаления выбранных фраг-
ментов изображения. С его помощью можно стереть часть изображения, при
этом при работе на фоновом слое (о слоях речь пойдет в отдельной главе) стертые
пикселы закрашиваются цветом фона, а при работе на любом другом слое (при
отключенной блокировке прозрачности) — становятся прозрачными. Можно вы-
брать форму кисти для этого инструмента, что позволит применять его не толь-
ко для технических, но и для художественных целей.

Выбрать инструмент Erase (Ластик) можно с помощью кнопки, располо- г^р
женной на панели инструментов. При этом на панели свойств инструмента •*«'*•*
появится набор настроек, практически идентичный набору настроек для инстру-
мента Brush (Кисть).

Как уже было сказано, для инструмента Erase (Ластик) можно задать форму
кисти. Также можно определить режим работы инструмента, но в отличие от
других инструментом это не режим наложения штриха на существующее изо-
бражение, а метод использования указанной вами кисти. Можно выбрать один
из трех режимов:

• Brush (Кисть) — кисть инструмента используется так же, как кисть инструмен-
та Brush (Кисть), — к штриху применяется сглаживание, инструмент может
работать в режиме аэрографа;

• Pencil (Карандаш) — к кисти не применяется сглаживание; этот режим удобен
для стирания изображения на больших площадях;

• Block (Блок) — используется курсор жестко заданной формы.

Кроме режима инструмента можно выбрать прозрачность штриха (для режимов
Brush (Кисть) и Pencil (Карандаш)). Сделать это можно при помощи поля ввода
Opacity (Непрозрачность) или клавиатуры, так же как и для инструмента Brush
(Кисть).

В режиме Brush (Кисть) можно переключить инструмент в режим аэрографа и за-
дать интенсивность применения инструмента.
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На панели свойств инструмента также находится флажок Erase to History (Сти-
рать до восстановления). Установив этот флажок, вы сможете стирать изображе-
ние не до пустого фона или полной прозрачности, а до некоторого состояния, со-
храненного в протоколе команд Adobe Photoshop (History). Выбрать момент, до
которого будет производиться стирание (точнее, восстановление изображения),
можно, установив специальный маркер в виде кисти напротив нужного пункта
на панели History (Протокол) (рис. 7.7)

Рис. 7.7. Напротив пунктов протокола команд можно установить маркер состояния, которое
будет использовано при работе с инструментом Erase и некоторыми другими инструментами

Если некоторое время удерживать нажатой кнопку инструмента Erase (Ластик),
на экране появится меню, из которого можно выбрать один из трех инструмен-
тов, связанных с этой кнопкой. Кроме инструмента Erase (Ластик) это инстру-
менты Background Eraser (Фоновый ластик) и Magic Eraser (Волшебный ластик).

Инструмент Background Eraser (Фоновый ластик) позволяет стирать фон (од-
нотонные области, занимающие большие части изображения), оставляя нетрону-
тыми сильно отличающиеся от него детали. С помощью инструмента Magic Eraser
(Волшебный ластик) можно автоматически стереть все пикселы, прилегающие
к пикселам, указанным инструментом и имеющим оттенок, отличающийся от
оттенка этих пикселов не более чем на величину допуска, задаваемого параметром
Tolerance (Допуск).

Инструмент Pain Bucket
Инструмент Paint Bucket (Заливка) позволяет заполнять указанные облас- ж:|
ти изображения цветом переднего плана или выбранным шаблоном. Его «"И
удобнее всего применять к выделенным областям или однотонным фрагментам
изображения.

ПРИМЕЧАНИЕ —
Для заполнения выбранным цветом выделенного фрагмента изображения вместо этого ин-
струмента можно с успехом использовать инструмент Pencil (Карандаш) с кистью большого
размера.

Для закрашивания области изображения выберите инструмент Paint Bucket
(Заливка), после чего щелкните левой кнопкой мыши над любой точкой вы-
бранной области изображения. Можно настраивать следующие параметры этого
инструмента.
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• Fill (Заполнить) — определяет, чем будет заполнена выбранная вами область.
Доступны два варианта — Foreground (Рабочий цвет) и Pattern (Узор). Если
выбран второй вариант, становится доступным список выбора узора для за-
полнения выбранной области.

ПРИМЕЧАНИЕ
Можно использовать шаблоны, оставляемые вместе с программой, или же создавать собст-
венные. Для этого выделите фрагмент изображения и вызовите команду Edit > Define Pattern
(Правка > Задать шаблон).

Mode (Режим) — определяет режим наложения цветной заливки или шаблона
на существующее изображение.

Opacity (Непрозрачность) — определяет непрозрачность (или прозрачность,
кто как привык) создаваемого инструментом изображения. Если вы умень-
шите прозрачность наносимой «краски», сквозь заливку проступит сущест-
вующее изображение. На прозрачном слое изображение при этом останется
частично прозрачным.

Tolerance (Допуск) — определяет разброс оттенков пикселов, которые будут
залиты при использовании инструмента. Данный параметр имеет значение,
если заполняемая область уже содержит изображение. Разброс определяется
относительно оттенка пиксела, указанного при щелчке мышью в выбранной
области. Указанное значение допуска может принимать значения от 0 до 255.
При допуске, равном 0, будет залиты только пикселы, окрашенные в тот цвет,
в который окрашен и пиксел, указанный при начале заполнения области. До-
пуск, равный 255, позволит залить все пикселы, независимо от их оттенка.

Anti-aliased (Сглаживание) — если этот флажок установлен, границы залитой
области будут сглажены, в противном случае все пикселы будут иметь одина-
ковый оттенок, а края заливки получатся «ступенчатыми».

Contiguous (Смежные) — если установлен этот флажок, залита будет только
замкнутая область, ограниченная пикселами, не удовлетворяющими указан-
ному параметру Tolerance (Допуск), Если этот флажок снят, заполнены будут
все пикселы изображения, оттенок которых подходит под заданный допуск.

All Layers (Все слои) — при установке этого флажка при определении границ
заполняемой области будет использоваться информация об изображении, нахо-
дящемся на всех слоях. Новое изображение наносится только на текущий слой.

Инструмент Gradient
Вместо инструмента Paint Bucket (Заливка) можно выбрать инструмент яр
Gradient (Градиент). Для этого, как и в случаях с другими инструментами, : S *
необходимо некоторое время подержать кнопку инструмента нажатой. Инстру-
мент позволяет заполнить выделенную область пикселами, оттенок которых
плавно изменяется от цвета переднего плана до цвета заднего плана. Используя
настройки, можно выбрать и другие режимы заливки.
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С помощью градиентных заливок можно выполнять различные действия: рисо-
вать рамки для фотографий, тонировать изображение, закрашивать дефектные
участки, готовить фон для коллажей и открыток, имитировать натуральные
материалы (например, металл) и округлые поверхности (сферы и цилиндры).

ПРИМЕЧАНИЕ
Читатели, изучавшие традиционные техники живописи и рисунка, знакомы с термином «рас-
тяжка». Он в данном случае аналогичен англоязычному термину «градиент». Сам термин
«градиент» обозначает изменение некоторого параметра в заданном направлении вдоль
прямой, на плоскости или в пространстве.

Для применения инструмента Gradient (Градиент) необходимо выполнить сле-
дующие действия.

1. Выделите область, которую вы хотите залить. В отсутствие выделения будет
заполнена вся область изображения, точнее, текущий слой.

2. Выберите инструмент и установите необходимые параметры. О том, как это
сделать, рассказано позже.

3. Подведите курсор к точке, которая должна быть полностью окрашена в цвет,
соответствующий началу градиента.

4. Нажмите левую кнопку мыши и, не отпуская ее, подведите курсор к точке,
которая будет окрашена в цвет, соответствующий концу градиента.

5. Отпустите кнопку мыши.

На рис. 7.8 показан вид окна изображения на третьем, четвертом и пятом этапах
процесса выполнения градиентной заливки.

а о в

Рис. 7.8. Этапы применения инструмента Gradient: a — выбор начальной точки градиента;
б — выбор направления изменения оттенков и конечной точки градиента;

в — результат использования инструмента Gradient

Возможна гибкая настройка инструмента Gradient (Градиент), что делает его од-
ним из наиболее мощных и часто используемых инструментов Adobe Photoshop.
Можно изменять следующие параметры.

• Тип градиента — из списка, находящегося на панели, можно выбрать один из
предустановленных типов градиентов. Щелкнув на образце градиента, можно
вызвать окно настройки текущего выбранного градиента. Выбрать один из
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предустановленных или ранее сохраненных вами градиентов можно, щелкнув
на кнопке со стрелкой, расположенной рядом с образцом
градиента. При этом на экране появится список с образцами
градиентов.

• Направление изменение цвета — можно выбрать направление, в котором бу-
дет изменяться цвет пикселов. Он может изменяться вдоль указанной вами
линии, радиально расходиться от начальной точки градиента, поворачиваться
вокруг нее и т. д. Для выбора направления используется
набор кнопок, расположенных на панели свойств инстру-
мента.

• Mode (Режим) — как и для многих других инструментов, этот параметр управ-
ляет способом наложения новой окраски пикселов на существующее изобра-
жение.

• Opacity (Непрозрачность) — определяет прозрачность создаваемого инстру-
ментом изображения.

• Reverse (Наоборот) — изменяет направление изменения цветов, заданное об-
разцом градиента, на противоположное. Это позволяет создать заливку с об-
ратным порядком цветов, не редактируя образец градиента.

• Dither (Сглаживание) — при установке этого флажка (по умолчанию он ус-
тановлен) цвета соседних пикселов частично смешиваются для того, чтобы
избежать появления однотонных полос. Такие полосы могут возникать, на-
пример, из-за недостаточного числа оттенков, доступных в текущем цветовом
режиме.

ПРИМЕЧАНИЕ
Цветовым режимам и моделям представления цвета посвящена глава 11 этой книги.

• Transparency (Прозрачность) — если этот флажок установлен, при исполь-
зовании инструмента Gradient (Градиент) будет учтена прозрачность, задан-
ная в образце градиента. Образцы градиента могут содержать информацию
как об изменении цвета, так и об изменении прозрачности заливки.

•

Редактирование образцов градиента
Научимся редактировать существующие и создавать новые образцы градиента.
Для вызова окна редактирования градиента щелкните на образце градиента, на-
ходящемся на панели свойств инструмента. При этом на экране появится окно,
показанное на рис. 7.9.

В верхней части окна расположен список образцов градиентов, доступных для
использования. Можно выбрать один из них для использования и редактирова-
ния. Для этого просто щелкните на нужном образце.

Два первых образца в списке — наиболее часто используемые: From Foreground to
Background (От основного к фоновому) и From Foreground to Transparent (От основ-
ного к прозрачному).
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Gradient Editor

anr»;':':;: ;| Foreground to Transparent

Рис. 7.9. Окно редактирования образцов градиента

Если вы выберете образец, его название будет выведено в поле Name (Назва-
ние). Можно изменить его и добавить образец к списку, щелкнув на кнопке New
(Новый). Удалить добавленный образец градиента можно, вызвав команду Delete
Gradient (Удалить градиент) из контекстного меню образца в списке, располо-
женном в верхней части окна.

ПРИМЕЧАНИЕ
Контекстное меню называется так потому, что его содержимое зависит от объекта, к которо-
му оно относится (от контекста). Как правило, контекстное меню вызывается при помощи
правой кнопки мыши.

Из списка Gradient Type (Тип градиента) можно выбрать, будет ли градиент за-
данной вами последовательностью цветов (Solid) или случайным набором цвет-
ных штрихов (Noise). Ниже рассмотрим процесс настройки обычного (Solid) гра-
диента.

В нижней части окна находится полоса, отображающая пример использования
градиентной заливки. Над ней расположено поле ввода Smoothness (Сглажива-
ние). Чем больше введенное в нем значение, тем более плавными будут цветовые
переходы. Особенно заметен эффект от изменения значений этого параметра
при наличии в заливке нескольких (больше чем двух) цветов.
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Вдоль верхней и нижней сторон полосы-примера градиента находятся маркеры
прозрачности (сверху) и цвета (снизу). Перемещая их при помощи мыши, мож-
но задать оттенок и прозрачность в выбранной точке.

ПРИМЕЧАНИЕ
Позиция маркера задается в процентах длины заливаемой градиентом области. Если пози-
ция маркера равна 10 % и вы при вызове инструмента Gradient (Градиент) проведете на-
правляющую линию (см. рис. 7.8) длиной 100 пикселов, цвет или значение прозрачности,
указанное маркером, будет присвоено пикселам, находящимся на удалении 10 пикселов
от начальной точки заливки.

Создать новый маркер можно, просто щелкнув левой кнопкой мыши на краю по-
лосы градиента. Для удаления маркера перетащите его мышью с полосы вверх
или вниз. Если вы выберете один из маркеров, между ним и соседними марке-
рами появятся дополнительные отметки. Перемещая их, можно задавать точку
50-процентного перехода между задаваемыми маркерами оттенками или значе-
ниями прозрачности.

При выборе маркера или отметки 50-процентного перехода под полосой гради-
ента становятся доступными элементы управления этим маркером. Для маркера
прозрачности доступно поле ввода Opacity (Непрозрачность), определяющее за-
даваемую маркером прозрачность заливки. Также доступно поле Location (Пози-
ция), задающее позицию маркера на полосе градиента (в процентах). Кнопка
Delete (Удалить) позволяет удалить маркер.

Для маркера цвета доступно поле Color (Цвет). Щелкнув на нем, можно вызвать
на экран окно выбора цвета и задать цвет в данной точке градиента. При щелчке
на кнопке со стрелкой, расположенной рядом с полем Color (Цвет), на экране вы-
водится меню, из которого можно выбрать одно из трех предустановленных зна-
чений — Foreground Color (Основной цвет), Background Color (Фоновый цвет) или
User Color (Специальный цвет). При помощи первых двух значений из этого спи-
ска можно указать на использование в градиенте цвета, задаваемого на панели
инструментов Adobe Photoshop.

Для отметок 50-процентного перехода, как для прозрачности, так и для цвета
градиента, можно задать только один параметр — Location (Позиция).

Мы рассмотрели основные инструменты Adobe Photoshop, в основном исполь-
зуемые при создании новых изображений. Кроме них в этом графическом ре-
дакторе имеются инструменты, ориентированные на коррекцию изображений.

Инструмент Clone Stamp
Этот инструмент позволяет копировать область изображения, указанную
пользователем, и применять ее в качестве «краски» для рисования в дру-
гой части изображения. Это позволяет легко устранять небольшие дефекты на
однородных поверхностях, при этом изображение, закрывающее дефект, являет-
ся копией участка этой же поверхности и легко сливается с ней, не оставляя
лишних следов работы инструмента.
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Образец рисунка для копирования берется из указанной пользователем точ-
ки. Для указания образца следует выбрать инструмент Clone Stamp (Штамп)
и щелкнуть в нужной точке изображения, удерживая нажатой клавишу Alt.
При рисовании точка, из которой берется образец, перемещается вместе с кур-
сором. На рис. 7.10 показан пример использования инструмента Clone Stamp
(Штамп).

Рис. 7.10. Пример использования инструмента Clone Stamp: образец для копирования
с указателем точки, из которой берется изображение (слева) и оставленный

инструментом след (справа). Стрелками показано направление движения
курсора и указателя точки исходного изображения

Например, можно легко закрасить попавшую в кадр банку от лимонада, на укра-
шающую белоснежный песок тропического пляжа, или замаскировать небольшие
дефекты кожи на портрете. Настройки инструмента Clone Stamp (Штамп) совпа-
дают с настройками инструмента Brush (Кисть), за исключением двух новых
флажков.

• Aligned (С выравниванием) — если этот флажок установлен, между образцом
для рисования и точкой, в которой накладывается изображение, поддержива-
ется постоянный интервал, даже если вы отпустили кнопку мыши и начали
новый штрих. Если флажок снять, для каждого нового штриха образец изо-
бражения будет выбираться из указанной вами точки.

• Use All Layers (Использовать все слои) — за исходное изображение для копи-
рования берется изображение, находящееся на всех слоях в данной точке изо-
бражения. Новое изображение наносится только на текущий слой.

Инструмент Pattern Stamp
Инструмент Pattern Stamp (Текстура) вызывается той же кнопкой, что и ин-
струмент Clone Stamp (Штамп). Вам потребуется вызвать связанное с кноп-
кой меню, чтобы выбрать, какой из инструментов будет использоваться. Эта
процедура уже рассматривалась нами ранее.

В отличие от обычного штампа данный инструмент воспроизводит в области
изображения шаблон, который можно выбрать на панели свойств инструмен-
та. Там же находится флажок Impressionist (Импрессионист). Если он установлен,
в создаваемое инструментом новое изображение вносятся искажения, что делает
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его более разнообразным. На рис. 7.11 приведен пример использования инстру-
мента Pattern Stamp (Текстура).

Рис. 7.11. След, оставленный инструментом Pattern Stamp

Инструмент Healing Brush
Adobe Photoshop CS предоставляет в ваше распоряжение несколько инструмен-
тов, специально предназначенных для устранения незначительных дефектов
изображения, таких как царапины, попавшие в кадр посторонние предметы, ис-
кажения оттенков.

Первым из этих инструментов рассмотрим инструмент Healing Brush (Кор- : ^ж
ректирующая кисть). Он предназначен для выборочной замены фрагмен- ^
тов изображения образцом, взятым с другого участка этого же документа. Его
действие напоминает Clone Stamp (Штамп), но изображение, создаваемое инстру-
ментом Healing Brush (Корректирующая кисть), частично смешивается с изобра-
жением, исходно находившимся в точке применения инструмента. При хорошо
подобранном исходном изображении для копирования следы работы инструмен-
та практически или даже полностью незаметны.

Для применения этого инструмента прежде всего следует указать исходную точку
для копирования изображения. Для этого щелкните на выбранной точке, удер-
живая нажатой клавишу Alt. После этого нанесите новое изображение на вы-
бранные участки, действуя инструментом, как обычной кистью. Вы будете видеть
маркер, указывающий точку, из которой копируется изображение. После того
как вы отпустите левую кнопку мыши, нанесенное изображение будет сглажено
и смешано с исходным.

На рис. 7.12 показан пример использования инструмента Healing Brush (Коррек-
тирующая кисть). На этом рисунке последовательно показаны исходное изобра-
жение, изображение в процессе обработки и результат применения инструмента.

Для инструмента Healing Brush (Корректирующая кисть) можно задать следую-
щие параметры.

• Brush (Кисть) — выбор кисти. В отличие от других инструментов кисть не
выбирается из списка, ее размер и другие свойства можно задать в отдельном
окне.

• Mode (Режим) — как и для других инструментов, можно выбрать режим нало-
жения нового изображения на существующее. В режиме Normal (Нормальный)
инструмент работает так, как описано выше. В режиме Replace (Заменить)
сглаживание нового и существующего изображений не производится.



96 Глава 7. Использование инструментов редактирования изображений

Рис. 7.12. Пример использования инструмента Healing Brush: a — исходное изображение;
б — процесс копирования изображения; в — результат применения инструмента

Source (Источник) — можно выбрать источник изображения для реставрации
существующей фотографии (или другого изображения). При значении Sample
(Образец) изображение для наложения выбирается из указанной вами точки
(см. выше). Установив значение Pattern (Узор), можно выбрать шаблон, кото-
рый будет накладываться на изображение. Источник изображения при этом
не понадобится. Также можно установить параметры Aligned (С выравни-
ванием) и Use All Layers (Использовать все слои). Их значение такое же, как
и для инструмента Clone Stamp (Штамп).

Инструмент Patch
Данный инструмент выполняет ту же функцию, что и инструмент Healing Brush
(Корректирующая кисть). Отличие состоит в методе выбора образца изобра-
жения. Работая с инструментом Patch (Заплата), вы не «красите» изображения
кистью, а выделяете фрагмент изображения и заменяете его на другой «оптом».
Этот подход удобен для быстрой обработки больших площадей изображения, не
требующих выделения мелких деталей.

Для выбора инструмента Patch (Заплата) переключите в этот режим кноп- ГЖ1
ку инструмента Healing Brush (Корректирующая кисть). ЯШ

Для работы этого инструмента вам потребуется выделить часть изображения.
Для этой цели можно использовать любой известный вам метод или сам инстру-
мент Patch (Заплата). Обведите нужный участок изображения. Если на панели
свойств инструмента переключатель Patch (Заплата) установлен в положение
Destination (Получатель), вам следует выделить будущую «заплату» и, закончив
выделение, «перенести» ее мышью при помощи инструмента Patch (Заплата)
на фрагмент, который нужно «починить». Если этот переключатель установлен
в положение Source (Источник), «перенесите» выделенную область на фрагмент,
который будет служить «материалом» для изготовления «заплаты».

На рис. 7.13 приведен пример использования инструмента Patch (Заплата) в ре-
жиме Destination (Получатель).
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Рис. 7.13. Пример использования инструмента Patch (Заплата): а — исходное изображение;
б — процесс копирования изображения; в — результат применения инструмента.

Стрелкой указано направление перемещения выделенной области

Кроме уже описанного выше параметра Patch (Заплата), можно задать следую-
щие параметры.

• При помощи кнопок, расположенных на панели инструментов, можно вы-
брать режим, в котором выполняемое при помощи инструмента Patch (Запла-
та) выделение будет взаимодействовать с уже существующими выделенными
областями. Кнопки (слева направо) имеют следующее значение: создать но-
вую выделенную область, добавить фрагмент к выделенной области, вычесть
фрагмент из выделенной области, выделить фрагмент, принадлежащий и ста-
рому и новому выделению. Добавлять и вычитать фрагменты из существую-
щей выделенной области можно, удерживая нажатой клавишу Shift или Alt.

• Transparent (Прозрачность) — если вы установите этот флажок, накладывае-
мая на изображение «заплата» будет не сглаживаться и накладываться прак-
тически незаметно, а накладываться поверх существующего изображения, ос-
тавляя его видимым.

• Кнопка Use Pattern (Использовать узор) — эта кнопка позволяет применить
к выделенной области не фрагмент, полученный из другой части изобра-
жения, а шаблон, который можно выбрать из расположенного рядом с кноп-
кой списка.

Следующая группа инструментов, с которыми мы познакомимся, особенно по-
лезна при подготовке фотографий и создании художественных эффектов, близ-
ких к традиционным фотографическим приемам.

Инструмент Blur
Инструмент Blur (Размытие), как и следует из его названия, предназна-
чен для размытия изображения. Можно, действуя этим инструментом, как
кистью, уменьшить резкость изображения в выбранных участках изображения.
Регулируя «прозрачность» инструмента, можно управлять силой производимого
эффекта. Данный инструмент можно с успехом использовать для имитации

4 Зак. 805
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эффекта глубины резкости или для выделения наиболее важного объекта на фо-
тографии.

Настраивая инструмент Blur (Размытие), можно изменить следующие параметры:

• форма кисти; . ч

• Mode (Режим) — режим наложения результатов применения инструмента на
существующее изображение;

• Strength (Величина) — аналог параметра Opacity (Непрозрачность), используе-
мого для других инструментов;

• Use All Layers (Использовать все слои) — если этот флажок установлен, в каче-
стве исходных данных для применения инструмента используется информа-
ция, находящаяся в указанной точке изображения, на всех слоях; изображе-
ние создается только на текущем слое.

Инструмент Sharpen
В противоположность инструменту Blur (Размытие) инструмент Sharpen
(Резкость) предназначен для повышения резкости на указанных участках
изображения. Для выбора инструмента переключите в соответствующий режим
кнопку инструмента Blur (Размытие). Повышение резкости производится за счет
увеличения контрастности соседних пикселов. Чрезмерное использование этого
инструмента может привести к появлению излишне контрастных точек, грубых
линий, непропорционально насыщенных оттенков.

Инструмент Smudge
Инструмент Smudge (Палец) по сути является аналогом инструмента Blur год
(Размытие), но он не только «размывает» изображение. Также произво- **™*
дится перемещение пикселов, причем Дальность, на которую они перемещаются,
задается параметром Strength (Величина). На рис. 7.14 приведен пример исполь-
зования итого инструмента. Для выбора инструмента переключите в соответст-
вующий режим кнопку инструмента Blur (Размытие).

Рис. 7.14. Пример использования инструмента Smudge
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Можно изменять для этого инструмента те же параметры, что и для инструмен-
тов Blur (Размытие) и Sharpen (Резкость).

Дополнительно можно установить или снять флажок Finger Painting (Рисова-
ние пальцем), который позволяет инструменту Smudge (Палец) не только смазы-
вать изображение, но и наносить мазки, цвет которых определяется цветом
переднего плана.

Инструмент Dodge

L1JЕсли вам потребуется выборочно увеличить яркость определенных уча-
стков изображения, можно выделить их и воспользоваться одной из ко-
манд, позволяющих изменять яркость (например, Image > Adjustments > Brightness/
Contrast (Изображение > Настройки > Яркость/Контраст)). Но если участки, тре-
бующие коррекция яркости, невелики, можно с успехом использовать инст-
румент Dodge (Осветлитель). Он увеличивает яркость изображения в указанной
точке.

Для этого инструмента можно настроить следующие параметры:

• Brush (Форма кисти) — выбирается так же, как и для других инструментов;

• Range (Диапазон) — указывает, на какие пикселы инструмент будет оказы-
вать воздействие. Возможные варианты: Highlights (Светлые), Midtones (Сред-
ние тона), Shadows (Тени). Таким образом можно регулировать диапазон яр-
кости точек, которые будут изменены в результате применения инструмента
Dodge (Осветлитель);

• Exposure (Экспозиция) — параметр, эквивалентный параметру Opacity (Непро-
зрачность) или Strength (Величина) других инструментов.

Кроме того, воспользовавшись расположенной на панели инструментов §тж
кнопкой, можно переключить инструмент в режим аэрографа — эффект от *̂
его воздействия будет постепенно накапливаться при повторном проходе по од-
ной и той же точке.

Инструмент Burn
Инструмент Burn (Затемнитель) предназначен для уменьшения яркости г;;*р
изображения в указанной точке изображения. Для его вызова переключите Нв
в нужный режим кнопку инструмента Dodge (Осветлитель). Параметры этого
инструмента совпадают с параметрами инструмента Dodge (Осветлить).

Инструмент Sponge
Этот инструмент позволяет изменять насыщенность оттенков в указанной
вами точке изображения. В этот режим можно переключить кнопку инст-
рументов Dodge (Осветлить) и Burn (Затемнить).
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Кроме формы кисти можно задать следующие параметры:

• Mode (Режим) — переключение инструмента в режим уменьшения (Desaturate)
или увеличения (Saturate) насыщенности;

• Flow (Поток) — аналог параметра Opacity (Непрозрачность);

Также можно переключить инструмент в режим аэрографа.

Инструменты History Brush
и Art History Brush
Данные инструменты позволяют восстановить состоя-
ние выбранного участка изображения до состояния,
соответствующего определенному моменту протокола
команд (по умолчанию — моменту открытия или создания файла). Выбор мо-
мента нужного момента протокола показан на рис. 7.7.

Инструмент History Brush (Восстанавливающая кисть) имеет тот же набор настро-
ек, что и инструмент Brush (Кисть). Инструмент Art History Brush (Художествен-
ная восстанавливающая кисть) делает то же самое, что и инструмент History Brush
(Восстанавливающая кисть), но в отличие от него позволяет создавать штрихи,
состоящие из нескольких штрихов, исходящих из одной точки. Форма штрихов
определяется выбранной вами формой кисти. Для инструмента Art History Brush
(Художественная восстанавливающая кисть) можно задать параметры автомати-
чески создаваемых штрихов. Для этого используйте параметры, находящиеся
в группе Style (Стиль) панели свойств инструментов.

Выбор режима наложения изображений
Рассматривая использование многих инструментов, мы сталкивались с парамет-
ром Mode (Режим). Для некоторых инструментов (таких, как Dodge (Осветли-
тель) или Sponge (Губка)) этот параметр имеет особое значение, рассмотренное
при их описании. Для большинства инструментов, а также в некоторых других
случаях (в команде Fade (Ослабление), при выборе режима наложения слоев)
этот параметр определяет режим наложения изображения, находящегося на
выбранном слое, создаваемого фильтром или инструментом на уже имеющееся
изображение или на лежащие ниже слои. В этом разделе мы рассмотрим свой-
ства режимов наложения изображений. Обратите внимание — для конкретного
инструмента или фильтра могут быть доступны далеко не все из описанных
здесь режимов.

• Normal (Нормальный) — в этом режиме пикселы текущего слоя или созда-
ваемого изображения (дальше будем называть их новыми) просто накладыва-
ются поверх текущего изображения (далее — старые пикселы). Наложение
производится с учетом прозрачности слоев, плотности наносимого инстру-
ментом штриха, а также изменения прозрачности, задаваемого формой кисти
выбранного инструмента.
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• Dissolve (Растворение) — режим, аналогичный режиму Normal (Нормальный),
с той лишь разницей, что изменения прозрачности имитируются при помощи
случайного удаления новых пикселов. На рис. 7.15 приведены примеры штри-
хов, оставленных инструментом Brush (Кисть).

'Рис. 7.15. Примеры штрихов, оставленных инструментом Brush в режиме
Normal (вверху) и в режиме Dissolve (внизу)

Behind (Подложка) — доступен только при рисовании на существующем слое,
имеющем прозрачные участки. Инструмент обрабатывает только прозрачные
участки изображения, оставляя штрих «сзади» уже существующего на слое
изображения.

Clear (Очистка) — доступен только при рисовании на слоях, отличных от фо-
нового. Инструмент действует, как инструмент Erase (Ластик).

Darken (Замена темным) — инструмент или изображение, находящееся на слое,
воздействует только на пикселы, яркость которых больше, чем у' новых пик-
селов (из старого и нового пикселов остается более темный).

Lighten (Замена светлым ) — инструмент или изображение, находящееся на
слое, воздействует только на пикселы, яркость которых меньше, чем у новых
пикселов (из старого и нового пикселов остается более светлый).

Multiply (Умножение) — результат наложения старого и нового пикселов на-
поминает результат рисования на одной поверхности прозрачными маркера-
ми или наложения друг на друга прозрачных пленок. При наложении черного
цвета в этом режиме результатом будет черный цвет, при наложении белого
старое изображение не изменится.

Color Burn (Затемнение) — цвет старых пикселов затемняется путем увеличе-
ния контраста, для того чтобы соответствовать цвету накладываемых новых
пикселов. Наложение пикселов белого цвет& не изменяет старые пикселы.

Linear Burn (Линейное затемнение) — аналогичен предыдущему режиму, но
затемнение пикселов производится за счет уменьшения их яркости.

Screen (Осветление) — изображения накладываются так, как смешиваются
изображения двух проектируемых на один экран слайдов. Наложение белого
пиксела дает белый цвет, наложение черного не изменяет старые пикселы.
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• Color Dodge (Отбеливание) — цвет старых пикселов осветляется путем умень-
шения контраста, для того чтобы соответствовать цвету накладываемых новых
пикселов. Наложение пикселов черного цвета не изменяет старые пикселы.

• Linear Dodge (Линейное отбеливание) — аналогичен предыдущему режиму, но
осветление пикселов производится за счет увеличения их яркости.

• Overlay (Перекрытие) — пикселы накладываются в режиме Multiply (Умно-
жение) или Screen (Осветление), в зависимости от яркости старых пикселов.
Это позволяет придать изображению окраску, сохранив его тени и блики.

• Soft Light (Мягкий свет) — если цвет новых пикселов ярче, чем 50-процент-
ный серый, старые пикселы осветляются; если новые пикселы темнее 50-про-
центного серого — старые пикселы затемняются. Степень воздействия за-
висит от того, насколько цвет новых пикселов отличается от нейтрального
серого.

• Hard Light (Жесткий свет) — если цвет новых пикселов ярче, чем 50-процент-
ный серый, производится наложение в режиме Screen (Осветление); если но-
вые пикселы темнее 50-процентного серого — наложение в режиме Multiply
(Умножение). Степень воздействия зависит от того, насколько цвет новых
пикселов отличается от нейтрального серого.

• Vivid Light (Живой свет) — если цвет новых пикселов ярче, чем 50-процентный
серый, производится увеличение контраста старых пикселов; если новые пик-
селы темнее 50-процентного серого — производится уменьшение контраста.

• Linear Light (Яркий свет ) — если цвет новых пикселов ярче, чем 50-процент-
ный серый, -производится увеличение яркости старых пикселов; если новые
пикселы темнее 50-процентного серого — производится уменьшение яркости.

• Pin Light (Точечный свет) — если цвет новых пикселов ярче, чем 50-процент-
ный серый, производится наложение в режиме Lighten (Белее светлый); если
новые пикселы темнее 50-процентного серого — наложение в режиме Darken
(Замена темным).

• Difference (Разница) — производится вычитание значений яркости во всех
цветовых каналах (вычитается цвет с меньшей яркостью из цвета с большей
яркостью). Наложение белого цвета инвертирует изображение, наложение
пикселов черного цвета не изменяет старые пикселы.

• Exclusion (Исключение) — эффект, аналогичный Наложению в режиме Difference
(Разница), но полученное в результате изображение имеет меньший контраст,
становится более близким к нейтральному серому цвету.

• Hue (Цветовой тон) — старые пикселы сохраняют насыщенность цвета и яр-
кость, но приобретают оттенок новых пикселов. Полезен для коррекции от-
тенка старого изображения.

• Saturation (Насыщенность) — старые пикселы сохраняют яркость и оттенок,
но приобретают насыщенность новых пикселов. Режим позволяет корректи-
ровать насыщенность выбранных участков изображения.
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• Color (Цветность) — старым пикселам присваиваются значения оттенка и на-
сыщенности новых пикселов, яркость старых пикселов (а значит, и форма
изображенного объекта) не изменяется. В этом режиме можно изменять цвет
изображенных объектов, например, изменить цвет глаз или волос на портрете.

• Luminosity (Яркость) — старые пикселы сохраняют оттенок изображения и на-
сыщенность, приобретая яркость новых пикселов. Этот режим позволяет на-
носить на изображения «призрачные» штрихи или проектировать на него
другое изображения (для этой цели во многих случаях гораздо лучше подхо-
дит режим Screen (Осветление)).

СОВЕТ
Можно просмотреть цветные иллюстрации использования различных режимов наложения
изображений в справочной системе Adobe Photoshop CS. Для этого обратитесь к разделу
Selecting a blending mode (Выбор режима наложения).

Инструменты Hand и Zoom
Эти инструменты не влияют на само изображение, но они позволяют влиять на
масштаб вывода изображения на экран и быстро перемещаться от одной области
изображения к другой, выбирая нужный участок.

Инструмент Hand (Рука) позволяет быстро «схватить» изображение и про- ндр
крутить его в окне документа. Это гораздо удобнее, чем использовать по- ! *й
лосы прокрутки. Чтобы применить инструмент, выберите его, подведите к изо-
бражению и перемещайте курсор, удерживая нажатой левую кнопку мыши. На
панели свойств инструмента находится флажок Scroll All Windows (Перемещать во
всех окнах), при установке которого будут одновременно «прокручиваться» все
открытые окна. Также на панели свойств инструмента вы найдете три кнопки,
позволяющие быстро установить масштаб изображения, равный 100 %, подо-
гнать масштаб для отображения всего изображения в свободной части окна Adobe
Photoshop и просмотреть изображение таким по размеру, каким оно будет при
выводе на принтер.

Инструмент Zoom (Масштаб) служит для изменения масштаба изображе-
ния. Щелкая им над некоторой областью изображения, можно приблизить
ее или отдалить от вас. При этом изменяется масштаб вывода на экран всего изо-
бражения, а точка, над которой находился курсор в момент щелчка, помещается
в центр окна документа.

На панели свойств инструмента для инструмента Zoom (Масштаб) нахо- fSisa
дятся две кнопки, позволяющие выбрать режим работы инструмента — йМШ
уменьшение или увеличение. Можно использовать клавишу Alt для быстрого вре-
менного переключения на противоположное направление изменения масштаба.

Также на панели свойств инструмента находятся три флажка:

• Resize Windows to Fit (Подогнать размер окон) — при установке этого флаж-
ка будет изменяться не только масштаб изображения, но и размер окна изо-
бражения;
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• Ignore Palettes (Игнорировать панели) — при установке описанного ранее
флажка можно включить режим, в котором окно документа будет изменять
свои размеры, даже если при этом оно окажется частично скрыто панелями
инструментов;

• Zoom All Windows (Масштабировать все окна) — после установки этого флаж-
ка масштаб изображения будет одновременно изменяться во всех открытых
в данный момент окнах документов.

Там же вы найдете три кнопки быстрого выбора изображения, описанные при
рассмотрении инструмента Hand (Рука).

СОВЕТ
Можно изменять масштаб изображения, используя комбинации клавиш Ctrl+«+» и Ctrl+«-».
Этот метод действует даже при работе с окнами команд и фильтров Adobe Photoshop, когда
использование инструментов невозможно.

Инструмент Eyed гор ре г
Инструмент Eyedropper (Пипетка) служит для получения образцов цвета из ж
разных точек изображения. Он может использоваться и для размещения »^
точек наблюдения за цветом (образцов). Рассмотрим простейший случай его
применения. Щелчок в любой точке изображения позволит установить цвет пик-
села, который в данный момент окажется под курсором мыши, в качестве цвета
переднего плана. Щелчок при нажатой клавише Alt позволит выбрать цвет фона.

На панели свойств инструментов для инструмента Eyedropper (Пипетка) нахо-
дится раскрывающийся список, из которого можно выбрать размер площади,
с которой будет «собран» цвет:

• Point Sample (Точка) — цвет выбирается из конкретной точки (пиксела), этот
режим используется по умолчанию;

• 3 by 3 Average (В среднем 3x3)— образец цвета получается усреднением цвета
в квадрате площадью 3 x 3 пиксела; этот режим удобен при получении образ-
цов цвета сложных по текстуре поверхности объектов, например человеческой
кожи или песка;

• 5 by 4 Average (В среднем 5 x 5 ) — аналогично режиму 3 by 3 Average (В сред-
нем 3 х 3), но площадь, на которой производится усреднение цвета, имеет
больший размер.

Использование клавиш при работе
с инструментами
Работая с рисующими инструментами, можно значительно облегчить и ускорить
свою работу, пользуясь клавишами Ctrl, Alt, Shift, пробел и Enter. Они позволяют
временно (пока вы удерживаете клавишу нажатой) изменить режим работы ин-
струмента или переключиться на другой инструмент.
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• Клавиша Ctrl — позволяет временно переключиться на инструмент Move (Пе-
ремещение), с помощью которого можно переместить выделенный фрагмент
изображения или изображение, находящееся на текущем слое (если слой не
является фоном).

• Клавиша Alt — для большинства инструментов эта клавиша позволяет временно
переключиться на инструмент Eyedropper (Пипетка) и «подобрать» из изобра-
жения цвет переднего плана. Для некоторых инструментов (например, Clone
Stamp (Штамп) или Healing Brush (Корректирующая кисть)) эта клавиша позво-
ляет выбрать точку, из которой будет взят образец изображения для копирования.

• Клавиша Shift — если вы нажмете и будете удерживать нажатой эту клавишу
во время рисования инструментом, независимо от перемещения курсора след
от инструмента будет иметь направление, соответствующее преобладающему на-
правлению движения курсора (по вертикали или по горизонтали) в момент на-
жатия клавиши. Еще одна функция клавиши Shift — построение прямых линий.
Выбрав и настроив инструмент, щелкните в точке, из которой вы хотите провес-
ти линию, затем нажмите клавишу Shift и щелкните в конечной точке. Две
точки будут соединены прямой, построенной выбранным вами инструментом.

• Клавиша пробел — позволяет временно переключиться на инструмент Hand
(Рука), с помощью которого вы сможете пролистать изображение, не поме-
щающееся полностью в окне документа. Такой способ прокрутки значитель-
но быстрее, чем использование полос прокрутки. Кроме того, применять ин-
струмент Hand (Рука) таким образом можно даже во время работы с другими
инструментами, например, во время выделения фрагмента изображения.

• Клавиша Enter — перемещает курсор на панель свойств инструмента. После
этого можно работать с ней, как с обычным диалоговым окном Windows, —
клавиша Tab и сочетание клавиш Shift+Tab позволяют перемещаться между
элементами панели, клавиша Enter — подтвердить ввод параметра и вернуться
к работе с изображением, клавиша Esc — выйти из режима работы с панелью
свойств инструмента.

СОВЕТ
Для переключения на многие из инструментов можно использовать «горячие клавиши»:
подведите курсор мыши к кнопке инструмента — вы найдете название клавиши в по-
явившейся на экране всплывающей подсказке. «Горячие клавиши», связанные с командами
меню, обычно указываются рядом с соответствующим пунктом этого меню.

В этой главе мы познакомились с инструментами, непосредственно влияющими
на изображение, — «рисующими инструментами». Мы изучили их виды, осо-
бенности использования, параметры, ознакомились с общими для инструментов
и для слоев изображения режимами наложения изображений, позволяющими
добиваться интересных художественных эффектов. Также мы узнали, как упро-
стить и ускорить выполнение некоторых действий, используя клавиши.

Кроме того, мы познакомились с инструментами, не предназначенными для
рисования, но выполняющими не менее важную функцию — выбор цвета для
использования при работе рисующих инструментов и управление выводом изо-
бражения на экран для удобства просмотра и редактирования.
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Панели инструментов
Панели инструментов в Adobe Photoshop — незаменимые помощники при рабо-
те с изображениями. Панели инструментов можно отображать на экране и уби-
рать, группировать по собственному усмотрению, изменять размеры и распола-
гать в удобной для вас области рабочего пространства.

В данной главе представлен обзор всех панелей инструментов в алфавитном по-
рядке. Те из них, которые могут понадобиться вам при обработке цифровых изо-
бражений, описаны подробно, остальные — более кратко.

Панель Actions
С помощью панели Actions (Операции) можно записывать, запускать, редактиро-
вать и удалять последовательности команд, которые обычно называются макро-
командами или макросами, а в Adobe Photoshop имеют собственное название —
«действия».

Панель вызывается на экран командой меню Window > Actions (Окно > Операции)
или при помощи комбинации клавиш Alt+F9. Внешний вид панели Actions (Опе-
рации) представлен на рис. 8.1.

Actions

< Hi DAuft Acliora.atrl

> Vignette (selection)

^ Frame Channel - 50 pixel

> Wood Frame - SO pixel.

> Cut Shadow (type)

|> Water Reflection (type)

^ Custom RGB to Grayscale

> Molten Lead

t» Make Clip Path (selection)

I> Sepia Toning (layer)

> Quadrant Colors

|> Save As Photoshop PDF

|» Gradient Map

a t
Рис. 8.1. Внешний вид панели Actions
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Как видно из рис. 8.1, рабочая область панели содержит следующие элементы:

• столбец включения и отключения действий;

• столбец включения и отключения диалоговых окон работы с командами, ис-
пользующимися в действии;

• список стандартных наборов действий;

• кнопки управления действиями;

• кнопка вызова контекстного меню.

Кнопка вызова контекстного меню предоставляет доступ к следующим группам
команд:

• режимы отображения панели;

• работа с действиями: создание нового действия и нового набора действий,
создание копии, удаление и воспроизведение выбранного действия;

• вспомогательные команды для записи действия;

• настройки действия и воспроизведения;

• работа со списком действий: очистка списка действий, восстановление настро-
ек, заданных по умолчанию, загрузка наборов действий, замена одних набо-
ров действий на другие, сохранение наборов действий;

• отображение ограниченной части списка действий.

Панель Brushes
Панель Brushes (Кисти) предназначена для задания параметров стандартных
кистей, а также для создания собственных. Кисти позволяют изменять форму
штриха инструмента Brush (Кисть), а также других инструментов редактирова-
ния изображения.

ПРИМЕЧАНИЕ
В ходе работы с инструментами вы можете выбирать кисти при помощи панели свойств
инструмента.

Панель вызывается на экран командой меню Window > Brushes (Окно ^ Кисти)
или при помощи клавиши F5.

Панель содержит следующие элементы:

• кнопка перехода в режим Brush Presets (Образцы кистей);

• кнопка перехода в режим Brush Tip Shape (Форма кисти);

• флажки групп регулируемых параметров;

• столбец запрещения/разрешения изменений;

• кнопки управления кистями: Create New Brush (Создать новую кисть) и Delete
Brush (Удалить кисть).

Регулируемые параметры сгруппированы на вкладках, активируемых установ-
кой флажков, расположенных в левой части окна.
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Shape Dynamics (Динамика формы) определяет количество следов от кисти в каж-
дом штрихе. Внешний вид области настройки представлен на рис. 8.2.

Рис. 8.2. Внешний вид области настройки регулируемых параметров группы Shape Dynamics

Основным регулируемым параметром является Jitter (Генератор). Для него мож-
но задать размер, минимальный диаметр, наклон, угол, скругление.

Помимо ползунков регулирования в области настройки находятся три раскры-
вающихся меню Control (Контроль), предназначенных для динамического регу-
лирования параметров при использовании чувствительного к нажиму планшета.
Можно выбрать следующие значения: Off (Нет), Fade (Ослабление), Pen Pressure
(Нажим пера), Pen Tilt (Наклон пера), Stylus Wheel (Вращение пера), Initial Direction
(Направление базиса), Direction (Направление).

И последнее, что можно увидеть в области настройки, это два флажка: Flip X Jitter
(Генерировать отражение относительно оси X) и Flip Y Jitter (Генерировать от-
ражение относительно оси Y), включающие и отключающие переворачивание
кисти. Scattering (Рассеивание) — характеризует количество и расположение
следов от кисти в каждом штрихе. Внешний вид области настройки представлен
на рис. 8.3.

Регулируемыми являются следующие параметры:

• Scatter (Рассеивание);

• Count (Счетчик);

• Count Jitter (Генератор повторений).
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Рис. 8.З. Внешний вид области настройки регулируемых параметров для группы Scattering

Раскрывающееся меню Control (Контроль) предназначено для динамического
регулирования параметров при использовании чувствительного к нажиму план-
шета.

Последний элемент в этой области настройки — флажок Both Axes (По обеим
осям), включающий и отключающий рассеивание по обоим направлениям. Texture
(Текстура) — позволяет создать текстурированную кисть. Внешний вид области
настройки представлен на рис. 8.4.

В верхней части области настройки находятся кнопка выбора образца текстуры,
флажок Invert (Инвертировать) и кнопка создания новой установки для текуще-
го узора. Ниже расположен ползунок Scale (Масштаб), устанавливающий размер
применяемой текстуры. Далее виден флажок Texture Each Tip (Текстурировать
каждый штрих) и раскрывающееся меню Mode (Режим), определяющее режим
взаимодействия текстуры и кисти. Режимы могут быть следующими: Multiply
(Умножение), Subtract (Вычитание), Darken (Замена темным), Overlay (Перекры-
тие), Color Dodge (Отбеливание), Color Burn (Затемнение), Linear Burn (Линейное
затемнение), Hard Mix (Постеризация).

Ниже находятся ползунки следующих регулируемых параметров:

• Depth (Глубина);

• Minimum Depth (Минимальная глубина);

• Depth Jitter (Генератор глубины).
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Рис. 8.4. Внешний вид области настройки регулируемых параметров для группы Texture

Раскрывающееся меню Control (Контроль) предназначены для динамического
регулирования параметров при использовании чувствительного к нажиму план-
шета.

Dual Brush (Двойная кисть) позволяет создать двойную кисть. Внешний вид об-
ласти настройки представлен на рис. 8.5.

В верхней части области настройки находится раскрывающееся меню Mode (Ре-
жим), определяющее режим взаимодействия текстуры и кисти. Режимы могут
быть следующими: Multiply (Умножение), Subtract (Вычитание), Darken (Замена
темным), Overlay (Перекрытие), Color Dodge (Отбеливание), Color Burn (Затемне-
ние), Linear Burn (Линейное затемнение), Hard Mix (Постеризация).

Правее мы видим флажок Flip (Отражение), включающий и отключающий пере-
ворачивание кисти. Ниже расположен каталог образцов кистей, под ним — ползу-
нок Diameter (Диаметр) и кнопка Use Sample Size (Использовать размер образца).

Далее находятся ползунки следующих регулируемых параметров:

• Spacing (Интервал);

• Scatter (Рассеивание);

• Count (Счетчик).

Около ползунка Scatter (Рассеивание) имеется флажок Both Axes (По обеим
осям), включающий и отключающий разброс по обоим направлениям.

Color Dynamics (Вариации цвета) — определяет, каким образом будет распреде-
ляться цвет на протяжении штриха. Внешний вид области настройки представ-
лен на рис. 8.6.
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Рис. 8.5. Внешний вид области настройки регулируемых параметров для группы Dual Brush
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Рис. 8.6. Внешний вид области настройки регулируемых параметров для группы Color Dynamics
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Можно регулировать следующие параметры:

• Foreground/Background Jitter (Генератор Рабочий/Фоновый);

• Hue Jitter (Генератор тона);

• Saturation Jitter (Генератор насыщенности);

• Brightness Jitter (Генератор яркости);

• Purity (Чистота).

Раскрывающиеся меню Control (Контроль), как и ранее, предназначены для дина-
мического регулирования параметров при использовании чувствительного к на-
жиму планшета.

Other Dynamics (Динамика остальных параметров). Внешний вид области настрой-
ки представлен на рис. 8.7.

Рис. 8.7. Внешний вид области настройки регулируемых параметров для группы Other Dynamics

Регулируемыми являются следующие параметры:

• Opacity Jitter (Генератор прозрачности);

• Flow Jitter (Генератор потока).

Раскрывающиеся меню Control (Контроль), как и ранее, предназначены для ди-
намического регулирования параметров при использовании чувствительного
к нажиму планшета.

Вкладка «спецэффектов»: шум, мокрые края, распылитель, сглаживание, защита
текстуры. Внешний вид панели Brushes (Кисти) для режима Brush Presets (Образ-
цы кистей) представлен на рис. 8.8.
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Рис. 8.8. Внешний вид панели Brushes для режима Brush Presets

Как видно из рис. 8.8, рабочая область панели для этого режима содержит сле-
дующие элементы:

• образцы стандартных кистей;
'

• ползунок Master Diameter (Главный диаметр);

• окно просмотра результата;

• кнопка вызова контекстного меню.

Внешний вид панели Brushes (Кисти) для режима Brush Tip Shape (Форма кисти)
представлен на рис. 8.9.

Как видно из рис. 8.9, рабочая область панели в этом режиме содержит следую-
щие элементы:

• каталог образцов кистей;
.

• ползунок Diameter (Диаметр);

• флажки Flip X Jitter (Генерировать отражение относительно оси X) и Flip Y Oitter
(Генерировать отражение относительно оси Y), включающие и отключающие
переворачивание кисти;

• поле ввода значения параметра Angle (Угол);

• поле ввода значения параметра Roundness (Округлость);

• ползунок Hardness (Жесткость);
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Рис. 8.9. Внешний вид панели Brushes для режима Brush Tip Shape

• флажок и ползунок Spacing (Пробел);

• кнопка вызова контекстного меню.

Кнопка вызова контекстного меню предоставляет доступ к следующим группам
команд:

• режимы отображения панели:

П Dock to Palette Well (Поместить палитру в пристыковываемое окно) — пере-
мещает панель в верхний правый угол панели свойств инструментов, по-
сле чего она разворачивается по щелчку мыши;

П Expanded View (Перейти к расширенному виду) — отображение всех эле-
ментов рабочей области панели;

• управление установками кисти: New Brush Preset (Заготовка новой кисти);

• команды общего управления панелью:

D Clear Brush Controls (Сброс настроек параметров кисти);

О Reset All Locked Settings (Восстановить все установки);

D Copy Texture to Other Tools (Копировать текстуру для других инструментов);

• команды работы с кистями;

• режимы отображения образцов кистей;

• составление каталога образцов кистей.
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• управление каталогом образцов кистей: восстановление, загрузка, сохранение,
замена кистей.

• управление текущим набором кистей в каталоге образцов.

Панель Channels - . . .•

Панель Channels (Каналы) позволяет просматривать все содержащиеся в изобра-
жении каналы и переключаться на любой из них.

Каналами принято называть отдельные составляющие изображения, например
цветовые компоненты R (Red — Красный канал), G (Green — Зеленый канал),
В (Blue — Синий канал). В качестве каналов могут рассматриваться сохранен-
ные выделенные области или изображения, для нанесения которых на бумагу
или иной носитель будут использоваться «плашечные» цвета — цвета, подбирае-
мые по каталогам.

Панель вызывается на экран командой меню Window > Channels (Окно > Каналы).
Внешний вид панели Channels (Каналы) представлен на рис. 8.10.

Рис. 8.10. Внешний вид панели Channels

Как видно из рис. 8.10, рабочая область панели содержит следующие элементы:

• столбец индикации видимости каналов;

• список каналов;

• кнопки управления каналами, слева направо: Load channel as selection (За-
грузить канал как выделение), Save selection as channel (Сохранить выделение
в канале), Create new channel (Создать новый канал), Delete current channel
(Удалить текущий канал);

• кнопка вызова контекстного меню.

Кнопка вызова контекстного меню предоставляет доступ к следующим группам
команд:

• режим отображения панели: Dock to Palette Well (Поместить палитру в при-
стыковываемое окно) — перемещает панель в верхний правый угол панели
свойств инструментов, после чего она разворачивается по щелчку мыши;
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• команды работы с каналами:

D New Channel (Новый канал) — создание нового альфа-канала на основе мас-
кированной или выделенной области;

П Duplicate Channel (Дублировать канал) — создание копии выбранного кана-
ла как в текущем изображении, так и в другом;

П Delete Channel (Удалить канал) — удаление канала;

• команды работы с каналами «плашечных» цветов:

П New Spot Channel (Новый канал «плашечного» цвета) — создание нового ка-
нала «шишечного» цвета для его последующего выведения на отдельную
печатную форму;

D Merge Spot Channel (Объединить каналы «плашечных» цветов) — объедине-
ние канала «плашечного» цвета с каналами стандартных цветовых моделей;

• управление настройками: Channel Options (Настройки канала) — выбор назва-
ния канала, области для цветовой индикации, цвета и его прозрачности;

• управление каналами:

П Split Channels (Разделить каналы) — каждый канал становится отдельным
полутоновым изображением;

D Merge Channels. (Объединить каналы) — объединение каналов в одно мно-
гоканальное изображение согласно выбранной в диалоговом окне цвето-
вой модели;

• управление панелью: Palette Options... (Настройки панели) — в диалоговом ок-
не можно выбрать размер миниатюры для списка каналов.

Панель Character
Панель Character (Символ) предназначена для задания атрибутов символа. Вы-
зывается на экран командой меню Window > Character (Окно > Символ). Внешний
вид панели представлен на рис. 8.11.

Character

| Fixedsys [5*|: f Regular

is Pi ml mm (Auio)

• if! о.
If [ioo%_ j%Д| ioo%__

т. if ъ т т,
English: USA Sharp

Рис. 8.11. Внешний вид панели Character
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Как видно из рис. 8.11, рабочая область панели содержит следующие элементы:

• раскрывающиеся меню выбора гарнитуры и начертания шрифта;

• раскрывающиеся меню выбора размера шрифта, интерлиньяжа, кернинга и тре-
кинга (подробнее эти понятия рассмотрены в главе 15).

• поля ввода значений масштаба символов по горизонтали и по вертикали, а так-
же величины базовой линии и цвета шрифта;

• кнопки задания дополнительных атрибутов символов, таких как жирное и по-
лужирное, курсивное начертания, все прописные, малые прописные, верхний
и нижний индексы, подчеркивание, зачеркивание;

• раскрывающиеся меню установки языка выделенного текста для последую-
щей проверки орфографии и расстановки переносов, а также задания метода
сглаживания шрифта;

• контекстное меню.

Кнопка вызова контекстного меню предоставляет доступ к следующим группам
команд:

• режимы отображения панели;

• дополнительные атрибуты символов;

• управление ориентацией текста;

• управление шириной символа;

• запрещение переносов;

• управление возможностями шрифтов Open Type:

D Oldstyle (Старый стиль) — цифра опускается ниже базовой линии;

П Ordinals (Порядковые числительные) — автоматическое форматирование
порядковых числительных путем добавления верхнего индекса;

D Swash (Официальный) — официальные символы (стилизованные образцы
письма с утолщенными штрихами);

П Titling (Заголовок) — изменение регистра символов;

D Contextual Alternates (Контекстуальные варианты) — выбор лучшего вари-
анта согласования;

D Stylistic Alternates (Стилистические варианты) — стилизация символов для
соответствия эстетическим требованиям;

D Ornaments (Украшения) — добавление личной подписи в семейство шриф-
тов и возможность использования различных декоративных элементов;

О Ligatures (Лигатуры) — типографские замены таких пар символов, как fi, fl,
ff, ffi и ffl;

П Discretionary Ligatures (Дискреционные лигатуры) — типографские замены
таких пар символов, как ct, st и ft;

D Fractions (Дроби) — автоматическое форматирование дробей.

• управление панелью.
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Панель Color .
Панель Color (Цвет) предназначена для выбора цвета и работы с ним. Вызывает-
ся на экран командой меню Window > Color (Окно » Цвет) или при помощи клави-
ши F6. Внешний вид представлен на рис. 8.12.

Рис. 8.12. Внешний вид панели Color

Как видно из рис. 8,12, рабочая область панели содержит следующие элементы:

• образец основного цвета;

• образец цвета фона;

• треугольник предупреждения о выходе выбранного цвета за пределы цвето-
вой гаммы модели CMYK;

• образец цвета, близкого к выбранному основным, но не выходящего за преде-
лы цветовой гаммы модели CMYK;

• ползунки установки каждой из цветовых составляющих;

• поля ввода численных значений каждой из цветовых составляющих;

• спектр допустимых цветовых оттенков;

• образцы белого и черного цветов;

• контекстное меню.

Кнопка вызова контекстного меню предоставляет доступ к следующим группам
команд:

• режимы отображения панели;

• режимы отображения ползунков для разных цветовых моделей:

П Grayscale Slider (Ползунок оттенков серого);

П RGB Sliders (Ползунки RGB);

П HSB Sliders (Ползунки HSB);

П CMYK Sliders (Ползунки CMYK);

П Lab Sliders (Ползунки Lab);

П Web Color Sliders (Ползунки цветов Web).

• работа с HTML-кодом: Copy Color as HTML (Копировать цвет как код HTML) -
передает HTML-код в буфер обмена;
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• режимы отображения спектра для разных цветовых моделей:

П RGB Spectrum (Спектр RGB);

D CMYK Spectrum (Спектр CMYK);

D Grayscale Ramp (Оттенки серого);

П Current Colors (Текущие цвета);

• управление безопасными для Web цветами.

Панель File Browser
Панель File Browser (Браузер файлов) обеспечивает доступ к файлам изобра-
жений и к различной информации о них. Вызывается на экран командой меню
Window > File Browser (Окно > Браузер файлов) или при помощи щелчка на кноп-
ке рядом со стеком панелей. Внешний вид панели File Browser (Браузер файлов)
представлен на рис. 8.13.

И File Browser

File ЕЛ Automata Sort View

FeMersX Jlili

£5"Pj5 APCS и цифровая фотогрЩ

j gJJ Для перевода

i -̂ĵ ~tl Красные глаза :й:̂

{ 33"gj Отправлено ^

1Ф1-Р̂ > Старая книга Ш
ш

MetadaU \KeywQti

Filename

Date Created

Date Modified

Image Format

i 21.02.200401:23:57

: 21.02.200401:24:02

: Photothop . Ь •.-. ,•

Рис. 8.13. Внешний вид панели File Browser
•

Как видно из рис. 8.13, рабочая область панели содержит следующие элементы:

• меню File (Файл), содержащее команды, помогающие работать с файлами и фай-
ловой структурой;
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• меню Edit (Редактирование), содержащее команды, позволяющие работать
с рейтингом файлов, поворачивать изображения, добавлять дополнительную
информацию, называемую метаданными;

ПРИМЕЧАНИЕ
Рейтингом файлов называется вводимая пользователем информация об их состоянии или
назначении. Обычно используется в качестве условия для последующей сортировки.

Чтобы задать рейтинг файла, нужно щелкнуть правой кнопкой мыши на миниатюрном изо-
бражении в окне просмотра, а затем выбрать команду Rank (Рейтинг) из открывшегося кон-
текстного меню и в появившемся диалоговом окне ввести необходимую информацию. Вве-
денное значение рейтинга отобразится на панели Metadata (Метаданные), в разделе File
Properties (Параметры файла). Удалить рейтинг можно командой Clear Ranking (Удалить
рейтинг) из того же контекстного меню.

меню Automate (Автоматизация), содержащее команды для автоматической об-
работки групп изображений, создания презентаций, коллажей и фотогалерей;

меню Sort (Сортировка), содержащее команды для сортирования файлов по
различным признакам;

меню View (Вид), содержащее команды, управляющие отображением файлов
изображений в окне просмотра;

кнопки управления, слева направо: Rotate CCW (Повернуть против часовой
стрелки), Rotate CW (Повернуть по часовой стрелке), Flag File (Отметить файл),
Search (Поиск), Delete File (Удалить файл);

область проводника;

контекстное меню проводника, состоящее из команды Refresh (Обновить);

область предпросмотра;

панель Metadata (Метаданные), отображающая информацию о файле, сгруп-
пированную по разделам: File Properties (Параметры файла), Camera Data (ExiF)
(Описание камеры), GPS, Camera Raw (Параметры съемки), Edit History (Редак-
тировать протокол);

контекстное меню панели Metadata (Метаданные), содержащее следующие ко-
манды: Search (Поиск), Decrease Font Size (Уменьшить размер шрифта), Increase
Font Size (Увеличить размер шрифта), Metadata Display Options (Параметры
отображения метаданных);

панель Keywords (Ключевые слова), отображающая информацию о ключевых
словах, ассоциированных с данным файлом;

контекстное меню панели Keywords (Ключевые слова), содержащее следующие
команды: New Keyword (Новое ключевое слово), New Keyword Set (Новый набор
ключевых слов), Rename (Переименовать), Delete (Удалить), Search (Поиск);

кнопка Up One Level (На один уровень вверх);

раскрывающееся меню списка каталогов;

раскрывающееся меню Show (Показать), содержащее следующие параметры
отображения файлов: Flagged and Unflagged (Отмеченные и неотмеченные),
Flagged (Отмеченные), Unflagged (Неотмеченные);
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область просмотра файлов;

кнопки управления действиями, слева направо: Cancel (Отмена), Apply (При-
менить).

Панель Histogram
Панель Histogram (Гистограмма) позволяет просмотреть информацию о тональных
и яркостных характеристиках изображения. Эта панель отсутствовала в преды-
дущих версиях Adobe Photoshop.

ПРИМЕЧАНИЕ
Гистограммой называется график, показывающий распределение значений интенсивности
каждого цвета на изображении. Высота каждого вертикального столбика гистограммы зави-
сит от количества пикселов с такой интенсивностью.
__«__—^^—_^_____^~^__»__^—^«^^__

Панель вызывается на экран командой меню Window > Histogram (Окно > Гисто-
грамма). Внешний вид панели представлен на рис. 8.14.

Channel: !RGB

Mean! 391,83

StdDevi 51,64
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Рис. 8.14. Внешний вид панели Histogram

Как видно из рис. 8.14, рабочая область панели содержит следующие элементы:

• раскрывающееся меню Channels (Каналы);

• кнопка Uncached Refresh (Обновление);

• область просмотра гистограммы;

• раскрывающееся меню Source (Источник);

• информация об изображении;

• контекстное меню.

Информация об изображении включает в себя следующие данные:

• Mean (Среднее) — показывает усредненное значение интенсивности;

• Standard deviation (Std Dev) (Стандартное отклонение) — показывает, как ве-
личина интенсивности изменяется в различных точках;
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• Median (Медиана) — показывает среднюю величину в пределах значений ин-
тенсивности;

• Pixels (Пикселы) — показывает общее число пикселов, использованных для
расчета гистограммы;

• Level (Уровень) — отображает уровень интенсивности области под указате-
лем;

• Count (Счет) — показывает общее число пикселов, соответствующих уровню
интенсивности под указателем;

• Percentile (Процентиль) — отображает число пикселов в месте расположения
указателя или под ним; эта величина выражается как процент от общего чис-
ла пикселов изображения;

• Cache Level (Уровень кэширования) — показывает текущее кэширование изо-
бражения, использованное для создания гистограммы. Если в настройках
кэширования (команда Edit > Preferences > Memory and Image Cache preferences
(Редактирование > Установки > Память и кэширование изображения)) ус-
тановлен флажок Use Cache for Histograms (Использовать кэширование для
гистограмм), то гистограмма строится быстрее и основывается на репре-
зентативной выборке пикселов. Основанная на репрезентативной выборке
пикселов гистограмма менее точна, чем гистограмма, основанная на всех пик-
селах изображения.

Кнопка вызова контекстного меню предоставляет доступ к следующим группам
команд:

• режимы отображения панели;

• обновление: Uncached Refresh (Обновление некэшированного);

• режимы отображения:

D Compact View (Компактное представление) — отображение только области
просмотра гистограммы;

П Expanded View (Расширенное представление) — отображение всех элемен-
тов панели;

D All Channels View (Все каналы) — отображение всех элементов панели и ги-
стограмм всех каналов изображения;

• управление отображением информации:

П Show Statistics (Показать статистические данные) — отображение инфор-
мации об изображении;

D Show Channels in Color (Показать каналы в цвете) — отображение цветных
гистограмм всех каналов.

На практике гистограмма дает прежде всего возможность оценить изображение
для выбора метода последующей его коррекции.

Как видно из рис. 8.15, изображение является недостаточно выдержанным, его
гистограмма смещена вправо, в область светлых тонов. Следовательно, для его
коррекции нужно уменьшить яркость.
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Рис. 8.15. Недостаточно выдержанное изображение и панель Histogram для него
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Рис. 8.16. Нормально экспанированное изображение и панель Histogram для него

Из рис. 8.16 видно, что представленное изображение в коррекции не нуждается,
его гистограмма распределена равномерно.



124 Глава 8. Панели инструментов

Рис. 8.17. Излишне выдержанное изображение и панель Histogram для него

Гистограмма изображения, представленного на рис. 8.17, смещена влево, в об-
ласть темных тонов. Для его коррекции потребуется увеличить яркость.

Панель History
Панель History (Протокол) предоставляет доступ к истории ранее выполненных
действий и команд редактирования изображения. Используя эту панель, вы мо-
жете не только просмотреть историю команд, но и вернуться на некоторое коли-
чество шагов назад. Это бывает полезно, если полученный в результате выполне-
ния некоторых действий результат вас не удовлетворил. Панель вызывается на
экран командой меню Window > History (Окно > Протокол). Внешний вид панели
представлен на рис. 8.18.

Рис. 8.18. Внешний вид панели History



Панель Info 125

Для возврата к определенному состоянию документа просто выберите нужный
пункт и щелкните по нему левой кнопкой мыши.

Как видно на рис. 8.18, рабочая область панели содержит следующие элементы:

• столбец включения/отключения источника для инструмента History Brush
(Восстанавливающая кисть);

• список состояний;

• кнопки управления состояниями, слева направо: Create new document from
current state (Создать новое изображение из текущего состояния), Create new
snapshot (Создать новый снимок), Delete current state (Удалить текущее со-
стояние);

• кнопка вызова контекстного меню.

Кнопка вызова контекстного меню предоставляет доступ к следующим группам
команд:

• режимы отображения панели;

• движение по списку состояний:

П Step Forward (Шаг вперед);
.

П Step Backward (Шаг назад);

• работа с состояниями:

П New Snapshot (Новый снимок) — создание нового снимка из текущего изо-
бражения целиком, связанных слоев или текущего слоя;

П Delete (Удалить) — удаление выбранного состояния;

D Clear History (Очистить протокол) — удаление всех состояний открытого
изображения;

• работа с изображениями: New Document (Новый документ) — создание нового
документа из выбранного состояния;

• управление панелью: History Options (Настройки истории) — определение па-
раметров автоматического создания снимков и включение разрешения на ве-
дение нелинейной истории.

СОВЕТ
Можно перемещаться по протоколу команд при помощи клавиатуры. Для этого используйте
комбинации клавиш Ctrl+Alt+Z (шаг назад) и Ctrl+Shift+Z (шаг вперед). Отменить или повто-
рить последнее действие можно при помощи комбинации клавиш Ctrl+Z.

Панель Info
Панель Info (Информация) предоставляет доступ к информации о значениях
цвета под указателем и других измеряемых величинах в зависимости от ис-
пользуемого инструмента. Вызывается на экран командой меню Window > Info
(Окно > Информация) или при помощи клавиши F8. Внешний вид панели пред-
ставлен на рис. 8.19.
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Рис. 8.19. Внешний вид панели Info

Как видно из рис. 8.19, рабочая область панели содержит следующие элементы:

• область численных значений цветовых составляющих модели RGB;

• область численных значений цветовых составляющих модели CMYK;

• координаты указателя мыши;

• длина и ширина выделенной области;

• кнопка вызова контекстного меню.

Кнопка вызова контекстного меню предоставляет доступ к следующим группам
команд:

• режимы отображения панели;

• управление панелью:
.

п Palette Options (Настройки панели) — выбор первого и второго цвета, ото-
бражаемых на панели, а также задание единиц измерения;

П Color Samplers (Инструменты выбора цвета) — позволяет измерять цвета
отдельных пикселов, выбранных с помощью инструмента Color Sampler
(Проба цвета).

Панель Layer Comps
Панель Layer Comps (Композиции) обеспечивает доступ к информации о со-
стояниях слоя. Состояниями слоя называется снимок панели Layers (Слои), со-
держащий следующую информацию: видимость слоя, его расположение и стили,
примененные к слою. Панель вызывается на экран командой меню Window > Layer
Comps (Окно > Композиции). Внешний вид панели представлен на рис. 8.20.

L £$t Document State

Layer Comp 1

Рис. 8.20. Внешний вид панели Layer Comps
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Как видно из рис. 8.20, рабочая область панели содержит следующие элементы:

• список состояний слоя;

• кнопки управления;

• кнопка вызова контекстного меню.

Кнопка вызова контекстного меню предоставляет доступ к следующим группам
команд:

• режимы отображения панели;

• работа с наборами слоя;

• управление наборами слоя;

• настройка сохранения состояния слоя.

Панель Layers
Панель Layers (Слои) предназначена для работы со слоями изображения. Панель
вызывается на экран командой меню Window > Layers (Окно > Слои) или клави-
шей F7. Внешний вид панели представлен на рис. 8.21.

•

Рис. 8.21. Внешний вид панели Layers

Как видно из рис. 8.21, рабочая область панели содержит следующие элементы:

• раскрывающееся меню выбора режима смешивания слоя;

• ползунок установки глобальной прозрачности слоя;

• кнопки блокирования, слева направо: Lock transparent pixels (Блокировка про-
зрачных пикселов), Lock image pixels (Блокировка пикселов изображения),
Lock position (Блокировка положения), Lock all (Заблокировать все);

• ползунок установки внутренней прозрачности слоя;

• столбец включения/отключения видимости слоя;

• столбец включения/отключения связывания слоя;

• список слоев;

• кнопки работы со слоями, слева направо: Add a layer style (Добавить эффект),
Add layer mask (Добавить маску слоя), Create a new set (Создать новую группу
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слоев), Create new fill or adjustment layer (Создать новую заливку или корректи-
рующий слой), Create a new layer (Создать новый слой), Delete layer (Удалить
слой);

• кнопка вызова контекстного меню.

Кнопка вызова контекстного меню предоставляет доступ к следующим группам
команд:

• режимы отображения панели;

• работа со слоями:

D New Layer (Новый слой) — создание нового слоя;

D Duplicate Layer (Дублировать слой) — создание копии выбранного слоя;

D Delete Layer (Удалить слой) — удаление выбранного слоя;

D Delete Linked Layers (Удалить связанные слои);

D Delete Hidden Layers (Удалить скрытые слои);

• работа с группой слоев:

D New Layer Set... (Новый набор слоев) — создание нового набора слоев;

D New Set From Linked (Новый набор из связанных слоев) — создание нового
набора слоев из предварительно связанных;

D Lock All Layers In Set (Закрепить все слои в наборе) — запрещение внесения
изменений в один или несколько параметров, например прозрачность или
расположение на «холсте» изображения;

• настройки слоя:

D Layer Properties (Свойства слоя) — задание имени слоя и цвета его отобра-
жения в списке слоев на панели;

D Blending Options (Настройки смешивания) — задание параметров смешива-
ния слоя;

• управление слоями:

D Merge Layers (Объединить слои) — объединение нескольких слоев в один;

П Merge Visible (Объединить видимые) — объединение всех видимых слоев в
один;

П Flatten Image (Свести слои) — объединение всех слоев изображения в один
фоновый слой;

• управление панелью: Palette Options (Настройки панели) — в диалоговом окне
можно выбрать размер миниатюры для списка слоев.

Панель Navigator
Панель Navigator (Навигация) служит для передвижения по изображению и из-
менения его масштаба. Панель вызывается на экран командой меню Window >
Navigator (Окно » Навигация). Внешний вид панели представлен на рис. 8.22.
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Рис. 8.22. Внешний вид панели Navigator

Как видно из рис. 8.22, рабочая область панели содержит следующие элементы:

я уменьшенное изображение с рамкой, ограничивающей текущую видимую об-
ласть. Вы можете перемещать ее с помощью мыши «пролистывая» изображение;

• поле ввода численного значения масштаба изображения;

• кнопка уменьшения масштаба;

• ползунок масштабирования;

• кнопка увеличения масштаба;

• кнопка вызова контекстного меню.

Кнопка вызова контекстного меню предоставляет доступ к следующим группам
команд:

• режимы отображения панели;

• управление панелью: Palette Options (Настройка панели) — в диалоговом окне
можно выбрать цвет рамки, ограничивающей текущую видимую область.

Панель Options
Панель Options (Параметры) отображает параметры и настройки того инструмен-
та, который в данный момент выбран на панели Tools (Инструменты). Панель
вызывается на экран командой меню Window (Окно) > Options (Настройки). Внеш-
ний вид панели Options (Параметры) представлен на рис. 8.23.

Рис. 8.23. Внешний вид панели Options для инструмента Rectangular Marquee

Панель Paragraph
Панель Paragraph (Абзац) позволяет выполнять форматирование текста. Панель
вызывается на экран командой меню Window > Paragraph (Окно > Абзац). Внеш-
ний вид панели Paragraph (Абзац) представлен на рис. 8.24.

Как видно из рис. 8.24, рабочая область панели содержит следующие элементы:

• кнопки управления выравниванием;

• кнопки управления выключкой текста;

5 Зак. 805



130 Глава 8. Панели инструментов

Рис. 8.24. Внешний вид панели Paragraph

• кнопки управления отступами от левого и правого края;

• кнопка управления отступом первой строки;

• кнопки управления отступами до и после абзаца;

• флажок Hyphenate (Переносы);

• кнопка вызова контекстного меню.

Кнопка вызова контекстного меню предоставляет доступ к следующим группам
команд:

• режимы отображения панели;
/

• управление правилами пунктуации;
•

• управление выключкой и расстановкой переносов;

• управление стилями набора;

• управление панелью.

Панель Paths
Панель Paths (Контуры) предназначена для работы с путями и векторными
масками.

ПРИМЕЧАНИЕ
Контур — созданная с помощью соответствующего инструмента область, содержащая от-
резки прямых и кривых линий с опорными точками.

Векторной маской называется слой, содержащий векторную фигуру, созданную при помощи
соответствующих инструментов.

Панель вызывается на .экран командой меню Window > Paths (Окно > Контуры).
Внешний вид панели представлен на рис. 8.25.

Как видно из рис. 8.25, рабочая область панели содержит следующие элементы:

• список путей и векторных масок;

• кнопки работы с путями;

• кнопка вызова контекстного меню.
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Рис. 8.25. Внешний вид панели Paths

Кнопка вызова контекстного меню предоставляет доступ к следующим группам
команд:

• режимы отображения панели;

• управление путями: создание пути, создание копии и удаление выбранного
пути;

• создание рабочего пути;

• работа с путями: создание выделения из пути, заливка пути выбранным цве-
том, обводка пути кистью;

• подготовка к экспорту;

• настройка панели.

Панель Styles
-j

Панель Styles (Стили) позволяет оформить слой уже готовыми стилями. Панель
вызывается на экран командой меню Window I Styles (Окно > Стили). Внешний
вид панели Styles (Стили) представлен на рис. 8.26.

Рис. 8.26. Внешний вид панели Styles
.

Как видно из рис. 8.26, рабочая область панели содержит следующие элементы:

• каталог стандартных стилей;

• кнопки работы со стилями;

• кнопка вызова контекстного меню.
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Кнопка вызова контекстного меню предоставляет доступ к следующим группам
. команд:

• режимы отображения панели;

• работа со стилями;

• управление каталогом стилей; '

• составление каталога образцов стилей;

• восстановление, загрузка, сохранение и замена стилей;

• управление текущим набором стилей в каталоге образцов.

Панель Swatches
Панель Swatches (Каталог) предоставляет возможность выбрать основной и фо-
новый цвета, а также создать собственную библиотеку цветов. Панель вызывает-
ся на экран командой меню W i n d o w > Swatches (Окно > Каталог). Внешний вид
панели представлен на рис. 8.27.

Рис. 8.27. Внешний вид панели Swatches

Как видно из рис. 8.27, рабочая область панели содержит следующие элементы:

• каталог цветов;

• кнопки работы с образцами цветов, слева направо: Create new swatch of foreground
color (Создать новый образец основного цвета), Delete swatch (Удалить образец);

• кнопка вызова контекстного меню.

Кнопка вызова контекстного меню предоставляет доступ к следующим группам
команд:

• режимы отображения панели;

• работа с каталогом образцов цвета;

• New Swatch (Новый образец) — создание собственного образца;

• управление видом каталога образцов цвета;

• составление каталога образцов цвета;

• управление каталогом образцов цвета: восстановление, загрузка, сохранение
и замена образцов цвета.
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Панель Tool Presets
-

Панель Tool Presets (Предустановки инструментов) предоставляет возможность
создать и сохранить набор предустановок для каждого инструмента. Панель вы-
зывается на экран командой меню Window > Tool Presets (Окно > Предустановки
инструментов). Внешний вид панели представлен на рис. 8.28.

t_i Rectangular Marquee Tool 1

13 Current Tool/Only; jj

Рис. 8.28. Внешний вид панели Tool Presets

Как видно из рис. 8.28, рабочая область панели содержит следующие элементы:

• список предустановок;

• флажок Current Tool Only (Только текущий инструмент);

• кнопки работы с предустановками;
t• кнопка вызова контекстного меню.

Кнопка вызова контекстного меню предоставляет доступ к следующим группам
команд:

• режимы отображения панели;
,

• работа с предустановками инструментов;

• управление отображением предустановок инструментов;

• управление видом списка предустановок инструментов;

• управление инструментами;

• составление списка предустановок инструментов;

• управление списком предустановок инструментов;

• управление текущим набором предустановок инструмента в списке.

Панель Tools
Панель Tools (Инструменты) предназначена для работы с инструментарием Adobe
Photoshop. Наиболее популярные инструменты Adobe Photoshop мы подробно
рассмотрели в главе 7. Панель вызывается на экран командой меню W i n d o w >
Tools (Окно > Инструменты). Внешний вид панели представлен на рис. 8.29.
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Рис. 8.29. Внешний вид панели Tools

Рабочая область панели содержит следующие элементы:

• инструменты;

• вкладка выбора основного и фонового цветов;

• кнопки режимов редактирования изображения;

• кнопки режимов отображения;.
• кнопка перехода в ImageReady.

Изучив эту главу, вы получили представление о том, как работать с панелями
инструментов, какие возможности дает их применение, как избавиться от боль-
шей части рутинной работы, посвятив освобожденное время исключительно
творчеству.



Глава 9

Дополнительные элементы
и инструменты
Дополнительными элементами изображения Adobe Photoshop будет считать ото-
бражаемые только на экране монитора вспомогательные элементы: измеритель-
ные линейки, направляющие, сетку, контуры, границы выделенной области,
фрагменты изображения и заметки. В рамках этой главы рассмотрим инстру-
менты создания контура, фрагментов и заметок (примечаний в изображении).

Измерительные линейки
Линейки предназначены для точного позиционирования изображений и их
частей. Линейки появляются на экране после выбора команды View > Rulers
(Вид > Линейки). Они располагаются вдоль левой и верхней границ изобра-
жения.

пример, jps® 100% (RGB/8) ptalikl

Рис. 9.1. Внешний вид открытого изображения с линейками
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Для изменения начала координат необходимо потянуть мышью значок в левом
верхнем углу и перетащить его в нужное место. Клавиша Shift, нажатая при пере-
мещении, позволит привязать начало координат к отметкам линеек. Чтобы вос-
становить начало координат, заданное по умолчанию, дважды щелкните мышью
на этом значке.

Изменить единицы измерения линеек можно одним из следующих способов:

• дважды щелкнув мышью на линейке;

• с помощью контекстного меню, открывающегося при нажатии правой кноп-
кой мыши на линейке;

• выполнением команды меню Edit > Preferences > Units & Rulers (Редактирование >
Настройки > Единицы измерения и линейки);

• с помощью диалогового окна, открывающегося при выполнении команды Palette
Options (Настройки панели) контекстного меню панели Info (Информация).

Направляющие линии
Направляющими называются вспомогательные линии, не выводящиеся на печать.
Направляющие можно создавать, передвигать, закреплять и удалять.

Создать направляющую можно одним из следующих способов:

• выполнением команды меню View > New Guide (Вид > Новая направляющая);

• потянув мышью одну из линеек.

Рис. 9.2. Внешний вид открытого изображения с линейками и направляющими

Сделать направляющие видимыми можно с помощью команд меню View > Show >
Guides (Вид > Показать > Направляющие) и View V Extras (Вид > Дополнительные).
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Переместить направляющую, работая с любым инструментом кроме Move (Пере-
мещение), можно с помощью мыши при нажатой клавише Ctrl.

ВНИМАНИЕ -
При работе с инструментами Slice (Фрагмент) и Hand (Рука) переместить направляющую
нельзя.

Сделать направляющие неподвижными можно командой меню View >• Lock Guides
(Вид > Закрепить направляющие).

Удаление направляющих можно произвести одним из двух способов:

• ухватить направляющую и переместить ее до линейки;

• выполнить команду меню View > Clear Guides (Вид > Очистить направляю-
щие).

Для того чтобы изображение или его части оказались привязанными к направ-
ляющим, необходимо выполнить команду меню View > Snap To > Guides (Вид >
Привязать к > Направляющие).

Настроить направляющие по своему усмотрению можно в диалоговом окне, откры-
вающемся после выполнения команды меню Edit > Preferences > Guides, Grid & Slices
(Редактирование > Настройки > Направляющие, сетка и фрагменты нарезки).

Сетка
Сетка помогает симметрично выстраивать элементы изображения и точно позицио-
нировать их. Отобразить сетку на экране можно с помощью команд меню View >
Show > Grid (Вид > Показать > Сетка) и View > Extras (Вид > Дополнительные).

Рис. 9.3. Внешний вид открытого изображения с линейками и сеткой
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Привязать изображение или его части к сетке позволяет команда меню View >
Snap To > Grid (Вид > Привязать к > Сетка). Настроить параметры сетки можно
в диалоговом окне, открывающемся после выполнения команды меню Edit >
Preferences > Guides, Grid & Slices (Редактирование > Настройки > Направляющие,
сетка и фрагменты нарезки).

Контуры
Контур — созданная с помощью соответствующего инструмента область, содер-
жащая отрезки прямых и кривых линий с опорными точками. Контуры помога-
ют точно выделить нужные части изображения.

Для создания контура могут быть использованы следующие инстру- ж $•••' Ц
менты: Реп (Перо), Freeform Pen (Свободное перо), Rectangle (Прямо-
угольник), Rounded Rectangle (Скругленный прямоугольник), Ellipse (Эл- И ®
липе), Polygon (Многоугольник) и Custom Shape (Произвольная фигура). /~ч -̂
Все эти инструменты находятся на панели Tools (Инструменты).

Для редактирования контура предназначены инструменты Add A n c h o r А+ А-
Point (Добавить узел), Delete Anchor Point (Удалить узел) и Convert Point
(Преобразовать узел). Эти инструменты также можно найти на панели Tools к
(Инструменты).

Для отображения на экране контура используются команды меню View > Show >
Target Path (Вид > Показать > Контур) и View > Extras (Вид > Дополнительные).

It пример.jpg @ 100% (RGB/8) "ЛЕШ
... Р. . . . Г, ... Р. ... Г . . . Г

Рис. 9.4. Внешний вид открытого изображения с линейками и контуром



Контуры 139

Инструмент Pen
Каждый щелчок мышью при выбранном инструменте Реп (Перо) добавляет к кон-
туру опорную точку. Двойной щелчок левой кнопкой мыши закрывает контур.
Панель Options (Параметры) для этого инструмента показана на рис. 9.5.

:|Ж: ••<• ̂  '-^"Т-'- -̂1] ' Г Г~1 ••

* ' I—Н 1 —3 !

Рис. 9.5. Внешний вид панели Options для инструмента Реп

Слева направо располагаются следующие элементы:

• вкладка Tool Presets (Предустановки инструмента);

• кнопка Shape Layers (Слои для фигур) — для каждой векторной фигуры созда-
ется отдельный слой, который можно увидеть на панели Layers (Слои);

• кнопка Paths (Контуры) — нарисованные контуры отображаются на панели
Paths (Контуры);

• кнопка Fill Pixels (Залить пикселы) — на уже имеющемся слое создается зали-
тая выбранным цветом фигура;

• кнопки выбора инструментов: Реп (Перо), Freeform Pen (Свободное перо),
Rectangle (Прямоугольник), Rounded Rectangle (Скругленный прямоуголь-
ник), Ellipse (Эллипс), Polygon (Многоугольник),'Си5Ьт Shape (Произвольная
фигура);

• меню Pen Options (Свойства пера), содержащее флажок Rubber Band (Рези-
новая лента) — контур, создаваемый инструментом Реп (Перо), отображается
в виде непрерывной линии;

• флажок Auto Add/Delete (Автоматическое добавление/удаление) — автомати-
ческое добавление или удаление опорных точек при наведении указателя мыши;

• кнопки Add to path area (Добавить к области контура), Subtract from path area
(Вычесть из области контура), Intersect path areas (Пересечение областей
контура), Exclude overlapping path areas (Исключить пересекающиеся области
контура).

При нажатой кнопке Shape Layers (Слои для фигур) на панели появляются сле-
дующие элементы:

• кнопка изменения свойств слоя;

• выпадающее меню выбора стиля слоя;

• поле выбора цвета заливки контура.

Инструмент Freeform Pen
Инструмент Freeform Pen (Свободное перо) позволяет создать контур произ- &..•
вольной формы, рисуя сплошную линию. Панель Options (Параметры) для
этого инструмента показана на рис. 9.6.
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сз Q Q \

Рис. 9.6, Внешний вид панели Options для инструмента Freeform Pen

Если сравнить рис. 9.5 и 9.6, можно заметить, что элементы панели Options (Па-
раметры) инструментов Реп (Перо) и Freeform Pen (Свободное перо) практически
совпадают. Флажок Magnetic (Магнит) позволяет инструменту автоматически
отслеживать границы областей, окрашенные в разные цвета.

Инструмент Rectangle
Инструмент Rectangle (Прямоугольник) позволяет создать контур прямоуголь-
ной формы. Панель Options (Параметры) для этого инструмента показана на
рис. 9.7.

а т п£ш о : $' tiliiO о Q \ & -} : B№W* i i зд.щ- ^«^ГП
Рис. 9.7. Внешний вид панели Options для инструмента Rectangle

Для этого и всех последующих инструментов добавляется кнопка New Shape Layer
(Новый контурный слой), которая позволяет расположить каждую вновь созда-
ваемую фигуру на собственном- слое.

Отличающимся является меню Rectangle Options (Свойства прямоугольника), со-
держащее следующие элементы:

• переключатель Unconstrained (Произвольный);

• переключатель Square (Квадрат);

• переключатель Fixed Size (Фиксированный размер) с полями ввода значений
ширины и высоты;

• переключатель Proportional (Пропорциональный) с полями ввода значений
ширины и высоты;

• флажок From Center (Из центра);

• флажок Snap to Pixels (Привязать к пикселам).

Инструмент Rounded Rectangle
Инструмент Rounded Rectangle (Скругленный прямоугольник) позволяет создать
контур в виде прямоугольника с закругленными углами. Панель Options (Пара-
метры) для этого инструмента показана на рис. 9.8.

® • ид-ша] TVaualQ э \ 0 •-[• ».d̂ .[ii;p.

Рис. 9.8. Внешний вид панели Options для инструмента Rounded Rectangle

Отличающимся является поле ввода значения радиуса скругления Radius (Радиус).
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Инструмент Ellipse
Инструмент Ellipse (Эллипс) позволяет создать эллиптический контур. Вид па-
нели Options (Параметры) для этого инструмента полностью совпадает с видом
панели Options (Параметры) для инструмента Rectangle (Прямоугольник).

Отличается только меню Ellipse Options (Свойства эллипса), содержащее следую-
щие элементы:

• переключатель Unconstrained (Произвольный);

• переключатель Circle (Круг);

• переключатель Fixed Size (Фиксированный размер) с полями ввода значений
ширины и высоты;

• переключатель Proportional (Пропорциональный) с полями ввода значений
ширины и высоты;

• флажок From Center (Из центра),

Инструмент Polygon
Инструмент Polygon (Многоугольник) позволяет создать контур в виде много-
угольника. Панель Options (Параметры) для этого инструмента показана на рис. 9.9.

Q - {^ШГНП "ф f ;з а 'О>Щ \ 0:' : sw«: [tZ. j j :Г1Я, Е %; ̂  . ! I а,ы Щ ' СоЬг: ГП

Рис. 9.9. Внешний вид панели Options для инструмента Polygon

Для этого инструмента добавляется поле ввода значения Sides (Стороны), в ко-
тором задается количество сторон многоугольника.

Меню Polygon Options (Свойства многоугольника) содер'жит следующие эле-
менты:

• поле ввода значения величины Radius (Радиус);

• флажок Smooth Corners (Сглаженные углы);

• флажок Star (Звезда);

• поле ввода значения величины Indent Sides By (Глубина лучей);

• флажок Smooth Indents (Сгладить углы между лучами).

Инструмент Custom Shape
Инструмент Custom Shape (Произвольная форма) позволяет создать контур в виде
произвольной фигуры. Панель Options (Параметры) для этого инструмента пока-
зана на рис. 9.10.

& t':B. Ш 0 9- \ Ш т 1 **"*••• : — * . i SKlf * . *' « 1 : 1: :. avw: Щ г , col ~~

Рис. 9.10. Внешний вид панели Options для инструмента Custom Shape
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Для этого инструмента добавляется раскрывающееся меню Shape (Фигура), из
которого можно выбрать подходящую фигуру. Используя команды контекстного
меню, появляющегося при щелчке на кнопке в правом верхнем углу, можно на-
строить вид отображаемых фигур, отсортировать их список, загрузить другие,
создать собственный набор фигур, а также удалять и переименовывать стандарт-
ные фигуры.

Меню Custom Shape Options (Свойства многоугольника) содержит флажок From
Center (Из центра), а также следующие переключатели:

• Unconstrained (Произвольный);

• Defined Proportions (Заданные пропорции);

• Defined Size (Заданный размер);

• Fixed Size (Фиксированный размер) с полями ввода значений ширины и вы-
соты.

.

Границы выделенной области
Границы выделенной области отображаются на экране в виде движущегося
пунктира (рис. 9.11).

IS пример.jpg е> 100% (RGB/8)

Рис. 9.11. Внешний вид открытого изображения с линейками и границами выделенной области

Для отображения на экране границ выделенной области используются команды
меню View > Show > Selection Edges (Вид > Показать * Границы выделенной облас-
ти) и View > Extras (Вид > Дополнительные). В главе 12 подробно рассматривают-
ся методы выделения фрагментов изображений.
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Фрагменты изображения
Фрагменты изображения предназначены для отделения тех частей изображения,
которые предполагается использовать в дальнейшем, например, в качестве эле-
ментов веб-страницы. Они бывают трех типов: созданные автоматически, создан-
ные пользователем и созданные на основе слоя.

Инструмент для создания фрагментов изображения Slice (Фрагмент) рас- jjf
полагается на панели Tools (Инструменты). Этот инструмент создает пря-
моугольную рамку вокруг выделяемой им части изображения.

Для редактирования фрагментов служит инструмент Slice Select (Выде- w
ление фрагмента), который также располагается на панели Tools (Инст-
рументы). »

Для отображения на экране фрагментов служат команды меню View > Show >
Slices (Вид > Показать > Фрагменты) и View > Extras (Вид > Дополнительные).

npnMep.jpg <& 100% (RGB/8)
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Рис. 9.12. Внешний вид открытого изображения с линейками и фрагментами

Заметки
Заметками в среде Adobe Photoshop называются текстовые или звуковые ком-
ментарии. Команда File > Import > Annotations (Файл > Импорт > Комментарии)
позволяет добавить в качестве комментариев PDF или PDF-файлы.

Для создания текстовых заметок служит инструмент Notes (Заметки), рас- ПЦ
положенный на панели инструментов. После щелчка инструментом Notes «^
(Заметки) в любой части изображения появляется окно ввода текста.
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Ж примероре Ш100% (RGB/8)

Рис. 9.13. Внешний вид открытого изображения с окном ввода текста инструмента Notes

На панели Options (Параметры) можно задать следующие параметры: имя автора
заметки, шрифт и его размер, цвет рамки. Также на этой панели расположена
кнопка Clear All (Очистить все), позволяющая удалить все текстовые заметки
к данному изображению.

При щелчке правой кнопкой мыши на значке текстовой заметки открывает- р-ч
ся контекстное меню. Оно содержит следующие команды: New Note (Новая LJ
заметка), Import Annotations... (Импорт комментариев), Open Note (Открыть
заметку), Close Note (Закрыть заметку), Delete Note (Удалить заметку), Delete All
Annotat ions (Удалить все комментарии).

Для создания звуковых заметок служит инструмент Audio Annotations (Звуко-
вые комментарии) на панели инструментов. После щелчка этим инстру- .л А
ментом в любой части изображения появляется диалоговое окно, показан- ^ч* *
ное на рис. 9.14.

Audio Annotation

•'•••• Instruction
Press the Start button to begin
recording by speaking into the
microphone, . .т

Cancel

Рис. 9.14. Внешний вид диалогового окна работы с инструментом Audio Annotations

Чтобы начать запись звукового комментария, необходимо подключить микро-
фон и нажать кнопку Start (Начать). Для завершения щелкните на кнопке Stop
(Остановить).
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На панели Options (Параметры) можно задать следующие параметры: имя автора
заметки и цвет рамки. Также на этой панели расположена кнопка Clear All (Очи-
стить все), позволяющая удалить все звуковые заметки к данному изображению.

При щелчке правой кнопкой мыши на значке звуковой заметки открывается |̂
контекстное меню. Оно содержит следующие команды: New Audio Annotation ^
(Новый звуковой комментарий), Import Annotations... (Импорт комментариев), Play
(Воспроизвести), Stop (Остановить), Delete Audio Annotation (Удалить звуковой
комментарий), Delete All Annotations (Удалить все комментарии).

•
Для отображения на экране значков текстовых и звуковых заметок используются
команды меню View> Show > Annotations (Вид > Показать > Комментарии) и View >
Extras (Вид > Дополнительные).

В этой главе мы познакомились с так называемыми дополнительными элемента-
ми и инструментами Adobe Photoshop. Теперь вы сможете самостоятельно соз-
давать контуры, фрагменты нарезки и добавлять комментарии к своему изобра-
жению. Направляющие линии и сетка помогут вам точно разместить различные
элементы изображения, а фрагменты — быстро сохранить изображение, разделив
его на отдельные файлы.



Глава 10

Слои изображения
и их использование
В этой главе мы познакомимся с одной из наиболее известных и мощных воз-
можностей Adobe Photoshop — слоями изображения.

По сути, слои являются независимыми изображениями, хранящимися в одном
файле. Изображения, находящиеся на разных слоях, накладываются друг на дру-
га, как будто они нарисованы на сложенных стопкой листах прозрачной пленки.
Можно независимо изменять разные слои, управлять их прозрачностью и нало-
жением на другие слои, изменяя вид всего изображения в целом.

На рис. 10.1 приведен пример изображения, содержащего два слоя. Можно изме-
нять изображения, находящиеся на слоях, например переместить слои относи-
тельно друг друга или границ документа.

Ш, Frog.tif 8 16.7% (Layer 1. ВСВШ IS teg.lif в. 1 *. 7* (Layer I, »GB/8j

Рис. 10.1. Изображения, находящиеся на разных слоях, можно
перемещать по «холсту» документа

Инструменты редактирования изображений, фильтры и команды, за редкими
исключениями, также воздействуют на слои по отдельности. Это позволяет при-
менять к различным фрагментам изображения разные инструменты и команды,
не боясь повредить другой фрагмент. Также можно создавать резервные копии
изображения или его фрагментов прямо в файле.
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Доступ к слоям изображения
Доступ к слоям изображения вы можете получить при помощи панели Layers
(Слои), показанной на рис. 10.2. При помощи этой панели можно выбрать слой
для редактирования, объединять слои в наборы, менять порядок их расположе-
ния, создавать новые слои или удалять ненужные.

На рис. 10.2 показан пример изображения, содержащего два слоя, и панель Layers
(Слои) в том виде, который она имеет при работе с данным документом.

TSESî .̂ I Hi
"Щ Opacity;'! 100% I

jh £| Fill: I 100%

Рис. 10.2. Панель Layers (справа) и документ (слева), состояние которого
панель отображает в данный момент

В данном случае на панели Layers (Слои) видны слои двух типов — фоновый
слой (Background) и обычный слой изображения (Layer 1). Типы слоев рассматри-
ваются ниже. На фоновом слое находится фотография (памятник Петру I у Ми-
хайловского замка, Санкт-Петербург), а на слое 1 (Layer 1) — белая рамка, кото-
рую вы можете видеть на рис. 10.2.

Можно редактировать текущий слой, выбранный на панели Layers (Слои). Вы-
брать слой можно, щелкнув на соответствующем пункте списка слоев. При этом
пункт, соответствующий этому слою, будет выделен цветом.

Типы слоев изображения
Существует несколько типов слоев — фоновые слои, слои изображения, слои
векторных форм, корректирующие слои. Здесь мы рассмотрим слои изображе-
ния, фоновые слои и корректирующие слои.

Фоновый слой (Background) находится в документе в момент его создания. Если
вы открываете документ, не содержащий слоев (например, файл, формат которо-
го не поддерживает сохранение слоев). Фоновый слой является обычным слоем
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изображения с одним исключением — он не может содержать прозрачных облас-
тей, а находящееся на нем изображение можно переместить только после выде-
ления его фрагмента. При перемещении фрагмента или удалении фонового слоя
освободившееся пространство заполняется цветом заднего плана.

По умолчанию фоновый слой называется Background (Фон), рядом с его именем
отображается символ блокировки, показывающий, что текущий слой не может
изменить свою прозрачность, а находящееся на нем изображение нельзя переме-
щать по холсту.

ПРИМЕЧАНИЕ —
При создании нового документа можно указать в качестве цвета фона значение Transparent
(Прозрачный). При этом по умолчанию будет создан не фоновый слой, а обычный слой изо-
бражения.

Обычный слой изображения может содержать прозрачные области. Для каждого
пиксела можно задать 256 градаций прозрачности. Кроме того, вы можете изме-
нять прозрачность слоя в целом и режим наложения слоя на слои, лежащие под
ним. Таким образом, слои могут накладываться друг на друга, а прозрачность
изображения позволяет в удобном порядке совмещать находящиеся на них фраг-
менты изображения.

Корректирующие слои представляют собой отдельный тип слоев — они явля-
ются своеобразными светофильтрами, сквозь которые вы будете наблюдать
слои, расположенные ниже. Изображение, находящееся на корректирующем
слое (в оттенках серого), не видно само по себе, но позволяет задать степень
влияния слоя на те или иные области холста. Черный цвет соответствует от-
сутствию эффекта в данной точке, белый — полному воздействию на изобра-
жение.

Создание, перемещение и удаление слоев
Существует несколько способов создать новый слой. Фоновый слой создается
в изображении в момент создания нового документа. Нельзя сделать слой фоно-
вым, но даже его отсутствие не скажется на процессе редактирования.

.

ПРИМЕЧАНИЕ
Меню панели вызывается при помощи кнопки со стрелкой, расположенной в верхнем га
правом углу панели.

Для создания нового слоя изображения используйте команду Layer > New > Layer
(Слой > Новый > Слой) или команду New Layer (Новый слой) из меню панели
Layers (Слои). Также можно использовать комбинацию клавиш Ctrl+Shift+N iig~w
или кнопку, расположенную в нижней части панели Layers (Слои).

При вызове любой из этих команд на экран выводится окно создания нового
слоя, показанное на рис. 10.3.
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Рис. 10.3. Окно создания нового слоя

В большинстве случаев для создания нового слоя достаточно просто щелкнуть
на кнопке ОК. При необходимости можно задать следующие параметры слоя:

• Name (Имя) — имя слоя, которое будет отображаться на панели Layers (Слои);
по умолчанию слои получают имена вида Layer N (N — порядковый номер
слоя по порядку создания);

• Use Previous Layer to Create Clipping Mask (Использовать предыдущий слой для
создании обтравочной маски) — установите этот флажок, если вам необходи-
мо, чтобы находящееся на новом слое изображение накладывалось только на
слой, лежащий под ним;

• Color (Цвет) — можно выбрать цвет, которым данный слой будет выделяться
на панели Layers (Слои), на цвет изображения этот параметр не влияет;

• Mode (Режим) — определяет режим наложения текущего слоя на слои, распо-
ложенные под ним; режимы наложения в большинстве случаев аналогичны
режимам наложения, рассмотренным в главе 7;

• Opacity (Непрозрачность) — определяет непрозрачность (или прозрачность,
кто как привык) слоя, задаваемую при его создании; позже можно легко из-
менить этот параметр.

Для некоторых режимов наложения в нижней части окна создания нового слоя
доступен флажок, установив который можно залить новый слой цветом, нейтраль-
ным для данного режима. В данном случае под нейтральным цветом, понимается
цвет, не влияющий на изображение при наложении в выбранном режиме. Эта
возможность полезна при использовании некоторых фильтров, применить ко-
торые к пустому слою нельзя.

Еще один способ создать новый слой — вставить в документ фрагмент изображе-
ния из буфера обмена. При этом новый слой создается автоматически, и на него
помещается новый фрагмент.

Созданный слой помещается на панель Layers (Слои). После этого можно изме-
нить параметр следования слоев. Для этого «перетащите» его на нужную пози-
цию при помощи мыши. Этот процесс показан на рис. 10.4.

Таким способом можно изменить только порядок следования слоев изображе-
ния, но не расположение изображения на них. Для выделения и перемещения
фрагментов изображения используйте инструменты работы с изображением.
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В»

Рис. 10.4. Изменить порядок следования слоев можно, переместив слой при помощи мыши

Возможно, вам потребуется удалить слой изображения. Для этого выделите нуж-
ный слой и перетащите его на кнопку с изображением мусорной корзины, располо-
женную в нижней части панели Layers (Слои). Этот процесс показан на рис. 10.5.

Рис. 10.5. Для удаления слоя воспользуйтесь кнопкой на панели Layers

Можно просто щелкнуть на этой кнопке. При этом на экран будет выведен за-
прос на удаление текущего слоя. Щелкните на кнопке Yes (Да) для удаления
слоя, выделенного в данный момент.

Если вы хотите снять с фонового слоя присущие ему ограничения, воспользуйтесь
командой Layer > New > Layer From Background (Слой > Создать > Слой из фона). При
этом на экран будет выведено окно создания нового слоя. После подтверждения
создания слоя фоновый слой будет преобразован в обычный слой изображения.

ВНИМАНИЕ
Изображения, содержащие слои, нельзя сохранить во многих форматах (например, BMP
или JPEG). Adobe Photoshop может сохранять изображения в этих форматах только после
объединения слоев (данная операция может выполняться автоматически при сохранении
изображения как копии текущего документа).
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Для объединения слоев используйте следующие команды:

• Layer ^ Merge Down (Слой > Объединить нижележащие) или комбинация кла-
виш Ctrl+E — позволяет объединить текущий слой со слоем, расположенным
под ним. При выделении слоя, связанного с другими, эта команда меняется
на команду Merge Linked (Объединить связанные), позволяющую объединить
набор связанных слоев;

• Layer > Merge Visible (Слой > Объединить видимые) или комбинация клавиш
Ctrl+Shift+E — позволяет объединить все слои, видимые в данный момент;

• Layer > Flatten Image (Слой > Выполнить сведение) — объединяет слои изобра-
жения в один фоновый слой. Если часть слоев в данный момент невидима, на
экране появится подтверждение на удаление невидимых слоев.

СОВЕТ
Вы можете использовать аналоги указанных выше команд, находящиеся в меню панели
Layers (Слои).

Параметры слоев и их использование
В этом разделе мы рассмотрим параметры слоев, которые можно использовать
при обработке изображений.

Основным параметром слоя (за исключением фона) является его прозрачность.
Прозрачность слоев была введена в ранних версиях Adobe Photoshop. Она зада-
ется параметром Opacity (Непрозрачность). Данный параметр позволяет управ-
лять прозрачностью находящегося на слое изображения. На рис. 10.6 показаны
два окна документа, для одного из слоев установлены различные значения про-
зрачности.

Рис. 10.6. Вид документа при различных значениях прозрачности одного из слоев;
значение прозрачности: слева — 10 %, в центре — 50 %, справа — 100 %

В Adobe Photoshop CS был введен дополнительный параметр — Fill (Заливка).
Он определяет прозрачность внутренних областей слоя, но не затрагивает, на-
пример, контуры, созданные при помощи слоевых эффектов. Слоевые эффекты
рассматриваются несколько позже.

Значение прозрачности для слоя позволяет контролировать прозрачность изо-
бражения, находящегося на слое, в целом. Полупрозрачные пикселы образуются
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также при использовании рисующих инструментов с кистями, имеющими раз-
мытую форму, или при установленной пониженной прозрачности штриха.

Если изображение не содержит фонового слоя или же он отключен (сделан невиди-
мым), вы увидите прозрачные области в виде «шахматной доски» (рис. 10.7).
Такой рисунок облегчает визуальное различение «заполненных» областей изо-
бражения и прозрачного «холста».

IS UntiJled-2 © 100% (Layer 1., RGB/8) - Га щ

Рис. 10.7. Отображение слоя, содержащего прозрачные области

Обратите внимание: часть изображения является полупрозрачной — «шахмат-
ная доска» на таких участках видна частично, как будто она подложена под по-
лупрозрачную пленку.

Изменить прозрачность слоя или прозрачность его внутренних областей можно
при помощи соответствующих полей ввода, расположенных на панели Layers
(Слои) (см. рис. 10.2). При щелчке на стрелке, расположенной рядом с полем
ввода, на экране появится ползунок, с помощью которого можно изменить зна-
чение параметра.

Еще один удобный способ изменения значения параметра Opacity (Непрозрач-
ность) — применение клавиатуры. При работе с инструментами выделения фраг-
ментов изображения нажатие клавиш 1, 2 ... 9, 0 позволяет задать значения пара-
метра, равньц 10, 20 ... 90 и 100 %. Нажав быстро две клавиши подряд, вы можете
ввести двузначное значение параметра, например 55 %.

СОВЕТ
Аналогичным методом задается прозрачность кисти при работе с рисующими инструментами.

Рядом с полем Opacity (Непрозрачность) находится раскрывающийся список
Mode (Режим), с помощью которого можно изменить режим наложения слоя на
слои, расположенные под ним.
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Кроме прозрачности вы можете изменять видимость слоя и связывать его с дру-
гими слоями. Выполнить эти операции можно при помощи панели Layers (Слои).

На рис. 10.8 показан вид панели Layers (Слои) для изображения, содержащего
два слоя.

Рис. 10.8. Вид панели Layers для изображения, содержащего два слоя

Символ слоя, находящийся на панели, содержит следующие элементы:

• символ видимости слоя — щелкнув по нему мышью, можно отключить щр
отображение слоя на экране и его воздействие на другие слои изображе- Я
ния; для включения слоя щелкните на месте, на котором находился символ ви-
димости (при отключении слоя символ видимости также убирается с панели);

• значек редактирования слоя — этот символ отображается для текущего :г^\
слоя (слоя, выбранного для редактирования); при редактировании мае- в!
ки слоя на месте этого символа выводится символ маски слоя.

ПРИМЕЧАНИЕ
Маска слоя позволяет скрыть некоторые части изображения, находящегося на слое, не уда-
ляя их. Маска слоя может редактироваться как обычное изображения в режиме Grayscale
(Оттенки серого). Маски слоя полезны при создании сложных коллажей или специальных
эффектов, но используются в достаточно сложных проектах, поэтому здесь мы их рассмат-
ривать не будем. Вы можете прочитать о них в одном из подробных руководств по использо-
ванию Adobe Photoshop CS.

• символ связи с другими слоями указывает на то, что данный слой связан
с другими слоями; если один из связанных слоев выделен как текущий
(выбран для редактирования), для связанных с ним слоев будут отображены эти
символы. Можно включить или отключить связь, щелкнув на символе мышью.

Также на панели находится несколько кнопок блокировки, кото-
рые позволяют блокировать параметры и режимы редактирования
слоя. Кнопки (слева направо) позволяют заблокировать прозрачность слоя, ис-
пользование рисующих инструментов, перемещение изображения по слою или
все параметры одновременно.
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ПРИМЕЧАНИЕ
Связанные слои в некоторых случаях обрабатываются одновременно. Например, находя-
щиеся на них изображения синхронно перемещаются при применении инструмента Move
(Переместить). К связанным слоям применимы команды меню Layer > Align Linked (Слой >
Выровнять связанные слои) и Layer > Distribute Linked (Слой > Распределить связанные
слои), позволяющие выравнивать находящиеся на слоях фрагменты изображения или рав-
номерно распределять их вдоль заданного направления. Кроме того, команда Layer > Merge
Linked (Слой > Объединить связанные слои) позволяет объединить все слои, связанные с те-
кущим слоем, в один.

При включении одного или нескольких режимов блокировки напротив на- ~
звания слоя выводится символ блокировки.

Блокировка изображения позволяет избежать случайного изменения изображе-
ния. Например, можно установить блокировку прозрачности и использовать ри-
сующие инструменты (например, Brush (Кисть)), не боясь изменить форму фраг-
мента изображения, находящегося на слое.

СОВЕТ
Получить доступ к параметрам слоя, например его названию, можно при помощи команды
Layer Properties... (Параметры слоя...) из контекстного меню слоя на панели Layers (Слои)
или из меню самой панели.

Использование слоевых эффектов
Слоевые эффекты позволяют быстро применять к слоям (кроме фона) различные
визуальные эффекты и преобразования. Например, можно легко заставить изобра-
жение отбросить тень или добавить к нему каемку. Дополнительным преимущест-
вом слоевых эффектов перед подключаемыми к программе модулями и фильтрами,
выполняющими аналогичные функции, является полная обратимость применения
эффектов — они не изменяют само изображение, находящееся на слое.

Рис. 10.9. Исходная фотография — Русский музей, Санкт-Петербург
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Здесь мы рассмотрим слоевые эффекты на примере наиболее известного и широко
применяемого эффекта — Drop Shadow (Тень). Заодно мы поближе познакомимся
с возможностями, которые предоставляет использование слоев изображения. Вы-
полним простую операцию — снабдим фотографию Русского музея (Санкт-Петер-
бург) рамкой, отбрасывающей тень. Исходная фотография показана на рис. 10.9.

Для начала создадим в изображении новый слой, на рис 10.10 показана панель
Layers (Слои) в этом случае.

Рис. 10.10. Панель Layers при подготовке к выполнению задания
>

После этого воспользуйтесь инструментом Marquee (Выделение) и выделите пря-
моугольную область, которая потом будет открытым внутренним пространством
рамки. Используйте команду Select > Inverse (Выделение > Инвертировать) для
того, чтобы поменять ролями выделенную и невыделенную части изображения —
выделенной окажется площадь будущей рамки. Вид окна документа в этот мо-
мент показан на рис. 10.11.

Рис. 10.11. Выделена область нового, пока еще пустого, слоя — будущая рамка
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Выберите в качестве цвета переднего плана инструмент Fill (Заливка). Убедитесь
в том, что параметр Opacity (Непрозрачность) для инструмента установлен на
100 %. Щелкните левой кнопкой мыши внутри выделенной области — она будет
залита белым цветом. Почти законченная рамка показана на рис. 10.12.

"К IMG_0394.jpg & 2Ь%

Рис. 10.12. Почти готовая рамка

Теперь применим к рамке эффект тени. Для этого выделите слой с рамкой, если
вы выбирали другие слои после выполнения предыдущих действий. Для получе-
ния доступа к слоевым эффектам можно использовать команду Blending Options
(Параметры наложения) из контекстного меню пункта, соответствующего слою
на панели Layers (Слои). Мы используем команду Drop Shadow (Тень) из меню,
выводимого при щелчке на специальной кнопке, расположенной в нижней части
панели Layers (Слои) (рис. 10.13).
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Рис. 10.13. Меню доступа к слоевым эффектам
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При вызове команды Drop Shadow (Тень) на экране появится окно, показанное
на рис. 10.14. В его левой части расположены флажки, позволяющие включать
и выключать отображение различных слоевых эффектов. При щелчке на названии
флажка в правой части окна отображается набор элементов, связанных с этим
эффектом.

Layer Style

Styles

Blending Options: Default

^щщ5Н
О Inner Shadow

Q Inner Glow v ; .';';'.

D Bevel snd Emboss

П satin

n^adient Ouerljy

П Pattern Ova-lay
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Cancel ; . J.

„New Styled"]
: 0 Preview

Qi-ayar Knocks Out Drop Shadow

Рис. 10.14. Окно управления слоевыми эффектами, в данном случае эффектом Drop Shadow

Задайте параметры эффекта. При установленном флажке Preview (Просмотр) вы
сможете наблюдать будущий эффект прямо в окне изображения.

Изменим направление, в котором отбрасывается тень. Для этого при помощи
мыши поверните указатель Angle (Угол) или введите значение 135° в располо-
женном рядом поле ввода.

ПРИМЕЧАНИЕ
Правильнее будет сказать, что задается направление, из которого исходит свет. При уста-
новленном флажке Use Global Angle (Использовать общий угол) изменение значения угла
сказывается на всех эффектах, примененных к текущему слою. Снимите этот флажок, если
такое влияние нежелательно.

Для эффекта зададим Drop Shadow (Тень) следующие параметры:

• Distance (Дистанция) — удаление тени от объекта;

• Spread (Распределение) — задает степень «заполненности» тени цветом; чем
больше этот параметр, тем более четкая тень получится;
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• Size (Размер) — определяет размер тени, в сочетании с параметром Drop Shadow
(Тень) он позволяет задать, насколько темной будет тень и насколько размы-
тыми будут ее границы.

Кроме того, при помощи образца цвета, расположенного в верхней части окна,
и параметра Opacity (Непрозрачность) можно задать цвет и прозрачность тени.

Внешний вид эффекта при одних и тех же значениях параметров зависит от
размеров и разрешения изображения, поэтому в каждом конкретном случае вам
стоит подобрать наиболее подходящие значения. Для применения эффекта щелк-
ните на кнопке ОК. На рис. 10.15 показан конечный вид изображения после при-
менения эффекта.

, IMGjm4.jpg Ф 25% flayer 1, RGB/8);

Рис. 10.15. Конечный вид изображения с рамкой

Итак, в этом разделе вы познакомились с некоторыми возможностями, которые
предоставляет вам использование слоев. Вы узнали, как можно создать новый
слой, настроить и изменить его параметры. Также мы рассмотрели на простом,
но полезном на практике примере возможности применения эффектов слоев.



Глава 11

Работа с цветом в Adobe
Photoshop CS
Пришло время уделить внимание одному из наиболее важных моментов в изуче-
нии Adobe Photoshop CS — работе с цветом. Под «работой с цветом» можно
понимать выбор нужного для конкретной задачи цветового режима, модели
отображения и задания цветов, использование средств выбора цвета. Об этом мы
и поговорим.

Изменение цвета с целью придания изображению необходимого вида называет-
ся цветокоррекцией. В последующих главах вы узнаете, как, используя инфор-
мацию о цвете, предоставляемую Adobe Photoshop CS, изменять по собственно-
му желанию или корректировать оттенки всего изображения или отдельных его
участков. Например, методы цветокоррекции позволяют устранять эффект «крас-
ных глаз».

Цветовая модель RGB
Рассмотрим основные модели представления (или описания) цвета. Компьютер,
обрабатывая изображение, должен оперировать с описывающими его последова-
тельностями чисел. Данная последовательность, как правило, задает положение
точки изображения (пиксела) в области изображения, а сами числа — присвоенный
этой точке цвет. В старых компьютерных системах число цветов ограничивалось
двумя (например, черный и белый), четырьмя, шестнадцатью, а в первых «про-
двинутых» видеоадаптерах VGA — 256. При таком «разнообразии» для выбора
цвета было достаточно указать его номер в записанной в памяти видеокарты па-
литре. О задании для каждого пиксела уникального цвета не могло идти и речи.

ПРИМЕЧАНИЕ
Возможность изменения цветов, записанных в палитре, существовала в некоторых режимах
работы видеоадаптера, но так как палитра описывала оттенки для всего изображения, а не
для конкретного пиксела, изменение оттенка немедленно сказывалось на всех пикселах
изображения, имеющих такой же номер цвета.

По мере развития систем вывода изображений росло и число отображаемых
оттенков. Задавать их просто номером стало неудобно, поэтому разработчики
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аппаратуры и программного обеспечения перешли к другой системе. Для каждого
пиксела стали записывать его собственный код цвета, не связанный с цветом
остальных пикселов. Для точного задания цвета изначально применяли три основ-
ных компонента, используемых для воспроизведения оттенков на экране монито-
ра или обычного телевизора, — красный (Red), зеленый (Green) и синий (Blue).
Так появилась система описания цветов, чаще называемая по первым буквам анг-
лийских названий основных цветов — RGB. Эти цвета так и называют — основные
цвета модели или просто «основные цвета». С этим термином, правда примени-
тельно к краскам, знакомо большинство читателей.

Такая система, или, как ее чаще называют, модель описания цвета, наиболее точно
подходит к принципам вывода изображения на экран монитора — три числа задают
яркость свечения зерен красного, зеленого и синего люминофора в заданной точке
экрана. Поэтому данная модель получила наибольшее распространение в области
компьютерной графики, ориентированной на просмотр изображений на экране
монитора. Светочувствительные матрицы цифровых фотокамер также воспри-
нимают изображение, разделяя его на три компонента — красный, зеленый и си-
ний каналы. Поэтому там также применяется модель представления цвета RGB.

ПРИМЕЧАНИЕ
Некоторые модели цифровых камер регистрируют (воспринимают) изображение не в основ-
ных цветах модели, а в дополнительных к ним цветах. Но конечный результат все равно за-
писывается в виде последовательности чисел, задающих яркость для красного, зеленого
и синего каналов в заданной точке изображения.

Итак, как мы видим, цветовая модель RGB хорошо подходит для описания изо-
бражений, формируемых источниками света — экранами мониторов и плазмен-
ных панелей, мультимедиа-проекторами и другими. Эта же цветовая модель ис-
пользуется при выводе изображения на фотопленку и фотобумагу в цифровых
печатающих машинах.

Так как при задании определенного оттенка в рамках модели RGB цвет форми-
руется в результате сложения света трех источников — красного, зеленого и си-
него, эту модель часто называют аддитивной (суммирующей). Таким образом,
для задания белого цвета необходимо указать для всех трех компонентов макси-
мальные значения яркости, а для задания черного — полностью погасить все ис-
точники (например, точки люминофора), задающие цвет в нужной точке изобра-
жения, — указать для них нулевую яркость. Можно задать любую яркость цвета
при нейтральном цвете, указав одинаковые значения для всех трех цветовых
компонентов.

Так как модель RGB возникла благодаря появлению компьютеров и других
цифровых устройств, яркость ее компонентов задается числами от 0 до 255 (мак-
симальное число, которое можно записать, используя один байт информации).

ПРИМЕЧАНИЕ
Цветовую модель или модель описания цвета часто называют цветовым пространством.
Координатами в этом пространстве служат значения цветовых составляющих. Например,
для модели RGB цветовое пространство является трехмерным.
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Цветовая модель CMYK
Еще одна распространенная модель задания цвета — субтрактивная (вычитаю-
щая) модель. Она основана не на смешении в каждой точке света от источников
базовых цветов, а на вычитании базовых цветов из исходного белого цвета при
помощи светофильтров. Светофильтры могут быть самыми различными — они
используются в прожекторах архитектурной и театральной подсветки, свето-
фильтрами в некотором роде являются наносимые на бумагу красители. Именно
использование смешивания базовых красок для получения полноцветных изо-
бражений при печати дало основу для развития этой модели задания цвета.

В субтрактивной модели применяются следующие базовые цвета — голубой
(Cyan), пурпурный (Magenta), желтый (Yellow) и черный (ЫасК). В англоязыч-
ной литературе и программах такую модель часто называют CMYK (по буквам,
обозначающим основные цвета).

ПРИМЕЧАНИЕ
Собственно, для задания оттенка необходимо только три красителя — голубой, пурпурный и
желтый, но при их использовании невозможно качественно передать черный и другие тем-
ные цвета. Поэтому дополнительно применяется черный краситель для регулировки ярко-
сти получаемого цвета.

Так как цвет в рамках этой цветовой модели получается путем не добавления,
а вычитания каких-либо оттенков из белого цвета, для уменьшения яркости не-
обходимо добавить больше красителя, а для получения чистого белого цвета —
задать нулевое содержание всех компонентов в краске. В модели CMYK, как и при
составлении реальных красок, принято задавать густоту (насыщенность) тех или
иных компонентов в процентах — от 0 (отсутствие красителя) до 100 % (макси-
мально возможная концентрация).

ПРИМЕЧАНИЕ
При печати чистой черной краской на бумаге получается несколько блеклое изображение,
поэтому для полумения густого черного цвета «черную» краску часто задают как смесь
черного и голубого красителей (содержание черного может составлять 100 %, а голубого —
около 80 %). Для получения насыщенного черного цвета могут использоваться и другие
красители в смеси с черным. Смесь всех красителей часто называется цветом совмещения
(registration) и используется для проверки совмещения печатных форм при печати, обеспе-
чения бесшовного соприкосновения черных и полноцветных объектов или для получения
«суперчерного» цвета.

Цветовая модель Lab
Описанные выше модели хорошо подходят для описания изображений, предна-
значенных к выводу на экран монитора или на печать, но они не вполне соответ-
ствуют тому, что воспринимает человеческий глаз. Для наиболее точного зада-
ния цветов в соответствии с особенностями восприятия цвета человеком была
разработана модель Lab. Она получила свое название по основным составляющим:
L (Luminosity — яркость) — определяет яркость конкретной точки изображения,

6 Зак. 805
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а — задает изменение оттенка от красного к зеленому, b — задает изменение оттенка
от синего к желтому. Яркость задается в процентах (от 0 до 100 %), цветовые со-
ставляющие могут принимать значения от -128 до 127. Для задания белого и чер-
ного цветов достаточно установить крайние значения яркости. Нейтральному серо-
му цвету соответствует нулевое значение обеих цветовых составляющих (а и Ь).

Особенности человеческого зрения делают основной характеристикой изобра-
жения его яркость. Вы, наверное, замечали, что в сумерках цвета перестают раз-
личаться, но вы все-таки способны различать очертания объектов. Цвет является
важной, но дополнительной характеристикой.

Основное назначение модели Lab — задание цвета в ходе научных исследований,
точных замерах цвета, преобразование цвета между другими моделями. Она не
связана с каким-либо устройствам вывода информации. Благодаря тому что эта
модель представляет раздельно яркость цвета и его оттенок, она является цен-
ным средством для коррекции изображений или выполнения художественных
эффектов и приемов.

Выше мы кратко рассмотрели основные цветовые модели или пространства
задания цвета. Все они могут использоваться при работе в Adobe Photoshop CS
с изображениями, ориентированными на отображение на экране или цифровую
фотопечать (модель RGB), традиционную печать (модель CMYK) или для об-
работки и коррекции изображений (модель Lab). Ниже рассмотрим несколько
«специализированных» моделей — они применяются в отдельных, специфиче-
ских случаях.

ВНИМАНИЕ
Некоторые команды, фильтры и эффекты могут не работать при переводе изображения в ту
или иную цветовую модель.

Модель Grayscale
Эта модель служит для описания черно-белых или однотонных изображений.
Единственная цветовая координата задает яркость пиксела. Обратите внимание -
хотя в названии модели упоминается серый (нейтральный) цвет, она может ис-
пользоваться при описании однотонных изображений, печатаемых краской, от-
личной от черной.

В Adobe Photoshop эта модель применяется при работе с черно-белыми полутоно-
выми изображениями, выделенными областями в режиме Quick Mask (Быстрая
маска), при сохранении выделенных областей в виде каналов изображения (о ка-
налах изображения речь пойдет чуть ниже), а также при работе с «плашечными»
цветами (строго заданными красками, получаемыми заранее при подготовке к пе-
чати, а не в процессе смешивания базовых цветов).

Преобразование изображения в модель Grayscale позволяет значительно умень-
шить объем файла, что особенно удобно при отправке его по электронной почте.
Разумеется, этот метод применим к изображениям, в которых цвет не важен (на-
пример, чертежи или схемы).
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Модель Bitmap
Эта модель хорошо подходит для описания изображения, каждая точка которого
может иметь только один из двух доступных оттенков. Например, передаваемое
по факсу изображение содержит только черные или белые точки. Ранние модели
мониторов могли отображать пикселы либо черными, либо зелеными или оран-
жевыми (в зависимости от модели монитора).

Такое представление цвета, разумеется, не подходит для цветных изображений,
но двуцветные изображения хорошо поддаются сжатию, поэтому эта модель ши-
роко применяется в устройствах передачи информации и подготовке изображе-
ний к такой передаче (например, по факсу).

Модель Indexed Colors
Данная модель также подразумевает ограниченный набор заданных (индексиро-
ванных) цветов, вызываемых при работе с изображением по номерам. Она широко
используется при сохранении изображений, предназначенных для размещения
в Интернете. Ограничение количества цветов в сочетании со сжатием данных
позволяет существенно уменьшить объем файла (данный метод применяется
в формате файлов GIF).

На практике модель Indexed Colors (Индексированные цвета) является упрощен-
ным вариантом модели RGB, CMYK или Lab — число цветов строго ограниченно,
но каждый цвет может быть задан в рамках одной из этих моделей.

Следует иметь в виду, что уменьшить объем файла можно при переводе в модель
Indexed Colors (Индексированные цвета) изображения, заранее имеющего огра-
ниченную палитру и большие однотонные области (чертежи, диаграммы). Фото-
графии и другие полноцветные изображения при переводе в эту модель теряют
качество, а степень сжатия оказывается невысокой.

СОВЕТ
Для размещения в Интернете чертежей, диаграмм и других подобных изображений исполь-
зуйте цветовую модель Indexed Colors (Индексированные цвета) и формат GIF. Для сохране-
ния фотографий лучше всего подходит формат JPEG, который поддерживает сохранение
изображений, переведенных в цветовые модели RGB и CMYK.

Выбор цветовой модели в Adobe
Photoshop CS
Все описанные выше цветовые модели реализованы в Adobe Photoshop. Инфор-
мация о текущей цветовой модели, или как принято в Adobe Photoshop — режи-
ме, доступна в заголовке окна документа.

На рис. 11.1 вы видите гелевую свечу, а в заголовке окна изображения — имя
файла (IMG_0030.jpg), текущий масштаб просмотра изображения (25 %) и цве-
товой режим (RGB/8 — модель RGB, 8 бит на канал).
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И MG_OD30,jpg g> 25% (RGB/8)

Рис. 11.1. В заголовке окна документа выводится имя файла, а также информация
о текущем масштабе изображения и его цветовом режиме

Выбрать цветовой режим можно с помощью команд меню Image > Mode (Изобра-
жение > Режим), показанного на рис. 11.2.
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Рис. 11.2. Меню выбора и настройки цветового режима изображения

Команды меню, имеющие названия цветовых режимов, служат для перевода изо-
бражения в соответствующую цветовую модель. Обратите внимание — на рис. 11.2
доступны не все команды меню — преобразование изображения в режимы возмож-
но только в определенных направлениях. Например, в режим Bitmap (Битовый)
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или Duotone (Полутона) изображение можно преобразовать, только переведя его
предварительно в режим Grayscale (Оттенки серого).

ПРИМЕЧАНИЕ
Режим Duotone (Полутона) позволяет задать от одной до четырех красок, с помощью кото-
рых будет отпечатано изображение, а также определить для каждой краски кривую зависи-
мости плотности красителя от исходной яркости пикселов. Это позволяет создавать тониро-
ванные изображения или настроить изображение для специфических условий печати.

СОВЕТ
Можно преобразовать изображение в режим Duotone (Полутона), придав ему при этом ори-
гинальный вид, а затем перевести его обратно в режим RGB и продолжить редактирование.
Это позволяет использовать режим Duotone (Полутона), а также другие режимы для приме-
нения художественных эффектов.

Для преобразования изображения в тот или иной режим выберите соответст-
вующую команду меню. Если изображение содержит слои, на экран будет вы-
ведено предупреждение о том, что изменение цветового режима может привести
к изменению взаимодействия между накладывающимися друг на друга слоями
(рис. 11.3).

Adobe Photoshop

/ Changing modes will affect layer compositing. Flatten image before

Flatten Cancel Don't Flatten

Рис. 11.3. Запрос об объединении слоев перед изменением цветового режима изображения

Вам будет предложено объединить слои перед изменением цветового режима.
Для объединения слоев щелкните на кнопке Flatten (Объединить), для отказа от
операции — на кнопке Cancel (Отмена), для изменения цветового режима без
объединения слоев щелкните на кнопке Don't Flatten (He объединять).

Преобразование в режимы RGB, CMYK, Lab производится без дополнительных
запросов. Перед переводом в режим Grayscale (Оттенки серого) на экране по-
явится запрос на уничтожение информации о цвете пикселов (рис. 11.4). Если
изображение содержит несколько слоев, вместо этого запроса будет выведен за-
прос об объединении слоев (рис. 11.3).

Adobe Photoshop

Discard color infori

Q Don't show again

Рис. 11.4. Окно запроса подтверждения преобразования изображения в режим Grayscale
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Перед переводом в другие режимы также могут выводиться запросы, но так как
они редко используются при обработке фотографий, здесь мы не будем их рас-
сматривать. Они подробно рассматриваются во многих книгах, посвященных
изучению общих вопросов работы в Adobe Photoshop.

Выбор цвета при работе с изображением
При работе с различными инструментами или командами вам может
потребоваться выбрать цвет. Чаще всего используются цвета переднего
и заднего плана, образцы которых находятся на главной панели инстру-
ментов.

Справа и сверху от образцов цвета находится кнопка с изображением двойной
стрелки. Она позволяет поменять образцы цвета местами. Слева внизу от образ-
цов цвета находится кнопка, позволяющая установить цвета, принятые по умол-
чанию, — черный цвет переднего плана, белый цвет фона. Для того чтобы поме-
нять образцы цвета местами, удобно использовать горячую клавишу X.

СОВЕТ

Многие инструменты и команды в Adobe Photoshop имеют клавиатурные сокращения («горя-
чие» клавиши), использование которых значительно ускоряет работу. Такие клавиши или
комбинации клавиш, как правило, указываются во всплывающих подсказках, появляющихся
на экране при наведении указателя мыши на кнопку или другой элемент управления. Для
команд меню связанные с ними комбинации клавиш обычно указываются прямо в меню ра-
дом с командой.

Вы можете задать цвет, щелкнув по нужному образцу. При этом на экране по-
явится окно выбора цвета Adobe Photoshop. Оно показано на рис. 11.5.
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Рис. 11.5. Окно выбора цвета в Adobe Photoshop
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В верхней части окна выводится название выбираемого в данный момент цвета
(Foreground color — основной цвет, Background color — цвет фона). В централь-
ной части окна находится поле выбора оттенка, а справа от него — вертикальная
полоса выбора параметра, задаваемого при помощи переключателей. Эти пе-
реключатели расположены рядом с полями ввода параметров, которые находят-
ся в правой части окна.

ПРИМЕЧАНИЕ
Цвет переднего плана используется рисующими инструментами, а также инструментами
работы с текстом и создания векторных форм. Цвет заднего плана применяется для за-
ливки места удаляемых объектов при работе на фоновом слое, при работе инструментов,
стирающих изображение (например, Erase (Стирательная резинка) или Pencil (Карандаш)
в режиме Auto Erase (Стирать)). Оба цвета задействованы при работе некоторых фильтров
Adobe Photoshop.

Установленный при помощи этих переключателей параметр можно изменять
при помощи вертикальной полосы выбора параметра. Щелкните мышью на
нужной точке полосы или проведите по ней мышью, удерживая левую кнопку
нажатой. При этом поле выбора оттенка будет менять свой вид в соответствии
с указанным вами при помощи полосы значением выбранного параметра. На
рис. 11.5 в качестве параметра, отображаемого на полосе, установлен параметр
Н — Hue (Оттенок).

В поле выбора оттенка находится круглый указатель текущего оттенка. Щелкни-
те мышью в нужной точке поля для выбора наиболее подходящего цвета. Вы-
брать цвет также можно, введя нужные значения цветовых координат в соответ-
ствующие поля. При изменении одного из параметров остальные будут меняться
в зависимости от влияния указанного вами параметра на цветовые координаты
в других моделях.

Обратите внимание — параметры цвета сгруппированы по цветовым моделям,
к которым они относятся. В окне выбора цвета присутствуют модели RGB,
CMYK и Lab, а также не рассматривавшаяся нами ранее модель HSB.

ПРИМЕЧАНИЕ
В окне выбора цвета можно выбрать любой из параметров любой модели (кроме модели
CMYK) для отображения на полосе выбора параметра. При этом два других параметра будут
отображаться в поле выбора оттенка.

Модель CMYK имеет четыре цветовые координаты, поэтому отобразить ее при помощи трех
координат (две — поле выбора оттенка, еще одна — полоса выбора параметра) нельзя. За-
дать цвет в модели CMYK можно только при помощи полей ввода.

Модель HSB (Hue Saturation Brightness — цветовой тон, насыщенность, яркость)
не связана с каким-либо устройством вывода. Она широко используется, по-
скольку позволяет легко задать нужный оттенок, не прибегая к цветовым коор-
динатам текущей цветовой модели изображения. Таким образом, если цвет до-
пустим, например, в моделях RGB и CMYK, он будет задан при помощи модели
HSB совершенно одинаково, хотя цветовые координаты моделей изображения
(в данном примере — RGB и CMYK) не имеют между собой ничего общего.
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Еще одно преимущество модели HSB — она непосредственно предоставляет ин-
формацию о насыщенности изображения, его яркости и оттенке. Знать эти пара-
метры полезно при выполнении цветокоррекции.

В правой части окна также находится образец выбранного цвета. В про-
цессе выбора цвета в правой части окна отображаются текущий основ-
ной цвет или цвет фона (в нижней части образца), а также цвет, выбран-
ный вами в данный момент в окне выбора цвета (в верхней части индикатора).

Если выбранный вами цвет не может быть отображен в рамках цветовой л •
модели CMYK, рядом с образцом цвета выводится предупреждающий сим- :
вол и образец ближайшего допустимого оттенка. Щелкнув на нем левой
кнопкой мыши, можно установить его в качестве нового цвета переднего или
заднего плана.

Похожий символ вы увидите, если выбранный вами цвет выйдет за преде- щв
лы так называемой «безопасной палитры web». Щелкнув на символе, вы г~т
сможете выбрать в качестве нового цвета оттенок, предложенный вам Adobe
Photoshop. В нижней части окна цвета находится флажок Only Web Colors (Только
цвета Web). Если он установлен, в поле выбора цвета вы увидите только цвета,
входящие в «безопасную палитру».

ПРИМЕЧАНИЕ
Безопасной палитрой Web называют набор из 216 цветов, одинаково отображаемых в боль-
шинстве операционных систем и браузеров. После появления и широкого распространения
видеоадаптеров, поддерживающих отображение тысяч и даже миллионов цветов, «безо-
пасная палитра» перестала быть актуальной — практически любой цвет может быть воспро-
изведен на компьютере пользователя с достаточной точностью.

Еще одно средство, ориентированное в основном на веб-дизайнеров, — поле, со-
держащее код цвета в формате, принятом в языке описания структуры веб-стра-
ниц — HTML. Это поле расположено в нижней части окна выбора цвета и имеет
обозначение # — символ кода цвета в языке HTML. Можно выбрать подходящий
цвет в окне выбора цвета и скопировать появившийся в этом поле код в HTML-
документ. Также можно ввести или скопировать в это поле готовый код. В окне
выбора цвета вы увидите соответствующий ему цвет.

Выбрав нужный вам цвет, щелкните на кнопке ОК. Для отмены изменения цве-
та щелкните на кнопке Cancel (Отмена). При нажатой клавише Alt она сменится
кнопкой Reset (Восстановить), позволяющей вернуть окно выбора цвета в состоя-
ние, соответствующее моменту вывода его на экран.

Рядом с кнопкой Cancel (Отмена) находится кнопка Custom (Произвольный). Если
щелкнуть на ней, окно выбора цвета примет вид, показанный на рис. 11.6. При
этом вы сможете выбрать цвет из одного из каталогов цветов, доступных в Adobe
Photoshop CS. Выбор стандартного цвета из каталога может понадобиться, на-
пример, при подготовке изображения к печати.

Раскрывающийся список Book (Каталог) позволяет выбрать каталог цветов, из
которого вам предстоит выбрать цвет. При помощи расположенной в центре окна
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полосы и увеличенного фрагмента каталога, расположенного в левой части окна,
вы можете выбрать нужный цвет. Если известен код цвета, выберите нужный ка-
талог, после чего введите начальную часть кода с клавиатуры. Подходящий цвет
будет автоматически отображен на экране.

Custom Colors

Book: PANTONE® solid coated

PANTONE 300 С

PANTONE 301 С

PANTONE 302 С

mem
PANtONE Wit

1 .Cancel .1

1,Г Picker J

Type a color name to .
select it in the color list.

Рис. 11.6. Окно выбора цвета в режиме работы с каталогами цветов

В момент переключения окна выбора цвета в режим работы с каталогами цветов
или при выборе другого каталога производится автоматический подбор цвета из
каталога, ближайшего к выбранному в данный момент цвету.

Для возврата в режим произвольного выбора цвета щелкните на кнопке Picker
(Выбор).

Увидеть цвета переднего и заднего плана и изменить их также можно при помощи
панели Color (Цвет). Она показана на рис. 11.7.

Рис. 11.7. Панель Color, служащая для выбора цвета переднего и заднего плана

На этой панели, так же как и на главной панели инструментов, находятся образ-
цы цвета переднего и заднего плана. Один из них может быть выбран для изме-
нения. При этом его образец обводится двойной чертой, а цветовые компоненты
отображаются на ползунках и полях ввода, находящихся на панели.
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Еще один способ выбрать цвет — воспользоваться спектром, расположенным
в нижней части панели. Укажите мышью нужную точку спектра и щелкните
левой кнопкой мыши.

Используя меню панели, вы можете переключить режим отображения ползун-
ков для выбора цвета, а также вид спектра.

ПРИМЕЧАНИЕ
Для вывода на экран меню панели нажмите кнопку со стрелкой, расположенную на панели
в правом верхнем углу.

Если вам часто приходится выбирать один и тот же цвете, воспользуйтесь пане-
лью Swatches (Каталог), показанной на рис. 11.8. На этой панели представлены
образца цвета, сохраненные в специальных файлах каталогов цветов.

Рис. 11.8. Панель Swatches — сборник образцов цвета

Для выбора цвета переднего плана щелкните на нужном образце левой кнопкой
мыши. Щелчок при нажатой клавише Ctrl позволит выбрать цвет заднего плана.

При помощи команд меню панели можно загружать на эту панель различные ка-
талоги цветов, входящие в комплект программы или созданные вами. Команда
New Swatch (Новый образец) позволяет добавить новый образец цвета. Образец
создается на основе цвета переднего плана. Для создания образца на экран выво-
дится окно, в котором вы можете ввести название образца.

Использование инструмента Eyedropper
Инструмент Eyedropper (Пипетка) позволяет выбрать образец основного ; ж
или фонового цвета из любой точки изображения. Это удобно, например, *"**
для закрашивания небольших дефектов, подбора цвета для надписей, получения
данных о цвете, принадлежащем указанной точке изображения.

Выбрав этот инструмент, щелкните левой кнопкой мыши в нужной точке изо-
бражения. Это позволит выбрать цвет переднего плана. Для выбора заднего пла-
на щелкните в нужной точке при нажатой клавише Alt.

Так как фотографии редко содержат однотонные области, полезно бывает полу-
чить образец цвета, усредненного по некоторой площади. По умолчанию инстру-
мент Eyedropper (Пипетка) позволяет выбрать образец цвета из одного указанно-
го пиксела. При помощи раскрывающегося списка Sample Size (Размер образца)
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можно указать, с какой площади будет выбираться образец цвета. Значение Point
Sample (Точка) соответствует выбору цвета из одной точки. При выборе ,значе-
ний 3 Ьу 3 Average (В среднем 3x3) или 5 by 5 Average (В среднем 5x5) образец
цвета будет получен при усреднении значений цвета, собранных с площади 3 x 3
или 5 x 5 пикселов.

И

Получение информации о цвете
и положении курсора
Можно оперативно получать информацию о положении курсора, размере выде-
ленной области и цвете в указанной точке. Эти данные выводятся на панели Info
(Информация), показанной на рис. 11.9. Они могут существенно помочь вам как
при исправлении различных недостатков изображения (в основном при цвето-
коррекции), так и при выделении фрагментов изображений.

Рис. 11.9. Панель Info предоставляет информацию о положении курсора,
размере выделенной области и цвете в указанной точке

В верхней части панели выводится информация о цветовых составляющих цвета
пиксела, на который в данный момент указывает курсор. Эти данные выводятся
при перемещении указателя мыши (курсора) над областью изображения редак-
тируемого документа.

СОВЕТ
Вы можете узнать параметры цвета, выбрав его в качестве цвета переднего или заднего
плана и открыв диалог выбора соответствующего цвета.

Обратите внимание — данные о цвете выводятся дважды. Щелкнув на кноп- ^
ке с изображением пипетки, вы сможете выбрать, в какой цветовой модели -
будет выводиться информация о цвете в выбранной вами части панели.

Вы можете выбрать отображение цвета в режимах RGB, CMYK, Lab, Grayscale (От-
тенки серого), HSB, Web Colors (Цвета Web). В режиме Web Colors (Цвета Web) на
панели будут выводиться коды цветовых составляющих RGB в шестнадцатерич-
ном формате, принятом в языке разметки веб-страниц — HTML. Кроме того,
если изображение находится в режиме Indexed Colors (Индексированные цвета),
вы сможете видеть номер указанного цвета в палитре цветов, соответствующей
редактируемому изображению.
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Кроме того, можно выбрать один из специальных режимов:

• Actual Color (Текущий цветовой режим) — цвет будет отображаться в цвето-
вом режиме, установленном для изображения;

• Proof Color (Допустимый цвет) — вы сможете наблюдать ближайший к указан-
ному цвету оттенок, допустимый в цветовом режиме CMYK; это полезно при
подготовке изображений к печати;

• Total Ink (Суммарная плотность краски) — позволяет определить общую
плотность краски, которая будет нанесена в указанную точку при печати;
этот режим полезен при подготовке изображения к печати, вы сможете про-
следить за тем, чтобы количество краски не превысило уровень, при кото-
ром бумага начнет коробиться, а изображение будет выглядеть непривле-
кательно;

• Opacity (Непрозрачность) — позволяет определить непрозрачность изображе-
ния в указанной точке; применим к изображениям, находящимся на прозрач-
ном фоне, в противном случае вы будете все время наблюдать значение 100 %.

Под информацией о цвете на панели Info (Информация) выводятся данные о по-
ложении курсора (в выбранных для данного документа единицах измере- _,
ния). Щелкнув на кнопке с изображением курсора, можно выбрать едини- *
цы измерения из появившегося на экране меню.

Выбор глубины цвета
Вы, наверное, обратили внимание, что вместе с обозначением цветового режима
в заголовке окна документа выводятся некоторые цифры (см. рис. 11.1). Эти
цифры указывают глубину цвета — число бит, отводимых для записи информа-
ции о каждой из цветовых составляющих (каналов), задающих цвет всех пикселов
изображения.

Adobe Photoshop может работать с изображениями, имеющими глубину цвета
8 или 16 бит. Стандартным и принятым в большинстве программ является ре-
жим 8 бит/канал. В предыдущих версиях Adobe Photoshop режим 16 бит/канал
предназначался только для загрузки изображений с профессиональных скане-
ров, имеющих большой цветовой охват.

ПРИМЕЧАНИЕ
В режиме 16 бит/канал для записи значений цветовых составляющих отводится больше
места, поэтому код цвета может быть определен и записан точнее, чем в обычном режиме
8 бит/канал. Однако использовать его при обработке всех изображений не имеет смысла,
так как большинство устройств не способны воспринять или отобразить цвет с такой точ-
ностью, а многие программы не в состоянии обрабатывать файлы, записанные в режиме
16 бит/канал.

В Adobe Photoshop CS можно использовать инструменты редактирования изо-
бражения и некоторые фильтры в режиме 16 бит/канал. Однако выбирать этот
режим стоит только тогда, когда это действительно необходимо.
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Для переключения между режимами глубины цвета выбирайте команды Image >
Mode > 8 bit/channel (Изображение > Режим > 8 бит/канал) и Image > Mode > 16 bit/
channel (Изображение > Режим > 16 бит/канал).

Цветовые модели и цветовой охват
Важной характеристикой цветовой модели является ее цветовой охват — число
оттенков, которые могут быть представлены в рамках данной модели. Цветовой
охват каждой модели отличается от других. Это вызвано различиями в числе цве-
товых координат, их допустимых значений, а также физическим смыслом явле-
ний, используемых при выводе изображений на то или иное устройство.

Наибольшим цветовым охватом обладает модель Lab, она включает в себя цве-
товые пространства, описываемые всеми другими моделями, рассматриваемыми
в этой книге. Модель RGB имеет меньший цветовой охват, а модель CMYK —
еще меньший. Модель Grayscale (Оттенки серого) в ее компьютерном вариан-
те позволяет описать до 256 градаций серого (включая белый и черный цвета).
В модели Indexed Colors (Индексированные цвета) число цветов, как правило,
не превышает 256, а в модели Bitmap (Битовая)-задается всего два цвета, причем
сами цвета определяются не цветовой моделью, а устройством, на которое изо-
бражение будет выведено.

Это вызывает различные проблемы при переводе изображения из одной цвето-
вой модели в другую. Вы можете без потери качества перевести изображение из
модели RGB или CMYK в модель Lab, но не наоборот. При обратном преоб-
разовании (не говоря уже о моделях, не предназначенных для описания пол-
ноцветных изображений) часть оттенков будет утеряна. На практике они будут
заменены ближайшими к ним «допустимыми» оттенками, что далеко не всегда
соответствует пожеланиям автора произведения.

Наибольшие проблемы из-за несоответствия цветовых охватов различных цве-
товых моделей возникают при подготовке изображения к печати. Принтеры вы-
водят изображение в цветовой модели CMYK. Для того чтобы избежать искаже-
ния цветов при печати, необходимо преобразовать изображение в режим CMYK
до отправки на печать.

ПРИМЕЧАНИЕ
Цифровые машины для вывода изображений на фотобумагу и фотопленку работают в цве-
товой модели RGB, поэтому преобразование изображения в режим CMYK не только не требу-
ется, но и может помешать работе машины.

В момент преобразования цветового режима можно заметить изменение цветов
невооруженным взглядом, если, конечно, они будут иметь место. Но проверить,
какие точки изображения изменят свой цвет при преобразовании в режим CMYK,
можно еще до выполнения преобразования.

При вызове команды View > Gamut Warning (Вид > Предупреждение о выходе из
цветового охвата) части изображения, окрашенные в цвета, недопустимые в ре-
жиме CMYK, будут закрашены отдельным цветом (по умолчанию — серым).
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Для отключения этого режима просмотра вызовите команду View > Gamut W a r n i n g
(Вид > Предупреждение о выходе из цветового охвата) еще раз.

СОВЕТ
Для переключения в режим просмотра оттенков допустимых в режиме CMYK, и обратно,
можно использовать комбинацию клавиш Ctrl+Shift+Y.

Вы также можете просматривать изображение и в других режимах. Для этого
выберите режим, используя команды подменю View > Proof Setup (Вид > Настройка
цветопробы). Команда View > Proof Colors (Вид > Цветопроба) позволяет просмо-
треть изображение в этом режиме. Для перехода в режим просмотра изображения
в выбранном цветовом режиме и обратно можно применить комбинацию кла-
виш Ctrl+Y.

После включения режима просмотра изображения в том или ином цветовом
режиме или режиме отображения недопустимых в режиме CMYK оттенков вы
можете применять различные инструменты и команды. При этом вы сможете на-
блюдать за их эффектом и корректировать изображение, с тем чтобы уменьшить
искажение цветов.

В этой главе рассматривались средства и особенности работы с цветом в Adobe
Photoshop CS. Вы познакомились со способами выбора цвета и определения цве-
товых составляющих цвета в указанной точке изображения. Теперь вы знаете,
что такое цветовые режимы и модели, как осуществить переход между ними и как
просмотреть изображение в том или ином режиме.



Глава 12

Выделение фрагментов
изображения
Очень часто при работе с графикой возникает необходимость выделить часть
изображения. Это может понадобиться для выборочного применения команды
или фильтра, перемещения или удаления объектов, рисования в ограниченной
области и многого другого. В этой главе мы рассмотрим способы создания вы-
делений различной формы, а также методы выделения фрагментов изображений.

Выделение областей изображения
в Adobe Photoshop
Прежде всего, следует сказать несколько слов о том, что представляет собой
«выделение». Под этим термином понимают область изображения, отделенную
от остального рисунка специальными методами. Выделенная область остается
частью изображения (до особой команды она не выносится на отдельный слой
или в отдельный файл). Все действия, обычно выполняемые над всем изображе-
нием, при наличии выделения выполняются только над пикселами, находящи-
мися внутри него. В окне документа граница выделения отображается в виде пе-
реливающейся пунктирной линии.

В Adobe Photoshop выделения задаются с помощью так называемых альфа-кана-
лов. Альфа-канал — это самостоятельное монохромное изображение, содержа-
щие до 256 градаций яркости и имеющее размер, равный размеру изображения.
Таким образом, каждой точке обычного изображения при создании выделенной
области ставится в соответствие точка в альфа-канале. Цвет этой точки опреде-
ляет степень «выделенности» точки обычного изображения. Черный обозначает
полное выделение (ГОО %), белый — отсутствие выделения (0 %), оттенки серо-
го — промежуточные степени. Например, если точка в альфа-канале имеет цвет
50 % черного, то точка на изображении будет выделена на 50 %. Это значит, что
все применяемые к ней операции будут ослаблены на 50 %. К точкам, выделен-
ным на 100 %, все действия применяются в полной мере. К невыделенным (точ-
кам белого цвета в альфа-канале) команды и эффекты не применяются. Такое
представление о выделении участков изображения позволяет редактировать вы-
деление как обычное изображение. При этом можно использовать практически
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все инструменты, фильтры и команды. Работа в этом режиме рассматривается
позже. Начнем рассмотрение работы с выделенными областями изображения
с самых простых приемов.

ПРИМЕЧАНИЕ
Одно из основных назначений выделенных областей — копирование графических объек-
тов. Для того чтобы скопировать выделенный фрагмент, используйте команду Edit > Copy
(Редактирование > Копировать) или комбинации клавиш Ctrl+C или Ctrl+Insert. Используя
команду Edit > Cut (Редактирование > Вырезать) или сочетания клавиш Ctrl+Del или Ctrl+X,
можно вырезать фрагмент изображения, поместив его в буфер обмена. При помощи команды
Edit * Paste (Редактирование > Вставить) можно вставить в изображение фрагмент из буфе-
ра обмена. Если текущий спой не пустой, то фрагмент будет помещен на новый слой. Для
этой же цели можно применить комбинации клавиш Ctrl+V или Shift+Insert. В меню Edit
(Редактирование) и в контекстных меню изображения находятся еще несколько команд,
позволяющих оперировать фрагментами изображений.

Быстрое выделение всего изображения
и снятие выделения
Команды управления выделенными областями изображения находятся в меню
Select (Выделить). Среди них есть команды, часто используемые при выполне-
нии даже простых действий по обработке изображений, например:

• Select > All (Выделить > Все) — позволяет выделить все изображение. Вы так-
же можете использовать комбинацию клавиш, Ctrl+A;

• Select > Deselect (Выделить > Снять выделение) — снимает выделение с фраг-
мента изображения. Комбинация клавиш, связанная с этой командой, — Ctrl+D.

Инструменты выделения фрагментов
изображения
Adobe Photoshop предоставляет пользователям набор инструментов для работы
с выделениями. Доступ к ним осуществляется при помощи кнопок, расположен-
ных в верхней части панели инструментов. Они показаны на рис. 12.1.

Рис. 12.1. Кнопки вызова инструментов работы с выделенными областями изображений

Рассмотрим эти инструменты подробнее. Первый и наиболее часто исполь-
зуемый инструмент — Rectangular Marquee (Прямоугольное выделение).
Для выделения прямоугольного участка изображения подведите курсор к точке,
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в которой должен находиться верхний левый угол выделения, нажмите левую
кнопку мыши и, перемещая мышь, выделите нужный участок. После этого от-
пустите кнопку мыши. Если при этом держать нажатой клавишу Alt, выделение
рисуется не от верхнего левого угла, а от центра. Удерживая клавишу Shift, мож-
но создать выделение квадратной формы.

СОВЕТ
Во многих случаях клавиша Shift служит для создания объектов правильной формы или для
сохранения ее во время преобразований. Например, если, масштабируя объект, вы буде-
те удерживать эту клавишу, будут сохранены пропорции объекта. Это относится не только
к Adobe Photoshop, но и к другим программам.

Можно изменить действие инструмента Rectangular Marquee (Прямоугольное вы-
деление). Для этого щелкните на соответствующей кнопке на панели инструмен-
тов и удерживайте ее некоторое время. На экране появится меню выбора инстру-
ментов, изображенное на рис. 12.2.

1 T~l Rectangular Marquee Tool M
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("J ElliplicatM«rqueeT.orf ; • • • ' : • : - '?'•:• ' • ; ' ••- '• . , :M•.

Й-ГЛ Single Row Marquee tool : 1 .

E| Single Column Marquee Tool : :

Рис. 12.2. Меню выбора инструментов, используемых для создания выделения заданной формы

Представленные в нем инструменты предназначены для создания выделения за-
данной формы, такой как прямоугольник, эллипс или линия.

Инструмент Elliptical Marquee (Овальное выделение) напоминает инструмент
Rectangular Marquee (Прямоугольное выделение), с той лишь разницей, что мож-
но выделять овальные области. При нажатой клавише Shift образуется выделе-
ние, имеющее форму правильного круга. Инструменты Single Row Marquee (Выде-
ление строки пикселов) и Single Column Marquee (Выделение столбца пикселов)
предназначены для выделения области высотой или шириной в один пиксел. На
практике они используются редко.

Инструменты выделения можно настраивать, для этого служит панель настрой-
ки. Она изображена на рис. 12.3.

L. Fuihirti 0 р. : '•••' ••••-. : Щ 'NU™,I

Рис. 12.3. Вид панели настройки при работе с инструментом Rectangular Marquee

В поле Feather (Растушевка) указывается, на сколько пикселов будет «размыто»
выделение. Если это значение отлично от 0, границы выделенной области будут
нечеткими. При установленном флажке Anti-aliased (Сглаживание) скругленные
границы выделения сглаживаются. Это делается для устранения «ступенек». Из
раскрывающегося списка Style (Стиль) можно выбрать режим построения выде-
ления. Доступны три варианта:

• Normal (Нормальный) — выделение полностью контролируется движением
мыши;
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• Constrained Aspect Ratio (Фиксированное соотношение сторон) — независимо
от движения мыши поддерживается заданное соотношение размеров выделе-
ния по горизонтали и по вертикали; числа, определяющие ширину и высоту
выделенной области, вводятся в поля Width (Ширина) и Height (Высота);

• Fixed Size (Фиксированный размер) — выделенная область будет иметь задан-
ные в полях Width (Ширина) и Height (Высота) размеры.

Стили работают при работе с прямоугольным и эллиптическим выделением.

СОВЕТ
Стиль Constrained Aspect Ratio (Фиксированное соотношение сторон) очень удобен, если
требуется вырезать множество фрагментов одного размера из различных по размерам ис-
ходных изображений. В этом случае выделенные фрагменты легко масштабировать, приво-
дя к нужным габаритам.

Еще одна группа инструментов предназначена для создания выделения f£p
произвольной формы. Главный из них (хотя и не самый нужный) — Lasso ! Е*
(Лассо). С его помощью можно выделять участки изображения любой формы.
Достаточно провести мышью по нужной траектории, удерживая левую кнопку
нажатой. При отпускании кнопки траектория автоматически замыкается, обра-
зуя выделенную область. Если удерживать нажатой клавишу Alt, то после щелч-
ка в некоторой точке можно, не нажимая кнопку мыши, провести линию. Ее ко-
нец определяется следующим щелчком.

Щелкнув на кнопке инструмента Lasso (Лассо) и подержав ее нажатой некоторое
время, можно вызвать меню выбора инструментов работы с выделением произ-
вольной формы. Оно показано на рис. 12.4.

• 'OUssoTool :1
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Рис. 12.4. Меню выбора инструментов для работы с выделением произвольной формы

Инструмент Polygonal Lasso (Многоугольное лассо) предназначен для по- г-ж-
строения выделения в виде многоугольника с прямыми гранями. Углы *>*
многоугольника определяются щелчками мыши. Для замыкания контура не-
обходимо приблизить курсор к начальной точке (при этом форма курсора из-
менится) и щелкнуть мышью. Если, рисуя контур, удерживать клавишу Shift,
линии будут строиться под углами, кратными 45°.

Наиболее интересный инструмент этой группы — Magnetic Lasso (Магнит- гщр
ное лассо). С его помощью можно быстро выделить объект, имеющий чет- 1**
кий контур. Для этого достаточно щелкнуть на границе объекта и вести курсор
вдоль нее. При достижении начальной точки надо еще раз щелкнуть мышью.
Клавиша Alt позволяет в процессе построения выделения временно перейти в ре-
жим многоугольного лассо. Щелчок мыши при нажатой клавише Ctrl приводит
к немедленному замыканию выделения. Клавиша Shift позволяет автоматически
строить выделение из отрезков прямых.



Инструменты выделения фрагментов изображения 179

Инструмент Magnetic Lasso (Магнитное лассо) имеет сложную систему настроек.
Параметр Width (Ширина), уже встречавшийся ранее, в данном случае определяет
размеры зоны изображения, анализируемой при перемещении указателя мыши
над изображением. Параметр Edge Contrast (Контраст краев) определяет, какая
разность яркости соседних пикселов будет распознаваться как граница объекта.
Если выделяемый объект имеет малоконтрастную границу, этот параметр следует
уменьшить. Для контрастных изображений можно увеличить значение контра-
ста. При помощи параметра Frequency (Линиатура) можно задать, с какой часто-
той будут расставляться опорные точки выделения. При работе с выделениями
сложной формы имеет смысл уменьшить интервал между опорными точками.

СОВЕТ
Опорные точки выделения создаются автоматически и позволяют изменять только что про-
веденную линию выделения, не затрагивая при этом линии, проведенные ранее. Вы можете
ставить их вручную. Для этого достаточно во время обводки контура щелкнуть в нужной
точке мышью.

Если вам необходимо выделить однотонный фрагмент изображения, по- щ;"1
пробуйте воспользоваться инструментом Magic Wand (Волшебная палочка). !—si
Выберите этот инструмент и щелкните мышью внутри области, подлежащей вы-
делению. Все пикселы, имеющие цвет, схожий с цветом отмеченного пиксела
и непосредственно связанные с ним, будут выделены. Настройки инструмента
позволяют достаточно гибко настраивать этот процесс. Параметр Tolerance (До-
пуск) определяет, насколько может отличаться цвет выделяемых точек от цвета
пиксела, с которого была начата работа инструмента. Уменьшите его значение
для более точного выделения, для выделения более широкого диапазона оттен-
ков его надо увеличить. Флажок Anti-aliased (Сглаживание), как уже было сказа-
но, позволяет сделать границы выделения гладкими. Если установлен флажок
Contiguous (Смежные), выделены будут только пикселы, соприкасающиеся с точ-
кой начала выделения через другие выделенные пикселы, Сняв этот флажок,
можно выделить все точки изображения, имеющие подходящий оттенок. Уста-
новив флажок Use All Layers (Все слои), можно строить выделение, используя ин-
формацию обо всех содержащихся в файле слоях.

Если в документе уже имеется выделенная область, действие описанных выше
инструментов несколько меняется. Появляется возможность передвигать гра-
ницы выделения и выделенный фрагмент изображения, добавлять к выделению
новые области или вычитать их. При наведении курсора на выделенную область
(при этом должен быть выбран инструмент для работы с выделением) он изме-
нит свою форму. Для перемещения выделения нажмите левую кнопку к
мыши и, удерживая ее, переместите выделенную область. Если при этом :::

удерживать нажатой клавишу Ctrl, перемещаться будет не граница выделения,
а выделенная область изображения. При этом форма курсора также изменится.

СОВЕТ
Перемещать подобным образом фрагменты изображения можно при работе практически со
всеми инструментами Adobe Photoshop. Если выделенная область отсутствует, перемещает-
ся все изображение, находящееся на активном слое (за исключением фона).
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Клавиши Alt и Shift позволяют вычитать фрагменты из выделения или добавлять
к нему новые участки. Для выполнения этой операции пользуйтесь инструмен-
том выделения, удерживая соответствующую клавишу нажатой. При вычитании
фрагментов выделения рядом с курсором отображается знак «-», при добавле-
нии — «+». Если удерживать нажатыми Alt и Shift одновременно, к выделенной
области будет применяться операция «логическое И». Это значит, что после при-
менения инструмента выделенной останется область, являющаяся пересечением
изначально выделенного фрагмента и только что обведенного участка. Во время
выполнения подобной операции рядом с курсором выводится значок «X». Все
эти режимы можно вызывать при помощи кнопок, находящихся на панели на-
стройки. Они отвечают за следующие режимы (слева направо): нор-
мальный (создание нового выделения), добавление к существую-
щему выделению, вычитание из выделения, режим пересечения.

СОВЕТ
Удерживая одновременно нажатыми клавиши Ctrl и Alt, можно копировать выделенный
фрагмент изображения в пределах текущего слоя.

Создав выделенную область, можно в любой момент удалить ее. Для этого доста-
точно щелкнуть на невыделенном участке изображения (при этом должен быть
выбран «выделяющий» инструмент). Еще один способ удалить выделение — ис-
пользовать клавиатуру: нажмите сочетание клавиш Ctrl+D.

СОВЕТ
При помощи клавиатуры можно не только удалять выделение, но и вызывать его. Комбина-
ция Ctrl+A позволяет выделить все изображение. При помощи комбинации Ctrl+Shift+D
можно вызвать последнюю использовавшуюся выделенную область. В меню Select (Вы-
делить) находятся аналогичные команды: АИ (Все), Deselect (Убрать выделение), Reselect
(Восстановить выделение).

Инструменты, предназначенные для работы с. выделениями, очень полезны. С по-
мощью уже рассмотренных нами способов можно выделять объекты прямоуголь-
ной, эллиптической и более сложной формы, отделять объекты от фона (при помо-
щи инструментов Magnetic Lasso (Магнитное лассо) или Magic Wand (Волшебная
палочка)), перемещать их. Но во многих случаях их возможностей оказывается
недостаточно. Тогда можно использовать более сложные средства.

Выделение пикселов сходных оттенков
на всей площади изображения
Если вам требуется выделить на всем изображении однотонные пикселы, удобнее
всего воспользоваться командой Select > Color Range (Выделение > Цветовой диапа-
зон). После ее вызова на экране появится окно управления, показанное на рис. 12.5.

В левой части окна находится уменьшенная копия изображения, на которой ото-
бражаются само изображение или его выделенная область. Выделение произво-
дится путем задания образца цвета (при помощи «пипеток») и выбора разброса
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цвета выделяемых пикселов (при помощи ползунка Fussiness (Разброс), располо-
женного над копией изображения). При разбросе, равном 0, выделяются только
пикселы выбранного цвета. Если разброс равен 200, выделенным окажется все
изображение. При промежуточных значениях пикселы, имеющие выбранный
цвет, выделяются полностью. Пикселы, цвет которых несколько отличается от
выбранного, выделяются частично. Это значит, что все команды, фильтры и эф-
фекты будут применяться к ним в зависимости от степени выделения.

Рис. 12.5. Окно настройки команды Color Range

Ниже копии изображения находятся два переключателя — Selection (Выделение)
и Image (Изображение). Они указывают программе, что отображать в окне на-
стройки команды — выделенную область изображения или само изображение.

В правой части окна находятся кнопки для вызова пипеток, позво- р*̂ ! i'^ ^
ляющих выбирать выделяемые оттенки. Обычная пипетка позволя- :ucJ:W.';-: '̂~
ет выбрать цвет, от которого отсчитываются оттенки выделяемых
точек (в зависимости от заданного разброса). «Пипетка с плюсом» позволяет до-
бавить к выделению оттенки, не попавшие в него после первого выбора цвета.
Например, после выбора простой «пипеткой» красного цвета на изображении
оттенки зеленого выделяться не будут. Для того чтобы «захватить» и их, надо
использовать «пипетку с плюсом». «Пипетка с минусом», наоборот, предназна-
чена для исключения оттенков из выделенной области.

СОВЕТ
Щелкнув мышью на кнопке выбранной в данной момент «пипетки», вы можете вызвать
на панель настроек список Sample Size (Размер образца). Он позволяет указать, будет ли
образец цвета браться из указанной «пипеткой» точки или же будет взят оттенок, усреднен-
ный по некоторой площади ( 3 x 3 или 5 x 5 пикселов).

Строить выделение можно не только на основе выбранных образцов цвета, но
и при помощи предустановленных значений. Для того чтобы воспользоваться
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ими, выберите нужный пункт из раскрывающегося списка Select (Выделение).
Пункт Selected Colors (Выбранные цвета) соответствует режиму выбора цветов,
остальные пункты определяют некоторый цветовой диапазон. В зависимости от
цветового режима, в котором находится изображение, набор доступных вариан-
тов выделения может изменяться. При выборе фиксированного диапазона из
списка ползунок Fussiness (Разброс) и пипетки становятся недоступными.

Процесс построения выделенной области можно наблюдать при помощи умень-
шенного изображения в окне настройки (при установленном переключателе
Selection (Выделение)). Из списка Selection Preview (Просмотр выделения) можно
выбрать режим отображения будущего выделения непосредственно в окне доку-
мента. Это может оказаться полезным при создании выделений сложной формы,
но в большинстве случаев можно обойтись копией изображения, находящейся
в окне команды. Доступны следующие режимы просмотра:

• None (Нет) — выделение в окне документа не отображается; данный режим
используется по умолчанию;

• Grayscale (Оттенки серого) — в окне документа отображается монохромный
альфа-канал, содержащий выделение; черные участки соответствуют выде-
ленным пикселам, белые — невыделенным, оттенки серого — выделенным
частично;

• Black Mate (Матирование черным) — границы выделения обводятся черным
цветом;

• White Mate (Матирование белым) — границы выделенной области обводятся
белым;

• Quick Mask (Быстрая маска) — выделение выводится в режиме быстрого ре-
дактирования маски (выделенной области изображения).

СОВЕТ
Установив флажок Invert (Инвертировать), можно выделить пикселы, не попадающие в за-
данный диапазон оттенков.

После того как вы завершите подбор оптимального цветового диапазона, щелкни-
те на кнопке ОК для применения команды. Отменить операцию можно, щелкнув
на кнопке Cancel (Отмена). Если вы нажмете и будете удерживать клавишу Alt,
кнопка Cancel (Отмена) изменится на кнопку Reset (Восстановить). Щелкнув на
ней, можно вернуть настройки команды в исходное состояние.

Непосредственное редактирование
выделенной области — использование
режима Quick Mask
Описывая возможные способы предварительного просмотра выделенной облас-
ти при использовании команды Color Range (Выбор цвета), мы упомянули режим
Quick Mask (Быстрая маска). С его помощью можно редактировать границы выде-



Непосредственное редактирование выделенной области 183

ленной области так, как будто это — простое изображение. Там используются
все фильтры, команды и инструменты, которые можно применять при работе
с монохромными изображениями. Это позволяет выделять объекты сложной
формы, а также создавать специальные эффекты.

ПРИМЕЧАНИЕ
Термин «маска» в данном случае обозначает пикселы, не относящиеся к выделенной облас-
ти (спрятанные, замаскированные).

Сама возможность подобного «обращения» с выделенными пикселами определя-
ется тем, что степень «выделенности» задается цветом пикселов в канале выде-
ления — альфа-канале. Если пиксел в альфа-канале черный, то соответствующий
пиксел изображения выделен, а если пиксел в альфа-канале белый, соответст-
вующий пиксел изображения не выделен. Промежуточные оттенки в альфа-ка-
нале (оттенки серого) определяют частичное выделение пиксела (эффект от всех
команд, инструментов и фильтров проявляется для такого пиксела частично).
Все рассмотренные ранее средства выделения областей изображения показывали
пользователю лишь границу выбранного участка, скрывая альфа-канал. В режи-
ме Quick Mask (Быстрая маска) граница выделения не отображается, зато альфа-
канал выводится непосредственно в окне документа.

Так как альфа-канал может содержать оттенки, промежуточные между черным
и белым цветами, возникает проблема отображения границы выделенной облас-
ти при работе в нормальном режиме. Она решена очень просто — привычная
мерцающая граница проводится там, где яркость пикселов в альфа-канале перехо-
дит через значение 50 %, то есть внутри границы оказываются пикселы, выделен-
ные более чем на 50 %. Если таких пикселов нет (выделение неполное и очень
слабое), граница выделения не отображается. При возникновении подобной ситуа-
ции на экран выводится предупреждение о том, что граница выделения не видна.

ВНИМАНИЕ
Если граница выделения не видна на экране, но само выделение присутствует, инструмен-
ты, команды и фильтры будут применяться к пикселам изображения в соответствии со сте-
пенью «выделенности». Если такое выделение останется в документе после выполнения
некоторых операций, выполнение дальнейших действий может оказаться невозможным.
Поэтому после использования выделения его следует снять (удалить).

Теперь рассмотрим работу в режиме быстрого редактирования выделе- Ijfeijll
ния (Quick Mask). Для его активизации следует щелкнуть на кнопке, %ж!Ш11
расположенной в нижней части панели инструментов. В зависимости от настро-
ек режима она может принимать разный вид. То, что программа перешла в тре-
буемый режим, легко установить по следующим признакам:

• кнопка перехода в режим Quick Mask (Быстрая маска) остается нажатой;

• границы имеющихся в документе выделенных областей заменяются цветной
окраской;

• в заголовке окна документа выводится название режима — Quick Mask (Быст-
рая маска).
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На рис. 12.6 показано окно документа, находящегося в режиме Quick Mask (Быст-
рая маска).

Рис. 12.6. Окно документа до перехода в режим Quick Mask (слева) и после него (справа)

Обратите внимание — в режиме Quick Mask (Быстрая маска) выделенные области
отображаются в виде закрашенных цветом областей изображения. Для удобства
работы изображение, определяющее выделение, отображается полупрозрачным.
При этом сквозь него можно видеть изображение, содержащееся в документе.
Перейдя в режим Quick Mask (Быстрая маска), можно редактировать «выделение»
с использованием практически любых инструментов (в том числе инструментов
выделения), команд и фильтров. Команды и фильтры действуют так же, как при
работе с изображением в режиме Grayscale (Градации серого). Рисующие инстру-
менты (кисть, карандаш, аэрограф и другие) позволяют добавлять к выделенной
области новые участки или, наоборот, уменьшать размеры выделенной области.
Для того чтобы расширить выделенную цветом зону, рисуйте черным цветом,
для того чтобы ее уменьшить — белым. Рисование различными оттенками серого
позволяет задавать частичное выделение пикселов.

ПРИМЕЧАНИЕ
Режим Quick Mask (Быстрая маска) является по сути аналогом режима Grayscale (Градации
серого). Поэтому в нем для рисования доступны только цвета, являющиеся оттенками серо-
го цвета.

По умолчанию в режиме Quick Mask (Быстрая маска) выделение закрашивает-
ся красным цветом. Максимальная непрозрачность пикселов, отображающих
выделение, устанавливается равной 50 %. Можно изменить эти параметры. Для
этого дважды щелкните мышью на кнопке входа в режим Quick Mask (Быст-
рая маска) или выхода из него. При этом на экране появится окно, показанное
на рис. 12.7.

В зоне Color Indicates (Цветом показаны) можно установить, что будет показывать
цветная заливка. При установке переключателя Masked Areas (Маска) цветом
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будут выделяться области, не вошедшие в выделение. Переключатель Selected
Areas (Выделение) позволяет «покрасить» выделенный участок. Для практиче-
ского применения этот режим более удобен, чем предыдущий. На рис. 12.7 пока-
зан пример работы с «покраской» выделенной области.

Quick Mask Options

Color Indicates:

!••••' L Cancel!]

Рис. 12.7. Окно настройки параметров режима Quick Mask
1

ПРИМЕЧАНИЕ
Вид кнопки, служащей для перехода в режим Quick Mask (Быстрая маска), меняется в зави-
симости от установки этих переключателей. При окраске замаскированных областей на
ней отображается темный прямоугольник с белым кругом, а при окраске выделенной об-
ласти — белый прямоугольник и темный круг.

Щелкнув мышью на цветном квадрате, расположенном в зоне Color (Цвет), вы
можете определить цвет, используемый для окраски выделенной области. Это
бывает полезным в тех случаях, когда используемый по умолчанию цвет плохо
виден на фоне изображения. Тут же, в поле Opacity (Непрозрачность), можно задать
максимальную непрозрачность окраски выделенных (или замаскированных)
областей. Максимальную непрозрачность имеют области, закрашиваемые в ре-
жиме Quick Mask (Быстрая маска) черным цветом. Места, закрашиваемые белым,
полностью прозрачны.

После завершения «быстрого редактирования» выделенной области можно \пЩ
вернуться в нормальный режим работы программы. Для этого щелкните на 1"***
кнопке, расположенной на панели инструментов рядом с кнопкой перехода в ре-
жим Quick Mask (Быстрая маска).

Возможность редактирования выделенных областей предоставляет богатые воз-
можности для создания различных эффектов. Например, готовя выделенную
область, к которой планируется применить какой-либо фильтр, можно легко
контролировать степень выделения пикселов и тем самым управлять силой воз-
действия фильтра.

Если возникнет задача отделить от фона некоторый объект, можно «закрасить»
его в режиме Quick Mask (Быстрая маска). После перехода в нормальный режим
будет образована выделенная область, точно повторяющая контуры объекта.
Сам объект после этого может быть перемещен, скопирован или изменен. Мож-
но инвертировать выделение и работать с фоном, не затрагивая объект.
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Еще одна область применения режима быстрого редактирования масок — созда-
ние выделенных областей со сложным изменением степени выделения пикселов.
На рис. 12.8 приведен пример выполнения такой операции.

Рис. 12.8. Пример создания выделения сложной формы при помощи режима быстрого
редактирования маски

Для того чтобы образовать рисунок с плавным изменением цвета, прежде всего,
зададим выделенную область нужной формы. Сделаем это в режиме Quick Mask
(Быстрая маска) при помощи инструмента Gradient (Градиент). Результат этого
действия показан на рис. 12.8, слева вверху. После выхода из режима Quick Mask
(Быстрая маска) будут образованы контуры этой области (рис. 12.8, справа ввер-
ху). Закрасим область при помощи инструмента Paintbrush (Кисть). Результат
можно видеть на рис. 12.8, снизу. Разумеется, это простейший пример выполне-
ния действия такого рода. Выделение может быть «нарисовано» при помощи
любого доступного средства. На заключительном этапе также могут использо-
ваться любой инструмент, команда или фильтр.

СОВЕТ

Подобные средства могут использоваться, например, для удаления некоторых частей изо-
бражения при создании различного рода коллажей. Определив выделенную область, на-
жмите клавишу Delete для ее очистки.
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Использование команд редактирования
выделенной области
После того как границы выделенной области определены, их можно изменять,
используя встроенные в Adobe Photoshop средства. Команды, которые понадо-
бятся вам для этого, находятся в меню Select (Выделить).

Часто возникает необходимость «вывернуть» выделение наизнанку, то есть до-
биться того, чтобы выделенные области стали невыделенными, а невыделенные-
выделенными. В этом случае можно использовать команду Inverse (Инвертиро-
вать).

ПРИМЕЧАНИЕ -
Возможны и более сложные варианты. Например, можно перейти в режим Quick Mask (Быст-
рая маска), применить команду Image > Adjustments * Invert (Изображение > Настройки >
Инвертировать), а затем вернуться в нормальный режим.

Если вам надо сгладить границы выделения, сделать их менее резкими, восполь-
зуйтесь командой Feather (Растушевка). После ее вызова на экране появится
окно, в котором следует ввести радиус размытия краев выделенной области. Эта
операция может оказаться полезной, например, для смягчения перехода от зоны
действия инструмента или фильтра к незатронутой области. Можно применить
эту команду для получения фрагментов изображения с плавным изменением
прозрачности по краям. Выделив фрагмент и сгладив границы выделения, надо
скопировать содержимое выделения в буфер обмена или инвертировать выделе-
ние и удалить все, кроме нужного объекта.

Команды Grow (Смежные пикселы) и Similar (Подобные оттенки) дают возмож-
ность расширить выделение на другие пикселы изображения, ориентируясь на
их цвет. Команда Grow (Смежные пикселы) позволяет распространить выделе-
ние на пикселы, прилегающие к уже выделенным и имеющие сходный оттенок.
Это похоже на инструмент Magic W a n d (Волшебная палочка). Если вам необходи-
мо распространить выделение на все пикселы изображения, имеющие оттенки,
сходные с оттенками выделенных пикселов, используйте команду Similar (По-
добные оттенки). Ее действие сходно с действием команды Color Range (Выбор
цвета), но за* основу для построения выделения берутся оттенки пикселов, уже
содержащихся в выделенной области.

Трансформирование выделенной области
После того как выделение создано, его геометрические размеры можно изменять
вручную. Для этого служит команда Transform Selection (Трансформация выде-
ления). Она позволяет изменять высоту и ширину выделения, поворачивать
его, наклонять и искажать. Эти операции можно выполнять двумя способами —
в окне документа при помощи мыши или при помощи панели настроек. Первый
способ обеспечивает большую наглядность и удобен для визуального подбора
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пропорций и размеров. Второй способ основан на вводе параметров в цифровом
виде, что удобно для многократного повторения однотипных операций, а также
для точной установки размеров выделенной области.

Сначала рассмотрим изменение параметров при помощи мыши. Во время транс-
формирования выделения в окне документа отображается специальная рамка.
На ее границах и углах располагаются маркеры. Перемещая их мышью, можно
изменять форму и пропорции выделенной области. Вид окна документа во вре-
мя выполнения этой операции показан на рис. 12.9.

у \ф
/

Рис. 12.9. Трансформирование выделенной области

При наведении курсора мыши на маркеры рамки он изменяет свою форму.
Она зависит от того, какой из размеров выделения можно изменять. Для
изменения выделения подведите курсор к маркеру, нажмите левую кнопку мыши
и переместите маркер в нужное положение. Угловой маркер позволяет изменять
одновременно и высоту и ширину области. Если, выполняя это действие, удер-
живать нажатой клавишу Shift, пропорции выделения останутся неизменными.
Это полезно для масштабирования без искажений.

Кроме высоты и ширины выделенной области вы можете изменять ее форму.
Эта операция выполняется при помощи тех же маркеров, но при нажатой клави-
ше Ctrl. Перемещая центральные маркеры сторон рамки, можно наклонять выде-
ление. При помощи угловых маркеров можно изменить его форму. На рис. 12.10
показано, как выглядит при этом окно документа.

Вы можете вращать выделение. Для этого подведите курсор к рамке с внеш- .
ней стороны. При этом он изменит форму, указывая направление поворота.
Нажмите левую кнопку мыши и переместите курсор, — рамка, а вместе с ней и вы-
деление будут вращаться. В нужный момент отпустите кнопку мыши. Центр
вращения изначально находится в центре рамки (он выделен точкой с перекре-
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стием), но вы можете переместить его для удобства придания выделенной ж
области нужного положения. Перемещение центра вращения также вы- 1Ф

полняется при помощи мыши. «Схватите» его при помощи левой кнопки,
перенесите в нужную позицию и отпустите кнопку. Возможно, вам захочется
вернуть центр вращения в исходное положение. Это выполняется тем же обра-
зом. Причем для облегчения установки, когда до центра рамки остается опреде-
ленное расстояние, центр вращения «прилипает» к нему.

S» 100% (RGB/8)

Рис. 12.10. Изменение формы выделения

Также предоставляется возможность перемещения выделения. Для этого поме-
стите курсор мыши внутри рамки (но не над центром вращения). Нажмите левую
кнопку мыши и переместите рамку в нужное положение.

После того как вы произведете все необходимые действия, следует применить
их. Для этого нажмите клавишу Enter или дважды щелкните внутри рамки. Если
вы не хотите применять изменения, нажмите клавишу Esc.

Если вы хотите точно управлять изменением выделенной области или вам не-
обходимо повторить ранее выполненную операцию, воспользуйтесь панелью
настройки. С ее помощью возможно осуществление практически всех преобразо-
ваний, выполняемых при помощи мыши.

Рассмотрим элементы управления, находящиеся на панели настройки во тш
время работы с командой Transform Selection (Трансформация выделения), «й*
Слева расположен переключатель в виде девяти квадратов. При помощи него
можно выбрать положение центра вращения. Центральный квадрат соответству-
ет расположению опорной точки в центре рамки. Остальные квадраты позволя-
ют поместить центр вращения в один из маркеров, расположенных на краях рам-
ки. Переместить опорную точку можно, щелкнув мышью на нужном квадрате.
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Изменение размеров и формы выделенной области осуществляется путем ввода
значений с клавиатуры в имеющиеся на панели поля. Переместить выделение
можно при помощи полей X и Y. По умолчанию в них к ^...~~...... ^ ^ ^в*|
отображаются координаты центра вращения. Если щелк- «,8™ш»ет«"Ж ',/---•—-'?,•
нуть на кнопке с изображением треугольника, расположенной между полями, будут
выведены не значения координат, а разница между текущим и исходным положе-
нием (приращения координат). Эти значения могут быть больше и меньше нуля.

Поля W и Н отвечают за высоту и ширину выделенной области. Между по- •**
лями расположена кнопка с изображением звеньев цепи. Если она нажата,
изменение размеров выделения происходит синхронно — при изменении одного
автоматически изменяется другой. Это позволяет изменять размеры, не изменяя
при этом форму.

Отдельное поле отвечает за поворот выделения. В него можно ввести :~-т'-р^^ад
угол поворота в градусах. Также имеются поля, при помощи которых
можно изменять наклон выделенной области. Отдельно г --•••- —...;...:...,

,<Р Н: 0.0 !* .V;] 0.0 |1>
вводятся значения наклона (также в градусах) для вер-
тикальных (поле Н) и горизонтальных (поле V) сторон рамки.

После того как вы внесете необходимые изменения, их следует применить. Для
этого можно дважды щелкнуть мышью внутри рамки или нажать Enter. Также
можно щелкнуть на кнопке с флажком, расположенной в правой части панели
настройки. Для отмены преобразования можно нажать клавишу Esc или щелк-
нуть на кнопке с изображением креста, также находящейся на панели настройки.

Сохранение и загрузка областей
Кроме операций по преобразованию выделенных областей Adobe Photoshop
предоставляет возможность сохранения выделений в файле изображения и его
последующей загрузки. Хранить выделения могут только файлы, сохраненные
в форматах, поддерживающих такие возможности, например, в формате PSD.
Сохранить выделенную область можно командой Save Selection (Сохранить вы-
деление). При ее вызове на экране появится окно настройки, показанное на
рис. 12.11.

Из списка Document (Документ) выберите имя файла (из числа открытых в дан-
ный момент), в котором будет сохранено выделение. Если вы выберете пункт
New (Новый), Photoshop создаст новый документ, в котором выделение будет со-
хранено в виде альфа-канала, причем этот канал будет единственным. Из списка
Channel (Канал) можно выбрать, в каком канале будет сохранено выделение. По
умолчанию выбран пункт New (Новый) — выделение сохраняется в новом аль-
фа-канале. При этом в поле Name (Имя) можно ввести название канала. Образо-
ванные таким образом каналы доступны при помощи палитры Channels (Кана-
лы). Выбрав на ней нужный канал, вы можете редактировать его как обычное
изображение. При этом будет изменено выделение, сохраненное в канале.
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Destination •"--•• : —

Document: j Untitled-4

Channel:! New

OK

Name:! Selection_l

Operation .....;.;..........

©New Channel

Рис. 12.11. Окно команды Save Selection

Вы также можете сохранить выделение в уже существующем канале (это воз-
можно, если вы уже сохраняли выделенные области в этом документе). При
этом становятся доступными переключатели, расположенные в нижней части
окна:

• Replace Channel (Заменить канал) — сохраняемое выделение замещает имею-
щийся канал; при сохранении выделения в новом канале этот переключатель
называется New Channel (Новый канал);

• Add to Channel (Добавить к каналу) — выделение добавляется к выбранному
каналу;

• Subtract from Channel (Вычесть из канала) — выделение вычитается из канала;

• Intersect with Channel (Пересечение с каналом) — в канале будет сохранена об-
ласть, принадлежащая одновременно и новому и уже сохраняемому выделениям.

ПРИМЕЧАНИЕ
Если вы не введете имя нового канала, то он получит имя вида AlphaN, где N — номер канала.

Список Channel (Канал), кроме уже перечисленных пунктов, содержит пункт Layer
N Mask (Маска слоя N). При выборе этого пункта выделение будет сохранено в виде
маски слоя номер N (невыделенные области будут скрыты). На рис. 12.12 показана
панель Layers (Слои) с выделенной областью, сохраненной в виде маски слоя 1.

После того как вы сохраните выделение в файле, его можно будет в любой мо-
мент загрузить и использовать в работе. Для этого вызовите команду Select > Load
Selection (Выделить > Загрузить выделение). При этом на экране появится окно
настройки, показанное на рис. 12.13.

Из списка Channel (Канал) выберите альфа-канал, содержащий нужную выде-
ленную область. Если вы установите флажок Invert (Инвертировать), выделение
будет загружено в инвертированном (негативном) виде. При работе на любом
слое, кроме фона, в списке каналов присутствует пункт вида Layer N Transparency
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(Прозрачность слоя N). Выбрав этот пункт, можно выделить непрозрачные
области слоя.

Рис. 12.12. Выделенная область, сохраненная в виде маски слоя 1

О Invert

© New Selection

OSubtract from Selection
Olntersect with Selection

Рис. 12.13. Окно команды Load Selection

В том случае, когда документ уже содержит выделенную область, с загружаемым
выделением можно производить некоторые дополнительные операции. Для это-
го используйте переключатели, находящиеся в зоне Operation (Операция):

• New Selection (Новое выделение) — перед загрузкой выделения имеющиеся
выделенные области очищаются; этот переключатель установлен по умолча-
нию;

• Add to Selection (Добавить к выделению) — загружаемое выделение добавля-
ется к уже существующему;

• Subtract from Selection (Вычесть из выделения) — загружаемое выделение вы-
читается из уже выделенной области;

• Intersect with Selection (Пересечь с выделением) — после загрузки выделенной
окажется область, входящая и в загружаемое выделение и в выделение, нахо-
дившееся в окне до вызова команды.
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ПРИМЕЧАНИЕ
Если текущий слой имеет маску (Layer mask), можно при помощи команды Load Selection (За-
грузить выделение) преобразовать ее в выделенную область. Для этого из списка Channel
(Канал) выберите пункт Layer N Mask (Маска слоя N).

Использование выделенных областей
После того как вы подготовите выделенную область нужной формы, можно ис-
пользовать ее для ограничения зоны действия инструментов, фильтров и команд.
Это наиболее часто встречающееся использование выделения.

Еще одна область применения выделенных областей — отделение фрагментов
изображения от окружающего фона. Подобные действия часто требуется выпол-
нять при подготовке коллажей, подборок фотографий и других подобных опера-
циях. Например, вы можете выделить фрагмент изображения, отделить его от
фона и перенести на прозрачный слой. После этого вам будет легко помещать
этот объект на любой фон и в любое окружение.

На рис. 12.14 приведен пример такой операции.

'

Рис. 12.14. Пример выделения объекта из окружающего фона

7 Зак. 805
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В верхнем левом углу (см. рис. 12.14) показано исходное изображение. Это
фотография конной статуи Петра I. Выделим ее. Для этого, прежде всего, надо
построить выделенную область, повторяющую контур выбранного объекта,
воспользовавшись инструментом Magic Wand (Волшебная палочка). Получаемое
при этом выделение может иметь искажения и отклонения по краям. Исправить

•их можно при помощи режима Quick Mask (Быстрая маска). На рис. 12.14 (вверху
справа) показано построенное выделение. Выделив объект, можно инвертировать
выделение (при помощи команды Select > Inverse (Выделить > Инвертировать))
и, нажав клавишу Delete, удалить окружающий фон. Для удобства дальнейших
операций перед удалением фона лучше поместить изображение на новый слой,
например, скопировав слой текущий. Выделенный объект показан на рис. 12.14
внизу слева. Полученный в результате таких операций объект следует доработать.
Дело в том, что на его краях остаются пикселы, частично окрашенные в цвет
фона. При помещении такого объекта на фоне, имеющем оттенок, отличный от
фона исходного изображения, вокруг объекта возникает ореол темных или светлых
пикселов. Исправить этот недостаток можно при помощи команды Layer > Matting >
Defringe (Слой > Обработка краев > Устранить кайму). Она позволяет заменить
расположенные на краях изображения пикселы, отличающиеся по цвета от ос-
новного цвета объекта, на пикселы, близкие к основному цвету. Вызвав команду,
введите в появившемся на экране окне радиус зоны обработки. После обработки
можно поместить объект на новый фон и применить к нему какие-либо эффекты
например добавить тень. На рис. 12.14 внизу справа показан результат выпол-
ненных действий.

ПРИМЕЧАНИЕ *•
Кроме команды Defringe (Устранить кайму) в меню Layer > Matting (Спой > Обработка краев)
содержатся команды Remove White Mate (Удалить белую кайму) и Remove Black Mate (Уда-
лить черную кайму). С их помощью можно удалить светлый или темный ореол на границе
объекта, находящегося на прозрачном слое.

Использование команды Extract
Adobe Photoshop содержит средство, позволяющее выполнять выделение объек-
тов из изображения в полуавтоматическом режиме. Это команда Filter > Extract
(Фильтр * Экстракция). С ее помощью вы можете получить отделенный от фона
объект без необходимости вручную строить выделение.

После вызова этой команды на экране появится окно настройки. Оно показано
на рис. 12.15.

Использовать это средство достаточно просто. Прежде всего, надо определить
область, в которой будет производиться поиск границы объекта. Для этого ис-
пользуется инструмент Edge Highlighter (Маркирование краев). Выберите его гж$
и обведите объект по контуру. В поле Brush Size (Размер кисти) можно вы- ™^
брать размер кисти. Это позволяет задать ширину зоны поиска границы объекта.
Из списка Highlight (Подсветка) можно выбрать цвет, которым будет отмечаться
граница. Если вы установите флажок Smart High l ight ing (Полуавтоматическое
маркирование), то во время выделения границы программа будет автоматически
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отслеживать границу между контрастными пикселами. Границу выделенного
объекта следует замкнуть. Удерживая при рисовании границы клавишу Ctrl,
можно временно переключиться в этот режим без установки флажков.

fw lh. ̂ rrtn ir-ji Mtht results to the ыл*'* df̂ w.nn!,

Рис. 12.15. Окно настройки команды Extract

ПРИМЕЧАНИЕ
Сочетание клавиш Ctrl+Z позволяет или отменить последнее действие, или вернуть послед-
нее отмененное действие.

После того как вы выделите границу объекта, залейте «внутренность» объ- [jo
екта при помощи инструмента Fill (Заливка). Залитая область будет отде- :^*
лена от фона в любом случае. При отсутствии заливки произвести выделение
объекта нельзя. Если вы все-таки не хотите задавать эту область, установите
флажок Force Foreground (Выделить рабочий цвет) и выберите цвет, на котором
будет основано выделение. Для выбора цвета щелкните на цветном прямоуголь-
нике, расположенном под флажком (выбрать цвет можно только при установ-
ленном флажке). Из списка Fill (Заливка) можно выбрать цвет, которым будет
отмечена залитая область.

При необходимости подкорректируйте границу и заливку при помощи ин- Qp
струмента Eraser (Ластик).

Подготовив объект, нажмите кнопку Preview (Просмотр). В окне команды вы уви-
дите предварительный результат выделения объекта. После этого вы сможете
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исправить недостатки полученного изображения. Для удаления частей изобра-
жения используйте инструмент Cleanup (Очистка). Инструмент Edge Touchup
(Восстановление границы) позволяет увеличить четкость границы выде-
ленного объекта. Если границы объекта имеют резкие изломы, попробуйте
увеличить значение в поле ввода Smooth (Сгладить). Исправив обнаружен-
ные недостатки, щелкните на кнопке О К для применения эффекта. Если вы хоти-
те вернуться к исходным настройкам, нажмите клавишу Alt и затем щелкните на
кнопке Reset (Восстановить), замещающей кнопку Cancel (Отмена).

При грамотном использовании команда Extract (Экстракция) может существенно
упростить работу по подготовке материалов для оформления сайтов и выполне-
ния других подобных работ. В некоторых случаях программа не может качест-
венно определить контур объекта. Особенно часто это происходит, если обраба-
тывается малоконтрастное одноцветное изображение. Тогда можно использовать
различные сочетания методов выделения.

На этом закончим рассмотрение основных методов работы с выделенными об-
ластями и перейдем к рассмотрению процесса подготовки элементов веб-стра-
ниц на основе графических и текстовых объектов.

В этой главе мы ознакомились с основными средствами работы с выделенными
областями изображения. Мы рассмотрели методы создания выделений, их об-
работки и изменения, а также способы сохранения выделенных областей в файле
и их вызова для использования.

Были подробно рассмотрены методы выделения фрагментов изображения, та-
кие как инструменты Magic Wand (Волшебная палочка) и Lasso (Лассо), команды
Color Range (Выбор цвета) и Extract (Извлечь), а также режим Quick Mask (Быстрая
маска). Умение пользоваться ими позволит вам легко подготавливать исходные
материалы для составления коллажей и композиций.
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Цветовая коррекция фотоснимков
В этой главе мы познакомимся с наиболее привлекательной возможностью циф-
ровой фотографии — простотой коррекции и устранения различных недостат-
ков полученного изображения. Такие недостатки, как низкая яркость, слишком
высокий или недостаточный контраст, искажения оттенков, легко устраняются
с помощью графического редактора, причем результат обработки можно наблю-
дать прямо в процессе редактирования. Методы ретуши (устранения недостатков
изображения) цифрового изображения намного превосходят методы традицион-
ной фотографии. Можно с легкостью устранить небольшие недостатки, такие как
морщины на портрете или попавшие в кадр объекты.

Устранение явных «механических»' повреждений снимка мы рассмотрим в од-
ной из следующих глав, а здесь уделим основное внимание коррекции отклоне-
ний яркости, контраста и оттенков изображения от реальности или от желаемого
состояния.

Анализ экспозиции кадра
Часто бывает полезным оценить, достаточной ли была экспозиция при съемке
кадра. Располагая этими данными, можно выбрать меры, необходимые для кор-
рекции изображения. Также вы сможете учесть недостатки изображения при
дальнейших съемках.

Для анализа экспозиции кадра удобно использовать гистограммы яркости — гра-
фики, отображающие распределение пикселов изображения по яркости. Обычно
эти графики называют просто «гистограммы». На таком графике можно увидеть,
какая часть изображения окрашена в темные тона, какая — в близкие к нейтраль-
ным, а какая — в светлые.

Получить доступ к гистограммам можно при помощи специальной панели Histogram
(Гистограммы) или команды Image > Adjustments > Levels (Изображение > Настрой-
ки > Уровни). Панель Histogram (Гистограммы) показана на рис. 13.1.

График распределения пикселов по яркости имеет следующий смысл — яркость
пикселов возрастает слева направо. Чем выше пик в соответствующей точке, тем
большее число пикселов имеет соответствующую яркость. На рис. 13.1 приведе-
на гистограмма для изображения, большая часть которого окрашена в темные
или нейтральные тона. Цвета, близкие к чистому белому, практически отсутствуют.
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Рис. 13.1. Панель Histogram

Разница между минимальной и максимальной яркостями (крайними справа и сле-
ва столбцами на гистограмме яркости) определяет диапазон яркостей, присутст-
вующих в изображении, — его динамический диапазон. Чем шире динамический
диапазон, тем более качественным, «гладким» будет изображение. Однако при
чрезмерно равномерном распределении пикселов по яркости изображение мо-
жет оказаться малоконтрастным. Высококонтрастное изображение имеет узкий
динамический диапазон.

В некоторых случаях в верхнем правом углу панели отображается символ : ,||
в виде треугольника. Щелкнув на нем, можно увидеть график, реально со-
ответствующий изображению в данный момент. Наличие этого символа на пане-
ли означает, что на панели находится график, построенный по ранее сохранен-
ным данным.

ПРИМЕЧАНИЕ
Гистограммы указывают не цвет конкретного пиксела, а число пикселов, имеющих опреде-
ленную яркость. Кроме того, высота столбцов на графике относительная, то есть она ото-
бражает не реальное число пикселов, а соотношение между числом пикселов, имеющих раз-
ные значения яркости.

Рассмотрим влияние экспозиции на вид гистограмм яркости. На рис. 13.2 пока-
зан пример изображения с нормальной экспозицией.

Рис. 13.2. Изображение, имеющее нормальную экспозицию, и гистограмма
яркости, соответствующая этому изображению
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На гистограмме (рис. 13.2) видно, что большая часть изображения имеет окра-
ску, близкую к нейтральной, или окрашена в светлые тона. Хотя график яркости
содержит несколько пиков, это не значит, что изображение имеет какие-либо де-
фекты. Распределение пикселов по яркости в значительной степени зависит от
сюжета кадра. Например, кадр снежного поля или пустыни при солнечном свете
будет содержать в основном светлые пикселы, а при равномерном распределе-
нии пикселов во всем диапазоне яркостей может стать совершенно невырази-
тельным или искусственным.

СОВЕТ
При анализе гистограмм яркости всегда учитывайте сюжет съемки. Настройки экспозиции
путем простого «растягивания» пикселов по диапазону яркости (такая операция выполняет-
ся при автоматической коррекции цветовых уровней) может улучшить вид изображения, но
применим этот метод далеко не всегда.

На рис. 13.3 приведен пример переэкспонированного изображения и соответст-
вующей ему гистограммы.

iiii
Рис. 13.3. Пример переэкспонированного изображения и гистограмма яркости

Как видно на этом рисунке, большая часть пикселов окрашена в светлые тона.
Основная часть диаграммы яркостей (гистограммы) смещена в область светлых
оттенков. Динамический диапазон изображения уже, чем у изображения, пока-
занного на рис. 13.2, изображение имеет низкий контраст. Для регулировки яр-
кости и контраста следует растянуть динамический диапазон в сторону темных
оттенков. О том, как это сделать, мы расскажем позже.

На рис. 13.4 показано недоэкспонированное изображение, оно гораздо темнее,
чем изображения, показанные на рис. 13.2 и 13.3.

В отличие от изображения, показанного на рис. 13.3, динамический диапазон
изображения смещен в область темных тонов. Он также уже, чем у нормально
экспонированного изображения. Для исправления экспозиции необходимо рас-
ширить динамический диапазон изображения в область светлых оттенков.
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Рис. 13.4. Пример недоэкспонированного изображения и гистограммы яркости

Настройки яркости и контраста
изображения
В тех случаях, когда изображение кажется вам слишком светлым или слишком
темным, можно проанализировать экспозицию изображения и применить имею-
щиеся в Adobe Photoshop CS средства цветокоррекции. Сложные методы кор-
рекции, дающие вам практически полный контроль над параметрами изображе-
ния, мы рассмотрим несколько позже, а сейчас познакомимся с более простыми
методами, позволяющими решить проблему в большинстве случаев.

Команда Image > Adjustments > Brightness/Contrast (Изображение > Настройки >
Яркость/Контраст) позволяет вам изменять общую яркость изображения и его
контраст. На рис. 13.5 показано окно, выводимое на экран при вызове этой ко-
манды.

BrigJunessConlrast

•'Brightness;

Contrast;

j +23

Cancel J

Рис. 13.5. Окно команды Image > Adjustments > Brightness/Contrast

Ползунок и поле ввода Brightness (Яркость) позволяют вам управлять яркостью
изображения, а ползунок и поле ввода Contrast (Контраст) контролируют контра-
стность картинки. Увеличивая или уменьшая значения, отображаемые на пол-
зунках и в полях ввода, можно соответственно увеличивать или уменьшать яр-
кость или контраст изображения.
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Действия,.выполняемые при изменении «обобщенных» значений яркости и кон-
траста изображения, на самом деле приводят к изменению цветовых уровней
и динамического диапазона изображения. Используя команду Brightness/Contrast
(Яркость/Контраст), можно выполнять довольно сложные преобразования, поль-
зуясь простым и понятным интерфейсом.

На рис. 13.6 показан пример обработки изображения при помощи команды
Brightness/Contrast (Яркость/Контраст). В верхнем ряду можно видеть (слева на-
право) исходное изображение, изображение после уменьшения яркости и изо-
бражение после увеличения яркости. В нижнем ряду также находится исходное
изображение, изображение после уменьшения контраста и изображение после
увеличения контраста.

1UntiHe<l-2.!Pl,.,

Рис. 13.6. Пример использования команды Brightness/Contrast

Провести коррекцию контраста изображения также можно в автоматическом
режиме. Для этого используйте команду Image > Adjustments > Auto Contrast (Изо-
бражение > Настройки > Автоконтраст). Эта команда автоматически изменяет
контраст изображения так, чтобы самые яркие участки изображения стали белы-
ми, а самые темные — черными.

ПРИМЕЧАНИЕ
Хотя автоматизированная коррекция может дать неплохой результат, эффективность ее
применения сильно зависит от вида изображения.
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Также можно управлять соотношением темных и светлых участков изображения.
Для этого используйте команду Image > Adjustments > Shadow/Highlight (Изобра-
жение > Настройки > Тени/Света). Она позволяет изменять площадь, занимае-
мую тенями или светлыми участками изображения, их яркость, а также соотно-
шение темных и ярких участков изображения. На рис. 13.7 показано окно этой
команды.

Amount:

- Highiights Ш :

Amount:

О Show/ More Options

I S O !% !,
l 1:...ж:: J

Cancel

fo"'""l%T•'•[. Save...

..:..]: 0 Preview

Рис. 13.7. Окно команды Image > Adjustments > Shadow/Highlight

Ползунок A m o u n t (Эффект), расположенный в группе Shadows (Тени), позво-
ляет регулировать плотность теней — темных участков изображения. В группе
Highlights (Блики) расположен ползунок, с помощью которого можно управлять
плотность (затемненностью) светлых участков изображения. Вместо ползунков
можно использовать для указания значений параметров расположенные рядом
с ними поля ввода.

В нижней части окна, показанного на рис. 13.7, находится флажок Show More
Options (Дополнительные параметры). Установив его, можно вывести на экран
дополнительные органы управления соотношением темных и светлых обла-
стей изображения. При этом окно команды примет вид, показанный на рис. 13.8.

В расширенном режиме можно дополнительно задать для темных и светлых об-
ластей два параметра:

• Tonal Width (Диапазон оттенков) — определяет диапазон оттенков, к которым
применяется преобразование. Увеличивая это значение, вы увеличиваете об-
ласть, подвергающуюся обработке;

• Radius (Радиус) — определяет радиус, в пределах которого для каждого пиксе-
ла производится поиск светлых и темных областей.

Также вы получите доступ к еще нескольким новым параметрам:

• Color Correction (Цветовая коррекция) — управляет дополнительно вводимой
в изображение коррекцией оттенков светлых и темных областей. Используя
этот параметр, можно сделать цвета изображения более или менее насыщен-
ными. Обратите внимание — цветокоррекция в данном случае применяется
только к областям изображения, распознанным и обработанным как тень или
ярко освещенная область.
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Рис. 13.8. Окно команды Image > Adjustments * Shadow/Highlight в расширенном режиме

• При работе в режиме Grayscale (Градации серого) этот параметр заменяется
параметром Brightness (Яркость).

• Midtone Contrast (Контраст средних тонов) — позволяет управлять контрастом
изображения в областях, окрашенных в нейтральные и близкие к ним цвета.

• Black Clip (Отсечение черного) и White Clip (Отсечение белого) — определяют,
какой уровень яркости получат новые тени и светлые участки изображения.
По сути дела, увеличивая эти значения, вы управляете сужением динамиче-
ского диапазона изображения. Это позволяет сделать изображение более чет-
ким, однако излишне высокие уровни теней и подсветок приводят к потере
деталей и излишнему контрасту.

В правой части окна находятся кнопки ОК и Cancel (Отмена). Кнопки Save (Со-
хранить) и Load (Загрузить) позволяют сохранять и загружать ранее сохра-
ненные значения параметров применения команды. Там же находится флажок
Preview (Просмотр). Когда он установлен, результаты изменения параметров сразу
же отображаются в окне изображения.
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Настройки цветовых уровней
В некоторых случаях изображение страдает от неправильно установленной экспо-
зиции или же возможностей простых средств коррекции, рассмотренных выше,
не хватает для достижения желаемого эффекта. Тогда можно прибегнуть к кор-
рекции цветовых уровней.

Цветовыми уровнями называют значения яркости, соответствующие самым яр-
ким, самым темным и нейтрально окрашенным участкам изображения. На нор-
мальном, среднестатистическом изображении самые яркие участки окрашены
в белый цвет, самые темные — в черный, а нейтральные — в серый, яркость кото-
рого лежит посередине между яркостью белого и черного цветов. Поэтому цве-
товые уровни часто называют уровнями белого, черного и серого.

Уровни белого и черного цветов ограничивают диапазон яркостей, присутствую-
щих в изображении, — его динамический диапазон. Чем дальше друг от друга они
находятся, тем больше деталей может содержать изображение и тем более плав-
ными могут быть содержащиеся в нем цветовые переходы. Изменяя эти уровни,
можно регулировать ширину динамического диапазона, изменяя тем самым
контрастность изображения. Кроме того, изменение уровней белого и черного
цветов позволит управлять яркостью изображения в ярко освещенных областях
и в затененных участках.

Уровень серого задает нейтральную, промежуточную яркость — середину ди-
намического диапазона. Изменив этот уровень, можно изменить соотношение
между яркостями пикселов, относящихся к «темной» и «светлой» половинам
диапазона яркостей. Это позволяет, например, сделать более яркими чрезмерно
затененные области или, наоборот, затемнить излишне светлые. Благодаря таким
действиям часто оказывается возможным восстановить детали, ставшие практи-
чески незаметными из-за неправильной установки экспозиции.

Еще одна функция уровней белого, черного и серого цветов — управление цвето-
вым балансом изображения. Так как чистый белый, черный и серый цвета ней-
тральны по окраске, указав в изображении опорные точки для определения этих
цветов, можно устранить нежелательную окраску, вызванную, например, недо-
статочно точной установкой баланса белого в цифровой фотокамере или особен-
ностями освещения при съемке на обычную пленку.

СОВЕТ
При съемке объектов с повышенными требованиями к цветопередаче полезно разместить
рядом с ними эталонную карту цветов. Это позволит впоследствии быстро выставить цве-
товые уровни, устранив недостатки экспозиции или освещения. Карту цветов можно при-
обрести в фотомагазине или изготовить самостоятельно. В простейшем случае она должна
содержать образцы белого (например, бумага), черного (бархат, матовый пластик, мато-
вая бумага) и серого (специальный эталонный картон, серая бумага подходящего цвета).
Дополнительные образцы основных цветов (например, красного, зеленого и синего) и их
комбинаций позволяют судить о необходимости более тонких преобразований и следить за
ходом их выполнения.
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Выполнить коррекцию цветовых уровней в Adobe Photoshop CS можно несколь-
кими способами. Самый точный, дающий вам полный контроль над процессом, —
использование команды Image > Adjustments > Levels (Изображение > Настройки >
Уровни). Также можно использовать комбинацию клавиш Ctrl+L На рис. 13.9 по-
казано окно команды Levels (Уровни).

Input Levels; О В 1.00 255

Рис. 13.9. Окно команды Levels

Большую часть окна занимает график распределения пикселов изображения по
яркости — гистограмма. На этом графике можно видеть, является ли изображе-
ние в общем светлым, темным или нейтральным.

Под гистограммой расположены три треугольника — черный, серый и белый. Они
указывают текущее значение уровней черного, белого и серого. Соответствующие
цифровые значения выводятся над гистограммой в полях Input Levels (Входные
значения). Слева находится значение для уровня черного (оно может принимать
значения от 0 до 255), справа — значение для уровня белого (также может иметь
значение от 0 до 255), а в середине — значение для уровня серого. Уровень серо-
го отображается в виде отношения уровня белого к уровню черного.

Можно изменять значения уровней, перемещая при помощи мыши указатели-
треугольники или же вводя значения в полях ввода. Практически поля ввода
удобны разве что для быстрого указания нейтрального уровня серого — доста-
точно ввести в соответствующем поле 1.

После щелчка на кнопке ОК производится перерасчет яркостей пикселов в соот-
ветствии с указанными вами значениями уровней яркости.

ПРИМЕЧАНИЕ
Независимо от положения уровней уровни черного и белого ограничивают динамический
диапазон изображения, а уровень серого указывает его середину — нейтральное значение
яркости. На гистограмме можно видеть состояние изображения на момент вызова команды,
а указатели уровней покажут вам, какие значения примут уровни после применения преоб-
разования.
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Под гистограммой, в нижней части окна, находится полоса, отображающая мак-
симально широкий динамический диапазон. Над полосой расположены два поля
ввода Output Levels (Выходные значения) и указатели, отображающие это значе-
ния на полосе.

При помощи выходных значений уровней черного и белого можно задать плот-
ность краски (или яркость), соответствующую этим уровням. Это удобно при
подготовке изображения к полиграфической печати — типографии часто вводят
ограничения на максимально допустимую плотность краски. Кроме того, выход-
ные уровни позволяют контролировать общую яркость изображения.

В верхней части окна находится список Channel (Канал). Из этого списка можно
выбрать цветовой канал изображения (одну из цветовых составляющих, исполь-
зуемых в текущем цветовом режиме), к которому будет применено преобразование.
По умолчанию выбран пункт с названием текущего цветового режима, а преобра-
зования применяются ко всему изображению в целом. Использование различных
цветовых каналов позволяет производить кроме коррекции яркости еще и кор-
рекцию оттенков изображения в темных и светлых областях изображения. Однако
выполнение таких действий требует хорошего понимания механизма образова-
ния цвета и наличия опыта.

ВНИМАНИЕ
При установке цветовых уровней при помощи гистограммы вы принудительно назначаете
яркость цветовых составляющих для каждого пиксела, даже если редактирование произво-
дится для всех каналов одновременно. При этом вы не можете контролировать, является ли
тот или иной оттенок в действительности нейтральным или имеет некоторую окраску. Это
может привести к появлению нежелательной окраски областей, освещенных не так, как
основная область изображения, например, затененных участков.

В правой части окна находятся три кнопки с изображением пипеток. Они слу-
жат для выбора цветовых уровней непосредственно по изображению. Выберите
пипетку и щелкните ею в нужной точке изображения. Этим вы назначите пиксе-
лам указанной яркости черный, серый или белый цвет. Назначае- ^ ^ ^
мый цвет зависит от окраски «пипетки» — можно определить ее ^ ^ #
по виду кнопки.

ПРИМЕЧАНИЕ
Двойным щелчком на кнопке «пипетки» задается цвет, который вы сможете устанавливать
при помощи этого инструмента.

В отличие от задания цветовых уровней при помощи гистограммы или полей
ввода использование «пипеток» позволяет установить чистые значения черного,
серого и белого и избежать появления нежелательной окраски. Более того, уста-
новка цветовых уровней таким образом позволяет устранить нежелательную до-
полнительную окраску, вызванную, например, окраской света от использованно-
го источника освещения.

Теперь посмотрим, как изменение уровней влияет на реальное изображение.

На рис. 13.10 показано исходное изображение и окно команды Levels (Уровни)
сразу после ее вызова. Как видите, исходное изображение можно отнести к пере-
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экспонированным — большая часть изображения окрашена в темные тона. Это
заметно и на гистограмме яркости.

Рис. 13.10. Исходное изображение и вид окна команды Levels сразу после ее вызова

На фотографии изображено здание Русского музея, снятое в яркий солнечный
день. Поэтому прежде всего откорректируем уровень белого цвета — это позво-
лит вернуть изображению яркость. Сдвинем указатель уровня белого в сторону
уменьшения яркости (в сторону указателей черного и серого уровней). При этом
часть пикселов окрасится в более светлые тона, а динамический диапазон изо-
бражения несколько сузится, что увеличит контрастность изображения.

На рис. 13.11 показано изображение после выполнения этого этапа работ, на
этом же рисунке представлено окно команды Levels.

Рис. 13.11. Вид изображения и окна команды Levels после коррекции уровня белого

Теперь видно, что ярко освещенные солнцем элементы здания стали в долж-
ной степени белыми. Для придания изображению законченного вида необходимо
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несколько изменить соотношение яркости темных и светлых элементов изобра-
жения. Это позволит сделать видимыми детали, пока еще скрытые в тени.

Выполнить такое преобразование можно, сместив уровень серого таким обра-
зом, чтобы на долю «светлых» пикселов пришлась большая часть динамиче-
ского диапазона. Вид изображения и окно команды Levels (Уровни) показаны
на рис. 13.12. Щелкните на кнопке ОК для применения преобразований к изо-
бражению.

'Channel;; RGB

Input Levels: j 0
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Г OK I

{ ...... Cancel .... j

} Load, ~~1
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Output Levels: j 0 _ ||255 J||
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Рис. 13.12. Настройки уровня серого для выявления деталей, скрытых
в темных участках изображения

В данном случае нам не потребовалась коррекция уровня черного — тени на
изображении и так достаточно густые. Однако если бы изображение изначально
было не темным, а излишне светлым, коррекция уровня черного помогла бы
придать ему контраст и увеличить детализацию.

СОВЕТ

Вместо установки уровней цвета при помощи указателей можно использовать «пипетки».
Это особенно удобно для изображений, содержащих ярко выраженные области теней, ней-
тральных оттенков и ярко освещенные области изображения.

Если при съемке вы использовали эталонную карту с цветами, выставьте цветовые уровни
по соответствующим полям карты.

Если вы вызовете команду Levels (Уровни) снова, после того, как воспользо-
вались ею, вы увидите, что ранее слитный график распределения пикселов по
яркости приобрел вид набора пиков (рис. 13.13). Это говорит о том, что дина-
мического диапазона изображения, измененного при коррекции уровней, не
хватает для плавного отображения цветовых переходов. Если излишне повысить
контрастность изображения, число градаций яркости (в данном случае именно
они отображаются на гистограмме) станет слишком малым для корректного ото-
бражения плавных переходов цвета (например, неба), а иногда и других деталей
изображения.
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Channel: I RGB

v Input levels: I 0

Рис. 13.13. При коррекции яркости и контраста изображения (в частности, с помощью
команды Levels) число градаций яркости пикселов может уменьшиться, что приведет

к снижению точности передачи переходов цвета или более мелких деталей

Настройки цветовых кривых
Еще более мощное средство цветокоррекции и управления яркостью изображе-
ния — изменение формы цветовых кривых. Цветовые кривые задают соотноше-
ние между исходными значениями яркости пиксела (или яркости в отдельных
цветовых каналах) и значениями, получаемыми после применения команды. По
умолчанию эти зависимости имеют линейный вид. Например, пикселы, имею-
щие яркость 128, после применения команды получат точно такую же яркость.

Изменяя форму этой зависимости (цветовой кривой), можно управлять яркостью
пикселов и их оттенком (для этого необходимо отдельно редактировать различ-
ные цветовые каналы). Преобразование может быть нелинейным — например,
можно увеличить яркость темных областей, получившихся на снимке излишне
густыми, или же, наоборот, затемнить темные области и осветлить светлые,
усилив тем самым контраст изображения.

Преобразование цветовых кривых (в технике принят термин «передаточная функ-
ция») выполняется при помощи команды Image > Adjustments > Curves (Изобра-
жение> Настройки > Кривые). На рис. 13.14 показано окно этой команды.

В центральной части окна находится график кривой передачи цвета. По гори-
зонтали откладываются исходные значения яркости, а по вертикали — значения,
которые будут присутствовать в изображении после обработки. При перемеще-
нии курсора над полем кривой под графиком отображаются два значения — Input
(Входное значение) и Output (Выходное значение). Верхний правый угол соот-
ветствует уровню белого, нижний левый — уровню черного. Щелкнув на гради-
ентной полосе, расположенной под графиком, можно переключить график в ре-
жим работы с полиграфическими красками. При этом вы будете управлять не
яркостью, как в используемом по умолчанию режиме, а плотностью красителя.
Из расположенного над графиком списка можно выбрать конкретный цветовой
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канал или пункт с названием текущего цветового режима для применения пре-
образования одновременно ко всем каналам.

I Channel: | RGB
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Рис. 13.14. Окно команды Curves

Можно изменять форму кривой при помощи мыши. Щелчок на графике по-
зволяет создать опорную точку, которую вы затем можете переместить в нужное
положение. На рис. 13.15 представлен пример кривой, используемой, в данном
случае, для усиления контраста изображения.
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Рис. 13.15. Пример изменения кривой передачи цвета с целью коррекции изображения,
в данном случае — для увеличения контрастности
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Если одна из опорных точек стала вам не нужна, просто «утащите» ее мышью за
пределы окна команды. Точка будет удалена.

В правой части окна находятся уже знакомые по работе с командой Levels (Уров-
ни) кнопки с изображением пипеток. Используя их, можно задавать цветовые
уровни, щелкая по нужным точкам изображения. Если вы хотите проверить, к ка-
кой точке кривой относится тот или иной пиксел изображения, наведите на него
курсор при нажатой клавише Alt. Соответствующая точка будет выделана на
кривой круглым маркером.

Использование команды Curves (Кривые) требует определенных навыков. Надо
хорошо представлять, к каким изменениям в изображении приведет изменение
яркости тех или иных пикселов. В данном случае имеются в виду не конкретные
пикселы, а группы пикселов, имеющих сходную яркость.

СОВЕТ
Если вы замечаете, что ваша цифровая камера или сканер постоянно создают несколько
темное или, наоборот, несколько светлое изображение, можно подобрать форму кривой,
устраняющей этот недостаток.

Простые приемы цветокоррекции
Во многих случаях у фотографа возникает желание или необходимость произве-
сти коррекцию цветов изображения. Adobe Photoshop CS предоставляет несколь-
ко способов изменить такие характеристики изображения, как оттенок и насы-
щенность. Используя любой из них, можно, например, сделать ярче краски на
бледном снимке или изменить оттенок лица, получившегося немного неестест-
венным из-за неудачного освещения.

Самым простым в использовании и наглядным методом цветокоррекции в Adobe
Photoshop CS является команда Image > Adjustments > Variations (Изображение >
Настройки > Варианты). С ее помощью можно постепенно изменять оттенок,
яркость и насыщенность изображения. Причем вы сможете видеть, к какому ре-
зультату приведет то или иное преобразование.

На рис. 13.16 приведен пример обработки изображения при помощи команды
Variations (Варианты). В окне команды находится несколько образцов изображе-
ния, щелкая по которым можно изменять изображение.

В верхней части окна находится исходное изображение — Original (Оригинал).
Щелкнув на нем, можно в любой момент вернуть изображение в исходное со-
стояние. Рядом находится образец изображения в текущем состоянии — Current
Pick (Текущее состояние).

СОВЕТ
Во многих окнах команд Adobe Photoshop CS можно вернуть изображение в исходное состоя-
ние, щелкнув на имеющейся в окне кнопке Cancel (Отмена), удерживая при этом нажатой
клавишу Alt.
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;Q Shadows

О Highlights
О Saturation

Рис. 13.16. Окно команды Variations

Рядом с этими образцами находится группа переключателей, с по-
мощью которой можно выбрать изменяемые параметры. Можно
установить следующие значения:

• Shadows (Тени), Midtones (Нейтральные), Highlights (Света) —
можно выбрать, насколько яркие пикселы будут подвергнуты
обработке;

• Saturation (Насыщенность) — можно переключить окно команды в режим из-
менения насыщенности.

При выборе одного из диапазонов яркости окно приобретает вид, показанный
на рис. 13.16. В левой части окна при этом находится семь образцов изображе-
ния. В центре находится образец текущего изображения, а вокруг него — образ-
цы изображения после добавления к его окраске какого-либо оттенка. Образцы
имеют подписи, помогающие определить, какой именно оттенок связан с этим
образцом.

Можно добавить к изображению следующие оттенки:

• More Green (Добавить зеленого) — смещает окраску изображения в сторону зе-
леного цвета;
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• More Yellow (Добавить желтого) — смещает окраску изображения в сторону
желтого цвета;

• More Magenta (Добавить пурпурного) — смещает окраску изображения в сто-
рону пурпурного цвета;

• More Blue (Добавить синего) — смещает окраску изображения в сторону сине-
го цвета;

• More Cyan (Добавить голубого) — смещает окраску изображения в сторону го-
лубого цвета.

В правой части окна находится образец текущего состояния изображения и два
образца: изображения повышенной (Lighter) или пониженной (Darker) яркости.

При переключении окна в режим Saturation (Насыщенность) вместо образцов
семи различных оттенков вы увидите три образца — текущее состояние докумен-
та, образец пониженной насыщенности (Less Saturation) и образец повышенной
насыщенности (More Saturation).

Образцы состояний документа не только отображают вид изображения после
применения того или иного преобразования. Щелкая по образцам, можно при-
дать изображению вид, показанный на образце.

Ползунок, расположенный в верхней части окна, позволяет изме-
нять силу эффекта от одного «шага» преобразования (щелчка на
образце).

Рядом с ползунком располагается флажок Show Clipping (Показать ;|_
отсечение). Если он установлен, на образцах изображения будут
ярким цветом выделены области, окраска которых выходит за пределы диапазо-
на, допустимого в режиме CMYK.

Также в верхней части окна находятся кнопки ОК и Cancel (Отмена). Кнопки Load
(Загрузить) и Save (Сохранить) позволят вам, установив параметры преобразо-
вания, сохранить их в файле на жестком диске и затем использовать при обра-
ботке других изображений.

Расширенные возможности
цветокоррекци и
В Adobe Photoshop CS имеется еще несколько команд, позволяющих корректи-
ровать оттенки изображения. В отличие от команды Variations (Варианты) они не
содержат образцов изображения, но зато можно видеть предварительный резуль-
тат преобразования непосредственно в окне изображения.

Настройки оттенка и насыщенности изображения
Команда Image > Adjustments * Hue/Saturation (Изображение > Настройки > Цветовой
тон/Насыщенность) позволяет независимо изменять оттенок изображения или
его выделенного фрагмента, насыщенность цвета и его яркость. На рис. 13.17 по-
казано окно этой команды в исходном состоянии.
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Рис. 13.17. Окно команды Hue/Saturation

Основными органами управления в этом окне являются три ползунка, позво-
ляющих контролировать параметры изображения:

• Hue (Цветовой тон) — позволяет сдвигать оттенки выделенных пикселов (или
всех пикселов изображения) на указанную величину. Изменение производит-
ся с шагом в 1° (оттенок традиционно задается как положение на цветовом
круге в градусах). Диапазон изменений от -180 до +180°, причем значения
-180° и +180° эквивалентны — цветовой круг в обоих случаях «проворачива-
ется» на пол-оборота.

• Saturation (Насыщенность) — управляет насыщенностью цвета. Измеряется
в процентах и может принимать значения от -100 % (полное обесцвечива-
ние) до +100 % (максимальная насыщенность).

• Lightness (Яркость) — позволяет управлять яркостью цвета. Принимает значе-
ние от -100 (черный цвет) до +100 (белый цвет).

При установленном флажке Preview (Просмотр) вы будете видеть вносимые в изо-
бражения изменения непосредственно в окне документа.

Флажок Colorize (Тонирование) позволяет вместо изменения оттенков изображе-
ния придать всем пикселам новый оттенок — тонировать изображение или его
выделенный фрагмент. Этот эффект используется, например, для создания эф-
фекта тонированных фотографий (например, сепия).

Под ползунками находятся две полосы, окрашенные в цвета спектра. Верхняя
полоса является эталонной — на ней можно видеть исходный спектр (этот спектр
является отражением эталонных цветов, а не цветов, присутствующих в изобра-
жении). При выполнении преобразования на нижней полосе отображаются изме-
нения цвета.

По умолчанию эффект от преобразования применяется ко всем пикселам, попав-
шим в выделенный фрагмент (или всем пикселам изображения). Можно допол-
нительно ограничить область применения команды пикселами, изначально окра-
шенными в определенный цвет.
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В верхней части окна команды находится раскрывающийся список Edit (Редак-
тирование). Из него можно выбрать диапазон оттенков, на который распростра-
нится действие преобразования. По умолчанию из списка выбран пункт Master
(Все), соответствующий редактированию всего изображения.

При выборе диапазона оттенков для редактирования между полосами спектра
в нижней части окна отображаются маркеры, указывающие границы диапазона
редактируемых оттенков (рис. 13.18).

Hue/Saturation

BJit:j Yellows

::^ v.Hue;...-

Lightness;

15?/45* •

Cancel

Save...

Bcalorlze
В Preview

Рис. 13.18. Окно команды Hue/Saturation в режиме редактирования
определенного цветового диапазона

Границы редактируемого диапазона оттенков ограничиваются двумя парами марке-
ров. Их позиция (в градусах) отображается над полосами. Крайние маркеры ука-
зывают границу диапазонов. Маркеры, находящиеся ближе к центру диапазона,
ограничивают зону полного воздействия команды на изображение. Между парами
маркеров находится зона частичного воздействия на пикселы, окрашенные в со-
ответствующие тона. Такая «размытость» границ позволяет избежать появления
на изображении резких границ обработанных и необработанных фрагментов.

Выбрав диапазон цветов из списка Edit (Редактирование), вы смо- ;;Г 1̂ ж л
жете использовать кнопки с изображениями пипеток, располо- ;Mi~U** .•'*•••.
женные в нижней части окна. «Обычная пипетка» позволяет выбрать диапазон
оттенков при щелчке мышью на нужном участке изображения.

«Пипетка с плюсом» и «пипетка с минусом» позволяют добавлять новые оттен-
ки в диапазону редактируемых цветов или вычитать оттенки из него. При этом
диапазон оттенков не может содержать несколько фрагментов. Он может быть
только слитным.

СОВЕТ
Для вызова этой и многих других команд можно использовать «горячие клавиши» — комби-
нации клавиш, связанные с тем или иным действием. Такие комбинации клавиш, как правило,
указываются рядом с соответствующим пунктом меню.
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Изменение баланса цветов
В некоторых случаях возникает желание или необходимость изменить баланс цве-
тов, содержащихся в изображении. Например, сделать лежащий на столе апельсин
более желтым, убрав при этом излишне зеленую окраску скатерти. Выполнять
подобные действия можно при помощи команды Image > Adjustments > Color Balance
(Изображение > Настройки > Цветовой баланс).

На рис. 13.19 показано окно этой команды. В нем содержатся три ползунка, с по-
мощью которых можно изменять соотношение в изображении основных цветов
и цветов, дополнительных им: голубой-красный (Cyan-Red), пурпурный-зеле-
ный (Magenta-Green) и желтый-синий (Yellow-Blue).

Color Balance

Cancel

E] Preview

ОShadows ©Midtones О Highlights

0 Preserve Luminosity

Рис. 13.19. Окно команды Color Balance

В нижней части окна находится переключатель, при помощи которого можно ог-
раничить область воздействия команды, он имеет три положения:

• Shadows (Тени) — преобразование применяется к пикселам темных тонов;

• Midtones (Нейтральные тона) — изменяется окраска пикселов, имеющих цвет,
близкий к нейтральному;

• Highlights (Света) — будет изменена окраска ярко окрашенных пикселов.

При установленном флажке Preserve Luminosity (Сохранить яркость) будет изме-
нен только оттенок пикселов, а их яркость сохранится неизменной.

Имитация использования
фотографических фильтров
Команда Image > Adjustments > Photo Filter (Изображение > Настройки > Фото-
фильтр) позволяет имитировать результат использования во время съемки цвет-
ных светофильтров. На рис. 13.20 показано окно этой команды.

В группе Use (Использовать) можно выбрать, какой именно фильтр будет при-
менен к изображению. Режим выбирается при помощи имеющегося в группе пе-
реключателя.
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Рис. 13.20. Окно команды Photo Filter

В режиме Filter (Фильтр) имитируется эффект от использования фильтра, тип
которого можно выбрать из расположенного рядом с пунктом переключателя
раскрывающегося списка.

В режиме Color (Цвет) можно самостоятельно выбрать цвет фильтра, щелкнув на
расположенном рядом с пунктом переключателя образце.

ПРИМЕЧАНИЕ
При выборе фильтра из списка образец цвета приобретает соответствующую выбранному
фильтру окраску. После этого можно переключить команду в режим Color (Цвет) и откоррек-
тировать оттенок фильтра, который будет применен к изображению.

В нижней части окна находится ползунок Density (Эффект). При помощи него
можно задать плотность фильтра. Этот параметр определяет эффект, производи-
мый командой.

Также в окне находится флажок Preserve Luminosity (Сохранять яркость). Если он
установлен, яркость пикселов в процессе преобразования останется неизменной.

Обесцвечивание изображения
В некоторых случаях бывает необходимо обесцветить изображение, например,
для печати черно-белых фотографий, в то время как в вашем распоряжении име-
ется цветной оригинал.

Выполнить эту операцию можно при помощи команды Image > Adjustments >
Desaturate (Изображение > Настройки > Обесцветить).

ПРИМЕЧАНИЕ
Многие действия в Adobe Photoshop CS можно выполнить несколькими путями. Например,
обесцветить изображение можно при помощи команды Desaturate (Обесцветить) или
установив минимальное значение насыщенности в окне команды Hue/Saturation (Цветовой
тон/Насыщенность).

По мере накопления опыта работы с Adobe Photoshop вы узнаете множество способов
выполнить одно и то же действие. Некоторые из них значительно ускоряют работу, другие
позволяют точнее контролировать процесс обработки.
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В этой главе мы с вами познакомились с наиболее удобными и широко исполь-
зуемыми, особенно на начальных этапах освоения Adobe Photoshop, приемами
коррекции яркости, контраста и оттенков изображения. По мере освоения вами
технологий и приемов цифровой фотографии вы сможете откорректировать или
значительно улучшить вид несколько неудачной или даже почти испорченной
фотографии. Кроме того, на цветокоррекции основано множество художествен-
ных приемов, которые позволят вам не только изменить изображение для дости-
жения желаемого эффекта, но и создать на его основе совершенно новое произ-
ведение, лишь отдаленно напоминающее оригинал. Измененные таким образом
фотографии часто используются при разработке дизайн-проектов рекламных
модулей, оформлении витрин, подготовке к печати сложных и красочных жур-
налов и каталогов. В последующих главах мы познакомимся с некоторыми прие-
мами устранения «механических» повреждений фотографии (мелких дефектов,
случайно попавших в кадр и ненужных объектов), а также с некоторыми про-
стыми приемами художественной обработки фотографий.

'



Глава 14

Использование фильтров
Цифровым фотографиям, равно как и сканированным изображениям,.нередко
присущи такие недостатки и искажения, как размытость или избыточная резкость
и наличие посторонних шумов.

Данная глава будет посвящена тому, как избавиться от этих недостатков при по-
мощи арсенала фильтров Adobe Photoshop, а также имитировать эффекты, при-
сущие реальным физическим явлениям.

Фильтры повышения резкости
В случае недостаточной резкости изображения на помощь придет группа фильт-
ров Sharpen (Резкость). В группе находится четыре фильтра, действие которых
основано на повышении контрастности соседних пикселов. Рассмотрим принцип
действия и практическое применение каждого из фильтров этой группы.

1. Sharpen (Резкость). Данный фильтр увеличивает резкость всего изображения
или его выделенной области, дополнительных настроек не имеет.

2. Sharpen Edges (Резкость на краях). Фильтр выделяет границы однотонных об-
ластей и увеличивает их контрастность. Обрабатывает только ярко выражен-
ные границы и контуры, оставляя без изменений все остальное. Дополнитель-
ных настроек также не имеет.

3. Sharpen More (Резкость+). Эффект от применения аналогичен Sharpen (Резкость),
но примерно в два раза сильнее. Дополнительных настроек не имеет.

На рис. 14.1 показаны результаты применения трех вышеописанных фильтров.

Unsharp Mask
Этот фильтр предназначен для более точной коррекции изображения. Диалого-
вое окно работы с данным фильтром представлено на рис. 14.2.

Как видно из рис. 14.2, управлять можно следующими параметрами:

• Amount (Эффект) — задает силу действия фильтра. Изменяется в пределах от
1 до 500 %. Поскольку эффект от применения фильтра заметнее на экране мо-
нитора, нежели на бумаге, то в случае последующего вывода изображения на
печать имеет смысл увеличить значение данного параметра.
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Рис. 14.1. Результаты применения трех первых фильтров группы Sharpen (Резкость):
а — оригинальное изображение; 6 — фильтр Sharpen (Резкость); в — Sharpen Edges

(Резкость на краях); г — Sharpen More (Резкосты-)

Unsharp Mask

В

Threshold:! 15 ; levels

Рис. 14.2. Диалоговое окно работы с фильтром Unsharp Mask
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• Radius (Радиус) — определяет область поиска пикселов, отличающихся от те-
кущего больше, чем на пороговую величину. Изменяется в пределах от 0,1 до
250 пикселов. При малых значениях данного параметра резкость увеличива-
ется только на границах областей, при больших также повышается резкость
внутри однотонных участков изображения.

• Threshold (Порог) — задает пороговое значение яркости, на которое должны
различаться пикселы для повышения их контрастности. Изменяется в пре-
делах от 0 до 255 уровней. Если этот параметр равен нулю, будут обработа-
ны все пикселы изображения. Высокие значения позволяют повысить рез-
кость только на границах однотонных областей или при резких перепадах
яркости.

На рис. 14.3 мы видим, что представляет собой результат применения фильтра
Unsharp Mask (Контурная резкость).

Рис. 14.3. Слева — оригинальное изображение; справа — изображение после применения
фильтра Unsharp Mask (Нерезкая маска) со следующими значениями параметров:

Amount = 145 %, Radius = 2 пиксела, Threshold = 5 уровней

Фильтры, размывающие изображение
(ослабляющие резкость)
При обработке цифровых фотографий или сканированных изображений сущест-
вует риск появления избыточной резкости. Для того чтобы решить подобную
проблему, можно использовать фильтры группы Blur (Размытие).

Эффект от воздействия фильтров этой группы основан на сглаживании перехо-
дов путем усреднения соседних пикселов.

ВНИМАНИЕ
Прежде чем применять фильтры размытия, убедитесь в том, что в палитре слоев не выбрана
опция Preserve Transparency (Сохранить прозрачность).

Average
Этот фильтр определяет средний цвет изображения или его выделенной облас-
ти, а затем заполняет этим цветом изображение или его выделенную область.
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Дополнительных настроек не имеет. Область применения данного фильтра вы-
ходит за рамки цифровой фотографии, скорее имея отношение к сканированным
изображениям. Например, фильтр Average (Усреднение) может помочь при очи-
стке сканированной диаграммы или текста.

Blur (Размытие) и Blur More (Размытие+). Оба этих фильтра предназначены для
устранения резких цветовых переходов в изображении или выделенной области.
Создают эффект размытия в соответствии с нормальным распределением. Раз-
личие между ними заключается в том, что эффект от фильтра Blur More (Размы-
тие+) в три-четыре раза превышает эффект от фильтра Blur (Размытие). Допол-
нительных настроек также не имеют.

На рис. 14.4 показаны результаты применения фильтров Blur (Размытие) и Blur
More (Размытие+).

Рис. 14.4. Результаты применения фильтров Blur и Blur More: a — оригинальное
изображение; 6 — изображение после применения фильтра Blur;

в — изображение после применения фильтра Blur More

Gaussian Blur
Принцип действия фильтра основан на использовании гауссовского распределе-
ния, имеющего вид колоколообразной кривой. Диалоговое окно работы с дан-
ным фильтром представлено на рис. 14.5.



Фильтры, размывающие изображение (ослабляющие резкость) 223

Gaussian Olur

0 »*> Ш :

: Radte;:J3,o | pixels

Рис. 14.5. Диалоговое окно работы с фильтром Gaussian Blur

Управляемым параметром является Radius (Радиус) — степень размытия изобра-
жения. Пределы изменения этой величины — от 0,1 до 255 пикселов.

После применения фильтра пикселы на границе двух разноокрашенных обла-
стей приобретают промежуточные оттенки.

Lens Blur
Фильтр позволяет создать на одном изображении области с различной степенью раз-
мытости. Для определения областей размытия можно либо просто выделить нуж-
ный фрагмент, либо, в более сложном случае градиентного размытия, создать альфа-
канал. Черные области альфа-канала станут передним планом изображения, белые —
размытым фоном. Диалоговое окно работы с фильтром представлено на рис. 14.6.

Как видно из рис. 14.6, управляемые параметры сгруппированы по назначению.
Рассмотрим по порядку все пять групп:

• Preview (Просмотр) — на этой вкладке находятся два переключателя, отве-
чающие за качество изображения в окне просмотра: Faster (Быстрее) и More
Accurate (Более точный).

• Depth Map (Карта глубины) — в эту группу входят следующие параметры:

D Source (Источник) — может принимать следующие значения: None (Нет),
Transparency (Прозрачность), Layer Mask (Маска слоя); определяет, с ис-
пользованием какого источника будет построена карта глубины: выделен-
ной области, прозрачной области или альфа-канала;

Q Blur Focal Distance ( Фокус размытия) — задается в случае использования
в качестве источника прозрачной области или альфа-канала; изменяется
в пределах от 0 до 255 пикселов; чем больше значение, тем меньше произ-
водимый эффект;

П флажок Invert (Наоборот) — меняет местами передний план и фон.
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Рис 14.6. Диалоговое окно работы с фильтром Lens Blur

Iris (Диафрагма) — на этой вкладке расположены параметры, связанные с диа-
фрагмой:

П Shape (Форма) — описывает многоугольник диафрагмы, количество углов
варьирует от трех до восьми;

D Radius (Радиус) — определяет степень размытия; изменяется в пределах от
О до 100 пикселов;

П Blade Curvature (Кривизна поля) — определяет скругленность диафрагмы;
изменяется в пределах от 0 до 100;

Q Rotation (Вращение) — задает угол поворота диафрагмы; изменяется в пре-
делах от 0 до 360 градусов.
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• Specular Highlights (Управление бликами) — в эту группу входят следующие
параметры:

D Brightness (Яркость) — задает яркость источника света; изменяется в пре-
делах от 0 до 100;

D Threshold (Порог) — задает пороговое значение яркости, на которое долж-
ны различаться пикселы для их подсвечивания; изменяется в пределах от
О до 255 уровней.

• Noise (Шум) — на этой вкладке находятся следующие параметры, связанные
с добавлением шума к изображению, подвергающемуся обработке:

П Amount (Эффект) — задает количество оттенков, на которое новый цвет
каждого пиксела должен отличаться от старого; изменяется в пределах от
О до 100;

П Distribution (Распределение) — определяет вид распределения шума; может
принимать одно из двух значений: Uniform (Равномерное) или Gaussian (Га-
уссовское);

П флажок Monochromatic (Монохромный) — создает «серый» шум, то есть
шум, равномерно распределенный по различным цветовым каналам.

На практике фильтр Lens Blur (Линзовое размытие) удобнее всего применять для
имитации глубины резкости. На рис. 14.7 показано, как выглядит изображение
до и после применения фильтра.

Рис. 14.7. Слева — оригинальное изображение; справа — изображение
после применения фильтра Lens Blur

Ослабление резкости может быть также направленным. Эта возможность реали-
зована в фильтрах Motion Blur (Размытие в движении) и Radial Blur (Радиальное
размытие).

Motion Blur
Фильтр создает эффект движения камеры или объекта съемки. Принцип действия
фильтра основан на применении линейного распределения, имеющего максимум
в центре и сводящегося к нулю на краях. Диалоговое окно работы с фильтром
представлено на рис. 14.8.

8 Зак. 805
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Motion Blur
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Рис. 14.8. Диалоговое окно работы с фильтром Motion Blur

Как видно из рис. 14.8, регулировать можно два следующих параметра:

• Afigle (Угол) — направление мнимого перемещения;

• Distance (Расстояние) — длина отрезка к которому применяется линейное
распределение от 1 до 999 пикселов.

Radial Blur
Диалоговое окно работы с фильтром представлено на рис. 14.9.
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Рис. 14.9. Диалоговое окно работы с фильтром Radial Blur

Как видно из рис. 14.9, производимый фильтром эффект будет зависеть от
выбранного параметра Blur Method (Способ размытия). При выборе метода Spin
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(Вращение) получаем эффект вращения изображения вокруг заданной точки.
Метод Zoom (Радиусы) имитирует удаление от наблюдателя объекта съемки.
Осевая точка для вращения или перемещения задается внутри сетки Blur Center
(Центр размытия).

Параметр A m o u n t (Эффект) задает расстояние действия фильтра. Изменяется
в пределах от 0 до 100 пикселов.

Параметр Quality (Качество) может принимать одно из трех следующих значений:

• Draft (Низкое) — обеспечивает минимальное время обработки изображения
фильтром, но оставляет необработанные пикселы;

• Good (Хорошее) — сглаживает изображение с помощью билинейной интерпо-
ляции;

• Best (Отличное) — сглаживает изображение с помощью бикубической интер-
поляции.

Рис. 14.10. Эффекты применения фильтров: а — оригинальное изображение;
б — изображение после применения фильтра Motion Blur; в — изображение

после применения фильтра Radial Blur

•
Smart Blur
Фильтр обрабатывает низкоконтрастные области изображения, не внося измене-
ний в контуры. Диалоговое окно работы с фильтром представлено на рис. 1.4.11.

Как видно из рис. 14.11, можно управлять следующими параметрами:

• Radius (Радиус) — определяет степень размытия изображения; пределы изме-
нения этой величины от 0,1 до 100 пикселов;

• Threshold (Порог) — задает минимальное различие между соседними пиксе-
лами, определяемыми как контур; пределы изменения этой величины от
0,1 до 100 пикселов;

• Quality (Качество) — определяет сглаженность контуров, может принимать
одно из следующих значений: Low (Низкое), Medium (Среднее) и H i g h (Вы-
сокое);

• Mode (Режим) — позволяет выделить белым цветом контуры, заданные па-
раметром Threshold (Порог); может принимать одно из следующих значений:
Normal (Нормальный), Edge Only (Только контуры) и Overlay Edge (Наложение
контуров).
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Рис. 14.11. Диалоговое окно работы с фильтром Smart Blur

На рис. 14.12 показано, какой результат можно получить, применяя фильтр Smart
Blur (Умное размытие).

Рис. 14.12. Применение фильтра Smart Blur: слева — оригинальное изображение; справа —
изображение после применения фильтра со следующими значениями параметров:

Radius = 5 пикселов, Threshold = 50 пикселов, Quality — High, Mode — Normal

Фильтры добавления и удаления шума
Следующая группа полезных при обработке цифровых или сканированных фо-
тографий фильтров — это группа Noise (Шум). В этой группе присутствуют как
фильтры добавления шума, так и фильтры избавления от него.
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«Шумы» — дефекты изображения, проявляющиеся в случайном изменении яр-
кости или цвета пикселов. Они часто возникают вследствие сканирования пыль-
ных или некачественных фотографий. Другой источник шума — чувствительные
матрицы цифровых фотокамер. Вследствие своей природы они создают «шум-
ное» изображение. Некоторые камеры оснащаются системой шумоподавления,
но какое-то количество шума все равно присутствует в изображении.

ВНИМАНИЕ
Устранить шум и дефекты из изображения можно только ценой потери мелких деталей,
не являющихся помехами. Поэтому следует стремиться получить в свое распоряжение как
можно более качественный оригинал.

СОВЕТ
Для уменьшения уровня шума попробуйте выполнить следующие действия: при печати фо-
тографий, предназначенных для сканирования, закажите или используйте глянцевую фото-
бумагу, при съемке цифровой фотокамерой установите минимально возможное значение
чувствительности (ISO Speed ) матрицы.

Add Noise
Фильтр имитирует зернистость поверхности. Диалоговое окно работы с фильт-
ром представлено на рис. 14.13.
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Рис. 14.13. Диалоговое окно работы с фильтром Add Noise

Регулируются следующие параметры:

• Amount (Эффект) — задает количество оттенков, на которое новый цвет каждого
пиксела должен отличаться от старого; изменяется в пределах от 0 до 100 %;



230 Глава 14. Использование фильтров

• Distribution (Распределение) — определяет вид распределения шума; может при-
нимать одно из двух значений: Uniform (Равномерное) или Gaussian (Гауссовское);

• флажок Monochromatic (Монохромный) — создает «серый» шум, то есть шум,
равномерно распределенный по различным цветовым каналам.

На рис. 14.14 представлен результат применения фильтра Add Noise (Доба-
вить шум).

Рис. 14.14. Результат применения фильтра Add Noise: слева — оригинальное изображение;
справа — изображение после применения фильтра со следующими значениями

параметров: Amount = 15 %, Distribution — Gaussian

Despecle
Фильтр ослабляет резкость изображения, не затрагавая границы (области с резким
изменением яркости пикселов). Дополнительных настроек нет. На рис. 14.15
представлен результат применения фильтра Despecle (Удалить шум).

Рис. 14.15. Слева — оригинальное изображение; справа — изображение после
применения фильтра Despecle

Dust & Scratches
Фильтр убирает шум, преобразуя отличающиеся от остальных пикселы. Диало-
говое окно работы с фильтром представлено на рис. 14.16.
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Рис. 14.16. Диалоговое окно работы с фильтром Dust & Scratches

Регулируются следующие параметры:

• Radius (Радиус) — определяет степень размытия изображения; пределы изме-
нения этой величины от 0,1 до 100 пикселов;

• Threshold (Порог) — задает минимальное различие между соседними пиксела-
ми, определяемыми как контур; пределы изменения этой величины от 0,1 до
100 уровней.

На рис. 14.17 представлен результат применения фильтра Dust & Scratches (Пыль
и царапины). Участок изображения, содержащий изъян, был предварительно
выделен инструментом Rectangular Marquee (Прямоугольная область).

Рис. 14.17. Результат применения фильтра Dust & Scratches: слева — оригинальное
изображение; справа — изображение после применения фильтра со следующими

значениями параметров: Radius = 11 пикселов, Threshold = 13 уровней
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Median
Этот фильтр уменьшает шум, действуя по тому же принципу, что и фильтр Average
(Усреднение), с той лишь разницей, что усреднению подвергается яркость пик-
селов. Полезен при необходимости устранения эффекта движения. Диалоговое
окно работы с фильтром представлено на рис. 14.18.

Рис. 14.18. Диалоговое окно работы с фильтром Median

Можно управлять параметром Radius (Радиус), который определяет степень воз-
действия на изображение. Пределы изменения этой величины от ОД до 100 пик-
селов. Результат применения представлен на рис. 14.19.

Рис. 14.19. Результат применения фильтра Median: слева — оригинальное изображение;
справа — изображение после применения фильтра Median

Кроме вышеперечисленных фильтров стандартный набор Adobe Photoshop вклю-
чает в себя следующие:
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• Artistic (Художественные) — имитируют различные живописные эффекты.
В этой группе находятся фильтры Colored Pencil (Цветной карандаш), Cutout
(Аппликация), Dry Brush (Сухая кисть), Film Grain (Зерно кинопленки), Fresco
(Фреска), Neon Glow (Неоновое свечение), Paint Daubs (Мазки краски), Palette
Knife (Шпатель), Plastic Wrap (Целлофановая упаковка ), Poster Edges (Очер-
ченные края), Rough Pastels (Пастель), Smudge Stick (Растушевка), Sponge (Губ-
ка), Underpainting (Подкраска), Watercolor (Акварель);

• Brush Strokes (Штрихи). В этой группе находятся фильтры Accented Edges
(Выделенные границы), Angled Strokes (Штрихи под углом), Crosshatch (Пе-
ресекающиеся штрихи), Dark Strokes (Темные штрихи), Ink Outlines (Черниль-
ные контуры), Spatter (Разбрызгивание), Sprayed Strokes (Аэрограф), Sumi-e
(Суми-е);

• Distort (Искажение). В этой группе находятся фильтры Diffuse Glow (Рассеян-
ный свет), Displace (Смещение), Glass (Стекло), Ocean Ripple (Океанские вол-
ны), Pinch (Дисторсия), Polar Coordinates (Полярные координаты), Ripple (Вол-
ны), Shear (Искривление), Spherize (Сферизация), Twirl (Скручивание), Wave
(Волна), ZigZag (Зигзаг);

• Pixelate (Оформление). В этой группе находятся фильтры Color Halftone
(Цветные полутона), Crystallize (Кристаллизация), Facet (Фасет), Fragment
(Фрагмент), Mezzotint (Меццо-тинто), Mosaic (Мозаика), Pointillize (Пуан-
тилизм);

• Render (Создание изображения). В этой группе находятся фильтры Clouds (Об-
лака), Difference Clouds (Облака с наложением), Fibers (Волокна), Lens Flare
(Блик объектива), Lighting Effects (Эффекты освещения);

• Sketch (Набросок). В этой группе находятся фильтры Bas Relief (Барельеф),
Chalk & Charcoal (Мел и уголь), Charcoal (Уголь), Chrome (Хром), Conte Crayon
(Мелки Конте), Graphic Pen (Перо), Halftone Pattern (Растровый шаблон),
Note Paper (Почтовая бумага), Photocopy (Фотокопия), Plaster (Штукатурка),
Reticulation (Ретикуляция), Stamp (Печать), Torn Edges (Рваные края), Water
Paper (Мокрая бумага);

• Stylize (Стилизация). В этой группе находятся фильтры Diffuse (Диффузия),
Emboss (Барельеф), Extrude (Экструзия), Find Edges (Выделение краев), Glowing
Edges (Свечение краев), Solarize (Соляризация), Tiles (Разбиение), Trace Contour
(Оконтуривание), Wind (Ветер);

• Texture (Текстура). В этой группе находятся фильтры Craquelure (Кракелюры),
Grain (Зерно), Mosaic Tiles (Мозаичные фрагменты), Patchwork (Цветная плит-
ка), Stained Glass (Витраж), Texturizer (Текстуризатор).

• Video (Видео). В этой группе находятся фильтры De-Interlace (Восстановить
строки), NTSC Colors (Цвета NTSC);

• Other (Другие). В этой группе находятся фильтры Custom (Заказной), High
Pass (Выделить края), Maximum (Максимум), Minimum (Минимум), Offset (Сме-
щение);
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м Digimarc (Цифровая подпись). В этой группе находятся фильтры Embed Water-
mark (Записать водяной знак), Read Watermark (Прочитать водяной знак). Этот
фильтр является дополнительным модулем Adobe Photoshop, поставляемым
компанией Digimarc. Эта компания разрабатывает средства защиты автор-
ских прав авторов изображений. Поставляемые ею фильтры позволяют вне-
дрять в изображение скрытые метки, указывающие на ваше авторство. Для
получения персонального авторского кода необходимо заплатить некоторую
сумму за его выдачу и годовую поддержку.

В этой главе вы познакомились с фильтрами Adobe Photoshop, наиболее по-
лезными при работе с фотографиями. Теперь вы знаете, какие фильтры нужно
применять для устранения основных недостатков цифровых и сканированных
изображений, и умеете ими пользоваться. Помимо этого, вы имеете представ-
ление об остальных фильтрах, входящих в стандартный набор поставки Adobe
Photoshop.

i



Глава 15 _^

Работа с текстом в Adobe
Photoshop, добавление
надписей к изображению
При обработке цифровых или сканированных изображений зачастую могут
потребоваться не только ретушь и цветокоррекция, но и применение некото-
рых дополнительных «спецэффектов», например нанесения на фотографию
текста: краткого комментария, даты и времени съемки. Средствами Adobe Photo-
shop очень легко добавить к изображению текстовую надпись, в чем мы и убе-
димся, изучив эту главу.

Добавление надписи к изображению
В любую область изображения можно добавить горизонтально или вертикально
расположенный текст, а также создать выделение в виде контура текста.

Для добавления надписи необходимо выбрать инструмент Туре (Текст), «т»
установить курсор в требуемой области изображения и щелкнуть левой
кнопкой мыши. Ввод текста производится как в обычном текстовом редакторе.

Таким образом создается обычный текстовый слой. Если вместо одного щелчка
мышью нажать левую кнопку, переместить курсор, рисуя рамку, а затем отпус-
тить кнопку, можно создать текстовый блок. Вы можете изменять размеры этого
блока, перемещая его границы. При помощи маркеров текстовый блок можно
поворачивать вокруг маркера центра преобразования (вы можете переместить
блок или центр преобразования при помощи мыши).

СОВЕТ
К текстовым слоям применима команды Edit > Free Transform (Редактирование > Свободная
трансформация), позволяющая изменять масштаб и форму выделенного объекта (фрагмен-
та изображения, текста, векторного пути или формы).

При создании надписи с помощью инструмента Туре (Текст) для нее автоматиче-
ски создается отдельный слой.
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ПРИМЕЧАНИЕ
В режимах Multichannel (Мультиканальный), Bitmap (Черно-белый) и .Indexed Color (Индекси-
рованные цвета) отдельный текстовый слой не создается, поскольку данные режимы ис-
пользование слоев не поддерживают. Текст накладывается непосредственно на изображе-
ние и последующему редактированию не подлежит.

При выборе инструмента Туре (Текст) в верхней части рабочей области по- «т»
является панель свойств. Ее внешний вид показан на рис. 15.1.рис.

*.

Рис. 15.1. Внешний вид панели свойств инструмента Туре

Рассмотрим кнопки и меню панели свойств инструмента Туре (Текст). Итак, по
порядку, слева направо:

• кнопка изменения ориентации текста; при нажатии горизонтальная над- |х
пись становится вертикальной и наоборот;

• раскрывающееся меню выбора гарнитуры шрифта;

• раскрывающееся меню выбора начертания шрифта;

ПРИМЕЧАНИЕ
Шрифт — это математическое описание букв, цифр и символов гарнитуры. Гарнитурой на-
зывается набор символов одного шрифта или его семейства. Она включает в себя буквы
обоих регистров, цифры, знаки, маркеры, фигуры. Семейство шрифтов — множество раз-
личных стилей начертания шрифта, например таких, как курсив или полужирный.

кнопка изменения размера шрифта;

раскрывающееся меню выбора размера шрифта;

раскрывающееся меню выбора метода сглаживания шрифта;

кнопка выравнивания по левому краю;

кнопка выравнивания по центру;

кнопка выравнивания по правому краю;

образец цвета текста;

кнопка искривления текста; ^

кнопка, управляющая отображением панелей инструментов Character »
(Символ) и Paragraph (Абзац). *3*

Редактирование надписи
Для изменения параметров текста используются средства двух панелей инстру-
ментов: Character (Символ) и Paragraph (Абзац). Вызвать их можно либо щелчком
на кнопке на панели свойств инструмента Туре (Текст), либо командами ЕЩ
W i n d o w > Character (Окно > Символ) и Window > Paragraph (Окно i> Абзац), ***
соответственно.
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Панель Character (Символ) предназначена для задания атрибутов символа. Внеш-
ний вид панели Character (Символ) представлен на рис. 15.2.
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Рис. 15.2. Внешний вид палитры Character

Как видно из рис. 15.2, на панели находятся пять групп элементов, разде- р*р
ленных горизонтальными полосами, и контекстное меню, открывающееся
при щелчке на кнопке в верхнем правом углу.

Раскрывающиеся меню первой группы позволяют выбрать гарнитуру и начерта-
ние шрифта.

Раскрывающиеся меню второй группы позволяют выбрать размер шрифта, ин-
терлиньяж, кернинг и трекинг.

ПРИМЕЧАНИЕ
Интерлиньяж — расстояние между базовыми линиями двух соседних строк. Кернинг —
расстояние между двумя соседними символами. Трекинг — дополнительное расстояние,
вводимое между символами текста. Для изменения этого параметра необходимо выделить
несколько символов.

Третья группа содержит элементы, позволяющие масштабировать символы по
горизонтали и по вертикали, а также устанавливать величину базовой линии
и цвет шрифта.

Элементы четвертой группы управляют дополнительными атрибутами символов,
такими как полужирное и курсивное начертания, все прописные, малые пропис-
ные, верхний и нижний индексы, подчеркивание, зачеркивание.

Раскрывающееся меню, находящееся в пятой группе, позволяет установить язык
выделенного текста для последующей проверки орфографии и расстановки пе-
реносов, а также задать метод сглаживания шрифта.

Контекстное меню, открывающееся при щелчке на кнопке в верхнем правом fm
углу, содержит семь разделов.

Первая команда Dock to Palette Well (Поместить палитру в пристыковываемое
окно) перемещает панель в верхний правый угол панели свойств инструментов,
после чего она разворачивается по щелчку мыши.
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Следующая группа команд полностью дублирует четвертую вкладку панели
Character (Символ), управляя дополнительными атрибутами символов (полужир-
ное и курсивное начертания, все прописные, малые прописные, верхний и ниж-
ний индексы, подчеркивание, зачеркивание).

Третья группа команд позволяет изменить ориентацию текста с вертикальной на
горизонтальную и наоборот.

Четвертая группа состоит из двух команд: Fractional Widths (Дробная ширина)
и System Layout (Системные значения).

Следующая команда No Break (Без переноса) запрещает расстановку переносов
в тексте.

Шестая группа команд задает параметры проверки синтаксиса.

Последняя команда Reset Character (Восстановить символ) восстанавливает стан-
дартные параметры символа, заданные по умолчанию.

Панель Paragraph (Абзац) позволяет выполнять форматирование текста. Внешний
вид панели представлен на рис. 15.3.

Рис. 15.3. Внешний вид палитры Paragraph

Как видно из рис. 15.3, на панели четыре группы элементов и контекстное
меню, открывающееся при щелчке на кнопке в верхнем правом углу.

В первой группе находятся кнопки, управляющие выравниванием и выключкой
текста.

ПРИМЕЧАНИЕ
Выключкой называется способ размещения текста относительно вертикали.

Вторая группа содержит элементы, позволяющие задать отступы от левого и пра-
вого края, а также величину отступа первой строки.

Кнопки третьей группы управляют отступами до и после абзаца.

В четвертой группе расположен флажок Hyphenate (Переносы), установка кото-
рого приводит к расстановке переносов в тексте.

Контекстное меню, открывающееся при щелчке на кнопке в верхнем правом тщ
углу, содержит пять разделов.

Первая команда Dock to Palette Well (Поместить палитру в пристыковываемое
окно) перемещает панель в верхний правый угол панели свойств инструментов,
после чего она разворачивается по щелчку мыши.
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Вторая команда Roman Hanging Punctuation (Латинские правила пунктуации) за-
дает способ проверки расстановки знаков препинания.

Третья группа состоит из двух команд: Justification (Выключка) и Hyphenation
(Расстановка переносов). Необходимые параметры задаются в диалоговых окнах
работы с этими командами.

Четвертая группа позволяет выбрать метод расстановки переносов слов и пере-
ходов на новую строку. Первая команда Adobe Single-line Composer (Набор в стиле
«единая строка») предлагает обработку отдельной строки в каждый отдельный
момент. При использовании этого метода можно вручную контролировать про-
цесс разбиения текста на строки.

Вторая команда Adobe Every-line Composer (Набор в стиле «несколько строк»)
предлагает единовременную обработку программой нескольких строк. При этом
программа минимизирует число переносов слов, отдавая предпочтение измене-
нию интервалов между соседними словами.

Последняя команда Reset Paragraph (Восстановить абзац) восстанавливает стан-
дартные параметры абзаца, заданные по умолчанию.

ПРИМЕЧАНИЕ
Команды переключения методов расстановки переносов доступны только при работе с тек-
стовым блоком. Для создания текстового блока не просто щелкните мышью в области изо-
бражения, а нажмите левую кнопку мыши, проведите ею, как при работе с инструментом
выделения, и отпустите кнопку мыши.
^

Работа с текстовым слоем
Поскольку для каждой надписи создается отдельный слой, мы можем использо-
вать команды работы со слоями и применять слоевые стили и эффекты. Примером
использования этого преимущества является применение команд меню Edit >
Free Transform (Редактирование > Свободная трансформация) и Edit > Transform
(Редактирование > Трансформация). Исключение составляют только две коман-
ды: Perspective (Перспектива) и Distort (Искажение).

ПРИМЕЧАНИЕ
Чтобы применить команды Edit > Transform > Perspective (Редактирование > Трансформация >
Перспектива) и Edit > Transform > Distort (Редактирование > Трансформация > Искажение),
необходимо растеризовать текстовый спой с помощью команды меню Layer > Rasterize >
Туре (Спой > Растрирование > Текст).

ВНИМАНИЕ
После растеризации текстового слоя текст становится недоступен для редактирования.

Команды работы с текстом
При работе с текстом будут полезными команды меню Layer > Туре (Слой > Текст).
Перечислим их и отметим основные особенности.

Команда Create Work Path (Создать рабочий контур) — создает на основе текстового
слоя векторный объект (путь). Редактировать такой объект как текст уже нельзя,
но вы можете использовать все возможности редактирования векторных объектов.
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Convert to Shape (Преобразовать в контуры). В результате применения этой ко-
манды мы получим вместо текстового слоя слой с векторной маской, аналогич-
ный векторным формам. Редактировать векторную маску как текст невозможно.

ПРИМЕЧАНИЕ
Векторные объекты не могут быть созданы на основе растровых шрифтов, а также на основе
текста, к которому применены.

Изменить ориентацию текста можно командами Horizontal (Горизонтальный)
и Vertical (Вертикальный).

Для того чтобы текст выглядел аккуратно, границы символов сглаживаются. Ре-
жим сглаживания переключается с помощью следующих команд: Anti-Alias None
(Без сглаживания), Anti-Alias Sharp (Резкое сглаживание), Anti-Alias Crisp (Четкое
сглаживание), Anti-Alias Strong (Твердое сглаживание) и Anti-Alias Smooth (Мяг-
кое сглаживание).

Команда Convert to Paragraph Text (Преобразовать в текст абзаца) позволяет преоб-
разовать текст в текстовый блок. Для ее применения необходимо выбрать тек-
стовый слой на панели Layers (Слои).

Команда Convert to Point Text (Преобразовать в текст) позволяет преобразовать
текстовый блок в обычный текст. Для ее применения также необходимо выбрать
текстовый слой на панели Layers (Слои).

Вписать текст в разнообразные формы позволяет команда Warp Text (Искривить
текст). Диалоговое окно работы с этой командой представлено на рис. 15.4.
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Рис. 15.4. Диалоговое окно работы с командой Warp Text

Пример того, что может получиться в результате применения этой команды, мы
видим на рис. 15.5.

Update All Text Layers (Обновить все текстовые слои). При открытии файла, соз-
данного с помощью предыдущей версии Photoshop или Photoshop Elements, вы
можете получить сообщение о необходимости обновления текстовых слоев. Это
требуется для корректного преобразования текста в векторный формат. Если вы
случайно проигнорируете данное сообщение при открытии файла, команда Update
All Text Layers (Обновить все текстовые слои) поможет исправить ситуацию.
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Рис. 15.5. Результат работы команды Warp Text

Replace All Missing Fonts (Заменить все отсутствующие шрифты). С помощью этой
команды можно заменить шрифты, которые некорректно отображаются, посколь-
ку отсутствуют в системе.

СОВЕТ
Для изменения цвета надписи можно использовать клавиатурные сокращения. Для заливки
надписи основным цветом нажмите Alt+Backspace, фоновым — Ctrl+Backspace.

Практические советы
Давайте попробуем применить полученные знания на практике. Рассмотрим не-
сколько стандартных ситуаций, когда требуется разнообразить имеющееся изо-
бражение. Выполнение необходимых действий опишем пошагово.

Создание полупрозрачной надписи, имитирующей датирование кадра фотоап-
паратом:

1. Выберите инструмент Т.

2. Щелкните мышью на нужном участке изображения.

3. Введите текст.

4. Установите желаемый цвет в качестве основного и нажмите Alt+Backspace.

5. Выберите подходящий шрифт и его размер с помощью палитры Character
(Символ).

6. На панели Layers (Слои) определите с помощью бегунка Opacity (Непрозрач-
ность) желаемую степень прозрачности.

На рис. 15.6 показан результат выполнения данной инструкции.

Размещение комментария вдоль произвольной кривой:

1. Создайте кривую с помощью инструментов Реп (Перо), Line (Линия) или любого
из инструментов формы. При работе с инструментами Реп (Перо) или Line (Ли-
ния) нужно учесть следующую особенность: при рисовании кривой слева напра-
во текст впоследствии будет расположен над ней, справа налево — под ней.

9 Зак. 805
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Рис. 15.6. Полупрозрачная надпись, имитирующая датирование кадра фотоаппаратом

2. Установите инструмент А так, чтобы он принял вид -f.

3. Введите текст.

На рис. 15.7 показан результат выполнения данной инструкции.

Рис. 15.7. Надпись, расположенная вдоль произвольной кривой

Эта глава была посвящена основным принципам работы с текстом в Adobe Photo-
shop. Подведем краткие итоги: теперь мы имеем общее представление о шрифтах,
умеем форматировать отдельный символ и абзац, изучили основные команды
работы с текстовыми слоями.



Глава 16

Исправление поврежденных
участков изображения
В этой главе мы познакомимся с некоторыми приемами устранения таких недо-
статков изображения, как попавшие в кадр посторонние предметы, царапины на
негативе или отпечатке, нежелательные следы грязи на снимке или на фотогра-
фируемом объекте.

Устранение со снимка случайно попавших
в кадр объектов или следов механического
повреждения снимка
Рассмотрим яркий пример подобных недостатков. На рис. 16.1 показан фраг-
мент фотографии здания. К сожалению, снимок, позволяющий изучить форму
капителей колонны, несколько испорчен попавшими в кадр проводами. Кроме
того, на левой колонне имеется несколько грязных пятен, а в верхнем правом
углу — темная полоса непонятного происхождения.

Рис. 16.1. Пример изображения, содержащего ряд дефектов и нежелательных
включений — провода, грязь и т. д.
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Попробуем устранить все или хотя бы большую часть этих дефектов, постарав-
шись сохранить остальное изображение в неприкосновенности. Как вы увидите,
для большинства дефектов применяются одни и те же методы очистки, незави-
симо от того, вызван дефект повреждением сканируемого фотоотпечатка или же
это случайно попавший в кадр кусок провода или пластиковый стаканчик.

Прежде всего устраним непонятный предмет в верхней части снимка. Восполь-
зуемся для этого инструментом Healing Brush (Корректирующая кисть). Она хо-
рошо подходит для устранения небольших дефектов, находящихся на равномер-
но окрашенных поверхностях, например на фоне гладкой стены (см. рис. 16.1).
Выберите кисть подходящего размера, щелкните на чистом участке поверхности,
удерживая нажатой клавишу Alt. Этим вы укажете, откуда следует брать образцы
для заполнения дефекта. После этого проведите кистью по поврежденной облас-
ти. Вы будете видеть курсор кисти и указатель в виде креста, указывающий точ-
ку выбора образца (рис. 16.2).

Рис. 16.2. В процессе работы с инструментом Healing Brush на экране отображается положение
кисти и точки выбора образца изображения для «починки» дефекта

Если поверхность достаточно однородная, удаление дефекта практически не ос-
тавляет следов. Результат только что выполненного нами действия показан на
рис. 16.3.

Теперь приступим к устранению со снимка более сложного объекта — проводов
и тросов. Сама по себе задача не сложнее, чем предыдущая, но в данном случае
объект находится на неоднородном поле, более того, этот «фон» является важ-
ной частью изображения, которое надо сохранить. Поэтому к выбору инструмен-
тов, их параметров и исходных изображений для заполнения дефектов следует
подходить более тщательно.

В левой части изображения находится крюк для крепления проводов. Для уст-
ранения такого сложного объекта инструмент Healing Brush (Корректирующая
кисть) или действующий аналогично ему инструмент Patch (Заплата) подходят
плохо. Дело в том, что при взаимодействии этого инструмента с протяженными
объектами возможно возникновение размытых пятен, ухудшающих вид изобра-
жения. В данном случае воспользуемся обычным копированием, этот процесс
проиллюстрирован на рис. 16.4.
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Рис. 16.3. Результат удаления дефекта с однородно окрашенной поверхности
при помощи инструмента Healing Brush

Рис. 16.4. Процесс копирования фрагмента изображения для замещения
«поврежденной» области

На рис. 16.4, а показан исходный фрагмент изображения. Выделите фраг-

мент, похожий на поврежденный, — в данном случае это соседний участок стены.
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В зависимости от конфигурации объектов используйте выделение необходимой
формы. Подойдет прямоугольное выделение.

Нажмите и удерживайте нажатыми клавиши Ctrl и Alt, этим вы переключите ин-
струмент в режим копирования. «Перенесите» выделенный фрагмент в нужную
точку изображения. Вид изображения в этот момент показан на рис. 16.4, б. Сни-
мите выделение фрагмента изображения, так как оно может помешать дальней-
шей обработке. Щелкните мышью в пустом участке изображения, предвари-
тельно выбрав инструмент выделения, или используйте команду Select > Deselect
(Выделить > Снять выделение).

Подберите необходимое положение выделенного фрагмента. Вы можете переме-
щать его до момента снятия выделения. При необходимости выровняйте грани-
цы фрагмента при помощи инструментов Healing Brush (Корректирующая кисть).

Результат такого преобразования показан на рис. 16.4, в.

Теперь очистим изображение от проводов. Тонкие объекты подобной формы
легко устраняются при помощи инструмента Healing Brush (Корректирующая
кисть). Грамотно подобрав положение кисти и точки выбора образца, можно
закрасить провод одним длинным мазком.

СОВЕТ
Вы можете рисовать прямые линии произвольной длины. Для этого выберите и настройте
нужный инструмент и щелкните мышью в начальной точке линии. После этого установите
курсор в конечной точке и щелкните мышью, удерживая нажатой клавишу Shift.

Можно включить режим точного указания точек изображения. Для этого нажмите клавишу
Caps Lock. При этом курсор примет форму креста, более удобную для точного указания
точек, чем курсор в форме кисти.

Более толстые линии, плохо обрабатываемые инструментами Healing Brush (Кор-
ректирующая кисть) и Patch (Заплата), можно закрасить, используя инструмент
Clone Stamp (Штамп). Он не производит смешивания исходного и копируемого
изображений, что избавит вас от возникновения пятен при соприкосновении
светлых и темных областей исходного и копируемого изображений.

Для выбора точки, из которой будет происходить копирование, укажите точку
с подходящим неповрежденным изображением и щелкните мышью, нажав кла-
вишу Alt. После этого закрасьте поврежденные участки.

Вы можете многократно выбирать новые точки выборки исходного изображе-
ния. Это позволит точнее воссоздавать изображение на участках, закрытых по-
сторонним предметом. Для более «гладкого» слияния исходного и копируемого
изображения используйте кисть с размытыми краями, однако кисть с резкими
краями дает более четкое изображение.

На рис. 16.5 показан результат применения этого инструмента для исправления
недостатков изображения.

Как видно, все посторонние включения, мешавшие рассмотреть основной объект
съемки, практически полностью устранены. Мы избавились от посторонних вклю-
чений и проводов, загораживавших колонну. Осталось избавиться от грязного
пятна на левой колонне — для этого воспользуемся инструментом Patch (Заплата).
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Рис. 16.5. Результат применения инструмента Clone Stamp для коррекции изображения
•

Прежде всего, выберите инструмент Patch (Заплата) и переключите его в наибо-
лее удобный для вас режим. Режим Source (Источник) позволяет выделить по-
врежденный участок и затем, «перетащив» его при помощи мыши, указать ис-
точник для выборки эталонного изображения. Режим Destination (Получатель),
наоборот, позволяет выделить участок эталонного изображения и «переместить»
его на поврежденный участок.

Можно использовать тот режим, который кажется вам более удобным. В данном
случае используем режим Source (Источник).

Выделите участок колонны с пятном, используя инструмент Patch (Заплата) или
любой другой инструмент выделения. Вид окна документа на этом этапе показан

на рис. 16.6.

Выделив нужный фрагмент, используйте инструмент Patch (Заплата) и «перета-
щите» выделенный фрагмент на неповрежденный участок изображения, схожий
с участком, «подлежащим ремонту». Перед этим убедитесь в том, что на панели
свойств инструмента переключатель Mode (Режим) установлен в положение Source
(Источник). Снимите выделение. При необходимости повторите операцию. Воз-
можно, будет полезно устранять повреждение по частям.

На рис. 16.7 показан конечный результат коррекции изображения. Теперь ничто
не помешает рассматривать понравившиеся вам фотографии. Однако помните
о том, что любая коррекция изображения приводит к потере деталей. В данном
случае мы избавили фото от мешавших нам предметов, однако уже никто, рассмат-
ривая вашу фотографию, не узнает, что на этом здании висят провода и есть пятна.
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Рис. 16.6. Для использования инструмента Patch в режиме Source выделите
поврежденный участок изображения

Рис. 16.7. Вид изображения после коррекции — заслонявшие изображение посторонние
предметы устранены, но помните — без деталей изображение может потерять свою

информативность и привлекательность
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Устранение эффекта «красных глаз»
Теперь познакомимся с методами устранения одного из наиболее распростра-
ненных недостатков портретных фотографий — эффекта «красных глаз».

Как известно, «красные глаза» возникают в результате отражения света фото-
вспышки от сетчатки глаза. Так как вспышка используется при съемке в услови-
ях плохой освещенности, зрачок глаза при этом оказывается расширенным и сет-
чатка особенно хорошо освещается при срабатывании вспышки.

Лучший способ избежать этого эффекта — принять соответствующие меры во вре-
мя съемки. При выполнении портретной съемки лучше пользоваться не вспыш-
кой, а постоянными источниками света (использовать осветители или выбрать
для съемки хорошо освещенное место). Если же съемка без вспышки невоз-
можна, попросите позирующих вам людей не смотреть прямо в объектив. В этом
случае эффект отражения света от сетчатки глаза в объектив будет выражен не
так сильно.

Если же перед вами возникла проблема устранения «красных глаз» со снимка,
вы можете использовать некоторые из возможностей Adobe Photoshop.

В Adobe Photoshop CS был введен специальный инструмент, предназна-
ченный для устранения подобных недостатков, — Color Replacement (Замена
цвета). Он позволяет производить замену цвета в указанной области изображе-
ния на цвет переднего плана.

Выберите этот инструмент, увеличьте нужный фрагмент изображения и устано-
вите в качестве цвета переднего плана черный. После этого установите курсор
над «красным глазом» и аккуратно, стараясь слегка (но только слегка) захваты-
вать края зрачка, обработайте его инструментом. На рис. 16.8 показаны исходный
фрагмент изображения и тот же фрагмент после применения инструмента Color
Replacement (Замена цвета).

тЯЯ

Рис. 16.8. Результат применения инструмента Color Replacement для устранения эффекта
красных глаз: исходное изображение (слева) и результат использования инструмента (справа)

Для получения наилучшего эффекта в каждом конкретном случае подберите опти-
мальные настройки инструмента. В данном случае использовался режим наложе-
ния Luminosity (Яркость). Обратите внимание: края «перекрашенного» зрачка
получились немного более четкими, чем это бывает на реальных снимках. Воз-
можно, стоило установить меньшее значение плотности (Hardness) краев кисти.
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СОВЕТ
Задать параметры кисти можно, щелкнув мышью на значке кисти на панели свойств инстру-
мента.

Еще один метод восстановления нормального вида зрачков на фотографиях —
ручная перерисовка. Вы можете просто нарисовать зрачки заново. Хотя этот ме-
тод несколько более трудоемкий, он дает вам больший контроль над изображе-
нием и применим в более ранних версиях Adobe Photoshop и других графиче-
ских редакторах, не имеющих специальных инструментов для замены цвета.

На рис. 16.8 вы уже видели исходное изображение. Выберите инструмент
Brush (Кисть), установите в качестве цвета переднего плана черный и под-
берите кисть подходящей формы.

Настроив инструмент, аккуратно закрасьте красный зрачок, стараясь не задеть
близлежащие участки радужной оболочки глаза, имеющие нормальную окраску.
Результат выполнения этого действия показан на рис. 16.9.

Рис. 16.9. Результат закрашивания «красного глаза» — нежелательная
окраска исчезла, но глаз приобрел неестественный вид

Как видно, глаз избавился от нежелательной окраски, но приобрел неестествен-
ный вид. Сравните его с исходным изображением (см. рис. 16.8, слева) — «но-
вый» глаз совершенно лишен бликов, обычно образующихся в глазах, что делает
его неестественным. Для восстановления естественного вида глаза добавим блики
от источников света.

Внимательно рассмотрите исходное изображение и отметьте для себя, как распо-
ложены блики от вспышки и иных источников света, а также какую они имеют
форму. Установите в качестве цвета переднего плана цвет, подходящий к цвету
бликов на исходном изображении. В нашем примере мы используем белый цвет.
Уменьшите форму кисти, при необходимости отрегулируйте прозрачность, зада-
ваемую для инструмента.

СОВЕТ
Перед выполнением сложных преобразований стоит сохранить резервную копию изображе-
ния или скопировать его на отдельный слой, который следует сделать невидимым и для
большей надежности заблокировать. Это позволит при необходимости обратиться к исходно-
му изображению и изучить его особенности или получить образец исходного изображения,
например, для восстановления поврежденных участков и заполнения дефектов.
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Поле того как инструмент готов к работе, нанесите несколько мазков так, чтобы
их положение и форма напоминали положение и форму бликов на исходном
изображении. При необходимости изменяйте параметры кисти между мазками.
Результат подобного действия показан на рис. 16.10.

Рис. 16.10. Результат устранения эффекта красных глаз вручную при помощи инструмента Brush

Как видно, блики «оживили» изображение, сделали только что нарисованный
нами зрачок похожим на настоящий.

Борьба с «цифровым шумом»
Цифровые фотокамеры являются электронной техникой, и им, как и любой другой
электронике, свойственны некоторые физические особенности, например чувстви-
тельность к влаге или шумы, возникающие при замыкании и размыкании контак-
тов, работе усилителей и датчиков. Светочувствительная матрица фотокамеры
также является источником шума, который проявляется на снимках и может стать
серьезной проблемой, особенно при использовании высокой чувствительности.

На рис. 16.11 приведен пример увеличенных фрагментов однородной гладкой
поверхности (край цветочного горшка), сделанных при минимально возможной
чувствительности, выбранной камерой автоматически, и при максимально воз-
можном значении чувствительности (в данном случае ISO 400).

Рис. 16.11. Два снимка, сделанных при низкой чувствительности матрицы (слева) и при
максимально возможном значении (справа)
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Как видно, при высокой чувствительности матрицы уровень шума, присутст-
вующего в любом случае, становится настолько высоким, что он четко заметен
на изображении.

ПРИМЕЧАНИЕ -
Подобная проблема возникает при работе с традиционными фотоматериалами. При исполь-
зовании пленки с высокой чувствительностью становится заметной ее зернистость.

При высокой чувствительности и длинных выдержках (например, при съемке ночных пейза-
жей) многие цифровые фотоаппараты задействуют систему шумоподавления, позволяющую
значительно снизить воздействие шума на готовое изображение.

Сразу оговорим важный момент борьбы с подобными явлениями — устранение
шума и других нежелательных элементов изображения без потери деталей не-
возможно. Поэтому предотвращать возникновение шума и других нежелатель-
ных элементов изображения следует еще во время съемки.

Для борьбы с шумом в изображении существует несколько методов. Adobe Photo-
shop CS содержит несколько фильтров, предназначенных для устранения шума
из изображения.

Фильтр Noise > Dust&Scratches (Шум > Пыль и царапины) позволяет устранять
с изображения незначительные вкрапления, такие как шум. На рис. 16.12 по-
казано окно управления этим фильтром. Параметр Radius (Радиус) задает радиус,
в пределах которого производится «размытие» каждого из пикселов изображе-
ния. Параметр Threshold (Порог) позволяет ограничить воздействие фильтра -
чем выше уровень порога, тем больше неоднородностей «пройдут» фильтр неиз-
менными. Это позволяет избежать излишне большой потери деталей.

Dust ft Scratches

.;f:"v:^ В 100%

Radius: ] 4 I pixels

Threshold; -i 3 ifevels

Рис. 16.12. Окно управления фильтром Noise > Dust&Scratches
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На рис. 16.13 приведен пример обработки изображения при помощи этого
фильтра.

Рис. 16.13. Пример обработки изображения при помощи фильтра Dust&Scratches

Фильтр Noise > Median (Шум > Медиана) также позволяет устранять неоднород-
ности изображения. Окно его управления показано на рис. 16.14.

Рис. 16.14. Окно управления фильтром Noise > Median

Результат применения этого фильтра сходен с результатом использования фильт-
ра Dust&Scratches (Пыль и царапины).

Еще один достаточно эффективный метод борьбы с цифровыми шумами осно-
ван на том, что цвет изображения значит для человеческого глаза гораздо мень-
ше, чем яркость. Так как большая часть шума приходится на вариации цвета,
можно попытаться устранить их, не затронув информацию о яркости пикселов.
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Для этого следует перевести изображения в цветовой режим Lab, который преду-
сматривает отдельное хранение информации о яркости и цвете пикселов. Пере-
ведите изображение в этот режим, после этого выберите по отдельности каждый
из каналов а и Ь, хранящих информацию о цвета, и примените к ним какой-либо
из фильтров, предназначенных для размытия изображения. При желании можно
применить один из описанных выше фильтров к каналу Lightness (Яркость).

В этой главе мы ознакомились с методами, которые позволят вам существенно
улучшить внешний вид ваших фотографий. Мы рассмотрели способы устране-
ния с изображений посторонних предметов, исправления эффекта красных глаз
и шума, возникающего при съемке с высокой чувствительность. Все эти знания
могут существенно помочь вам при подготовке фотографий к печати или исполь-
зованию в других работах, но помните о том, что любая коррекция приводит к ис-
кажению и потере деталей, поэтому стремитесь делать снимки так, чтобы после-
дующее вмешательство не требовалось вообще или было минимальным.



Глава 17

Дополнительная обработка
фотографий
В этой главе мы познакомимся с различными способами придать фотографиям
более интересный вид или сделать их более привлекательными и информатив-
ными для тех, кто будет их просматривать.

Кадрирование изображения
Зачастую предметы, являющиеся основным предметом съемки, занимают в кадре
слишком мало места и плохо смотрятся при печати. В таких случаях следует
кадрировать изображение, чтобы выделить основной объект.

В традиционной фотографии такие проблемы решаются на этапе печати — на-
строив фотоувеличитель или печатную машину, вы можете получить отпечаток
необходимой области кадра. При этом основной объект съемки может быть увели-
чен. Цифровое изображение не может быть увеличено без потери качества, точнее,
пределы увеличения, при котором качество изображения остается приемлемым,
ограниченны. Поэтому изображение, полученное со сканера или цифровой ка-
меры, можно только обрезать, выделив нужную часть кадра. При этом следует
обращать внимание на размеры выделяемой области — она не должна оказаться
меньше, чем требуется для качественной печати.

ПРИМЕЧАНИЕ
В большинстве случаев для качественной печати достаточно разрешения 300 dpi. При этом раз-
мер кадра для печати снимков в формате 10 х 15 не должен оказаться меньше 1200 х 800 пик-
селов (это примерный формат кадра камер, имеющих матрицу с 2 мегапикселами). •

Так как необходимо обеспечить требуемый размер кадра, для кадрирования при-
годны только изображения, имеющие достаточно большой размер, например, по-
лученный с камеры, имеющей матрицу 3,2 и больше мегапиксела.

СОВЕТ
Во многих случаях предпочтительнее использование увеличения во время съемки, хотя сни-
мать при большом увеличении часто невозможно из-за тряски или неудобно из-за вносимых
объективом искажений.
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Для кадрирования изображения, прежде всего, откройте нужный файл. Щелкни-
те мышью на заголовке панели Info (Информация) или вызовите ее на экран при
помощи команды Windows > Info (Окно > Информация). Она поможет следить за
размерами выделенной области во время выполнения кадрирования.

На рис. 17.1 показан вид исходного изображения. Его размер — 2594 х 1944,
что позволит выделить часть допустимого размера, вполне подходящего для
печати.

Рис. 17.1. Исходное изображение — кадрирование позволит выделить
часть изображения и сделать фотографию более интересной

Для кадрирования изображения удобно использовать инструмент Marquee fpyi
(Выделение). Выберите из списка Style (Стиль) на панели инструментов ;*"**;

пункт Fixed Aspect Ratio (Фиксированное соотношение сторон). Это позволит
выделить область, имеющую заданные пропорции. После этого введите в поле
Width (Ширина) значение 15, а в поле Height (Высота) — значение 10. Это задаст
правильное соотношение сторон для фотографии горизонтального формата. Для
вертикальной фотографии поменяйте значения местами. Это можно быст-
ро выполнить, щелкнув на расположенной между полями кнопке.

Выделите нужную область изображения. При этом следите за показаниями по-
лей W (Ширина) и Н (Высота) панели Info (Информация). Ширина фрагмента
не должна быть менее 1200 пикселов, а высота — менее 800 пикселов.
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На рис. 17.2 показан вид окна документа с выделенной областью, указывающей
будущую площадь кадра. На рис. 17.3 видно состояние панели Info (Информа-
ция) в этот момент: размеры области позволят отпечатать выделенный фрагмент
с приемлемым качеством.

Рис. 17.2. Окно документа с выделенной областью будущего отпечатка

R : 118
G : 168
В : 205 •'.*№•

H i 206°
S 5 42%
В ; 80%

X i
¥ i

1008
720

W i
H .'•:

1520
1013

Рис. 17.3. Вид панели Info (Информация) во время выделения области, показанной на рис. 17.2

Для завершения кадрирования обрежьте части изображения, находящиеся за
кадром. Вызовите команду Image > Crop (Изображение > Обрезка). На рис. 17.4
показан результат выполнения описанных выше действий.

В главе, посвященной подготовке изображений к печати, вы познакомитесь с тем,
как правильно указать размер будущего отпечатка при выводе на бумагу и разре-
шение печати.
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СОВЕТ
Как и многие другие операции, кадрирование может быть выполнено несколькими путями.
Например, вы можете воспользоваться инструментом Crop (Обрезка).

Рис. 17.4. Кадрированное изображение — наиболее интересный участок
теперь займет большую часть кадра

Создание размытой рамки
Мы уже рассматривали метод создания рамки вокруг изображения. Это была
простая прямоугольная рамка. Теперь попробуем создать более красивую и слож-
ную в изготовлении овальную размытую рамку.

Прежде всего, откройте файл, подлежащий обработке. В данном примере исполь-
зуем изображение, показанное на рис. 17.5.

Для удобства редактирования создайте новый слой и при помощи панели Layers
(Слои) убедитесь в том, что он активен (его пункт на панели выделен цветом).

Выберите инструмент Elliptical Marquee (Эллиптическое выделение). Для rps
этого удерживайте в течение некоторого времени нажатой кнопку инст- '&%&
румента Marquee (Выделение), а затем выберите инструмент Elliptical Marquee
(Эллиптическое выделение) из появившегося на экране меню.

Проверьте, установлен ли флажок Anti-aliased (Сглаживание), расположенный
на панели свойств инструмента, при необходимости установите его. Выдели-
те фрагмент изображения, который должен оказаться внутри рамки, включите
в рамку несколько больший фрагмент изображения — края рамки будут раз-
мытыми.
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Рис. 17.5. Исходное изображение — попробуем снабдить его овальной рамкой

На рис. 17.6 показано окно изображения на этом этапе редактирования.

Рис. 17.6. Выделенная область, определяющая границы будущей рамки
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Полученную выделенную область необходимо «вывернуть наизнанку» — исполь-
зуйте команду Select > Inverse (Выделение > Инвертировать). После этого устано-
вите в качестве основного цвета белый (или иной цвет по вашему вкусу) и выбе-
рите инструмент Paint Bucket (Заливка). Щелкните левой кнопкой мыши внутри
выделенной области для заполнения ее выбранным цветом. Снимите выделение
с закрашенного фрагмента изображения. Для этого воспользуйтесь, например,
командой Select > Deselect (Выделение > Снять выделение). Результат выполне-
ния этих действий показан на рис. 17.7.

Рис. 17.7. Почти готовая рамка; если результат вас устраивает, можете
использовать его без дополнительных преобразований

Для завершения процесса рисования рамки надо размыть ее края. Это несложно
сделать при помощи одного из фильтров размытия изображения. Так как мы ри-
суем рамку на отдельном слое, размытие не повлияет на остальное изображение.

Удобнее всего для размытия рамки использовать фильтр Filter > Blur > Gaussian Blur
(Фильтр > Размытие > Размытие по Гауссу). Вызовите эту команду и при помощи
имеющегося в окне фильтра ползунка отрегулируйте степень размытия рамки.
За эффектом вы можете наблюдать в процессе настройки в окне изображения,
если в окне фильтра установлен флажок Preview (Просмотр). Также можно вос-
пользоваться областью просмотра, расположенной прямо в окне фильтра.

На рис. 17.8 показано изображение после выполнения размытия рамки.

Аналогичным образом можно создавать рамки различной формы. Достаточно
выделить нужные фрагменты изображения, используя различные инструменты
и методы выделения.
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Рис. 17.8. Готовая размытая рамка

Добавления текстовых комментариев
Теперь попробуем добавить к фотографии текстовый комментарий. Мы уже вы-
полняли подобные задачи, рассматривая работу с текстом в Adobe Photoshop CS,
но теперь применим полученные в других главах знания и сделаем надпись бо-
лее красивой и информативной.

Сначала рассмотрим исходное изображение и выберем место для расположе-
ния надписи. Изображение, которое мы используем в этом примере, показано на
рис. 17.9.

Выберите наиболее подходящее, на ваш взгляд, место для поясняющей надписи.
В этом примере разместим ее в нижнем левом углу изображения.
Прежде всего установите в качестве цвета переднего плана цвет, хорошо замет-
ный на фоне изображения. В данном случае изображение в месте размещения
надписи окрашено в темные тона, поэтому выберем белый цвет. Воспользуйтесь
инструментом Туре (Текст) и создайте надпись, содержащую дату съемки. Под-
берите подходящий шрифт и размер надписи. Поместите надпись в вы- ги»з
бранную точку изображения. Завершите редактирование надписи, щелкнув : : : <:

на кнопке, расположенной на панели свойств инструмента, или просто •-•••^
выбрав другой инструмент. ш!
Таким же образом создайте еще один текстовый слой, в который поместите
информацию об объекте съемки. Выберите шрифт, отличающийся от шрифта,
которым была написана дата. При необходимости уменьшите размер шрифта.
На рис. 17.10 показан результат создания двух текстовых слоев.
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'ис. 17.9. Исходное изображение - здание Государственного Эрмитажа, Санкт-Петербург

lMM6_0/03,j№ ® 33,3» (ROM»)

ШИШ
-Ш if J i f f f

04.04.2004 Зимний дворец - Государственный Эрмитаж
Санкт-Петербург

Рис. 17.10. Результат добавления даты и поясняющего текста к фот

этого любой удобный" ^деления аЮ'ЩУЮ ̂ ^ Используйте для
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сделает надпись более заметной, если отрегулировать его прозрачность. Устано-
вите прозрачность слоя равной 30-50 %. В некоторых случаях подойдет другое
значение, в иногда потребность в подобном выделении надписи вообще отсутст-
вует. На рис. 17.11 показан результат проделанной работы.

Рис. 17.11. Поясняющая надпись помещена на специальный фон,
благодаря чему она стала более заметной

Надпись готова. Не забудьте перед печатью в фотолаборатории объединить слои
и сохранить изображение в формате, принимаемом лабораторией, с которой вы

работаете.

СОВЕТ
Так как надписи должны хорошо читаться не только на экране, но и после вывода на бумагу,
соотносите их размеры с размерами изображения. Возможно, вам будет удобно работать
при отображении фотографии в размере, которой она примет при печати. Для перехода
в этот режим воспользуйтесь командой View > Print Size (Вид > Размер при печати).

Объединение фрагментов панорамных
изображений
Многие любители цифровой, да и традиционной фотографии снимают панорам-
ные изображения достопримечательностей, пейзажей, помещений. Это дает воз-
можность запечатлеть объекты, не помещающиеся в одном кадре. Полученный
набор фотографий позволяет составить более полное представление о предмете
фотографирования.

Однако разрозненные фотографии смотрятся далеко не так хорошо, как один
отпечаток. При использовании традиционной фотографии можно отпечатать
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изображения, вырезать из них ножницами нужные участки, совместить в единое
целое, сфотографировать и заново отпечатать. Цифровые технологии значитель-
но облегчают и ускоряют этот процесс, но ручное совмещение снимков требует
опыта и времени.

Adobe Photoshop CS содержит компонент Photomerge (Объединение фотографий),
позволяющий выполнить объединение фотографий в общую панораму в авто-
матическом или полуавтоматическом режиме. Получить доступ к этому ком-
поненту вы можете при помощи команды File > Automate > Photomerge (Файл >
Автоматизация > Объединение фотографий).

При вызове этой команды на экран выводится окно, показанное на рис. 17.12.

Photomerge

Choose two or more flies to create a panorama
composition/ or click the "Open Composition" button to
view an existing composition.

OK

STC_0367.jpg
STA_0365.jpg
siB_0366.jpg

Browse.,

0 Attempt to Automatically Arrange Source Images

Рис. 17.12. Начальное окно работы с командой Photomerge

Если программа находит открытые в данный момент документы, пригодные
для слияния в панорамное изображение, они автоматически помещаются в рас-
положенный в окне список. В противном случае вам следует выбрать файлы
вручную.

Из списка Use (Использовать) выберите один из вариантов:

• Files (Файлы) — выбрав этот пункт, используйте кнопку Browse... (Просмотр...)
для вызова на экран окна открытия файлов. Используя это окно, найдите и вы-
берите необходимые документы.

• Folder (Папка) — нажав кнопку Browse... (Просмотр...), вы можете указать пап-
ку, содержащую нужные изображения.

• Open Files (Открытые файлы) — для получения панорамы используются доку-
менты, открытые в данный момент.
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Выбрав необходимые файлы, еще раз просмотрите список. Ненужные файлы
можно удалить из него (но не с диска) при помощи кнопки Remove (Удалить).
Кнопка Open Composition (Открыть композицию) позволяет загрузить ранее
сохраненные результаты использования модуля Photomerge (Объединение
фотографий).

Флажок Attempt to Automatically Arrange Source Images (Разместить изображения
автоматически) позволяет выполнить автоматическое совмещение выбранных
вами файлов в единое целое. Вы сможете откорректировать результат совмеще-
ния вручную.

Указав необходимые файлы и параметры, нажмите кнопку ОК. Программа авто-
матически откроет выбранные вами файлы.

После этого, если вы не указали на необходимость автоматического совмещения
изображений, на экране появится окно, показанное на рис. 17.13.

Cancel

P.SV;«YV

* D:£>uSlgntptiotoU3_03_2(№4'<STC_03&?.tH s

Рис. 17.13. Окно совмещения изображений в панораму

В верхней части окна находится список выбранных вами ранее фотогра- [£"|
фий. Выберите инструмент Select Image (Выбор изображения). После этого ™^
«схватите» мышью изображение из списка и перенесите его в центральную часть
окна. Если вы «поднесете» изображение к уже имеющимся в окне фрагментам,
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программа попытается автоматически подогнать эти фрагменты друг к другу.
Для перемещения уже выделенного фрагмента щелкните по нему мышью и «пе-
ренесите» в нужную точку окна. Вы можете дважды щелкнуть по изображению,
находящемуся в списке. При этом его положение среди уже помещенных в ниж-
нюю часть окна фрагментов будет определено автоматически.

Инструмент Rotate Image (Повернуть изображение) позволяет повернуть г^
выбранный фрагмент изображения. Выберите этот инструмент, щелкните *»»«
по нужному фрагменту и поверните его, перемещая мышь.

Если в момент выбора файлов для слияния в панораму вы установите флажок
Attempt to Automatically Arrange Source Images (Разместить изображения автомати-
чески) (см. рис. 17.12), вам не придется самим размещать изображения в окне.
Программа сделает это самостоятельно, вам останется только откорректировать
их размещение, если вы сочтете его недостаточно точным.

В правой части окна находятся органы управления работой модуля Photomerge.
Кнопки ОК и Cancel (Отмена) позволяют выполнить команду с установленными
настройками или же отказаться от ее выполнения. Кнопка Save Composition (Со-
хранить композицию) позволит вам сохранить параметры, заданные для коман-
ды в данный момент, и использовать их в дальнейшем.

В группе Navigator (Навигатор) вы можете просмотреть общий вид изображения
и изменить его масштаб при помощи ползунка. Вы можете работать с этими эле-
ментами так же, как с панелью инструментов Navigator (Навигатор).

В группе Settings (Настройка) вы можете выбрать режим настройки изображе-
ния. В режиме Normal (Нормальный) вы можете разместить изображения на под-
ходящие для них места. Режим Perspective (Перспектива) позволит также управ-
лять коррекцией перспективных искажений, возникающих, например, при съемке
протяженных объектов с одной точки.

На рис. 17.14 показан вид окна команды Photomerge в режиме Perspective (Пер-
спектива).

В режиме Perspective (Перспектива) вы можете задать точку схождения ss
воображаемых лучей перспективы. Для этого выберите инструмент Set ?
V a n i s h i n g Point (Установить точку схождения). Щелкните по фрагменту изо-
бражения, в котором находится точка схождения воображаемых параллельных
линий у горизонта. При этом геометрия остальных фрагментов будет изменена
для восстановления вертикальных и горизонтальных линий, переходящих из
одного фрагмента в другой.

Группа Composition Settings (Настройка композиции) позволит выбрать допол-
нительные настройки объединения изображений в панораму. Флажок Cylindrical
Mapping (Коррекция цилиндрических искажений) позволит включить коррекцию
искажений, возникающих при изменении изображений в процессе задания пер-
спективы.

Флажок Advanced Blending (Точное наложение) позволит увеличить плавность
цветовых переходов между соседними фрагментами панорамы.
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Результат включения этих режимов можно просмотреть только на готовом изо-
бражении или в специальном режиме предварительного просмотра. Для перехо-
да в этот режим нажмите кнопку Preview (Просмотр). Изменение параметров ко-
манды в режиме просмотра невозможно, для возврата в режим редактирования
нажмите кнопку Exit Preview (Выйти из режима просмотра).

Phulomerge

О ;••} Cancel

Рис. 17.14. Вид окна команды Photomerge в режиме Perspective (Перспектива)

В нижней части окна находятся еще два флажка. Флажок Snap to Image (При-
крепить к изображениям) позволяет автоматические производить распознание
и размещение схожих фрагментов изображения при их сближении. Флажок Keep
as Layers (Сохранить как слои) позволит вам получить результат работы команды
в виде слоев, а не единого изображения.

Для завершения процесса подготовки панорамного изображения нажмите кноп-

ку ОК.

На рис. 17.15 слева показан результат применения команды Photomerge (Объеди-
нение фотографий). Для завершения обработки остается кадрировать изображение,
для того чтобы устранить оставшиеся по краям прозрачные области. На рис. 17.15
справа показана кадрированная вертикальная панорама Михайловского замка
(Санкт-Петербург), составленная из трех кадров.
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Рис. 17.15. Результат применения команды Photomerge (Объединение
фотографий): слева — до кадрирования, справа — после

ВНИМАНИЕ
Обработка изображений при подготовке к объединению их в панораму и непосредственно
процесс объединения могут занять много времени, особенно если исходные изображения
имеют большой размер.

СОВЕТ
В ходе размещения изображений в окне команды Photomerge (Объединение фотографий)
вы можете использовать инструменты Hand (Рука) и Zoom (Увеличение), уже знакомые вам
по работе с изображениями в основном окне Adobe Photoshop.

В этой главе мы познакомились с некоторыми дополнительными возможно-
стями по обработке фотографий, которые предоставляет в наше распоряжение
Adobe Photoshop CS. Помимо непосредственно полученного результата — на-
пример, добавленной к изображению рамки, подобные упражнения позволяют
лучше освоить Adobe Photoshop, его инструменты и команды.



Глава 18

Отправка фотографий
по электронной почте,
публикация в Интернете,
создание индекса снимков
В этой небольшой главе мы познакомимся с тем, как подготовить фотографию
к отправке по электронной почте и к размещению в Интернете. Так как эта кни-
га посвящена прежде всего фотографии, авторы надеются на то, что основы ра-
боты в Интернете вы успешно освоите самостоятельно.

СОВЕТ
Авторы рекомендуют обратиться к одной из множества книг, посвященных работе'в Интер-
нете, в том числе выпущенных Издательским домом «Питер». Более подробную информа-
цию об этих книгах можно найти в разделе «Список рекомендуемой литературы».

Оптимизация фотографии для отправки
по электронной почте
Электронная почта — одна из самых старых служб Интернета. Она непрерывно
совершенствуется, так же как и доступные большинству пользователей системы
связи, однако отправка файлов большого объема по-прежнему остается про-
блемой: кто-то имеет относительно медленный доступ в Интернет через модем,
у кого-то объем письма ограничен почтовым сервером, да и почтовый ящик не
так велик, как хотелось бы, и т. д. Все это наводит на мысль о том, что для от-
правки по электронной почте объем файла изображения желательно уменьшить.
Рассмотрим методы выполнения этой операции.

Прежде всего определитесь с оптимальным размером изображения. Например,
изображение, полученное с цифровой фотокамеры, имеющей матрицу 5 мегапик-
селов, имеет размер приблизительно 2500 х 1900 пикселов. Файл, содержащий
такое изображение, даже при использовании сжатого формата будет иметь объ-
ем несколько Мбайт. В то же время большинство пользователей Интернета ра-
ботает с разрешением экрана 800 х 600 или 1024 х 768 пикселов. Это значит, что
полученное с камеры изображение просто не поместится на экран.
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Таким образом, мы выяснили, что для просмотра на экране (а это основной спо-
соб просмотра фотографий, пересланных по электронной почте) изображение
можно смело уменьшить до размера 800 х 600 пикселов и даже меньше. Это по-
зволит значительно снизить объем файла изображения.

Другое дело — пересылка изображений, предназначенных для печати. Как
мы уже говорили в предыдущей главе, для качественной печати фотографии
10 х 15 требуется изображение размером не менее 1200 х 800 пикселов. Поэтому
уменьшать размер файла придется за счет использования возможностей форма-
та, в котором сохраняется файл. Например, задав подходящую степень сжатия
для файла в формате JPEG.

В любом случае, кроме пересылки изображения для использования в высокока-
чественной полиграфии, для отправки изображения по электронной почте сле-
дует использовать один из распространенных в Интернете форматов — GIF или
JPEG. Использование этих форматов не только обеспечит нормальную пересыл-
ку изображения без возникновения конфликтов, вызванных неверным распо-
знаванием типа передаваемых данных, но и позволит получателю просмотреть
изображения с помощью средств, имеющихся в его операционной системе. Для
просмотра файлов, сохраненных в этих форматах, подойдет любой браузер, под-
держивающий работу с графикой.

ПРИМЕЧАНИЕ —
В полиграфии и других областях, связанных с обработкой и передачей высококачественных
изображений, принято использовать для обмена подобными данными формат TIFF. Но изо-
бражения, сохраненные в этом формате, занимают много места. Во многих случаях вы мо-
жете использовать формат JPEG с высоким качеством. Это обеспечит значительную эконо-
мию места при практически незаметных отклонениях изображения от оригинала. Если вы
все-таки хотите отправить файл в формате TIFF по электронной почте, используйте про-
грамму-архиватор для уменьшения объема файла.

Особенности применения форматов изображений мы подробно рассматривали в главе 3.

Форматы GIF и JPEG поддерживают сжатие данных, что позволяет уменьшить
объем файла, однако в силу своих особенностей формат GIF мало применим
для сохранения и передачи фотографий. Поэтому сохраняйте полноцветные изо-
бражения, предназначенные для отправки по электронной почте, в формате
JPEG. При этом вы сможете регулировать объем файла, выбирая степень сжатия.
В главе 5 мы познакомились с тем, как открыть и сохранить изображение в Adobe
Photoshop CS.

Эти же принципы применимы и к выбору размера изображения для размеще-
ния в Интернете. Однако к качеству изображения в этом случае предъявляются
повышенные требования, в то время как размер изображения (в пикселах), как
правило, заранее определен структурой веб-страницы.

СОВЕТ
Выбирая размер и степень сжатия для изображения, проведите несколько экспериментов.
Это особенно полезно на первых шагах освоения работы с цифровой фотографией. Вы смо-
жете сравнить результат сохранения изображений и размеры файлов.
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ВНИМАНИЕ
Перед сохранением изображения с высокой степенью сжатия сделайте его копию. Это по-
зволит при необходимости вернуться к работе над изображением, не искаженным алгорит-
мом сжатия.

Если вы по каким-либо причинам не хотите использовать сжатые форматы
изображений, сохраните изображение в формате TIFF и воспользуйтесь допол-
нительной программой-архиватором. Это позволит уменьшить размер файла.
Однако удостоверьтесь в том, что у получателя фотографии найдется программа,
способная распаковать присланный архив.

СОВЕТ
Вы можете использовать самораспаковывающиеся архивы — для их распаковки не потребу-
ется дополнительных программ, хотя файл имеет несколько больший объем. Главное, чтобы
пользователь, получивший файл, работал в операционной системе, совместимой с системой,
установленной на вашем компьютере. Создание самораспаковывающихся архивов входит
в набор функций большинства программ-архиваторов.

После того как изображение сохранено в подходящем формате и готово к отправ-
ке, создайте письмо в вашей программе работы с электронной почтой и присо-
едините к нему файл.

Подготовка изображений к размещению
в Интернете
Подготовка изображений к размещению в Интернете сводится, как правило, не
считая цветокоррекции и другой обработки, к заданию размера изображения
и выбору формата файла. Однако если вы хотите быстро и просто создать фото-
галерею, пригодную для размещения в Сети, используйте встроенные возможно-
сти Adobe Photoshop.

Команда File > Automate > Web Photo Gallery (Файл > Автоматизация > Фотогалерея
для Web...) позволит быстро создать веб-страницу, содержащую миниатюры ва-
ших работ, причем при желании пользователь сможет просмотреть их в большем
масштабе и даже написать вам письмо по электронной почте. На рис. 18.1 пока-
зано окно этой команды.

Прежде всего, выберите стиль оформления страницы галереи из списка Styles
(Стили). При этом в правой части окна вы сможете наблюдать уменьшенную ко-
пию примера оформления страницы в выбранном стиле. В поле E-mail введите
адрес электронной почты, который будет использоваться в качестве контактного
адреса, размещаемого на странице.

В группе Source Images (Изображения) укажите источник изображений. Из спи-
ска Use (Использовать) выберите пункт Folder (Папка), если хотите использовать
файлы, размещенные в некоторой директории. Выбрав пункт Selected Images from
File Browser (Выбранные на панели просмотра файлы), вы сможете задействовать
файлы, выбранные на панели File Browser (Браузер файлов). Файлы необходимо
выбрать до начала подготовки галереи.
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Web Photo Gallery

Site

Stiles:: | Centered Frame 2 - Feedback

E-mail:; j photoiSseiverjprn

Source Images

Ua3:. IFolder

. : 1 Browse..^

OK

Cancel

.',.:««:

Extension: j.htrn

П Use UTF 8 Encoding for URL

: :0 Acid Width and Height Attributes for Images

; . , ; О Preserve all metadata .

Рис. 18.1. Окно команды Web Photo Gallery — настройка параметров
автоматизированного создания online-фотогалереи

Если вы хотите взять файлы из какой-либо папки, щелкните на кнопке Browse
(Просмотр) и выберите папку, содержащую файлы изображений, которые вы хо-
тите поместить на страницу. Флажок Include All Subfolders (Включить вложенные
папки) позволит включить в галерею файлы, находящиеся не только в указан-
ной папке, но и во вложенных папках.

Нажмите кнопку Destination (Место хранения) и выберите папку, в которую будет
сохранен результат работы команды — готовая фотогалерея.

При помощи списка Options (Параметры) просмотрите группы параметров ко-
манды и при необходимости измените их. Вы можете изменить следующие груп-
пы параметров:

• General (Общие) — можно выбрать расширение для основного файла галереи
(.htm или .html), а также указать на необходимость сохранения дополнитель-
ных данных о структуре страницы. В большинстве случаев изменять установ-
ленные по умолчанию значения не следует;

• Banner (Заголовок) — можно задать название сайта (Site Name), имя фотогра-
фа (Photographer), контактную информацию (Contact Info) и дату (Date);
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• Large Images (Большие изображения) — вы можете задать параметры сохране-
ния больших копий изображений для детального просмотра;

• Thumbnai l s (Миниатюры) — задаются параметры уменьшенных копий изобра-
жений, используемых для предварительного просмотра без загрузки больших
изображений, файлы которых могут иметь значительный объем;

• Custom Colors (Цвета) — здесь можно задать цвета, которые будет использова-
ны для различных элементов страницы;

• Security (Безопасность) — можно задать параметры вывода различных элемен-
тов страницы на экран.

Закончив ввод параметров, щелкните на кнопке ОК.

На рис. 18.2 приведен пример страницы, созданной командой Web Photo Gallery
(Фотогалерая для Web). После завершения обработки изображений готовая
страница будет открыта в браузере автоматически. После этого вы сможете
загрузить ее на веб-сайт, откуда она будет доступна всем желающим. Обратите
внимание: Adobe Photoshop не всегда корректно работает с кодировками сим-
волов, отличных от латинского алфавита, поэтому для нормального отображе-
ния русских символов может потребоваться ручное редактирование HTML-кода
автоматически созданной страницы.

Э Test Pljetogdllery - Miuosofi Inlpinet Explorer

' Файл Правка Вид Избранное Сервис Справка

; о • 9 а а & \ Р •&• «г
; Аде*.: ;фЗ D:\rxiV*ork\rj:g:taIPhotografhy\Editor\

'omputer

Рис. 18.2. Пример страницы, созданной командой Web Photo Gallery

10 Зак. 805
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Создание индекса фотографий
Многие фотолаборатории предоставляют такую услугу, как печать индекса фото-
графий, — все кадры пленки распечатываются на одном листе бумаги. Это позво-
ляет быстро оценить, какие кадры стоит отпечатать в увеличенном формате.
Также вы можете, имея индексы, быстро определить, на какой пленке и на каком
кадре находится нужное изображение. Индекс можно отправить заказчику или
потенциальному клиенту, с тем чтобы он выбрал нужные кадры или оценил
ваши возможности. Разумеется, возможности фотографа лучше представлять,
демонстрируя полное портфолио, но доставить потенциальному клиенту объ-
емистую папку не всегда представляется возможным.

Adobe Photoshop позволяет быстро создать индекс файлов, находящихся в ка-
кой-либо папке. Это позволит, как и индекс фотопленки, выбрать кадры, кото-
рые хотелось бы просмотреть в большем разрешении. Например, вместо отправ-
ки нескольких десятков фотографий по электронной почте вы можете отправить
родственникам или друзьям индекс, с тем чтобы они выбрали те фотографии,
которые им нужны. Это позволит сэкономить время и затем доставить людям
только необходимые фотографии в оптимальном качестве.

Создать индекс можно при помощи команды File > Automate > Contact Sheet II...
(Файл > Автоматизация > Контакт-лист 2).

На рис. 18.3 показано окно настройки этой команды.

В группе Source Images (Исходные изображения), так же как для команды
Web Photo Gallery (Фотогалерая для Web), укажите папку с исходными изобра-
жениями.

В группе Document (Документ) задайте высоту (Height) и ширину (Width) кон-
такт-листа. При этом из списка Units (Единицы измерения) вы можете выбрать,
в каких единицах будут заданы эти размеры. В поле Resolution (Разрешение) вве-
дите разрешение, которое будет задано для документа. Это имеет значение, если
вы собираетесь выводить индекс на печать. В этом случае удобнее задать раз-
меры документа в дюймах или сантиметрах. Из списка, расположенного рядом
с полем Resolution (Разрешение), можно выбрать единицы измерения, в которых
указывается разрешение печати.

Из списка Mode (Режим) можно выбрать цветовой режим, в котором будет со-
хранен документ, а флажок Flatten All Layers (Объединить все слои) позволит
объединить слои, на основе которых создается документ индекса.

ПРИМЕЧАНИЕ
Индекс фотографий создается в виде графического файла, который затем может быть со-
хранен в любом графическом формате и обрабатываться как обычное изображение.

В группе Thumbnails (Миниатюры) вы можете задать параметры расположения
изображений в индексе. Из списка Place (Размещение) выберите, будут ли изо-
бражения размещаться справа налево (across first) или сверху вниз (down first).
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Поля Columns (Столбики) и Rows (Строки) позволяют задать число строк и столб-
цов, в которых будут размещены изображения. При снятом флажке Use Auto-
Spacing (Расстояния автоматически) вы можете ввести в поля Vertical (По верти-
кали) и Horizontal (По горизонтали) расстояния между изображениями. Флажок
Rotate For Best Fit (Повернуть для лучшего размещения) позволяет повернуть
изображения, ориентированные вертикально или горизонтально, так, чтобы
площадь листа была использована оптимальным образом. В правой части окна
показан примерный вид будущего индекса фотографий. Там же выводится число
листов и изображений, найденных в указанной директории.

0 Include А8.Subfofcters

Pjge I of 1
0 of 0 Images

: EJFlatter дШуегз

;:;:0use filename As Caption

в: I 12 pt p

Рис. 18.3. Окно команды Contact Sheet II

При установленном флажке Use File Name As Caption (Имена файлов в качестве
заголовков) имена файлов, вошедших в индекс, будут размещены рядом с фото-
графиями. Списки Font (Шрифт) и Font Size (Размер) позволяют выбрать шрифт
заголовков и их размер.
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Для начала создания индекса фотографий щелкните на кнопке ОК.

ПРИМЕЧАНИЕ
Если в процессе создания контакт-листа он оказывается переполненным, автоматически
создается новый документ, в котором продолжается размещение оставшихся фотогра-
фий. Таким образом будут созданы индексы для всех найденных в указанной директории
файлов изображений. \

СОВЕТ
Зачастую процесс создания индекса фотографий занимает много времени, но вы можете
в любой момент прервать этот процесс, нажав клавишу Esc.

На рис. 18.4 приведен пример контакт-листа, созданного командой Contact Sheet II...

(Контакт-лист 2...).

lMG_0723.jpg IMG_0724.jpg

}.jpg IMG_0

Рис. 18.4. Пример индекса фотографий, созданного командой Contact Sheet II
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В этой главе мы рассмотрели способы оптимизации файлов изображений для от-
правки по электронной почте, а также некоторые дополнительные возможности
Adobe Photoshop, позволяющие опубликовать изображения в Интернете или
подготовить их для демонстрации-в качестве контакт-листов. Контакт-листы
также могут оказаться полезными при организации коллекций изображений -
их можно распечатывать или записывать на диски вместе с файлами изобра-
жений. В этом случае для поиска нужного изображения вам понадобится про-
смотреть один или несколько контакт-листов вместо десятков или даже сотен
фотографий.

. -

•



Глава 19

Подготовка изображений к печати
и вывод их на бумагу
Настоящая глава посвящена тому, как распечатать полученное с цифровой камеры
или отсканированное изображение таким образом, чтобы оно выглядело достойно.

Основная проблема, возникающая при печати изображений, — несоответствие
цветов, которые мы видим на экране монитора, цветам на распечатанном изобра-
жении. Такого неприятного сюрприза можно попытаться избежать, если предва-
рительно выполнить некоторые действия.

Первое, что необходимо сделать, — проверить на совместимость с цветовой мо-
делью CMYK то изображение, которое требуется распечатать. Для этого нужно
выполнить команду View > Gamut W a r n i n g (Вид > Предупреждение о выходе из
цветового охвата) (рис. 19.1).

Рис. 19.1. Слева — исходное изображение, справа — изображение после
выполнения команды View > Gamut Warning
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Как видно из рис. 19.1, пикселы тех цветов, которые выходят за рамки цвето-
вого диапазона CMYK, то есть не могут быть адекватно переданы при печати,
приобрели серый оттенок. Повторное выполнение команды View > Gamut Warning
(Вид > Предупреждение о выходе из диапазона) позволяет отменить серую ок-
раску.

До вывода изображения на печать, но после того, как проведены все мероприя-
тия по его коррекции, нужно выполнить перевод из цветовой модели RGB в цве-
товую модель CMYK. Перевод из одной модели в другую осуществляется
командой Image > Mode > CMYK Color (Изображение > Режим > CMYK). При этом
происходит замещение цветов, не входящих в диапазон CMYK, на наиболее
к ним близкие.

После выполнения этой команды вы можете обнаружить, что некоторые цве-
та изменились, потускнели или приобрели другой оттенок. Поправить поло-
жение поможет небольшая коррекция, проведенная с помощью команды Image >
Adjustments > Hue/Saturation (Изображение > Настройки > Тон/Насыщенность)
(рис. 19.2).

Hue/Saturation

•Q"

L.:..

Reset.

I Load:., j

I Save.'.?' '."1

IQporize
E! Preview

Рис. 19.2. Диалоговое окно команды Image > Adjustments > Hue/Saturation

Попробуйте немного переместить вправо ползунки Saturation (Насыщенность)
и Lightness (Яркость). Это поможет вернуть цветам изображения вид, близкий
к исходному.

Теперь следует обратить внимание на расположение изображения на листе бума-
ги. Задание формата листа бумаги, на котором предполагается распечатывать
изображение, и его ориентации производится командой File > Page Setup (Файл >
Установка страницы) (рис. 19.3).

Самый простой способ посмотреть, как изображение вписывается в лист задан-
ного формата, — нажать левой кнопкой мыши на ту область в нижней части экра-
на, где отображается размер открытого изображения (рис. 19.4).
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Параметры страницы

: Бумага • •• : -••••-•;

.Размер: А4

Подача: (Автовыбор

Ориентация . Поля (мм)

OK I j Отмена [ [ Принтер.

Рис. 19.3. Диалоговое окно команды File > Page Setup

I o«r me area you wanl to enlarge. Change the zoom stjte on (h* OpUons bar

Рис. 19.4. Просмотр примерного расположения изображения на листе бумаги
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Если результат просмотра вас не устраивает и требуется изменить размер изо-
бражения, вам поможет команда Image > Image Size (Изображение > Размер изо-
бражения) (рис. 19.5).

Width- pixels

;;> J768 ] j pixels
=1J

Reset

Г 'Document Size;

36,12 JLSH.
cmHeight: 127,09

Resolution: {72 Ifpixeis/inch (Ц

El Scale Stales

; EOConstrain Proportions

Sftesample Image: ! Bicubic

Рис. 19.5. Диалоговое окно команды Image > Image Size

Группа Pixel Dimensions (Размеры в пикселах) показывает размеры изображения
в пикселах или в процентах, в зависимости от того, какие единицы выбраны из
выпадающего меню. Изменение этих размеров отобразится на экранных разме-
рах изображения.

Группа Document Size (Размер документа) показывает размеры изображения для
вывода на печать в привычных единицах измерения, таких как сантиметры или
миллиметры, а также его разрешение. Разрешение можно задавать в пикселах на
дюйм или в пикселах на сантиметр. Изменение этих размеров отобразится на
размерах печатного оттиска.

ВНИМАНИЕ
Изменение разрешения влияет на размеры изображения в пикселах. При увеличении разреше-
ния автоматически увеличиваются размеры изображения в пикселах, чтобы размер печатного
оттиска остался неизменным. При увеличении размеров печатного оттиска автоматически
увеличиваются размеры изображения в пикселах, чтобы неизменным осталось разрешение.

Флажок Scale Styles (Масштабировать стили) предназначен для пропорциональ-
ного изменения тех частей изображения, к которым применены стили.

Снятие флажка Constrain Proportions (Сохранить пропорции) позволяет изменять
ширину или высоту независимо друг от друга.

Флажок Resample Image (Интерполяция) указывает на то, что в соответствии
с заданными вами размерами должны быть изменены реальные размеры изобра-
жения — число описывающих его пикселов. Если этот флажок снят, изменены
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могут быть только размеры изображения при печати — реальный размер изобра-
жения останется неизменным.

ВНИМАНИЕ
Изменение реальных размеров изображения (в пикселах), особенно их увеличение, может
существенно ухудшиУь качество. Если вы хотите изменить размер изображения на печати,
снимите флажок Resample Image (Интерполяция) и измените размер печатного изображе-
ние или разрешающую способность.

В выпадающем меню представлены следующие методы интерполяции: Nearest
Neighbor (По ближайшему соседнему пикселу), Bilinear (Билинейная), Bicubic
(Бикубическая), Bicubic Smoother (Бикубическая плавная) и Bicubic Sharper (Би-
кубическая резкая). Метод Nearest Neighbor (По ближайшему соседнему пикселу)
увеличивает изображение, передавая его структуру. Остальные методы сглажи-
вают границы увеличиваемого изображения.

ПРИМЕЧАНИЕ
Интерполяцией называется метод определения чисел, находящихся между известными
значениями. В данном случае — расчет значений цвета для пикселов, добавляющихся при
увеличении размеров изображения.

Снятие флажка Resample Image (Пересчитать изображение) отключает связь
между размерами печатного оттиска и размерами изображения в пикселах, пре-
доставляя возможность изменения размеров печатного оттиска и разрешения
без изменения размеров изображения, хранящегося в файле.

После того как вы определились с размерами изображения, нужно настроить его
расположение на листе бумаги выбранного формата. Предварительный просмотр
можно провести при помощи команды File > Print With Preview (Файл > Печать
с предварительным просмотром) (рис. 19.6).

Scale::! 100% instate toHtMedia
: 1

0 Show; Bounding Box

Dshow More Options

Рис. 19.6. Диалоговое окно команды File > Print With Preview
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Группа Position (Расположение) позволяет задать отступы слева и сверху от края
листа или автоматически отцентровать изображение с помощью флажка Center
Image (Расположить изображение по центру).

Группа Scaled Print Size (Масштабировать размер оттиска) дает возможность из-
менить масштаб изображения или вписать его в заданный формат бумаги, а так-
же напечатать только выделенную область.

Иногда может также понадобиться вывод на печать дополнительной специфиче-
ской информации, такой как метки обреза, калибровочные цветовые шкалы или
название файла.

Для того чтобы получить доступ к заданию вывода такой информации, нужно
установить флажок Show More Options (Показать больше настроек) диалогового
окна команды Print With Preview (Файл > Печать с предварительным просмотром)
(рис. 19.7).

• Scaled Print Эге

Scale: Г100%
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Source space:.:';--;;™— ••- : - .--...:......'..-

Document: ©Document: sRGB IEC61966-2.1

Proof: О Proof Setup: U.S. Web Coated (SWOP) v2:

h Profile:! Same As Source

Рис. 19.7. Диалоговое окно команды File > Print With Preview после установки
флажка Show More Options

Далее из раскрывающегося меню выбираем параметр Output (Вывод). Обратите
внимание на флажки в правой части появившейся вкладки.
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Установка флажка Calibration Bars (Калибровочные шкалы) позволяет вывести на
печать калибровочные цветовые шкалы. Калибровочные шкалы предназначены
для проверки вывода отдельных тонов при цветоделении и представляют собой
полосы плотностей растра, начиная от 10 % и заканчивая 100 %.

ВНИМАНИЕ
Печать калибровочных шкал возможна только при использовании PostScript-принтера.

Установка флажка Registration Marks (Метки совмещения) разрешает вывод на
печать меток для совмещения цветоделенных изображений. Метки совмещения
располагаются по углам изображения и выглядят, как пара перекрестий и звез-
дочка.

Флажки Corner Crop Marks (Угловые метки рамки) и Center Crop Marks (Боковые
метки рамки) служат для определения границ изображения и его центра соот-
ветственно.

Установка флажка Description (Описание) выводит на печать ту информацию
о файле, которая вводится в диалоговом окне команды File > File Info (Файл >
Информация о файле).

Установка флажка Labels (Маркировка) добавляет название файла и обозначе-
ние краски.

Рисунок 19.8 дает представление о том, как выглядят метки совмещения и метки
рамки.

Рис. 19.8. Внешний вид меток совмещения и меток обреза

В Adobe Photoshop предусмотрена также возможность распечатывания изо-
бражения без дополнительных настроек. Сделать это позволяют две команды:
File > Print (Файл > Печать) и File > Print One Copy (Файл > Напечатать одну копию)
(рис. 19.9).
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Рис. 19.9. Диалоговое окно команды File > Print

Внешний вид диалогового окна, представленного на рис. 19.9, может изменяться
в зависимости от модели принтера, но остается практически неизменным. В этом
окне можно настроить диапазон печати, задать количество копий изображения,
получить доступ к специфическим настройкам принтера.

Команда File > Print One Copy (Файл > Напечатать одну копию) не имеет дополни-
тельных настроек.

В том случае, если вы собираетесь распечатывать изображение не дома, а в типо-
графии или фотолаборатории, задайте необходимые параметры изображения
(размеры при печати и разрешающую способность) и сохраните изображение
в одном из распространенных форматов. Для лучшей совместимости с програм-
мами, установленными на компьютере в типографии или лаборатории, исполь-
зуйте формат TIFF или, если размеры размер файла очень важен, формат JPEG.

После сохранения файла запишите его на носитель информации или отправьте
по электронной почте. Эти же процедуры применимы и к обычному переносу
файлов на другой компьютер.

ВНИМАНИЕ
Перед отправкой файла в типографию или фотолабораторию для печати обязательно уточ-
ните требования, предъявляемые к оригинал-макетам печатных изображений. Обратите
внимание на допустимые форматы фалов, размер изображения и разрешающую способ-
ность. Перед отправкой файла в «традиционную» печать преобразуйте изображение в ре-
жим CMYK, для фотолаборатории может потребоваться режим RGB.

СОВЕТ
Если вам необходимо отправить большой файл по электронной почте или записать на но-
ситель информации небольшого объема, можно выбрать вместо формата TIFF формат JPEG.
Однако с точки зрения качества изображения лучше использовать формат TIFF и какую-либо
из программ-архиваторов, используемых для уменьшения размеров файлов.
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ПРИМЕЧАНИЕ
На печати фотографии могут получиться несколько темнее или светлее, чем они выглядят
на мониторе. Это связано с особенностями отображения изображений на мониторах и выво-
да на конкретном печатающем устройстве. Воспользовавшись принтером или услугами ла-
боратории, обратите внимание на то, как изменилось изображение, и учтите это при подго-
товке к печати следующих изображений.

Если в вашем распоряжении имеются модули цветокоррекции для монитора и принтера
(обычно они поставляются вместе с драйверами устройств), проследите за тем, чтобы
они были включены. Это позволит точнее воспроизвести цвета как на мониторе, так и на
принтере. Процедура настройки цветокоррекции (калибровки) монитора и принтера под-
робно описана во многих книгах, посвященных обзору возможностей Adobe Photoshop.

Итак, в этом разделе мы познакомились с основами подготовки изображения
к печати, отправке в типографию или фотолабораторию для вывода на обычную
или фотобумагу. Эти знания пригодятся вам, если вы захотите перевести ваши
фотографии в традиционный вид. Возможно, эта процедура покажется вам не-
сколько сложной и требующей много времени, но радость от вида любимой фото-
графии в рамочке на вашем столе окупит затраты времени и сил.
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Создание коллекции изображений
Немаловажной частью работы фотографа является создание и организация коллек-
ции изображений. Без надлежащего упорядочивания даже редчайшие и очень
интересные кадры довольно быстро превратятся в беспорядочную груду, и найти
нужный кадр будет достаточно сложно, если вообще возможно, В этой главе мы
обсудим методы и способы организации хранения изображений. Существует
множество программ, предназначенных для облегчения этой работы, здесь мы
кратко рассмотрим наиболее распространенные возможности подобного про-
граммного обеспечения. Мы не станем рассматривать какую-либо программу
подробно — в комплекте с вашей цифровой камерой, скорее всего, поставляется
подобная программа и подробное руководство пользователя.

Несмотря на то что основная тема этой книги — обработка изображений, полу-
ченных при помощи цифровых камер, практически все, сказанное в ней, приме-
нимо и к обычной фотографии — многие с той или иной целью сканируют фото-
снимки и слайды. После того как изображение попадает на диск компьютера,
оно может обрабатываться и храниться любым доступным способом, Независимо
от того, какой фотоаппарат использовался при съемке.

Так как коллекция цифровых изображений является в первую очередь набором
файлов, к ним применимы все методы упорядочивания наборов файлов. Первый
шаг к упорядочиванию коллекции делает цифровая фотокамера в процессе съем-
ки — файлы изображений получают порядковые номера. Многие камеры ведут
отсчет непрерывно с момента первого снимка, не обращая внимания на смену
карт памяти, включение и выключение камеры, удаление снимков и перенос их
в компьютер. Это позволяет каждому файлу иметь уникальное имя (в пределах
снимков, сделанных этой камерой), а вам — не перепутать их.

Некоторые программы, предназначенные для копирования снимков из камеры
на жесткий диск компьютера, также позволяют дать снимкам новое имя, состоящее
из общей части и порядкового номера. Например, такой возможностью обладает
программа взаимодействия с цифровыми камерами, встроенная в Windows XP.
В качестве общей части имени вы можете указать название объекта съемки,
местности, в которой вы побывали, или дату. Если программа позволяет перепи-
сывать файлы группами, а не все сразу, можно выбирать близкие по сюжету
снимки и давать им однотипные имена.

Имена, содержащие номер файла, позволяют быстро производить поиск нужного
изображения по имени файла и упорядочивать их, однако такие имена не содержат
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информации о самом изображении. Для определения содержания файла вам при-
дется открыть его. Поэтому в некоторых случаях (особенно если изображения
предназначены для просмотра людьми, плохо знакомыми с сюжетом съемки) по-
лезно помещать в имени файла краткую информацию об изображении.

ВНИМАНИЕ
Задавая имя для файла, помните о допустимом наборе символов. Для обеспечения нормаль-
ной работы операционной системы и совместимости с другими системами, компьютерами и
программами имя файла должно содержать только буквы, цифры, символы «-» и «_» (под-
черкивание). Иногда допускается использование в имени файла пробелов. Стандартное имя
файла, воспринимаемое большинством операционных систем, должно иметь длину восемь
символов. Еще три символа отводятся для расширения, обозначающего тип файла. Расши-
рение отделяется от имени файла точкой.

Современные операционные системы семейства Windows позволяют использовать имена дли-
ной до 256 символов, имеющие несколько расширений (хотя значение имеет только последнее).
Также вы сможете использовать буквы русского алфавита (или других языков, установленных
на вашем компьютере). Однако такие имена допустимы далеко не во всех системах. При пере-
носе изображений на другие компьютеры, записи на компакт-диски, размещении в Интернете
старайтесь использовать только буквы латинского алфавита и короткие имена файлов. Учти-
те, что длина имени файла при записи на компакт-диск в наиболее распространенном фор-
мате Joliet не может превышать 64 символов (вместе с именем папки, содержащей файл).

Полезно не только давать файлам осмысленные имена, но и размещать их в со-
ответствии с темами. Например, можно создать отдельные папки для фотогра-
фий достопримечательностей, друзей, вечеринок или же для конкретных объек-
тов, если вы уделяете фотографированию одного предмета достаточно времени.

Для облегчения процесса упорядочивания изображений существует множест-
во специальных программ. Часто они поставляются вместе с камерой. Такие
программы обычно позволяют просмотреть список изображений, произвести
простую цветокоррекцию, записать текстовые комментарии для изображений.
Многие программы позволяют задавать для каждого файла набор ключевых
слов, а впоследствии быстро находить нужные изображения.

Также бывают доступны дополнительные функции, особенно полезные для на-
чинающих фотолюбителей, еще не умеющих или не считающих нужным исполь-
зовать специализированные программы. Например, программа для организации
коллекций изображений может содержать модуль для записи компакт-дисков,
для отправки писем с изображениями по электронной почте или для загрузки
изображений на сайт в Интернете. Но все же основной функцией подобных про-
грамм остается просмотр изображений, причем сама программа может иметь
симпатичный и необычный внешний вид. На рис. 20.1 приведен пример такой
программы — FlipAlbum Pro 5.0. Она может представлять изображения в виде
обычных фотографий, размещенных на страницах альбома.

Существует и другая разновидность программ организации и просмотра изо-
бражений. Они скромны и функциональны в оформлении, максимально про-
сты и удобны в обращении, не содержат «несвойственных» для программ работы
с изображениями функций, зато позволяют получить максимально подробную
информацию об изображении. На рис. 20.2 показано окно программы Canon File
Viewer, позволяющей не только просматривать изображения на жестком диске
(обратите внимание на выводимый объем служебных сведений), но и взаимодей-
ствовать с цифровыми фотокамерами.
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Рис. 20.1. Цифровой фотоальбом может выглядеть как традиционный и при этом обладать
массой интересных и удобных функций — окно программы FlipAlbum Pro 5.0
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Рис. 20.2. Canon File Viewer — пример профессиональной программы для просмотра
изображений — простой и понятный интерфейс, максимум информации
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Вместе с тем с цифровыми камерами и другим оборудованием, предназна-
ченным для получения и обработки изображений, могут поставляться доста-
точно мощные графические редакторы, позволяющие производить обработку
изображений практически на профессиональном уровне. На рис. 20.3 показа-
но окно программы ArcSoft PhotoStudio. С относительно простыми камерами
поставляется более простая, но и более наглядная версия программы этой
компании.

Fte Edit Select Layer Enhance Effects Convert View Window/Hap

J rectangle ~J Г" draw from сет «r T~il!effi»J M: f*T~~ h«gl»: pT™~ -:й;'.;::̂ :п»» Г *м Г subwiet: ,
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Рис. 20.3. AcrSoft PhotoStudio — пример достаточно мощного графического редактора,
поставляемого в комплекте с цифровой камерой

1

Помимо собственно редактирования графические редакторы, поставляемые с циф-
ровыми камерами, могут обладать дополнительными функциями, ориентирован-
ными в первую очередь на обычных пользователей, использующих фотокамеры
для развлечения и пополнения домашнего фотоальбома. Например, вы можете
быстро добавить к изображению рамку или изготовить из фотографии любимого
человека подарочный календарь, щелкнув на двух-трех кнопках.

Еще один интересный класс программ, имеющихся в распоряжении любителей
цифровой фотографии, — программы для обработки панорамных изображений.
Подобные программы позволяют автоматически объединять снятые в несколько
приемов панорамы. Разумеется, если вы на достаточно высоком уровне владеете
Adobe Photoshop или другим профессиональным графическим редактором, вы
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можете выполнить эту процедуру вручную. Но даже вы можете быть приятно
удивлены скоростью и качеством, с которым программы «склеивают» разрознен-
ные части большого изображения.

СОВЕТ
«Склеивание» изображений полезно не только при съемке панорам, но и при выполне-
нии других задач, например при пересъемке больших документов. В любом случае следует
стремиться к тому, чтобы кадры имели достаточно большие перекрывающиеся участки. Это
позволит лучше выполнить сведение и в автоматическом режиме, и вручную, в графиче-
ском редакторе.

На рис. 20.4 показано окно программы ArcSoft PanoramaMaker, предназначен-
ной для объединения изображений в панорамы.

Hortz

Рис. 20.4. Программа ArcSoft PanoramaMaker и ее «собратья» предназначены
для объединения последовательно снятых изображений в панорамы

После того как вы накопили достаточно большое количество фотографий, вы
можете захотеть записать их на компакт-диск. Это особенно актуально для фото-
графий большого размера, которые довольно быстро начинают занимать значитель-
ную часть жесткого диска, даже если в вашем распоряжении диск объемом 120 Гб.
Так как большая часть фотографий используется редко, вам будет полезно убрать
их с жесткого диска и освободить место для других данных и программ.
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Фотографии могут храниться на компакт-дисках, не занимая лишнего места
на жестком диске. Записанные на компакт-диск фотографии можно легко пе-
ренести на другой компьютер — показать друзьям или заказать печать в фотола-
боратории.

Вы можете записывать на диски все файлы подряд, однако гораздо удобнее
упорядочивать диски, разбивая фотографии по каким-либо признакам — дате
съемки, сюжетам и другим.

Для записи файлов на компакт-диски существует множество программ. Некото-
рые из них вы можете бесплатно загрузить из Интернета, другие поставляются
за плату или бесплатно в комплекте с оборудованием (например, устройством
для записи компакт-дисков). Простая программа для записи компакт-дисков
встроена в операционную систему Windows XP. В любом случае перед записью
диска полезно создать его «прототип» в папке на жестком диске. Это позволит
оценить правильность размещения файлов, еще раз проверить, все ли файлы,
которые вы хотели записать на диск, находятся на своих местах.

ВНИМАНИЕ
Перед записью файлов на диск убедитесь в том, что имена файлов имеют допустимую
длину. Как правило, для лучшей совместимости между операционными системами и устрой-
ствами для записи и чтения компакт-дисков длина имени файла (включая имена содержа-
щих его папок) ограничивается 64 символами. При превышении этого числа программа
для записи компакт-дисков может предложить вам изменить имена файлов или выбрать
другой формат записи.

ПРИМЕЧАНИЕ
Полезными окажутся краткие аннотации к дискам, помещенные в их обложки. Можно писать
эти аннотации от руки или печатать на принтере. Обложки дисков часто снабжаются специ-
альными полями для описания содержимого. Также многие программы для записи компакт-
дисков имеют простые средства для заполнения и печати таких обложек.

Кроме печати изображений в фотолаборатории вы можете захотеть отпечатать
несколько фотографий в домашних условиях. Мы уже говорили о том, как
распечатать изображение при помощи Adobe Photoshop CS. Этот способ наи-
лучшим образом подходит для печати ваших работ или для печати фотографий
с точной настройкой параметров печати. Но если вы хотите просто и быстро
распечатать несколько страниц для демонстрации друзьям или домашнего фото-
альбома, можно воспользоваться одной из многих предназначенных специально
для этого программ. Печатать фотографии можно и из программ обработки
изображений, прилагаемых к цифровым фотокамерам. Они же позволяют добав-
лять к изображениям рамки или различные эффекты.

На рис. 20.5 показано окно программы Canon PhotoRecord, предназначенной для
печати красивых фотоальбомов. Вы можете выбрать фотографии и вид фона,
указать, как должны выглядеть рамки фотографий, и расположить фотографии
на листах. После этого вам достаточно щелкнуть на кнопке Печать и выбрать
качество печати в окне управления принтером.
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Click and drag photos or tight-click F« optior

Рис. 20.5. Окно программы Canon PhotoRecord — эта и аналогичные ей программы позволяют
быстро и красочно оформить и отпечатать домашний фотоальбом на принтере

В этой главе мы познакомились с основными принципами организации коллек-
ций изображений. Также мы кратко рассмотрели программы, предназначенные
для организации коллекций изображений, печати изображений и записи их на
компакт-диски. Эта информация полезна для тех, кто предпочтет профессиональ-
ным графическим редакторам и специализированным программам для записи
компакт-дисков простые и быстрые в освоении программы.



Список рекомендуемой
литературы
Книга о цифровой фотографии и Photoshop уже подошла к концу. Если вы чувст-
вуете, что полученных знаний оказалось недостаточно, рекомендуем обратиться
к перечисленным ниже источникам:

1. Гринберг С. Цифровая фотография: Самоучитель. 3-е изд. — СПб.: Питер, 2003.

2. Кинг Дж. Цифровая фотография: стань профессионалом!: Самоучитель. —
СПб.: Питер, 2004.

3. Гурский Ю., Васильев A. Photoshop CS.: Трюки и эффекты (+CD). — СПб.:
Питер, 2004.

4. Надеждин Н. Технология цифровой фотографии. — М.: Кудиц-Образ, 2004.

5. Келби С. Справочник по обработке цифровых фотографий в Photoshop. —
М.: Вильяме, 2003.

6. Буш Д. Цифровая фотография и работа с изображениями. — М.: Кудиц-
Образ, 2003.

7. Надеждин Н. Цифровая фотография: Практическое руководство. — СПб.:
BHV, 2003.

8. Миронов Д. Ретушь на компьютере. — СПб.: Питер, 2004.

9. Джорджес Г., Map К., Берман Л. 50 эффективных приемов съемки цифровым
фотоаппаратом. — Киев: Диалектика, 2004.

10. Шнейдеров В. Фотография, реклама, дизайн на компьютере: Самоучитель.
2-е изд. - СПб.: Питер, 2004.

Справочная система Adobe Photoshop CS также может оказаться ценным источ-
ником информации.
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К Л У Б П Н О /Щ О С И С Ж А Л

В1997 году по инициативе генерального директора Издательского дома «Питер»
Валерия Степанова и при поддержке деловых кругов города в Санкт-Петербурге
был основан «Книжный клуб Профессионал». Он собрал под флагом клуба про-
фессионалов своего дела, которых объединяет постоянная тяга к знаниям и любовь
к книгам. Членами клуба являются лучшие студенты и известные практики из раз-
ных сфер деятельности, которые хотят стать или уже стали профессионалами в той
или иной области.
Как и все развивающиеся проекты, с течением времени книжный клуб вырос
в «Клуб Профессионал». Идею клуба сегодня формируют три основные «клубные»
функции:

• неформальное общение и совместный досуг интересных людей;
• участие в подготовке специалистов высокого класса

(семинары, пакеты книг по специальной литературе);
• формирование и высказывание мнений современного профессионала

(при встречах и на страницах журнала).

КАК ВСТУПИТЬ В КЛУБ?

Для вступления в «Клуб Профессионал» вам необходимо:

• ознакомиться с правилами вступления в «Клуб Профессионал»
на страницах журнала или на сайте www.piter.com;

• выразить свое желание вступить в «Клуб Профессионал»
по электронной почте postbook@piter.com или по тел. (812) 103-73-74;

• заказать книги на сумму не менее 500 рублей в течение любого времени
или приобрести комплект «Библиотека профессионала».

«БИБЛИОТЕКА ПРОФЕССИОНАЛА»

Мы предлагаем вам получить все необходимые знания, подписавшись на «Библио-
теку профессионала». Она для тех, кто экономит не только время, но и деньги.
Покупая комплект - книжную полку «Библиотека профессионала», вы получаете:

• скидку 15% от розничной цены издания, без учета почтовых расходов;
• при покупке двух или более комплектов - дополнительную скидку 3%;
• членство в «Клубе Профессионал»;
• подарок - журнал «Клуб Профессионал».

мзалгепьскип аом
Закажите бесплатный журнал
«Клуб Профессионал». *̂ *̂ www! Р!Т" я"
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МОЖНО ЛЮБЫМ УДОБНЫМ ДЛЯ ВАС СПОСОБОМ:

• по телефону: (812) 103-73-74;
• по электронному адресу: postbook@piter.com;
• на нашем сервере: www.piter.com;
• по почте: 197198, Санкт-Петербург, а/я 619,

ЗАО «Питер Пост».

ВЫ МОЖЕТЕ ВЫБРАТЬ ОДИН ИЗ ДВУХ СПОСОБОВ ДОСТАВКИ

И ОПЛАТЫ ИЗДАНИЙ:

^ Наложенным платежом с оплатой заказа при получении посылки на
ближайшем почтовом отделении. Цены на издания приведены ориентиро-
вочно и включают в себя стоимость пересылки по почте (но без учета
авиатарифа). Книги будут высланы нашей службой «Книга-почтой»
в течение двух недель после получения заказа или выхода книги из печати.

^ Оплата наличными при курьерской доставке (для жителей Москвы
и Санкт-Петербурга). Курьер доставит заказ по указанному адресу
в удобное для вас время в течение трех дней.

ПРИ ОФОРМЛЕНИИ ЗАКАЗА УКАЖИТЕ:

• фамилию, имя, отчество, телефон, факс, e-mail;
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• название книги, автора, код, количество заказываемых
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Башкортостан
Уфа, «Азия», ул. Зенцова, д. 70 (оптовая продажа),
маг. «Оазис», ул. Чернышевского, д. 88,
тел./факс (3472) 50-39-00.
E-mail: asiaufa@ufanet.ru
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Дальний Восток
Владивосток, «Приморский торговый дом книги»,
тел./факс (4232) 23-82-12.
E-mail: bookbase@mail.primorye.ru

Хабаровск, «Мире»,
тел. (4212) 30-54-47, факс 22-73-30.
E-mail: sale_book@bookmirs.khv.ru

Хабаровск, «Книжный мир»,
тел. (4212) 32-85-51, факс 32-82-50.
E-mail: postmaster@worldbooks.kht.ru

Европейские регионы России
Архангельск, «Дом книги»,
тел. (8182) 65-41-34, факс 65-41-34.
E-mail: book@atnet.ru

Калининград, «Вестер»,
тел./факс (0112) 21 -56-28,21 -62-07.
E-mail: nshibkova@vester.ru
http://www.vester.ru

Северный Кавказ
Ессентуки, «Россы», ул. Октябрьская, 424,
тел./факс (87934) 6-93-09.
E-mail: rossy@kmw.ru

Сибирь
Иркутск, «ПродаЛитЪ»,
тел. (3952) 59-13-70, факс 51-30-70.
E-mail: prodalit@irk.ru
http://www.prodalit.irk.ru

Иркутск, «Антей-книга»,
тел./факс (3952) 33-42-47.
E-mail: antey@irk.ru

УВАЖАЕМЫЕ ГОСПОДА!
КНИГИ ИЗДАТЕЛЬСКОГО ДОМА «ПИТЕР»

ВЫ МОЖЕТЕ ПРИОБРЕСТИ
ОПТОМ И В РОЗНИЦУ

У НАШИХ РЕГИОНАЛЬНЫХ ПАРТНЕРОВ.

Красноярск, «Книжный мир»,
тел./факс (3912) 27-39-71.
E-mail: book-world@public.krasnet.ru

Нижневартовск, «Дом книги»,
тел. (3466) 23-27-14, факс 23-59-50.
E-mail: book@nvartovsk.wsnet.ru

Новосибирск, «Топ-книга»,
тел. (3832) 36-10-26, факс 36-10-27.
E-mail: office@top-kniga.ru
http://www.top-kniga. ru

Тюмень, «Друг»,
тел./факс (3452) 21-34-82.
E-mail: drug@tyumen.ru

Тюмень, «Фолиант»,
тел. (3452) 27-36-06, факс 27-36-11.
E-mail: foliant@tyumen.ru

Челябинск, ТД «Эврика», ул. Барбюса, д. 61,
тел./факс (3512) 52-49-23.
E-mail:evrika@chel.surnet.ru

Татарстан
Казань, «Таис»,
тел. (8432) 72-34-55, факс 72-27-82.
E-mail: tais@bancorp.ru

Урал
Екатеринбург, магазин № 14,
ул. Челюскинцев, д. 23,
тел./факс (3432) 53-24-90.
E-mail: gvardia@mail.ur.ru

Екатеринбург, «Валео-книга»,
ул. Ключевская, д. 5,
тел./факс (3432) 42-56-00.
E-mail: valeo@etel.ru
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Photoshop CS
и цифровая фотография
Вы держите в руках книгу, посвященную использованию в цифровой
фотографии одного из наиболее совершенных и популярных графических
редакторов — Adobe Photoshop CS. Прочитав ее, вы научитесь производить
цветокоррекцию изображений, устранять недостатки фотографии, готовить
изображения к печати, выводить их на принтер и размещать в Интернете.
Несмотря на то что основное внимание в книге уделено обработке цифровых
фотографий, все сказанное применимо и к изображениям, полученным
«традиционными» способами.

Книга адресована в первую очередь тем, кто уже знаком с цифровой
фотографией и умеет пользоваться фотокамерой.

ISBN 5-469-00285-3
Научись профессионально
обрабатывать изображения!

9117854691Ю02857 1
Посетите наш web-магазин:
www.piter.comK WWW.PITER.COM




